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Getting Started 
InventoryControl is easy-to-use software that allows you to quickly setup the system.  We 
recommend that you read the Glossary topic before beginning so you are familiar with a few key 
terms that are used through the system and this help file.  While setup is quick and easy, we have 
made it even faster by providing you the steps, in order, you should take to begin entering 
information into the software. 
 
Please read the printed manual and view the video tutorials prior to beginning setup of your 
system.  These materials provide valuable information to make the setup process smooth and 
simple. 
 
Follow the steps below to begin populating your database.  Click on the links below to go to that 
topic for detail information completing each step.   
 

1. Add Users - When you first logon to InventoryControl, you will use Admin as the user 
name and leave the password blank.  This default user profile gives you access to 
everything in the system.  The first step you should take upon logging in is to create 
additional users (Administration > Security).  You should enter all users who will be using 
the system and you can assign specific rights to each user that limit their activities to 
certain functions.  You should also setup at least one additional admin user who has 
rights to all areas of the system. 
  

2. Enter Company Information - Next you should enter your company's information 
(Administration > Company Info).  On the Company Information screen you will enter 
your company's name and any addresses needed for receiving, shipping, corporate 
correspondence, etc.  The company name you enter on this screen will appear on all 
reports and in the title bar of InventoryControl.  In addition, if you have the Pro or 
Enterprise version of InventoryControl, the company name and addresses you enter will 
appear on Pick Orders and Purchase Orders created in the system. 
  

3. Define Sites and Define Locations - Now you are ready to begin entering sites and 
locations into the database. Locations are the areas into which you will be assigning 
inventory, while Sites contain the various locations.  In other words, a Site is a collection 
of Locations.   We suggest creating one site for each building that contains inventory.   
 
A location is typically shorthand for a physical place such as a shelf in your warehouse. 
 Commonly used conventions include Location codes like this: 
 
01 02 05   (for Row #, Shelf #, Bin #) 
 
A distribution business, for example, typically places inventory at a specific location in 
one or more warehouses.  InventoryControl requires that you define at least one Site 
containing at least one Location.  If you have multiple warehouses, you can set each one 
up as a Site, then create multiple locations within each site to represent the specific areas 
where you will be storing inventory.  For instance, you might setup a Site as Warehouse 
1 containing Locations Shelf 1, Shelf 2 and Shelf 3.   
 
A fleet business might define each vehicle as a Site with multiple Locations (bins, for 
example) within each vehicle.  In this case you could setup a Site as Vehicle 1 with 
Locations of Bin1, Bin2 and Bin3. Or each vehicle could be a single Location operating 
out of one or more Sites.  For example, the Site might be Docking 1 with locations of 
Vehicle 1, Vehicle 2, etc. 
 
A retail business might have multiple Locations at one Site or multiple Locations within 
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each of several Sites.  InventoryControl has the flexibility to be configured however it best 
suits your business needs.  Remember that though you must have at least one site 
containing one location, you could have multiple sites that contain multiple locations. 
 There is no limit to the number of locations you can assign to a site. 
 
It is important to note that you can have the same Location code defined at more than 
one Site - for instance, Warehouse 1 and Warehouse 2 may each have Location codes of 
Shelf 1 - so always pay attention to which Site you are working with when performing 
Inventory transactions.  
 
Setting up your locations now will allow you to just pick a Location from a list when you 
begin adding inventory later.  It is possible, however, to define Locations as you add 
inventory.  If you would prefer to do this, skip to Step 5 - Defining Suppliers. 
 
If you already have location information contained in another database, you may want to 
use InventoryControl's Import function rather than manually entering in this information. 
 For more information on importing locations, please refer to the topic Importing Into the 
Database. 
  

4. Creating Location Labels - If you have defined more than one Location, at this point 
you can use the integrated Wasp Labeler to print barcode Location labels for each 
Location and affix them to each warehouse bin, fleet vehicle, etc. 
  

5. Defining Suppliers - Suppliers are those businesses or individuals from which you will 
be obtaining your inventory.  Your business might require that each Item in your inventory 
have an associated supplier. You can have one supplier or many providing you with 
inventory.   
 
If you already have supplier information contained in another database, you may want to 
use InventoryControl's Import function rather than manually entering in this information. 
 For more information on importing locations, please refer to the topic Importing Into the 
Database. 
  

6. Printing the Supplier Report - Now that you have entered all of your Suppliers, you 
might want to print and review the Supplier Report to make sure all the information was 
entered correctly. 
 
  

7. Defining Items - All inventory is based on an Item that contains general information 
about the item, such as manufacturer, suppliers, a description and unit of measure 
information.  Items are created by you and represent the actual material or good that you 
will have in your inventory. The item is not part of your inventory until you add quantity to 
it and specify a location for it.  For example, you might create an Item entry for Mouse - 
Wireless.  Then you can add inventory, or quantity, to that item at a specific location.  
 
On the Create New Item screen, you can assign the item to multiple locations and even 
designate one location as the primary location for this item.  The primary location will the 
pre-populate the screen when removing, adding, receiving (Pro and Enterprise Version 
Only) and picking (Pro and Enterprise Version Only) this item.  
 
If you are using the Enterprise or Professional version of InventoryControl, you can also 
create items that are non-inventory.  This is useful if you need to create an item for 
marketing pamphlets, counter displays or anything you need to have on-hand but don't 
necessarily want to include in your inventory amounts.  In addition, you can create Kit or 
Assembly Items.  Please refer to the topics Assembly Overview and Kitting Overview 
for more information. 
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If you already have item information contained in another database, you may want to use 
InventoryControl's Import function rather than manually entering in this information.  For 
more information on importing locations, please refer to the topic Importing Into the 
Database. 
  

8. Creating Item Labels - You can use the integrated Wasp Labeler to print your Item 
labels.  Labels can be printed directly from InventoryControl, or you can access Wasp 
Labeler to edit or create new labels. 
 
  

9. Adding Inventory - Now that your items have been created, you are ready to add 
inventory, or quantity to those items.  Adding inventory is often referred to as receiving 
inventory. You can think of this step as stocking the InventoryControl program with the 
inventory that is in your warehouse. 
 
When you are adding inventory, you will complete fields specific to your inventory such 
as Location, Quantity, and Cost. Each time you add inventory for an Item, the transaction 
is stored separately in InventoryControl allowing for multiple Locations and cost 
averaging. 
 
If you already have inventory information contained in another database, you may want to 
use InventoryControl's Import function rather than manually entering in this information. 
 For more information on importing locations, please refer to the topic Importing Into the 
Database. 
 
Congratulations!  You are now on your way to populating your inventory database. 
 To add more Items to your database, just return to Step 4 to setup your new Item, 
then Add your inventory for that Item. 
  

10. Printing the Inventory Location Report - Printing the Inventory Location Report will 
allow you to check that your inventory has been entered correctly. 
  

11. After you have added your inventory you are ready to begin using InventoryControl.  Now 
you can setup your mobile devices, if needed, and begin keeping track of your inventory. 
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Glossary 

Adjust - This term refers to adjusting the quantity of inventory at a specified location.  Adjust is 
like a "mini" Audit and will update the quantity using FIFO (First In First Out) to make the total 
equal to the quantity you enter here.  The Adjust function is useful if too much or too little 
quantity is accidentally entered for an item (on a mobile device, for example), inventory is lost, 
found, broken, etc. and you need to quickly correct the quantity for that item.  Adjusting is 
different from an Audit in that the Audit function makes other functions of the software, such as 
adding inventory, unavailable to ensure inventory is not added or removed while you are doing 
the counts.  All features are still available when adjusting inventory. 

Archive - The Archive Transaction feature allows you to archive inactive transactions prior to a 
specified date.  Archiving old information keeps your database running quickly and efficiently. 

Assembly Item - (Pro and Enterprise versions only.) Assembly items are created when you 
combine two or more existing items to create a new item.  You will use the Assembly item type 
when you want to "build" several of the new items to have on hand in your inventory.   

Audit - Auditing your inventory means you are counting the inventory you actually have on hand 
and comparing that number with what is listed in the software.  This allows you to ensure you 
have actual counts in the system.  Audit Mode allows you to check the counts of all your 
inventory while disabling the Add, Remove, Move, Adjust, Check-In and Check-Out features to 
make sure inventory counts in the system do not change while you are performing the audit.  If 
you are using mobile devices, you can use them simultaneously with the PC to perform an audit 
by downloading the database in audit mode to each device.  Audit Mode features a simple Audit 
screen that allows you to enter your counts for inventory in each location and compares these to 
the counts already in the system.  You can then view the Complete Audit screen to review any 
discrepancies between your counts and what was in the system.  At the click of a button you can 
reconcile the counts or you can select certain transactions to accept or reject.  This software also 
comes equipped with several Audit Reports that allow you to review a variety of information at-a-
glance. 

Build Assembly - (Pro and Enterprise versions only.) The function that allows you to build your 
assembly item.  Building Assembly Items can be thought of as the "manufacturing" portion of the 
Assembly Item feature.  When you Build an Assembly Item, the on hand amounts for the sub-
items are reduced by the number needed to make the Assembly Item, and the on hand amount 
for the Assembly Item is increased.  Assembling/Building Assembly Items increases inventory 
for the Assembly Item in the same way that Adding increases inventory for other item types. 

Check-In - Check-in inventory means you are returning inventory that has been "checked-out", or 
assigned, to customer back into your on-hand inventory. 

Check-Out - InventoryControl gives you the ability to check-out, or assign, inventory to a 
customer for a specified (or open-ended) amount of time.  This removes the inventory from your 
on-hand amounts until it is checked back in.  Items that are checked-out cannot be permanently 
removed from your inventory until they are checked back in. 

Disassemble - (Pro and Enterprise versions only.) The process of Disassembling Assembly 
Items will reduce your inventory for the Assembly Item and increase your inventory of the 
associated sub-items.  You will be Removing inventory for the Assembly Item and Adding 
inventory to the sub-items, unless the sub-item has been marked to be scrapped. 
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FIFO -  An abbreviation for first-in, first-out, FIFO is a method employed in accounting for the 
identification and valuation of the inventory of a business. This is the inventory method the 
system uses when adjusting or removing inventory.  FIFO assumes that the first goods added are 
the first removed.  

Inventory - Inventory is the amount or quantity you have of a particular item.  

Item - Items represent the actual material or good that you will have in your inventory.  For 
example, you might create an Item entry for Mouse - Wireless.  Then you can add inventory, or 
quantity, to that item.  If you are using the Enterprise or Professional version of this software, you 
can also create items that are non-inventory.  This is useful if you need to create an item for 
marketing pamphlets, counter displays or anything you need to have, but for which you don't 
need to track quantity. 

Kit Item - (Pro and Enterprise versions only.)  Kit items are a group of items that are sold 
together, but are still considered separate inventory items.  As opposed to Assembly Items, you 
cannot add inventory, move or check out/in Kit Items.  While Assembly Items can be created in 
advance (pre-assembled) and kept in inventory, Kit Items are created at pick or sale time. 

Location - Locations are contained with a Site and represent the place where inventory is kept. 
 A location is typically shorthand for a physical place such as a shelf in your warehouse. 
 Commonly used conventions include Location codes like this: 

    01 02 05   (for Row #, Shelf #, Bin #) 
 
Another example would be to create Site labeled Warehouse 1 containing a Locations labeled 
Bin1 and Bin 2. 

Move - The Move function allows you to move inventory from one location to another. 

Order Unit - This is the supplier's unit of measure used  when ordering an item.  This may be 
box, pallet, etc.  This is different from the "Eaches" stocking unit.  For example, "jar" may be the 
stocking unit, but the supplier may ship the item in boxes containing 10 jars.   

Site - The Site is a broad term containing one or more Locations.  Inventory is assigned to the 
locations within the site.  For example, you might create a Site labeled Warehouse 1 containing a 
Locations labeled Bin 1 and Bin 2. 

Stocking Unit - This is the portion by which an item's quantity will be tracked.  This unit 
represents "Eaches", meaning how you want each item of this type to be measured. (Examples: 
bag, barrel, basket, block, bottle, box, carton, container, drum, gallon, jar, pack, package, pallet, 
section, tub, vial, etc.)    You can designate a different stocking unit for each item in your system, 
if desired. 

Track By - This software allows you to track your inventory by several fields, if desired.  Track By 
options are: Serial Numbers, Lot, Date Code and/or Pallet.  Tracking allows you to follow the 
movements of inventory from receiving, adjusting, moving, checking out, etc. 
 
It is important that you determine how you want to track each Item.  Typically, small Items that are 
all the same may not need to have any Tracked Bys selected.  Items such as printers may need 
to be tracked by Serial Number, so returns and maintenance can be properly tracked.  Medical 
supplies or food may need to be tracked by Date Code and/or Lot. 
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Transaction Code (TransCode) - Transaction Codes can be any code your business assigns to 
certain types of Adjustment transactions.  Assigning these codes can help you with reporting as 
each type of adjustment (breakage, return, etc.) can be given it's own code.  This software does 
not contain any preset codes to give you the opportunity to assign a code that best suits your 
needs, and to allow the entry of codes you already use in your business for these types of 
transactions.  Transaction codes are entered on the Adjust screen. 
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System Administrator Information 

Knowledge Base Available to Provide Answers and Solutions 

The Wasp Bar Code Knowledge Base is available to help you troubleshoot database issues. To 
access the Knowledge Base, go to www.waspbarcode.com/support, then select Knowledge 
Base. 

Video Tutorials and Printed Manual 

The video tutorials can be found in the How to Videos folder and a PDF version of the printed 
manual can be found in the Quick Start Guides folder on your installation CD. 

Changing the System Administrator Password Can Affect Repair Installs 

The System Administrator database password must be blank. If you change the System 
Administrator database password, you will not be able to replace database files.  
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PC Operation 

User Log On 

The Log On screen appears when InventoryControl is first started and when you select File > 
Log Out.   

 

Complete both fields, then click OK to logon to the system. 

The User Name field is not case sensitive. 

The Password field is case sensitive. Asterisks will be displayed as you type the Password. 

The first time you open InventoryControl you can enter the following information:  

User Name:  Admin   

Password:    (blank)   

After log on, the password can be changed via File > Change Password. 
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The Admin account, or any other account with Administration Privilege, can use the Security 
Privileges screen to add Users and set their privileges and reset their passwords.  For more 
information on adding users, please refer to the Adding Users/Editing Security Privileges 
topic. 
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About the About Screen 

The About Screen allows you to view and manage licenses and provides program version 
details 

Using/Viewing the About Screen: 

1. From the Main Window, click Help > About.  The About screen appears. 
 

.   
 
This screen displays your version and basic license information. 
 

2. Click the Licenses button to view additional licenses and your mobile device licenses. 
 On the next page is an example of the Licenses screen: 
 



 

12 

 
 

3. Click OK to return to the About screen. 
 

4. Click OK to close the About screen. 
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Main Window 

The Main Window is divided into four sections: 

Section A: Toolbar 

Section B: Left-Hand Navigation 

Section C: Main Functions 

Section D: Context-Sensitive Menu 

Below is an example of the Main Window: 
 
Note:  The Receive/Pick icon only appears on Pro and Enterprise Versions.   

 

 

Section A: Toolbar 

The toolbar provides access to the following functions: 

File Menu: 
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• Change Password - Allows the user currently logged in to change his/her password. 
• Log Off - Logs the current user off of the system. 
• Exit - Exits the system. 

Tools Menu: 

• Options - Accesses the Options screen where you can customize how certain aspects of 
the software behave. 

• Select Site - Accesses the Select Site screen.  InventoryControl allows you to work with 
more than one Site and multiple Locations within each Site.     

• Archive Transactions - Allows you to store older data in an archive. 
• Reset All Field Names - This option resets any field names you have customized 

through the Edit Field Names function. 
• Reset All Grid Settings - This option resets all settings (sorting, grouping, hidden 

columns) you may have made to your list screens to their default settings. 

Check For Alerts: 

When selected an Alerts drop down list will appear displaying any alerts, such as overdue 
items.   

Help Menu: 

• Contents/Index/Search - Accesses this help file. 
• Update Licenses - Allows you to update your existing license(s). 
• Check for Updates - When this option is selected, the system will search for updates to 

the software and alert you if any exist.  You can then download the updates at your 
convenience.  the software automatically searches for updates at start up.  This option 
allows you to manually search for updates at other times.  Checking for Updates requires 
internet access. 

 

Section B: Left-Hand Navigation 

This software contains a menu on the left side of the Main Window that provides access to the 
following features: 

• New - Displays a menu of all Create New screens (Customer, Locations, Items, etc.). 
 Select which type of data you want to create from the menu. 

• Lists - Displays a menu of all Lists in the system.  Select which List you want to view 
from the menu.  For detailed information on using the list screens, please refer to the 
topic Working with Lists. 

• Find - Displays a menu of data options from which to search (Customer, Locations, etc.) 
 Select which type of data you want to search.  A Find screen appears allowing you to 
quickly search for information. 

• Labels - Displays a menu of labels you can print.  Printing Labels utilizes the Labeler 
software that come bundled with your program.  For detailed instructions on using the 
Labeler software, please refer to the Labeler help file (accessible through the Labeler 
software). 
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Section C: Main Functions 

This section displays the primary functions of this software.  To access any of these functions: 

1. Click on an icon.  A menu of options for that function appears at the bottom of the screen 
(section D - described below). 

2. Click on an icon in the menu to access that function. 

Available menu options are: 

Administration - This option provides access to basic administrative functions such as adding 
users to the system, maintaining user security profiles, backing up and/or restoring the database, 
importing/exporting information and maintaining your company information. 

Inventory - This option provides access to the inventory features of the software.  From this 
menu you can add or remove inventory, move inventory from one location to another, adjust 
inventory amounts and audit all inventory in your system. 

Reports - This option opens the Reports window allowing you to select from a wide range of 
available reports. 

Mobility - This option provides access to your mobile device options. 

Pick/Receive (Pro and Enterprise Versions Only) - This options provides access to the 
pick/receive features of the software. 

 

Section D: Context-Sensitive Menus 

The bottom of the Main Window will display a menu based on the selection you make from the 
Main Functions icons. 

Examples: 

Administration Menu 
 

 

Inventory Menu 
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Receive/Pick Menu 

 
  

Mobility Menu 

This example is of the WDT2200 menu.  The icons in this menu will look different if you are using 
a Windows Mobile®/CE™ mobile device, but the options will be the same. 

 

Reports Menu 

This icon opens the Select Report screen.  For more information on the Select Report screen, 
please refer to the topic Selecting Reports. 
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Changing Your Password 

This feature allows the user currently logged in to change his or her password. 

Changing Your Password: 

1. From the Main Window, click File > Change Password.  The Change Password screen 
appears. 
 

 
 

2. Enter your old password, your new password, then confirm your new password.  As 
passwords are typed, asterisks will be displayed. Passwords are case sensitive. 
 

3. Click OK to save your changes. 
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Update License Screen 

The Update License screen allows you to enter a regular License Key to upgrade from the Demo 
version, or an Update License Key to increase the number of Mobile Devices InventoryControl 
will support.  You can also view the install serial number and activation code information.   

Updating License(s): 

1. From the Main Window, click Help > Update License.  The Update License screen 
appears. 
 

2. If the program has not yet been activated, you will be prompted to enter an Activation 
Code now.   
 

 
 
Click on the registration link that appears above the serial number and then complete the 
information on the Wasp support page.  An email will be sent back to you that contains 
the Activation Code.  Type this code back into the Activation Code field, then click OK to 
activate the program. 
 
If the program has been activated, the following screen appears: 
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3. Enter a new Serial Number to add additional features such as additional mobile device 
licenses. 
 

4. Click OK or click Cancel to exit without updating.  Exit and restart the software to use the 
new key. 

If you use this form to upgrade from the Demo version to a Licensed version of this software, the 
License Key you enter here will be displayed on the About screen. 

If you use this form to increase the number of Mobile Devices InventoryControl will support, your 
original License Key will continue to be displayed in Help About, but it will display the new number 
of mobile devices permitted. 
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Selecting Sites 

InventoryControl allows you to work with more than one Site and multiple Locations within each 
Site. At any time, you can limit all your transactions to a specified Source, a specified 
Destination, or allow transactions at All Sites.  These are chosen on the Select Site screen. 

Keep in mind that you can only select sites to which you have been given access in Security. 

Selecting a Source on the Select Site screen determines the locations available in the Location 
field of the Add, Remove, Check-In, Check-Out, Adjust and Audit functions.  It will also 
determine the locations available in the From Location field of the Move function.  Only locations 
within the Site selected in the Source field will be available for these functions. 

Destination determines the locations available in the Move function's To Location field. 

Remember, you are selecting Sites on this screen.  When you select a site, you are limiting the 
inventory functions to locations within that site. 

For information on adding new sites, please refer to the Creating a New Site topic.  For 
information on adding new locations, please refer to the Creating New Locations topic. 

A Note on Importing: The site specified in the Destination field of the Select Site screen can 
impact the Locations into which imported inventory will be recorded.  When something other 
than <all> is specified as your Source site, imported inventory will be put into Locations at the 
specified Source.  If you have varying site information you wish to import along with the location 
and quantity data for each Item Number, you must make sure the Source is set to <all>  before 
importing data into the Inventory table. 

This topic discusses: 

Selecting Sites 

Source and Destination Examples 

 

Selecting Sites: 

1. From the Main Window, select Tools > Select Site.  The Select Site screen appears: 
 

 
 
By default, all locations are allowed in all functions.  This is designated by choosing <all> 



 

21 

in both the Source and Destination fields, as shown above. 
 

2. Select the Source and Destination Site to which you want to limit transactions.  All 
locations you have entered in the system will appear in the drop down lists. 
 

3. Select OK to save your changes. 

 

Source and Destination Examples: 

Example 1:  

If you want to limit the available locations for adding, removing, checking in/out, adjust and 
auditing inventory to one location (in this example, Warehouse1), you would select that location in 
the Source field as shown below: 
 

 

In the above example, inventory can be moved from a location within Warehouse 1 to any other 
location at another site.. 

Example 2: 

If you want to limit the available locations for adding, removing, checking in/out, adjust and 
auditing inventory to one location (in this example, Warehouse1), and you want to limit move 
destinations to one site (in this example, Warehouse2), you would select Warehouse1 in the 
Source field and Warehouse2 in the Destination field as shown below: 

 

Example 3: 

If you want to limit the available locations for adding, removing, checking in/out, adjust and 
auditing inventory to one location (in this example, Warehouse2), and you want to limit move 
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destinations to locations in the same site, you would select Warehouse2 in the Source field and 
Warehouse2 in the Destination field as shown below: 
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Logging Out 

Logging Out allows the current user to log out of the system so another user can login, if 
needed. 

1. From the Main Window, click File > Log Out.  The Log On screen appears allowing 
another user to log in. 
 

 
 

2. Enter a valid User Name and Password and press OK to log on again or click Cancel to 
exit. 
 
Note:  You can also login as a different user by going to Administration > Security > 
Login as Different User. 
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Checking for Software Updates 

By default, the software will check for updates to the application and notify you if a more recent 
version is available when you login to the system.  You can then access the Updates website 
and download the latest version.  This ensures you are always working with the most up-to-date 
version available to you.   This feature is turned on by default.  

InventoryControl must be installed on a machine with Internet access to check for updates. 

You can turn off the automatic check and perform periodic manual checks, or leave the option on 
and perform a manual check, if desired. 

This topic discusses: 

Disabling the Automatic Version Check Feature 

Performing a Manual Check 

 

Disabling the Automatic Version Check Feature: 

1. From the Main Window, select Tools > Options.  The Options screen appears: 
 

 
2. Highlight the Check for Software Updates option and deselect the Yes checkbox.   
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3. Click OK to save your changes and to Close the Options screen.  The option is now 
disabled.  You can manually check for updates as needed. 

 

Performing a Manual Check: 

From the Main Window, click Help > Check for Updates.   
 

 
 
The system will automatically check for a newer version and notify you if one is available.  This 
procedure can be performed at any time. 
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Item Stock Level List Screen 

The software can automatically notify you of under-stocked items, broken down by location.  By 
enabling the Automatic Notification of Low Order Item on the Options screen, the software 
will display the Item Stock Level List when you first start up the system.  This screen contains 
items that have a Quantity value equal to or less than the Reorder Quantity value set for that 
item and location on the Location tab of the Create New or  Edit Item screen.  For more 
information on enabling and disabling this options, please refer to the Options Screen topic. 

In order for items to appear on this screen, a Reorder Quantity must be entered on the Location 
tab of the Create New Item screen or, after the item is created, on the Edit Item screen. 

Below is an example of the Item Stock Level List: 

 

Click the View Report button at the bottom of the screen to display the Reorder Report. 
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You can use this report to aid you in creating purchase orders for the under-stocked items. 
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Searching for Information 

Searching for Information 

The Find screen allows you to easily search for information within the Inventory Control 
database.  You can limit your search to a specific table in the database, field or even a value 
within a field on the Find screen. 

Searching for Information: 

1. From the Main Window, select the Find icon.  A menu of tables from which to search 
appears. 
 

2. Select what you want to search for by clicking on an option in the Find menu. In this 
example we are going to search for Customers. 
 
You can also access this screen by clicking the Filter button at the top of the List 
screens. 
 
Note:  If the table you select (Customers, Manufacturers, Items, etc.) contains over 
1000 pieces of data, you will automatically be taken to the Advanced Find screen.  For 
further information on the Advanced Find screen, please refer to the Advanced Find 
topic. 
 

 
 

3. The Find screen contains three fields:  

• Table is used to select the table you want to search.   
• Field is used to select the field in the listed table to be searched.   
• Value is the information for which you are searching.   

Selecting the Whole Word Only checkbox will search the selected table based upon the 
your entire entry in the Value field.  Partial matches will be excluded from the search 
results. 
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Selecting the Find All checkbox disables the Field and Value fields.  The search results 
will display all of the records from the table selected in Search. 
 
You can click the Advanced button to go to the Advanced Find screen which provides 
you with more search options. 

4. Click the Find button to start the search.  When the search is complete, a list will appear 
displaying all the records that match your criteria. 

 All searches are case insensitive. 

 Your most recent Find criteria are saved and will automatically be loaded the next time you 
access the Find screen. 

Examples: 

For these examples, assume that the Customer table is made up of three records containing one 
field, called FirstName. The values in this field are Fred, Frederick, and Sam. 

Example Table Field Value Whole 
Word Only 

Option 

Find 
All 

Option 

Search 
Result 

1 Customer FirstName Fred Off Off 2 records: 
Fred; 

Frederick 
2 Customer FirstName Fred On Off 1 record: 

 Fred 
3 Customer FirstName Mike Off On 3 records: 

Fred; 
Frederick; 

Sam 
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Advanced Find 

The Advanced Find screen allows you to search a table in the database using multiple values 
and logical expressions.  This screen is useful when the table you are searching contains a lot of 
data by allowing you to enter several parameters by which to filter your search. 

When you use this screen, you will construct a filter, which limits the information you are 
searching for to certain parameters. 

Using the Advanced Find Screen: 

1. From the Main Window, click the Find icon.  A menu of tables from which to search 
appears. 
 

2. Select what you want to search for by clicking on an option in the Find menu. In this 
example we are going to search for Customers. 
 
Note:  If the table you select (Customers, Manufacturers, Items, etc.) contains over 
1000 pieces of data, you will automatically be taken to the Advanced Find screen.  For 
further information on the Advanced Find screen, please refer to the Advanced Find 
topic. 
 
If you are not automatically taken to the Advanced Find screen, the Find screen will 
appear. 
 

3. Select the Advanced button on the Find screen.  The Advanced Find screen appears. 
 

 
 
The Advanced Find screen consists of seven input fields and a Filter Expression panel 
that displays the resulting filter as you build it.  These fields are described below: 

• Table is used to select the table you want to search. 
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• Parenthesis (open and close) can be used to control the order in which criteria 
will be processed.  The inner most pair of parentheses in any filter expression are 
evaluated first.   
 

• Field is used to select the field in the listed table to be searched. 
 

• Operator is a comparison operator used to evaluate an expression. 

Comparison Operator Meaning 
= equal 

<> not equal 
>= greater than or equal 
> greater than 

<= less than or equal 
< less than 

Like is similar to value 
Not Like is not similar to value 
Is Null no value 

Is Not Null any value 

 

• Like and Not Like are used for text pattern matching. They can only be used with 
plain text fields, not with dates.  The following characters, used within the text 
value, have a special meaning for the Like and Not Like operators:   

LIKE Operator Meaning Examples 
_  (underscore) matches any 

single 
character 

LIKE '_-inch'    matches 
'2-inch', '3-inch', etc. 

% matches zero 
or more 

characters of 
any value 

LIKE 'Eric W%' 
matches 'Eric White', 
'Eric Williams', etc. 

\ Escapes the 
special 

characters 
(gives them 
their normal 
meaning) 

LIKE '\%'   matches '%' 
LIKE '\\'  matches a 
single '\'  

 

• Value is the information you are searching for.  (This may included special 
characters for the Like or Not Like operators). 
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• Logical is a Boolean operator that combines one or more filter expressions into a 
single logical group: 

Boolean Operator Meaning 
AND gives you the intersection of 

two conditions 
OR gives you the union of two 

conditions 

 

4. Enter the desired values for the seven Advanced Find fields to construct a filter 
fragment.  For example, assume you make the following selections: 
 
Table - Customer 
Field - Address 1 
Operator - = 
Value - 2205 Anywhere Road 
 
The Customer table will be searched for any instance of 2205 Anywhere Road 
appearing in the Address 1 field. 
 

5. Click the Add button after building each filter fragment.  The filter will appear in the Filter 
Expression list as shown in the example below: 
 

 
 

6. The Move Up and Move Down buttons allow you to move a filter fragment toward the 
top or toward the bottom of the list, respectively.  To reposition a filter fragment in the 
Filter Expression panel, click on it, then click either the Move Up or Move Down button. 
 
You may edit a filter fragment by first selecting the fragment in the Filter Expression list. 
 The values of the filter fragment populate the seven input fields.  Update any of these 
fields, then click Replace to update the selected filter fragment in the Filter Expression 
list. 
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7. Click the Check button to check the syntax of the Filter Expression. 
 

8. Click the Find button to start the search process.  When complete, a list will be displayed 
showing all the records that match your criteria. 
 

 All searches are case insensitive. 
 

To search for a specific date, build your filter expression to include a time range of 
12:00am to 11:59pm for the given date.  For example, the filter expression Date >= 
12/25/02 12:00am to 12/25/02 11:59pm will return all records that have the date 
12/25/02. 
 

9. Click the Simplified button to revert to the standard Find screen. 
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Administration 

Administration Menu 

The Administration Menu groups tasks such as creating/editing your company information, 
Importing/Exporting functions and maintaining security settings into one place.   

To Access the Administration Menu: 

1. From the Main Window, click the Administration icon. The Administration Menu 
appears at the bottom of the screen. 
 

 
 

2. Click on any of the Administration Menu icons to go to that function.  Detailed 
descriptions of the options found on the Administration Menu are provided below: 
 

• Company Info - The Company Information screen allows you to enter or 
update your company information such as address, phone and email.  The 
Company Name you enter on this screen will be used as the "header" for 
InventoryControl and will appear on all reports and pre-defined labels.  The 
information on the Company Information screen should be filled out first when 
you are initially setting up the software.  For detailed information on this screen, 
please refer to the Company Information Screen topic. 
 

• Security - The Security Privileges screen allows users set up as Administrators 
to add users to the system, set user privileges, assign users to specific sites, and 
delete users.  For detailed information on this screen, please refer to the 
Security Privileges topic. 
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• Import/Export - Import/Export allows you to import data into the database from 
an file or export data to an external file.  Importing data from an external text or 
.csv file is a quick way to setup your software.  For detailed information on 
Importing, please refer to Importing Into the Database.  For detailed information 
on Exporting, please refer to Exporting to a Text File. 
 

• Backup/Restore - The Backup and Restore functions allow you to quickly 
backup your entire inventory database or restore the database as of the last 
backup.  Backing up your database regular is critical to maintaining your 
business continuity in the event of a system failure.  If you backup regularly, you 
can easily restore the database and minimize disruption to your business.  For 
detailed information on these functions please refer to the Backup Database 
topic or the Restore Database topic. 
 
Note: Backup and Restore is not available in the Enterprise version of 
InventoryControl. 
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Company Information Screen 

The Company Information screen allows you to enter or update information about your 
business.  The name entered in the Company Name field on this screen is used as the 
application header as well as the header for all reports and pre-defined labels.  The information 
on this screen should be completed first when setting up your software. 

This topic covers: 

Entering Company Information 

Entering Multiple Address Types 

Deleting an Address Type 

 

Entering Company Information: 

1. From the Main Window, click the Administration icon.  The Administration Menu 
appears at the bottom of the screen. 
 

2. On the Administration Menu, click the Company Info icon.  The Company 
Information screen appears. 
 

 
 

3. Type in the requested information.  The Company Name field is mandatory; all other 
fields on this screen are optional. 



 

37 

4. Click OK to save your changes. 

 

Entering Multiple Address Types: 

This software provides you with the ability to enter a Billing Address, Receiving Address and/or 
Shipping Address for your company and to create new address types as well.  You can enter an 
address for each site that might have inventory shipped to it from purchase orders.  To enter 
multiple address, follow the steps below: 

1. On the Company Information screen, enter your company name.  Select what type of 
address you will be entering from the Address Type drop down menu, or type in a new 
address type.  For example, you could enter Warehouse 1 in the Address Type field.   
 

 
 

2. If you entered a new address type, a confirmation message will appear verifying that you 
want to add it to the database.  Select Yes on this message to save the new address 
type.  The new entry will now appear in the Address Type drop down menu on all 
screens on which you can enter multiple address types (Create/Edit Suppliers, 
Create/Edit Customers, Create/Edit Manufacturers). 
 

3. Enter the remainder of the address information, then click OK.  You will be returned to 
the Administration Menu. 
 

4. Click the Company Info icon again.  The Company Information screen will reappear 
populated with the information you just entered. 
 

5. Select a different address type of the Address Type drop down menu, or enter a new 
one. The address lines (Address 1 and 2, City, State, Postal Code and Country) will clear 
while all other company information will remain on the screen.   
 

6. Enter the new address information, then click OK.  Repeat these steps for each address 
type.   
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Deleting an Address Type: 

You can delete one or more addresses for your company by following the steps below.  The 
delete button is only enabled when you have selected one of the address types you entered.  It is 
not enabled when one of the standard address types (Corporate, Receiving, etc.) is selected. 

1. On the Company Information screen, select the address type you want to delete by 
choosing from the Address Type drop down menu. 
 

2. Click the Delete button.  A confirmation screen will appear. 
 

3. Select Yes on the confirmation screen to delete the information for the selected Address 
Type. 

Note:  You cannot delete addresses that are part of active Pick Orders. 
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Adding Users/Editing Security Privileges 

The Security Privileges screen allows those users setup as Administrators in the system to add 
users, set privileges, and/or delete users.  

A user with Administration Privileges, called an Admin User can add new users and make 
changes to existing users' security options.  We recommend that at least one Admin user in 
addition to the default Admin user be added to the system soon after installation.   

This topic covers: 

Accessing the Security Privileges Screen 

Adding Users on the Security Privileges Screen 

Editing User Profiles on the Security Privileges Screen 

Making Users Inactive 

Copying User Security Profiles 

Security Privileges Definitions 

 

Accessing the Security Privileges Screen: 

1. To access the screen, from the Main Window, click the Administration icon.  The 
Administration Menu appears at the bottom of the screen. 
 

2. Click the Security icon on the Administration Menu.  The Security Privileges screen 
appears. 
 
Note:  The Receive, Pick, Build Assembly and Disassemble Privileges are only 
available to Pro and Enterprise Version Users. 
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When you first access this screen, you will see a user listed as Admin, User (as shown in 
the screen shot above).  This is the default Admin User and this user cannot be changed 
or deleted.  The Admin User profile allows you to access the system for the first time after 
installation and setup your system.  The password for this user can be changed, if 
needed.   

 

Adding Users to the Security Privileges Screen: 

1. On the Security Privileges screen, click File > Add User.  The Add New User screen 
appears. 
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2. First Name, Last Name, a User Name (used when logging on to the system), a 
Password and Status (which is normally set to Active) are required.  You can optionally 
enter a Title, Department, Manager and/or Email address.  If you mark this employee as 
Inactive in the Status field, Inactive will appear next to his/her name in the User List. 
 

3. Click OK to save the new user information.  You will be returned to the Security 
Privileges screen which will now display the new user's profile. 
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4. All privileges and sites are initially disabled when you enter a new user.  This means the 
user will not be able to access anything in the system.  You must select which features 
you want the user to be able to access by selecting the desired checkboxes in the 
Privileges window.  For example, in the screen shot below, the user Roger Dodger was 
given access to Add Inventory, Adjust Inventory and Delete and to Site 200. 
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5. Click OK when you have selected all privileges to which you want this user to have 
access.  These selections can later be changed by any user who has Administration 
Privilege. 
 

6. If you have more than one Site, you can limit this user's access to whichever sites you 
want.  To do this, select the Sites to which you want this user to have access.  Click 
Select All to quickly give the user access to all sites.   
 
Click the "User can access all current and future sites" to automatically give this user 
access to any sites you may add in the future. 
 

7. Click Save to save your changes to this user. 

 

Editing User Profiles on the Security Privileges Screen: 

1. On the Security Privileges screen, highlight the user name you want to edit in the User 
List.  You can now change the selections in the Privileges window by selecting or de-
selecting checkboxes.  An existing user's information can be updated by any user with 
Administration Privilege.  In addition to the ability to change other values, this is where an 
 Administration user can reset a Password for a user that has forgotten it. 
 

2. If you want to change the user name or personal information, highlight the user name in 
the User List and click Edit > Update User.  The Update Existing User screen will 
appear populated with the selected user's information. 
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3. Type in new data as needed, then click the OK button.  You will be returned to the 
Security Privileges screen. 
 

4. Click OK on the Security Privileges screen to save your changes.  If you change your 
own security privileges the changes will not go into effect until the next time you 
log on. 
 
Note:  If you select Cancel, you will exit the screen without saving changes made to the 
Privileges section on the currently selected user.  Changes previously made to other 
users will be saved.  A message will appear asking if you want to discard changes. 
 Select Yes to close the screen without saving the changes, or No to save any changes. 

      The Admin,User is unique in that its user name and privileges cannot be changed.  Only 
the password can be changed for the Admin user.   

 

Making Users Inactive: 

Admin Users can mark users as Inactive, meaning all privileges are revoked and the user's login 
will be inactivated. 

1. On the Security Privileges screen, highlight the user name you want to make inactive in 
the User List. 
 

2. Select Edit > Update User.  The Update Existing User screen appears. 
 

3. Select Inactive from the Status drop down menu. 
 

4. Click OK on the Update Existing User screen.  You will be returned to the Security 
Privileges screen. 
 

5. Select OK on the Security Privileges screen. 

 

Copying User Security Profiles: 

If you have multiple users who will have the same security privileges, you can create one profile, 
then copy it to other users, streamlining the setup process.  To do this: 

1. On the Security Privileges screen, highlight the user name you want to copy in the User 
List. 
 

2. Select Edit > Copy User Settings.  The Add New User screen appears.   
3.  
4. Enter the name and personal information of the user you are adding, then click OK on the 

Add New User screen.  You will be returned to the Security Privileges screen.  The 
user name you just added will appear in the User List and the Privileges will be those 
that you copied. 
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Security Privileges Definitions: 

Add Inventory:  The user will be able to manually add inventory to the system. 

Adjust Inventory:  The user will be able to adjust inventory amounts. 

Administration Privilege:  The user will be able to modify existing users' Security 
Privileges and perform all functions in the system. 

Allow PC Login: The user will be able to login to the program. 

Audit:  The user will be able to perform all audit functions. 

Backup and Restore:  The user will be able to backup and restore the inventory 
database. 

 Be aware that Restore can cause a loss of data added to the database since the 
date and time of the backup file chosen. 

Build Assembly - The user will be able to use the Build Assembly function to add 
inventory to Assembly Items. 

Check In:   The user will be able to Check-In inventory.   

Check Out:  The user will be able to Check-Out inventory. 

Delete: The user will be able to delete records. 

Disassembly - The user will be able to disassemble Assembly items. 

Edit: The user will be able to make changes to records. 

Labels: The user will be able to create labels. 

Move:  The user will be able to Move inventory to another location. 

New: The user will be able to create new items, suppliers, etc. 

Pick: The user will be able to pick inventory from pick orders on the Pick screen. 

Process Mobile Device Data:  The user will be able to process and apply transactions 
that have been downloaded from a mobile device. 

Receive Inventory: The user will be able to mark inventory as Received from purchase 
orders on the Receive screen. 

Remove Inventory:  The user will be able to manually Remove inventory. 

WDT2200:  The user will be able to use a WDT2200 mobile device to perform 
transactions. 
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Backing up the Database 

Note for Enterprise Users:  The Backup feature is not available in the Enterprise version.  You 
must use SQL to perform backups. 

Backing up your database is an important maintenance step that should be performed on a 
regular basis.  Having a current backup helps to minimize data loss in the case of a system shut 
down or power failure.  If you do experience a catastrophic system failure of some kind, having a 
current backup ensures you can quickly restore the most recent database.  For information on 
restoring your database, please refer to the Restoring the Database topic. 

Note:  Each time you Audit your inventory, a backup file is automatically created with the 
date/time included in the file name.  For more information on performing an Audit, please refer to 
the Auditing Your Inventory topic. 

Note for Remote Installations: 

If you have installed your database on a remote PC/Server (a PC/Server other than the one 
where you are running InventoryControl), you can specify a folder on that PC/Server to which the 
backup file will be saved.  This option is set on the Options screen.  For more information on 
designating a backup folder, please refer to the Options Screen topic.   

Backing Up Your Database: 

1. From the Main Window, click the Administration icon.  The Administration Menu 
appears at the bottom of the screen. 
 

2. On the Administration Menu, click Backup.  The Backup Database screen appears. 
 

 
 

3. Enter a name for this backup in the Backup File field.  It is a good idea to specify a name 
that will help you select the right backup file later if you need to restore the database. 
 Adding the date in the file name is a good way to know which file is the latest. 
 
By default, the backup file is written to: 
 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup  
 
Use the Browse button to select a different location. 
 

4. Click OK to backup the database. 

Important Note: The network version of the InventoryControl does NOT browse the file system 
on the local machine.  Instead of the local file system the file system on the machine where the 
database is installed will be displayed. 
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Restore the Database 

Then software allows you to quickly restore a backup database.  This is usually used when there 
has been some type of catastrophic system loss and allows you to minimize downtime in your 
business by restoring the last saved database.   

You can also restore over an existing database, but keep in mind that restoring erases all data 
currently in your database and replaces it with the data in the backup, including all inventory, 
users and items.  If there is a chance you will want to recover transactions that have been 
entered since the backup was done, it is a good idea to backup again before restoring. Save the 
backup to a different file name than the one you are about to restore. 

Note for Enterprise Users:  The Backup feature is not available in the Enterprise version.  You 
must use SQL to perform backups. 

Restoring Your Database: 

1. From the Main Window, click the Administration icon.  The Administration menu 
appears at the bottom of the screen. 
 

2. On the Administration menu, click Restore.  The Restore Database screen appears. 
 

 
 

3. Enter the location and name of the backup in the Restore From File field, or you can 
click Browse to search for a file  
 
By default, backup files are located in: 
 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup  
 

4. Click OK to perform the database restore. 

Important Notes: 

The network version does NOT browse the file system on the local machine.  Instead of 
the local machine file system, the file system on the machine where the database is 
installed will be displayed. 

If you receive an error when trying to restore the database that states "not all connections 
to the database are closed", make sure no other users are logged in to the system.  Close 
InventoryControl and try to restore again. 
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Options Screen 

The Options screen is where you can turn off and on some automatic processes for inventory 
functions and control how the software performs in certain situations.   

This topic covers the following: 

Accessing the Options Screen 

Inventory Options 

Allow Negative Quantities on Mobile Devices 

Automatic Customer Number 

Automatic Item Numbers 

Automatic New 

Automatic Notification of Low Order Items 

Decimal Places 

Enforce Date Code as a True Date 

Packing Slip for Session 

Support Options 

Check for Software Updates 

Close New Form 

Edit Field Names 

Max Row Count 

Previously Processed Mobile Data 

Show Cost Information During Receiving (applies to Pro and Enterprise Versions Only) 

Show Warning Messages 

SQL Server Backup Location 

Email Options 

Always Show Email Destination List 

Packing Slip CC Emails 
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Pick Order CC Emails 

Purchase Order CC Emails 

SMTP Password 

SMTP Port 

SMTP Server 

SMTP SSL/TSL 

SMTP User 

 

Accessing the Options Screen: 

From the Main Window, select Tools > Options.  The Options screen appears. 
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All of these options affect all users.  Changes made by one user will affect other users who log in. 
 
If the user accessing the Options screen does not have Administration Privileges (setup on the 
Security screen), the Options screen will look like the following: 
 

 
 
  

 

Allow Negative Quantities on Mobile Devices: 

This option allows you to remove or move items from inventory on the mobile device even though 
the quantity of those items may have been at zero, according to the database, the last time the 
mobile device was synchronized.  This option is valuable in a batch processing environment.   

If you have more than one mobile device, a situation might arise where some inventory is Added 
on one mobile device for a location.  The next mobile device comes along and sees the inventory 
ready for Remove, but since both devices have not been synchronized to the PC, the second 
device does not show that inventory exists.  In this case, if Allow Negative Quantities on Mobile 
Devices is turned off, mobile devices would have to synchronize before the item could be 
removed.   

Leaving this option turned on allows mobile device users to do their job in the field but opens up 
the possibility of error.  The responsibility for confirmation of batch processing on multiple mobile 
devices falls to the PC user.  Many safeguards and methods of verifying the recurring data have 
been added to help facilitate this effort.  See the Pending Uploads topic for more information. 
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To enable this option, select the Yes checkbox. 

 

Automatic Customer Number: 

This options allows you to enable automatic generation of a Customer Number when you are 
creating new customers. 

An automatically generated Customer Number will always be 1 greater than the value of the 
largest customer number currently in your database. 

If you are using alphabetic or alphanumeric values as Customer Numbers, the Automatic 
Customer Number option will still generate a numeric Customer Number, beginning with a 
value of 1, if it does not exist already. 

 

Automatic Item Numbers: 

This options allows you to enable automatic generation of an Item Number when you are 
creating a new item or when duplicating an existing item from the Item List. 

An automatically generated Item Number will always be 1 greater than the value of the largest 
Item Number currently in your database. 

If you are using alphabetic or alphanumeric values as Item Numbers, the Automatic Item 
Number option will still generate a numeric Item Number, beginning with a value of 1, if it does 
not exist already. 

 

Automatic New: 

This option enables the automatic opening the New screen when an entered value (Item Number, 
for example) is not in the database. 

When the Automatic New option is enabled: 

The Create New Item screen is opened if an unknown Item Number is entered on the 
Add Inventory, Create New Purchase Order or Create New Pick Order screen. 

The Create New Location screen is opened if an unknown Location is entered on the 
Add Inventory screen or in the To Location field of the Move Inventory screen. 

The Create New Supplier screen will be opened if an unknown Supplier is entered on the 
Add Inventory or Create New Purchase Order screen. 

The Create New Customer screen will be opened if an unknown Customer is entered on 
the Remove Inventory, Create New Pick Order or Check-Out Inventory screens. 
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When the Automatic New option is disabled: 

A prompt will ask you if you want to continue to the appropriate Create New screen. 
 Sometimes, when data input has a high error rate, this is more desirable as it allows the 
user to verify the number entered. 

 

Automatic Notification of Low Order Items: 

When this option is enabled, the software will notify you if the Item Stock Level List contains 
items that have a Quantity value equal to or less than the Min. Stock Level value set for that 
item and location on the Create New Item or screen/Location tab.  This notification appears for 
the location level only.  This notification will appear immediately after logging in to the software. 

 

Decimal Places: 

This option allows you to set the number of decimal places to display in numeric fields where this 
is possible. 

All values entered in numeric fields are stored to the number of Decimal Places allowed by this 
option at the time you entered the value, but screens and reports will always display numeric 
values to the number of Decimal Places currently allowed by this option.   

If the number of decimal places currently allowed by this option is greater than the number 
of decimal places allowed when a value was stored, the value will be displayed with trailing 
zeros.  For example, if a value of 25.5 was stored when Decimal Places was set to 1, it will 
be displayed as 25.500 if Decimal Places is later set to 3. 

If the number of decimal places currently allowed is less than the number of decimal 
places allowed when a value was stored, the value, as displayed, will be rounded.  For 
example, if a value of 25.5 was stored when Decimal Places was set to 1, it will be 
displayed as 26 if Decimal places is later set to 0.  (Values rounded for display at the 
currently specified number of Decimal Places will retain their original number of decimal 
places as stored in the database.) 

Enter a value within the range 0 through 4. 

 

Enforce Date Code as a True Date 

When this option is selected, any dates entered into InventoryControl must be in the format 
mm/dd/yyyy. 
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Packing Slip for Session 

The packing slip that can be printed and/or emailed upon saving by default displays only items 
picked in the current pick session. If you want to pick multiple times and print a packing slip that 
displays all the picks for this pick order, including items picked previously, you can select to do so 
on the Options screen. 

For example: 

Assume Pick Order 001 a quantity of 5 for item ABC and a quantity of 4 for item XYZ.  Today I 
pick 2 of item ABC and 2 of item XYZ and ship them. The packing slip will display 2 ABC and 2 
XYZ.  Tomorrow I pick the other 3 of item ABC and 2 of item XYZ and ship them. The packing slip 
has 3 ABC and 2 XYZ. 

This would also be exactly the same if both picks and ships were done on the same day. 

If, however, I pick what I have in the morning and don’t ship it and a shipment comes in that day 
or the next and I complete the order before shipping anything I will want all of the items picked 
throughout the day to display on one packing slip. To do this, select Yes for this option. 

 

Check for Software Updates: 

When this option is enabled, the system will automatically search for a newer version of the 
software when you log on to the system.  If a new version is found, you will receive a notification 
and can then go to the Wasp website to download the new version. 

This option is enabled when the Yes checkbox is selected.  This option is enabled by default. 
 You can disable the option by deselecting the checkbox.  Manual checks can still be performed 
(via the Help menu).  For more information on manually checking for updates, please refer to 
Checking for Software Updates. 

 

Close New Form: 

When this option is turned on, the Create New screen is automatically closed each time a new 
record is created. 

When this option is disabled, upon clicking the Save button on the Create New screen, the entry 
will be saved, the screen will remain open with the fields cleared, ready for another entry. 
 Clicking the Close button will exit the Create New screen. 

When this option is enabled, upon clicking the OK button on the Create New screen, the screen 
will close automatically.  Clicking the Cancel button on the Create New screen will exit the form 
without saving any entry made. 

It might be desirable to turn this option off when first entering data, for speed, then turn it on later 
to avoid confusion when using it infrequently. 
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Edit Field Names: 

When this option is enabled, users setup with Administrative Privileges on the Security screen 
can edit the names of some labels and tool tips in the software.  You might want to change a field 
name if your business calls one of the functions or fields something different than the default 
values.  Or, you might want to change the tool tip if you want to give special instructions to your 
users. 

For detailed instructions on how to edit fields once this option is enabled, please refer to the 
Editing Field Names topic. 

 

Max Row Count: 

This option allows you to specify the maximum number of rows to be displayed on most lists.  The 
number of rows can be limited to improve performance.  If you notice that it takes more than a 
few seconds for your list screens to appear you can reduce the number of rows to speed this up. 

A value of 0 indicates all rows should be displayed. 

Values between 1 and 99 are invalid.   

100 is the smallest maximum that can be specified. 

 

Previously Processed Mobile Data: 

When this option is turned on, the software alerts you if you attempt to upload data from the 
mobile device to the PC when that data has previously been uploaded.  

With this option turned on, if you upload and process data from the mobile device to the PC and 
then attempt to upload and process that same data again, in the Pending Uploads wizard, a 
symbol displays in the Accept column indicating this data will not be processed again because it 
has already been processed.  Below is an example of the symbol that will appear: 

 

When this option is turned off, you still will not be able to re-process data that has already been 
processed. The drop-down list in the first screen of the Pending Uploads wizard simply will not 
display the processed XML file.  
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Show Cost Information During Receiving: 

(applies to Pro and Enterprise Versions Only) 

When this option is enabled, cost information will display on the Receive screen when you are 
receiving inventory from a purchase order.  This option is disabled by default.  To enable this 
option, select the checkbox. 

 

Show Warning Messages: 

This options allows you to enable or disable the display of warning messages. 

 

SQL Server Backup Location: 

This option is useful if you have your database installed on a different PC/Server than where you 
are running the software. 

Enter an existing directory on the PC/Server where the SQL database is installed (this is where 
you installed the database during the initial installation process).  Make sure the user who will be 
performing the backups (Administration Menu > Backup) has permission to the database.   

If a location is not entered, the Microsoft SQL Server backup directory will be used to store 
backups.  This is where the system will look for backup files when you try to restore the database 
as well. 

If you specify a folder and SQL Server does not have rights to write to that folder, you will receive 
an error message and the backup will fail. It is your responsibility to give SQL Server the proper 
rights to write the backup in the specified folder.  

For information on how to give permissions to a folder, please refer to Wasp Technical Support, 
Knowledge Base and Downloads on the internet. 

By default, if you do not have a remote connection to your database, the backup folder is: 
C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Backup  

 

Always Show Email Destination List: 

Select Yes to always have the list of email destinations appear when you select the Send Emails 
Upon Save on the New Purchase Order and New Pick Order or the Pick (to email the packing 
slip) screens.  This list allows you to select the email addresses to which the order will be sent.   

If you deselect the Yes checkbox, the list will not appear and the emails will automatically be sent 
to every address on the list. 
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Packing Slip CC Emails: 

You can enter email address here to which a copy of the slip will automatically be sent if you have 
the Email Packing Slip checkbox selected on the Pick screen.  The CC email addresses are in 
addition to any email addresses selected on the Pick screen - Email Destination List (see 
above). 

 

Pick Order CC Emails: 

You can enter email address here to which a copy of the order will automatically be sent if you 
have the Email On Save checkbox selected on the Create New Pick Order screen.  The CC 
email addresses are in addition to any email addresses selected on the Create New Pick Order 
screen - Email Destination List (see above). 

 

Purchase Order CC Emails: 

You can enter email address here to which a copy of the order will automatically be sent if you 
have the Email On Save checkbox selected on the Create New Purchase Order screen.  The 
CC email addresses are in addition to any email addresses selected on the Create New 
Purchase Order screen - Email Destination List (see above). 

 

SMTP Password: 

If your SMTP server requires authentication to send outgoing mail, enter the password here.  If it 
does not require authentication, leave this field blank. 

 

SMTP Port: 

Enter the SMTP mail server listening port here.  The default port is 25. 

 

SMTP Server: 

Enter the name of an outgoing mail server that supports SMTP for delivering notification emails. 
 Enter the name of the same outgoing mail server that is setup in your own email program.  If you 
do not was InventoryControl to send notification emails, leave this field blank. 
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SMTP SSL/TSL: 

Turn this option on for all SMTP servers that require SSL or TSL, including GMail SMTP servers. 

Note on using GMail: To use a GMail SMTP server to send out mail from InventoryControl: 

1. Go to www.gmail.com and setup your gmail account.   
2. Have your IT department open port 587 and 465 on your computer.  
3. Turn on the SMTP SSL/TSL option, and set up the other SMTP related options on the 

Options screen. 

The GMail SMTP server address is smtp.gmail.com.  The SMTP user should be 
'yourgmailname@gmail.com' (don't forget @gmail.com).  The SMTP Password is your Gmail 
account password. 

Please be aware that you need to turn this option on for all SMTP servers that require SSL 
or TSL, not just for GMail SMTP servers. 

 

SMTP User: 

If your SMTP server requires authentication to send outgoing mail, enter the user name here.  If it 
does not require authentication, leave this field blank. 
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Archiving Transactions 

The Archive Transaction feature allows you to archive inactive transactions prior to a specified 
date.  This date defaults to the value specified when you enabled this option on the Options 
screen.  For more information on enabling this option, please refer to the Options Screen topic.  

Only inactive transactions are eligible for archive.  These are transactions that no longer impact 
the current inventory.   For instance, if you added a quantity of 10 to a specific item number and 
all of those have since been removed, the initial add transaction is inactive and will be archived if 
it occurred before the date specified.  

Archiving is useful to keep your database running quickly by storing unused information. 

Archiving Transactions: 

1. From the Main Window, click Tools > Archive Transactions.  The Archive 
Transactions screen appears. 
 

 
 

2. Set the Transaction Date to the date before which inactive transactions will be archived, 
or leave it at the default date. 
 

3. Click OK to archive the selected inactive transactions or click Cancel to close the screen 
without archiving any data. 
 

4. If desired, you can run the Transaction History (Archived) Report to review the 
archived transactions.  
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Editing Field Names 

When the Edit Field Names option is enabled on the Options screen, users setup with 
Administrative Privileges on the Security screen can edit some field and function names.  For 
more information on the Options screen, please refer to the Options Screen topic.  For more 
information on the setting security privileges, please refer to the Security Privileges topic. 

Editing Field Names is useful if your business calls one of the functions or fields something 
different than the default values, or you might want to change the Tool Tip (the text that appears 
when you hover the cursor over a field) if you want to give special instructions to your users. 

Please see the Using Custom Fields topic for additional information about customizing this 
software. 

This topic discusses 

Editing Field Names 

Resetting Field Names to their Default Values 

 

Editing Field Names: 

1. When this option is enabled several field names throughout the program will appear in 
recessed boxes, as seen below.   
 

 
 
Click on a recessed label, such as Add.  The Customize Field screen appears: 
 

 
 

2. You can change the text of the Label (or field name) and that field's associated Tool Tip 
or click Set to Default to reset the field and tool tip to its original name. 
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Note: Some fields allow the you to edit the tool tip and not the label itself.  This is 
because some label names must remain fixed due to internal constraints.  
 
The Form field is disabled, as shown above, for labels throughout the program except for 
some of the labels on the Create New Item screen.  The Form field for these few labels 
on the Create New Item screen permit you to specify different tool tips for different 
Inventory screens like Add, Remove, etc.  The same label is used for each, but the tool 
tips can be unique.   
 
For example, in the screen shot below, we are customizing the Item Number label on the 
Create New Item screen.  Here, the Form field is enabled and Item has been selected 
from the drop down list.   
 

 
 
The custom Label value, "Stock #:" that we entered will appear on all screens instead of 
the default Label value, "Item Number", and the custom Tool Tip value, "Enter Stock # 
in this field.  Stock # must be unique.", will appear on all screens as well (instead of 
the original Tool tip). 
 
Next we change the Form value from Item (the default Form value shown above) to 
Inventory_Transactions, as seen in the drop down list below. 
 

 
 
Now the custom Label, "Stock #", will continue to appear on all screens instead of the 
default Label value, "Item Number", but the custom Tool Tip will only be displayed 
where this field occurs within all of the Inventory transactions. 
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The scope of the custom Tool Tip for this field could be narrowed further by selecting a 
single Inventory transaction, such as Remove from the Form drop down list. 
 

3. Now select if you want this field to be Visible and/or Required.   

De-selecting the Visible option completely removes the field from the forms where it 
occurs.  This can be used to streamline data input operations by removing the distraction 
of unused fields.  (The label will still be visible while the Edit Labels option is turned on.) 

Selecting the Required option makes data entry mandatory for transactions that use the 
field being customized.  The Visible option will be grayed-out when the Required option is 
selected (Required fields must be visible). 
 
Some customizable fields must be both visible and required for the software to perform 
correctly.  In this case, the Visible and Required checkboxes will be disabled.  

4. Click OK to save your changes. 

 

Resetting Field Names to their Default Values: 

You can quickly restore the default values for all editable fields by following the instructions 
below. 

1. From the Main Window, click Tools > Reset All Field Names.   
 
A message appears asking if you want to reset all field names to their default values. 
 

 
 

2. Select Yes on the message.  All field names you have changed will return to their original 
values. 

Note:  The Reset All Field Names option on the Tools menu is disabled if the Edit Field Names 
option is disabled on the Options screen or the user currently logged in does not have 
Administrative Privileges. 
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Using Custom Fields 

The Custom Texts and Custom Numbers and Dates tabs can be found on each of the 
following screens: 

Create New Customer 

Create New Manufacturer 

Create New Item 

Create New Site 

Create New Location 

Create New Supplier. 

Note: The Edit Field Names option on the Options screen must be enabled in order to enter 
custom text, numbers and dates.  For more information on the Options screen, please refer to the 
Options Screen topic.  Below is an example of the Custom Texts tab found on the screens 
mentioned above: 
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Note: The fields seen above are not visible when the Edit Field Names option is turned off and 
no customizations have been applied.   
 
Custom Numbers fields will accept values ranging from -999999999999999.9999 to 
999999999999999.9999. 

Custom Dates will be displayed in the same format as found elsewhere in the product:   "day of 
the week, month dd, ccyy" 

 

Example: 

Here, with the Edit Field Names option enabled, we have clicked on the Custom Text 1 label 
(on the Custom Texts tab of the Create New Customer screen) to edit it.  The Form field is 
grayed-out because this label only occurs on the Customer screen. 

 

Click OK to save the customization or Cancel to abort. 

When the Edit Field Names option is subsequently disabled, the Customer Screen/Custom 
Texts tab appear as shown below: 
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This field will also be seen in the Edit Customer screen. 

 

 



 

65 

Importing/Exporting 

Importing Into the Database 

Import allows you to bring data into the program's database from external sources such as .CSV 
or .TXT files.  This allows you to quickly add information to your database rather than having to 
manually add it when you are initially setting up your software. 

Data must be imported into the database in the following order: 

1. Site 
2. Locations 
3. Suppliers 
4. Manufacturers 
5. Customers 
6. Items  
7. Inventory 

Samples for each import type are installed in the InventoryControl/Import Samples folder.  Use 
these samples to verify you have the correct data and format. 

This topic covers: 

Tips for Importing Data 

How to Import Data 

Required Fields 

Handling Import Errors 

Notes on Importing Inventory 

 

 

Tips for Importing Data: 

• Do not attempt to use Import to modify existing records. 
• Imported data will be truncated if field lengths exceed those within the program's 

database. Data Types and Sizes for each Table that can receive data via Import are 
documented in the Database Properties topic. 

• If your data normally resides in a different data format, you must first use your existing 
database software's File > Export or File > Save As function to translate the data to a 
.csv or .txt file.   

• You must strip out all currency symbols, including (but not limited to) these examples:  $, 
¢, ¥, £, §, or ¤, if you are about to import them into a numeric field, such as Cost, List 
Price, etc.  They are permissible in text fields.  

• Commas, sometimes used as "thousands" separators, should be removed from numeric 
fields.   
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• Commas are permissible in text fields only when residing within a pair of double quotes, 
which will cause them to be treated as normal text, not as field delimiters. 

• If you intend to import data to all available tables, make sure you import in the order 
specified above. It is also a good idea to review the information found in the Related 
Data Fields topic before proceeding with importing information.   

 

How to Import Data: 

In the example below, we will show how to import Locations.  The steps are the same for 
importing all other types of information. 

1. From the Main Window, click the Administration icon.  The Administration Menu 
appears at the bottom of the screen. 
 

2. On the Administration Menu, click Import.  The Import Wizard/Step 1: Origination 
and Destination Data screen will appear. 
 

 
 

3. Enter the location and file name of the file you want to import, or click the ... button 
located to the right of the Import File field to search for a file.  Then select the table to 
which you want to import data  from the To table drop down menu. 
  

4. Click Next when you are ready to proceed.  The Step 2: Field Delimiter screen appears. 
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Delimiters are used to separate the data items in a database (the columns in the 
database table) when transporting the database to another application. For example, a 
comma-separated values file (CSV file) is one in which each value in the cells of a table 
row is delimited by and separated from the next value by a comma. The beginning of a 
row is indicated by a new line character.  
 

5. Specify the field Delimiter used in the file from which you are importing data.  This will 
always be a comma for .csv files, but any of the characters shown in the list box can be 
used with .txt files. 
 
The preview window at the bottom of the screen will show you if your selected Delimiter 
is correct by displaying each column the system finds in your file when using that 
Delimiter.  If all the data is in one column of the preview pane, you have not selected the 
right Delimiter. 
 
Select the First row contains column headings option only if the first record of the file 
you are importing does not contain actual data.  Import cannot remove subtotals, section 
headers, or any other records within the file that do not match the format of the actual 
data records. These must be removed before you attempt the import.   
  

6. Click Next when you are ready to proceed.  The Step 3: Field Mapping screen appears. 
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The Field Mapping screen allows you to associate columns which occur within your 
imported data file and corresponding fields within the table into which data will be written. 
 Depending on the contents of your original database, not every column in your imported 
data needs to be mapped to a corresponding field in the program.  The object is to bring 
over at least the required fields and any others that may be of use. 
 
Note:  If the First Row Contains Column Heading checkbox was checked in Step 2, 
the Import Wizard automatically compares the import file's Import Data Column heading 
to the Map To column heading.  If a match is found, the Import Wizard populates the 
Field Mapping Import Data Column and Map To values.  You may change the mapping 
for any column if necessary.   
 
 
Special Note for Importing Items: When importing into the Item table, there are seven 
Map To fields which allow you to use the Import Data Columns for the purpose of 
enabling or disabling the Item To Be Tracked By or Require the user to fill out options 
found on the Create New Item and Edit Item screens.  For more information on these 
options, please refer to the Create New Item topic. 

Tracked By or Required Option is 
Enabled For This Record 

Tracked By or Required Option is 
Disabled For This Record 

True False 
T F 

Yes No 
0 1 

These values are case-insensitive, but they are the only values allowed.  Anything else will 
be rejected by Import.  The default value is False. 
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The Map To fields, to which data columns containing these True/False values can be 
mapped, are named as follows in the Map To drop list: 

• Date Code (Track by?)  
• Lot (Track by?) 
• Pallet (Track by?) 
• Serial Number (Track by?) 
• Customer (Required ?) 
• PO (Required ?) 
• Supplier (Required ?) 

   

If, for example, you wanted every item being imported to be tracked by Serial 
Number, you could create a new column in your source data that contains the word 
"yes" in every cell of that column.  If you chose to name this column TrackSer in 
your source data, you would then map from the TrackSer column to the Serial 
Number (Track by?) field.     
 
You could just as easily edit this TrackSer column to turn on Serial Number tracking 
for some items and not others, by specifying values of "yes" or "no", as necessary. 
 In either case, when you import the items, mapping your TrackSer column to the 
Serial Number (Track by?) field will correctly set the Tracked By Serial Number 
option for each item being imported.  This negates the need to manually edit each 
imported item's Item To Be Tracked By Serial Number option after importing the 
items. 
 
True/False, T/F, Yes/No or 0/1 columns can be added to your source data for any or 
all of the seven Map To fields shown above, so that the Tracked By and Required 
options are set for each item at the time of import. 
 
Each record added to an Auto Generated Number field takes the maximum number 
present in its column and increments this value by 1.  For an import, if the Employee 
table already has an ID field value that is equal to 100 and the Import Wizard 
recognized that your import file contains a value in a mapped column that is equal 
to or less than 100, it will present you with a Default Value of the first import record. 
 All subsequent imported records will increment this value by 1.  If this condition 
does not exist, the import will proceed with the values included in the import 
delimited text file. 

7. Click Finish when you are done mapping all the desired fields to the table.  A 
confirmation screen will appear that the data has been imported.  You can verify the 
import by going to the List screen (Main Window > Lists) and viewing the list for that type 
of information.  For example, if you just imported Locations, view the Locations List to 
verify the new information is there. 
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Required Import Fields: 
  

All tables have some required fields that must be mapped.  These are listed below: 

Table Required Fields 
Site Site 
Location Location, Site 
Supplier Supplier Code 
Manufacturer Name 
Customer Customer Number 
Item Item Number, Item Type 
Inventory Item Number, Quantity, Site and 

Location 
   

Example: Site and Location are required fields for importing Locations.  If you fail to map 
columns for the Location table's required fields, you will receive this prompt: 
 

 

 

Handling Import Errors: 

If any of the information you just imported contains errors, a message will appear when you click 
the Finish button telling you to check the error report.  Click OK on this message to view the 
Error report.   

It is not uncommon to get an error like this when duplicates occur in your source data. Duplicate 
errors can be ignored and the Import can be considered to have completed successfully.  For 
other error types, find the records that are in error; fix them; make a new import file (.txt or .csv) 
containing only these records and do another Import.  Alternatively, you can enter these records 
manually. 
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Notes on Importing Inventory: 

The steps for importing inventory are the same as those listed above; however, there is some 
important information to be aware of when you are importing inventory: 

• Importing data into the Inventory table is optional.  It is equivalent to manually adding 
inventory at the PC.  Quantity and Location data, imported along with an Item Number, 
increases Item quantities in the database. You cannot remove inventory by importing 
negative quantities.  

• The value specified in the Select Site screen/From Site field can impact the Locations 
into which imported Inventory information will be recorded.  When something other than 
<all> is specified as your From site, imported inventory will be put into Locations at the 
specified From Site.  If you have varying Site information you wish to import along with 
the Location and Quantity data for each Item Number, you must make sure the From Site 
is set to <all> in Select Site before importing data into the Inventory table.  For further 
information on the Select Site screen, please see the Select Site topic. 

• Item Number, Quantity, Site and Location are all required fields for Importing into the 
Inventory table.  If, while importing Inventory data, a previously unknown value for either 
Item Number, Site, Location, or Supplier Code is read, a new Item Number, Site, 
Location or Supplier Code will not be created using the new value.  Instead, the Inventory 
record being imported will be rejected.  Negative values for Quantity can also cause an 
Inventory record to be rejected.    

• If one or more Tracked By or Require the user to fill out options are enabled for the Item 
Number specified in an Inventory record that fails to supply that information, the record 
will be rejected.  For more information on these options, please refer to the Create New 
Item topic. 

 

 



 

72 

Exporting to a Text File 

This software allows you to create text files containing data from one or more fields within each of 
the program's tables.  For example, if you want to create a text file of all of the manufacturers in 
your database, the Export function allows you to quickly do this. 

Data types and sizes for each table from which data can be exported are documented in the 
Database Properties topic. 

How to Export Data: 

1. From the Main Window, click the Administration icon.  The Administration Menu 
appears at the bottom of the screen. 
 

2. On the Administration Menu, click Export.  The Export Wizard/Step 1: Origination 
and Destination Data screen appears. 
 

 
 

3. Select the table from which you want to export from the Export Table drop down menu. 
 Then select the file to which you want to export the data.  Here, the Supplier table has 
been selected for import to an external file named Suppliers.csv (a comma separated 
values file).  Export also supports creation of .TXT files. 
  

4. Click Next to continue.  The Step 2: Export Field Selection screen appears. 
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The Export Field Selection screen allows you to select which of the Fields available in 
the table you have chosen to pull data from will be exported to the specified file.   
 
To select a field, highlight a listing in the Fields available window, then click the 

button to add it to the Fields selected box. 
 

Click the  button to add all of the available fields to the Fields selected box. 
 

After adding one or more fields to the Fields selected box, you can use the  or 

 buttons to return fields to the Fields available box. 
 
The graphic below displays this screen with all Fields available selected. 
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5. When you are finished selecting all the fields you want to use, click the Up or Down 
buttons to sequence the fields in the desired order.  This is the order they will appear in 
your exported file.  The Preview window at the bottom of the screen displays how your 
file will look. 
 

6. Click Next to continue.  The Step 3: Destination File Format screen appears. 
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The Destination File Format screen allows you to specify the Field Delimiter of choice 
and whether or not to Include field names on first row.    
 
Delimiters are used to separate the data items in a database (the columns in the 
database table) when transporting the database to another application. For example, a 
comma-separated values file(CSV file) is one in which each value in the cells of a table 
row is delimited by and separated from the next value by a comma. The beginning of a 
row is indicated by a new line character.  
 
If the file name you specified in Step 1 uses the extension .CSV, you must specify 
<Comma> as your field delimiter (the default).  If you specified a file name with the 
extension of .TXT in Step 1, you may use any of the field delimiters available in the drop 
list (as long as the chosen character does not occur within the data itself.) 
 

7. Click the Finish button to perform the export.  On completion, you'll receive a 
confirmation screen stating your export was successful. 
 
You can confirm the export by opening and reviewing the .csv or .txt file you specified in 
Step 1. 
 
Exports can be performed from any of the program's tables: Location, Supplier, 
Manufacturer, Item, Customer or Inventory. 
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Related Data Fields 

Location Table Supplier Table Manufacturer 
Table 

Item Table Inventory 
Table 

Site    Site 
Location    Location 

 Supplier Code  Supplier Code Supplier Code 
  Name Manufacturer  
   Item Number Item Number 

The chart above shows the related data fields that exist within the database tables.  The chart 
should be interpreted from left to right: 

• If you will be importing data into both the Location table and the Inventory table:    

The same values that reside within the Import Data Columns you choose to map to the 
Location table's Site and Location fields must also occur within the Import Data Columns 
you choose to map to the Inventory table's Site and Location fields.  The actual Import file 
used for the Location import does not have to be used for the Inventory import.  It's the 
Site and Location values themselves which must be the same in both Imports to create the 
proper connections between the Location and Inventory tables.   

 If, while importing Inventory data, a previously unknown Site or Location value is read, 
a new Site and/or Location will be created using the new value; the Inventory record being 
imported will not be associated with an existing Site and Location. 

 

• If you will be importing data into the Supplier table and the Item table (or into the 
Supplier table and both the Item and Inventory tables):   

The same values that reside within the Import Data Columns you choose to map to the 
Supplier table's Supplier Code field must also occur within the Import Data Columns you 
choose to map to the Item or Inventory table's Supplier Code field.  The actual Import file 
used for the Supplier import does not have to be used for the Item or Inventory import.  It's 
the Supplier Code values themselves which must be the same in both Imports (or in all 
three Imports) to create the proper connections between the Supplier and Item tables (or 
between the Supplier, Item and Inventory tables).   

 If, while importing Item data, a previously unknown Supplier Code value is read, a 
new Supplier Code will be created using the new value;  the Item record being imported 
will not be associated with an existing Supplier Code. 

  If, while importing Inventory data, a previously unknown Supplier Code value is read, a 
new Supplier Code will not be created using the new value;  the Inventory record being 
imported will be rejected.   
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• If you will be importing data into both the Manufacturer table and the Item table:   

The same values that reside within the Import Data Columns you choose to map to the 
Manufacturer table's Name field must also occur within the Import Data Columns you 
choose to map to the Item table's Manufacturer field.  The actual Import file used for the 
Manufacturer import does not have to be used for the Item import.  It's the Name and 
Manufacturer values themselves which must be the same in both Imports to create the 
proper connections between the Manufacturer and Item tables.   

 If, while importing Item data, a previously unknown Manufacturer value is read, a new 
Manufacturer will be created using the new value;  the Item record being imported will not 
be associated with an existing Manufacturer. 

 

• If you will be importing data into both the Item table and the Inventory table:   

The same values that reside within the Import Data Columns you choose to map to the 
Item table's Item Number's field must also occur within the Import Data Columns you 
choose to map to the Inventory table's Item Number field.  The actual Import file used for 
the Item import does not have to be used for the Inventory import.  It's the Item Number 
values themselves which must be the same in both Imports to create the proper 
connections between the Item and Inventory tables.   

  If, while importing Inventory data, a previously unknown value for either Item Number, 
Site, Location, or Supplier Code is read, a new Item Number, Site, Location or Supplier 
Code will not be created using the new value;  the Inventory record being imported will be 
rejected.  Negative values for Quantity can also cause an Inventory record to be rejected. 
  Lastly, if one or more Tracked By or Require the user to fill out options are enabled for 
the Item Number specified in an Inventory record that fails to supply that information, the 
record will be rejected.  These errors will be listed in the Import-Export Error Report. 

 These same relationships apply when using Create New Location, Create New Supplier, 
Create New Manufacturer, Create New Item or Add Inventory. 

 The Customer table's fields are not related to fields within any of the other tables.   
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Import Specifics 

This topic lists all Field Names, Data Types and Sizes for the fields that can be imported.  

The import wizard contained in this software can automatically map the columns in your import 
files to the correct column in the database.  To do this, however, the column header must match 
one that the wizard is looking for and the data type must be correct.  Below is the header and 
data type the import wizard is expecting.  Modify your .csv or .txt file with the correct column 
header to simply the import process.  The order in which your columns are arranged in your file 
does not matter.  You can also find a .csv file with the header and one row of sample data on the 
installation cd that came with this product. 

The imported file formats discussed in this topic are: 

Customer 

Inventory 

Item 

Location 

Manufacturer 

Supplier 

Data Type Definitions are listed after the Table Properties. 

 

Customer Import Format: 

Column Header 
                   

Data Type Size (Precision, 
Scale) 

Address 1 varchar 100 
Address 2 varchar 100 

Cell No varchar 20 
City varchar 50 

Company Name varchar 50 
Country varchar 50 

Custom Date 1 datetime  
Custom Date 2 datetime  
Custom Date 3 datetime  
Custom Date 4 datetime  
Custom Date 5 datetime  

Custom Number 1 decimal 9(15,4) 
Custom Number 2 decimal 9(15,4)  
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Custom Number 3 decimal 9(15,4) 
Custom Number 4 decimal 9(15,4) 
Custom Number 5 decimal 9(15,4) 

Custom Text 1  varchar 100 
Custom Text 2  varchar 100 
Custom Text 3 varchar 100 
Custom Text 4 varchar 100 
Custom Text 5 varchar 100 
Custom Text 6 varchar 100 
Custom Text 7 varchar 100 
Custom Text 8 varchar 100 
Custom Text 9 varchar 100 
Custom Text 10 varchar 100 
Customer No. varchar 30 
Date Added datetime  

Department varchar 20 
Email varchar 250 
FAX varchar 20 

Home Phone varchar 20 
Name varchar 100 
Notes varchar 255 
Phone varchar 20 

Cell Phone varchar 20 
Customer Billing Address 

1 
varchar 100 

Customer Billing Address 
2 

varchar 100 

Customer Billing City varchar 50 
Customer Billing State varchar 50 
Customer Billing Postal 

Code 
varchar 10 

Customer Billing Country varchar 50 
Customer Billing Mail 

Drop 
varchar 20 

 

Inventory Import Format: 

Field Name                  Data Type Size (Precision, 
Scale) 

Date Acquired datetime 8 
Date Code varchar 25 

Item Description varchar 255 
Item Number varchar 30 

Location varchar 30 
Lot varchar 25 
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Pallet varchar 25 
PO varchar 25 

Quantity decimal 9(18,4) 
Serial Number varchar 25 

Site varchar 255 
Supplier Code varchar 30 

 

Item Import Format: 

Field Name                 Data Type Size (Precision, 
Scale) 

Alt Item Number varchar 30 
Category varchar 255 

Checkout Length int 4 
Cost money 8 

Custom Date 1 datetime 8 
Custom Date 2 datetime 8 
Custom Date 3 datetime 8 
Custom Date 4 datetime 8 
Custom Date 5 datetime 8 

Custom Number 1 decimal 9(15,4) 
Custom Number 2 decimal 9(15,4) 
Custom Number 3 decimal 9(15,4) 
Custom Number 4 decimal 9(15,4) 
Custom Number 5 decimal 9(15,4) 

Custom Text 1 varchar 100 
Custom Text 2 varchar 100 
Custom Text 3 varchar 100 
Custom Text 4 varchar 100 
Custom Text 5 varchar 100 
Custom Text 6 varchar 100 
Custom Text 7 varchar 100 
Custom Text 8 varchar 100 
Custom Text 9 varchar 100 
Custom Text 10 varchar 100 

Customer (Required ?) char 1 
Date Code (Track By?) char 1 

Description varchar 255 
Dimension Unit varchar 50 
File Reference varchar 255 

Height varchar 50 
Item Number varchar 30 

Length varchar 50 
List Price  money 8 

Lot (Track By?) char 1 
Manager varchar 50 
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Manufacturer varchar 50 
Max Stock Level decimal 9(15,4) 
Min Stock Level  decimal 9(15,4) 

Notes varchar 255 
Pallet (Track By?) char 1 
PO (Required?) char 1 

Reorder Qty decimal 9(15,4) 
Sale Price money 8 

Serial Number (Track 
By?) 

char 1 

Supplier (Required?) char 1 
Supplier Code varchar 30 
Supplier Name varchar 50 
Unit of Measure varchar 10 

Weight varchar 50 
Weight Unit varchar 50 

Width varchar 50 
 

Location Table Properties: 

Field Name                 Data Type Size (Precision, 
Scale) 

Custom Date 1 datetime 8 
Custom Date 2 datetime 8 
Custom Date 3 datetime 8 
Custom Date 4 datetime 8 
Custom Date 5 datetime 8 

Custom Number 1 decimal 9(15,4) 
Custom Number 2 decimal 9(15,4) 
Custom Number 3 decimal 9(15,4) 
Custom Number 4 decimal 9(15,4) 
Custom Number 5 decimal 9(15,4) 

Custom Text 1  varchar 100 
Custom Text 2  varchar 100 
Custom Text 3 varchar 100 
Custom Text 4 varchar 100 
Custom Text 5 varchar 100 
Custom Text 6 varchar 100 
Custom Text 7 varchar 100 
Custom Text 8 varchar 100 
Custom Text 9 varchar 100 

Custom Text 10 varchar 100 
Default? char 1 

Description varchar 255 
Location varchar 30 

Notes varchar 255 



 

82 

Site varchar 255 
 

Manufacturer Table Properties: 

Field Name                 Data Type Size (Precision, 
Scale) 

Address 1 varchar 100 
Address 2 varchar 100 

City varchar 50 
Contact Cell No varchar 20 

Contact Ext. varchar 10 
Contact FAX varchar 20 

Contact Name varchar 50 
Contact Phone varchar 20 

Country varchar 50 
Custom Date 1 datetime 8 
Custom Date 2 datetime 8 
Custom Date 3 datetime 8 
Custom Date 4 datetime 8 
Custom Date 5 datetime 8 

Custom Number 1 decimal 9(15,4) 
Custom Number 2 decimal 9(15,4) 
Custom Number 3 decimal 9(15,4) 
Custom Number 4 decimal 9(15,4) 
Custom Number 5 decimal 9(15,4) 

Custom Text 1  varchar 100 
Custom Text 2  varchar 100 
Custom Text 3 varchar 100 
Custom Text 4 varchar 100 
Custom Text 5 varchar 100 
Custom Text 6 varchar 100 
Custom Text 7 varchar 100 
Custom Text 8 varchar 100 
Custom Text 9 varchar 100 

Custom Text 10 varchar 100 
Email varchar 250 

Extension varchar 10 
FAX varchar 20 

Mail Stop varchar 20 
Name varchar 50 
Notes varchar 255 
Phone varchar 20 

Postal Code varchar 10 
State  varchar 50 

Web Site varchar 255 
 



 

83 

Supplier Table Properties: 

Field Name                 Data Type Size (Precision, 
Scale) 

Address 1 varchar 100 
Address 2 varchar 100 

City varchar 50 
Contact Cell No varchar 20 

Contact Ext. varchar 10 
Contact FAX varchar 20 

Contact Name varchar 50 
Contact Phone varchar 20 

Country varchar 50 
Custom Date 1 datetime 8 
Custom Date 2 datetime 8 
Custom Date 3 datetime 8 
Custom Date 4 datetime 8 
Custom Date 5 datetime 8 

Custom Number 1 decimal 9(15,4) 
Custom Number 2 decimal 9(15,4) 
Custom Number 3 decimal 9(15,4) 
Custom Number 4 decimal 9(15,4) 
Custom Number 5 decimal 9(15,4) 

Custom Text 1  varchar 100 
Custom Text 2  varchar 100 
Custom Text 3 varchar 100 
Custom Text 4 varchar 100 
Custom Text 5 varchar 100 
Custom Text 6 varchar 100 
Custom Text 7 varchar 100 
Custom Text 8 varchar 100 
Custom Text 9 varchar 100 

Custom Text 10 varchar 100 
Email varchar 250 

Extension varchar 10 
FAX varchar 20 

Mail Stop varchar 20 
Name varchar 50 
Notes varchar 255 
Phone varchar 20 

Postal Code varchar 10 
State  varchar 50 

Supplier Code varchar 30 
Web Site varchar 255 

 

 



 

84 

Data Type Definitions: 

 The maximum sizes permitted by the data types defined below are greater than the field 
lengths used in the database.  Refer to the sizes given in the tables above to avoid truncation 
when using Import. 

 Any field defined to the tables above that has a length of only one character expects only two 
possible values: "T" or "F" (uppercase).  "T" represents "True" or "On",  "F" represents "False" or 
"Off".  For example, The Customer (Required ?) field in the Item Table, is defined as "Char" with 
a Size of "1".   If you want to enable the Require user to fill out option for the Item record being 
imported, supply a value of "T". 

char   Fixed-length non-Unicode character data with a maximum length of 8,000 characters. 

datetime   Date and time data from January 1, 1753, through December 31, 9999, with an 
accuracy of three-hundredths of a second, or 3.33 milliseconds.   

Valid Alphabetic datetime Formats for Microsoft® SQL Server™ 2000 date 
data (characters enclosed in brackets are optional):  

Apr[il] [15][,] 1996 -- (mdy) 

Apr[il] 15[,] [19]96 -- (mdy) 

Apr[il] 1996 [15] -- (mdy) 

[15] Apr[il][,] 1996 -- (dmy) 

15 Apr[il][,][19]96 -- (dmy) 

15 [19]96 apr[il] -- (dmy) 

[15] 1996 apr[il] -- (dmy) 

1996 APR[IL] [15] -- (ymd) 

1996 [15] APR[IL] -- (ymd) 

 Suggestion:  To avoid ambiguity, use four-digit years. 

If the day is missing, the first day of the month is supplied. 

 Any of the alphabetic datetime formats shown above may be used -as 
long as- the format you select conforms to the year, month and date 
sequence exhibited by the Long Date format in effect on your PC.   This can 
be found at:  

Start > Settings > Control Panel > Regional Options > Date tab > Long 
Date format 
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For example, if your Long Date format, as shown in Regional Options is 
dddd, MMMM dd, yyyy (Friday, June 27, 2003), you can use any of the mdy 
alphabetic formats shown above, but you can not use any of the dmy or ymd 
formats. 

 

Valid Numeric datetime Formats for Microsoft® SQL Server™ 2000 
(characters enclosed in brackets are optional):  

number separator number separator number [time] [time] 

[0]4/15/[19]96 -- (mdy) 

[0]4-15-[19]96 -- (mdy) 

[0]4.15.[19]96 -- (mdy) 

[04]/[19]96/15 -- (myd) 

15/[0]4/[19]96 -- (dmy) 

15/[19]96/[0]4 -- (dym) 

[19]96/15/[0]4 -- (ydm) 

[19]96/[04]/15 -- (ymd) 

Slash marks (/), hyphens (-), or periods (.) may be used as separators.  

 Any of the numeric datetime formats shown above may be used -as long 
as- the format you select conforms to the year, month and date sequence 
exhibited by the Short Date format in effect on your PC.   This can be found 
at:  

Start > Settings > Control Panel > Regional Options > Date tab > 
Short Date format 

For example, if your Short Date format, as shown in Regional Options is 
M/d/yyyy (6/27/2003), you can use any of the mdy numeric formats shown 
above, but you can not use any of the dmy, ydm, ymd, myd, or dym 
formats. 

decimal    Fixed precision and scale numeric data from -10^38 +1 through 10^38 -1.  

Precision specifies the maximum total number of decimal digits  that can be stored, 
both to the left and to the right of the decimal point.   

Scale specifies the maximum number of decimal digits that can be stored to the 
right of the decimal point.   
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Size is the number of storage bytes consumed internally - this value should be 
ignored when determining whether or not a decimal value will be truncated - use 
Precision and Scale instead, to make this assessment.  Size can and should be 
used for all other Data Types. 

int    Integer (whole number) data from -2^63 (-9223372036854775808) through 2^63-1 
(9223372036854775807). 

money    Monetary data values from -2^63 (-922,337,203,685,477.5808) through 2^63 - 1 
(+922,337,203,685,477.5807), with accuracy to a ten-thousandth of a monetary unit. 

This data type is limited to a maximum of four decimal points.  Use a period to separate 
partial monetary units, like cents, from whole monetary units. For example, 2.15 specifies 2 
dollars and 15 cents.   

 Comma separators are not allowed. 

varchar    Variable-length non-Unicode data with a maximum of 8,000 characters. 
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Performing an Audit 

Auditing Your Inventory 

As many business owners know, keeping accurate counts of inventory is a critical part of 
maintaining a well-run business.  For instance, if an inventory item is listed in the system as 
having met its reorder point, but the quantity in the system is based on an inaccurate count, your 
business could end up wasting money on reordering inventory that was not in danger of being 
depleted.  On the other hand, if your system lists plenty of inventory for an item that is actually at 
or below the reorder point, you could be faced with too little stock on hand to fulfill orders, 
creating a costly back-order situation.  Many business owners also know that getting accurate 
counts can be a time-consuming task.   

With these issues in mind, InventoryControl was designed with a built-in audit mode that allows 
you to conveniently conduct audits at the PC and on one or more mobile devices while preventing 
access to such features as Remove and Add so that you can be assured you are getting accurate 
count comparisons. 

Audit Mode allows you to check the counts of all your inventory while disabling the Add, 
Remove, Move, Adjust, Check-In and Check-Out features to make sure inventory counts in the 
system do not change while you are performing the audit.  If you are using mobile devices, you 
can use them simultaneously with the PC to perform an audit by downloading the database in 
audit mode to each device.  Audit Mode features a simple Audit screen that allows you to enter 
your counts for inventory in each location and compares these to the counts already in the 
system.  You can then view the Complete Audit screen to review any discrepancies between 
your counts and what was in the system.  At the click of a button you can reconcile the counts or 
you can select certain transactions to accept or reject.  This software also comes equipped with 
several Audit Reports that allow you to review a variety of information at-a-glance. 

The topics listed below are included in this section.  It is best to review these topics in order as 
they outline the flow of performing an audit. 

1. Audit Flow Overview 
2. Beginning the Audit 
3. Using the Audit Screen 
4. Reviewing the Not Counted Items Report 
5. Reconciling Your Counts on the Complete Audit screen 
6. Reviewing the Remainder of the Audit Reports 
7. Ending the Audit 

 

Audit Flow Overview: 

The audit process in this software is broken into 7 steps: 

1. Create a pre-audit backup of your database. 
 

2. Start the Audit Mode on the PC.  If you are using mobile devices, create a database of 
the system while in audit mode and download it to the mobile devices to be used during 
the audit. 
 



 

88 

3. Use the Audit screen or the mobile devices to enter counts (and sync the mobile device 
data back to the PC). 
 

4. Review the Items Not Counted Report. 
 

5. Reconcile your counts entered in the Audit screen against the counts that were in the 
system. 
 

6. Review the remainder of the Audit Reports. 
 

7. End the Audit Mode. 

 

Beginning the Audit: 

1. On the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Audit icon.  The following confirmation message 
appears: 
 

 
 

3. Click Yes to begin the audit.  If you are using the Pro or Enterprise version of 
InventoryControl, a message appears reminding you to create a pre-audit backup of your 
database, if you have not already done so.   
 

4. Select OK on the Backup Reminder message to go to the Backup screen and create 
the backup now.  We recommend you create the backup file with a name similar to the 
following: 
 
Pre-Audit-yyyy-mm-dd-hh-mm-ss.bkp 
 
This backup of your database can be restored later, if necessary, but you will lose any 
transactions completed since that backup.  For more information on creating backups, 
please refer to the Backing Up the Database topic.  
 
Select No to begin the audit without creating a backup (this is not recommended). 
 
The screen will prominently display a message that Audit Mode is active and most of the 
Inventory menu will be disabled.  An example of the Inventory menu with Audit Mode 
activated is displayed below: 
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With Audit Mode Active, you should next create mobile databases and download them 
to mobile devices if you will be using mobile devices for the audit.   
 

5. Now you can begin entering counts manually on the PC or on the mobile devices via the 
Audit screen.  For information on using the Audit screen on the mobile device, please 
refer to the  

 

Using the Audit Screen: 

Now that you have started the Audit Mode on the PC and (optionally) downloaded the audit 
database to your mobile devices, you can begin your counts.   

To enter your counts on the PC: 

1. On the Inventory menu, click the Audit icon (this is the same icon you clicked to begin 
the Audit Mode).  The Audit screen appears: 
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Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Adds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  (The Add button does not have to clicked between each scan to 
post these add transactions to the Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

2. Complete the Item fields: Enter the Item Number of the item you want to audit.  To 
enter an Item Number, you can type or scan the value into the field, or you can use the 
drop down list to see the first 10 items in the database, select <more> on the drop down 
list to see all items in the Item List.  You cannot create a new item during an audit. 
 
Entering an Item Number populates the Item Number field as well as the Description 
field and enables the following fields: 

• Location 
• Quantity (unless the item is Tracked By Serial Number - Set on the 

Add or Edit Item screens, which fixes the Quantity to a value of 0 or 
1) 

• Any of the associated Tracked By fields: Serial Number, Date 
Code, Lot or Pallet (Set on the Add or Edit Item screens).  A 
Tracked By field is enabled or disabled at the time the item is 
created.  

Items tracked by serial number that are checked-out cannot be audited. 
 
Below is an example of the Audit screen enabled: 
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3. Enter a Transaction Code (optional): This field allows you to type in a value or select 
a previously-entered code that describes the transaction. 
  

4. Enter Notes (optional): This field allows you to add and store additional information 
that describes the transaction.   
 

5. After you have entered all information on the screen, click the Audit button.  The audit 
transaction will be added to the Pending Transaction List.   
 
The Audit button is not enabled until a valid value is entered in the Item Number field 
and the Location field. 
 
 

6. After reviewing the Pending Transaction List, click Remove to delete any selected 
transactions or click Remove All to delete all the records listed, then click the OK button 
to post the remaining audit transactions to your database.  
 
Audit's pending transactions are handled differently than other inventory transactions.  All 
pending transactions are listed (those just added as well as those previously added.) 
They do not go away until they are reconciled or removed from the list.  
 

7. Repeat these steps for each item for which you want to update quantity.  After you have 
finished updating quantity for all audited items (and downloaded any audit data from the 
mobile devices, if used) you are ready to review the Not Counted Items Report.   

 

Reviewing the Not Counted Items Report: 

This software contains several audit reports that allow you to review count and discrepancy 
information.  Most of these reports are useful for review after the audit is completed and are 
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discussed later in this topic.  The Not Counted Items Report, however, should be reviewed 
before you reconcile your counts.  This report lists any items for which quantity was not entered 
into the system either through the Audit screen on the PC or via the mobile devices.  By 
reviewing this report, you can quickly determine if any items were missed during the audit. 

To View the Not Counted Items Report: 

1. Click the Reports icon in the main functions section of the Main Window.  The Reports 
Selection screen appears displaying all Audit reports. 
 

2. Highlight the Not Counted Items Report and click OK or just double-click the report. 
 The report opens in the Report Viewer.  For more information on viewing reports, 
please refer to the Report Viewer topic. 
 

3. Review the report and add counts for any items that were missed.  After you have 
entered any additional quantities into the system, you are ready to reconcile your counts. 

 

Reconciling the Counts: 

The next step in the audit process is to reconcile your counts against those that were already in 
the system.  You can view this screen and reconcile as you go along, or you can wait until all 
counts are entered and reconcile once before ending the audit.   

To Reconcile: 

1. On the Inventory Menu (in Audit Mode), click the Reconcile/End icon.  The Complete 
Audit screen appears: 
 

 
 
This screen lists all audit transactions and includes the following columns: 

• Item Number 



 

93 

• Current Quantity - This is the quantity that was listed for this item in the system 
prior to the audit. 

• Audited Quantity - This is the quantity that you entered for this item on the 
Audit screen.  You can update this field on the Complete Audit screen by 
selecting the field and typing in a new number or by using the up or down arrow 
buttons next to the field. 

• Location - The location you selected for this item on the Audit screen. 
• Serial Number, Lot, Pallet - These appear populated only if this item is tracked 

by one or more of these fields. 
 

2. Select from the Action column what action you want to take with the selected item.  Your 
options are: 

• Audited Qty - Selecting this option means the system will keep the audited 
quantity you entered for this item on the Audit screen. 

• Current Qty - Selecting this option means the system will keep the quantity that 
was listed in the system prior to the audit. 

• Ignore Record - When the audit is ended, no action will be taken on this record. 
 Quantity amounts will stay the same for this item.  The system will behave as 
though this item was not audited.  The item will not appear on any audit reports.   
 
You must remove those items you mark as Ignore Record from the Pending 
Transaction List tab on the Audit screen before you can end the audit. 
 

3. After you have selected an action for all items on the list, click the OK button to post the 
transactions to your database.  You are now ready to end the audit. 

 

Reviewing the Remainder of the Audit Reports: 

This software contains several audit reports that allow you to review a variety of information. 
 Available reports are: 

• Accepted Audit Discrepancies Report 
• Accepted Audit Result Report 
• Audit History by Audit Date 
• Audit History by Item Number 
• Not Counted Item Report 
• Unreconciled Audit Discrepancies 
• Unreconciled Audit Report 

These reports are accessed by click the Reports icon on the Main Window.  The reports are 
viewed in the Reports Viewer.  For more information on viewing reports, please refer to the 
Report Viewer topic. 

 

Ending the Audit: 

The last step in the audit process is to end the Audit Mode session on your PC so all features 
are enabled.  To do this: 
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1. On the Inventory menu (in Audit Mode), click the Reconcile/End icon.   
 
If you have not reconciled all transactions on the Complete Audit screen (including 
removing any records marked as Ignore Record from the Audit screen/Pending 
Transactions List tab), the Complete Audit screen will appear.  For information on 
using this screen, please refer to the Reconciling the Counts topic, above. 
 
If you have reconciled all transactions, the following message will appear: 
 

 
 

2. Click Yes on the message screen to end the audit.  The system will go back into regular 
mode and you will have access to all features on the Inventory menu. 
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Creating New Data 

Creating a New Site 

The Create New Site screen allows you to add a new Site to your database.  Typically, a Site is a 
building that contains one or more inventory Locations.  It is usually a building, but it might also 
be a fleet vehicle, with one or more bins that can be defined as inventory Locations within that 
vehicle.  For more information on Locations, please refer to the Creating New Locations topic. 
 
It is not uncommon to use this product with only one Site defined.  A minimum of one Site is 
required. 

Adding a New Site: 

1. From the Main Window, select New > Site.   
 
OR 
 
From the Main Window, select Lists > Site.  On the Site List, select the New icon. 
 
The Create New Site screen appears: 
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2. Enter a Site and Description.  Description allows you to enter a description of the Site. 
 This is useful when the Site value is vague (For example, Site "H7" could be described 
as "Hangar 7"). 
 
Notes is a text field available to record any additional information you might have about 
this Site.  Click the Add Notes button to edit the Notes field. 

3. For information about the Custom Texts and Custom Numbers and Dates tabs, see 
Using Custom Fields. 
 

4. When you have finished adding information, click the OK/Save button.  The system 
behaves differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 

For more information about the Options screen, please refer to the Options Screen topic. 
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Creating New Customers 

The Create New Customer screen allows you to add a new customer to your database.  When 
you are setting up your software for the first time, you may want to import your customers rather 
than adding them one at a time through this screen.  For information on importing information into 
your database, please refer to the Import Into Database topic. 

Adding a Customer: 

1. From the Main Window, select New > Customer.   
 
OR 
 
From the Main Window, select Lists > Customer.  On the Customer List, select the 
New icon. 
 
The Create New Customer screen appears: 
 

 
 
Note: This screen is opened automatically when Checking Out or Checking In 
inventory and a new customer name is entered. 
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2. Type in the customer information.  The Customer No. and Address Type fields are 
required; all other fields are optional.  The customer name and address can then be 
selected when creating Pick Orders (Pro and Enterprise versions only). 
 
If you have the Automatic Customer Numbers option selected on the Options screen, 
the Customer No. field will appear populated with the next number in the sequence.  For 
further information on the this option, please refer to the Options Screen topic. 
 
The software provides you with the ability to enter a Billing Address, Receiving Address 
and/or Shipping Address for your customers.  To enter multiple address, follow the steps 
below: 
 

a. On the Company Information screen, enter your company name.  Select what 
type of address you will be entering from the Address Type drop down menu. 
 

b. Enter the remainder of the address information, then click OK.  You will be 
returned to the Administration Menu. 
 

c. Click the Company Info icon again.  The Company Information screen will 
reappear populated with the information you just entered. 
 

d. Select a different address type of the Address Type drop down menu. The 
address lines (Address 1 and 2, City, State, Postal Code and Country) will clear 
while all other company information will remain on the screen.   
 

e. Enter the new address information, then click OK.  Repeat these steps for each 
address type.   
 

3. When you have finished entering data in the General Information tab, click the 
Additional Information tab (this tab is optional). 
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The Additional Information tab provides optional fields where you can record the 
customer's Phone, Extension, Fax, Cell No., Home No. and Email.  In addition, you 
can create notes on this customer on this tab by clicking the Add Notes button.   
 

4. For information about the Custom Texts and Custom Numbers and Dates tabs, see 
Using Custom Fields. 
 

5. When you have finished adding information, click the OK/Save button.  The system 
behaves differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 

For more information about setting the Close New Form option on the Options screen, 
please refer to the Options Screen topic. 
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Creating New Items Inventory and Non-Inventory Items 

The Create New Item screen allows you to add a new Item to your database and to specify how 
you want to track each item (by Serial Number, Lot, Date Code and/or Pallet). 

For information on creating Assembly Items, please see the topic Creating an Assembly Item 
(Pro and Enterprise versions only). 

For information on creating Kit Items, please see the topic Creating a Kit Item (Pro and 
Enterprise versions only). 

An Item records information about each product you expect to have in inventory.   

Note for Pro and Enterprise Version Users:  You can create items that are not inventoried, but 
that you want to have a record of.  For instance, you can create an item for marketing pamphlets. 
 (In the Standard version of InventoryControl you cannot create items that are not inventoried.)  If 
you are using the Pro or Enterprise version, you will see a Type field on the Create New 
Items/General Tab.  Select Inventory or Non-inventory from the drop down list. Inventory is 
selected by default. 

When you are setting up your software for the first time, you may want to import your items rather 
than adding them one at a time through this screen.  For information on importing information into 
your database, please refer to the Import Into Database topic. 

This topic discusses: 

Accessing the Create New Items Screen 

General Information Tab 

Location Settings Tab 

Additional Information Tab 

Manage Suppliers Tab  

Custom Texts/Custom Numbers and Dates Tab 

Saving the New Item 

 

Accessing the Create New Items Screen: 

1. From the Main Window, select New > Item >Inventory or Non-Inventory.   
 
OR 
 
From the Main Window, select Lists > Item.  On the Item List, select the New icon. 
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Note: or information on creating Assembly Items, please see the topic Creating an 
Assembly Item (Pro and Enterprise versions only). 

For information on creating Kit Items, please see the topic Creating a Kit Item (Pro and 
Enterprise versions only). 
 
The Create New Item screen appears: 
 

 
 
  

 

General Information Tab: 

The General Information tab is where you will enter the basic information about the item.  Please 
see the screen shot above for an example of this tab. 

Input the appropriate information in the fields provided: 
  

• Item Number is a required field.  The Item Number is often available on a 
barcode label already attached to the item.  This allows you to scan or manually 
enter the number from each item as it comes in.  Item numbers cannot exceed 
20 digits.  
 
Do not use a description as the item number.  You should enter a numeric value 
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in the Item Number field.  A description of the item can be entered in the 
Description field. 
 
The Item Number is often the UPC code or SKU number of an inventory item. 
 Using an existing barcode for Item Number allows you to scan or manually enter 
the number from each Item as it comes in without having to print and affix your 
own barcode inventory item labels. 
 
Automatic Item Numbers: If you have the Automatic Item Numbers option 
selected on the Options screen, the Item Number field will appear populated 
with the next number in the sequence.  For further information on the this option, 
please refer to the Options Screen topic. 

• Category: When a new Category value is typed into the field, you will receive a 
message asking if you want to save it as a new Category.   

• Checkout Length specifies the default period, in days, that this Item can be 
checked out to a customer.   

• When a new Manufacturer is typed into the Manufacturer field, you will receive a 
message asking if you want to save the value as a new Manufacturer. 

• The Type drop down list applies to Pro and Enterprise version users only.  Select 
Non-inventory if you do not want this item to be inventoried, or select Inventory 
to inventory this item.  This field will not appear on the Standard version.  You 
can also select Assembly or Kit items.  See the Assembly Overview or Kitting 
Overview topics for more information on these item types. 
  

• The Item To Be Tracked By section contains check boxes which 
determine whether the Serial Number, Lot, Date Code and Pallet fields 
must be completed throughout InventoryControl before you can create 
inventory from this item. 
  

Items To Be Tracked By: Field Will Be 
Available For Use 

Field Will Also 
Be Required 

  Disabled (not checked) No - 
 Enabled (checked) Yes Yes 

It is important at this time that you determine how you want to track each item. 
 Typically, small items that are all the same may not need to have any Tracked Bys 
selected.  Items such as printers may need to be tracked by Serial Number, so 
returns and maintenance can be properly tracked.  Medical supplies or food may 
need to be tracked by Date Code and/or Lot. 

Tracked By options cannot be changed after you add inventory to the item. 

• Automatic Serial Numbers: You can choose to have the program automatically 
create and assign serial numbers each time you add inventory for this item 
(whether manually using the Add Inventory feature or by Receiving Inventory).  To 
do this: 

a. Click the button to the right of the Serial Number check box.  The Auto 
Serial Number Options screen is displayed: 
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b. Check the Auto Increment Serial Numbers to have the software 
automatically assign incremented serial numbers. Enter a Starting 
Number.  This number determines the number at which the serial 
number sequence starts.  Since this option is applied at the Item level, 
each Item in the program may have its own unique series of serial 
numbers. 
 

c. Click OK to accept your entries. 

• The Require the user to fill out section contains check boxes which act much 
like the Tracked By boxes, but contains a different set of fields (Ref #, Supplier 
and Customer) which are always available for use, even if they are not required. 
 For example, if the option is not enabled for the Supplier Code field, a user adding 
inventory can enter a value for Supplier Code if he knows it or skip entering a 
value if he doesn't.  If however this option is enabled, a value for Supplier Code is 
required to complete the transaction. 

Require The User to Fill 
Out: 

Field Will Be 
Available For Use 

Field Will Also 
Be Required 

Disabled (not checked) Yes No 
Enabled (checked) Yes Yes 

   

• Cost specifies the amount paid to get this item into inventory.   
• Average Cost is a calculated value that averages the costs paid for the current 

Quantity.  

If you have 20 quantity of this item at cost 10.00  

and add another 30 quantity at cost 8.00, 

Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 =  8.80 

Removes are calculated using the FIFO method, therefore, if you later remove 5, 5 
of the cost 10.00 items will be removed first, 

Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67 

When calculating Average Cost, the software does not include records that have an 
average cost of zero.  When you run an Inventory Cost Report, the software does 
include zero cost quantities when calculating Total Cost. 
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• List Price specifies a manufacturer's list price for an item. 
• Sale Price specifies the price at which you sell an item. 
• Min Stock Level specifies the minimum stock level you wish to maintain.  
• Max Stock Level specifies the maximum stock level you wish to maintain. 
• Reorder Qty specifies the quantity at which you want to reorder inventory. 

 
Note:  The Minimum Stock Level, Maximum Stock Level and Reorder 
Quantity fields found on this tab represent these levels at the item level only, 
meaning these are the stock levels for this item throughout all locations.  If you 
want to maintain these levels by location, you can do so on the Location Settings 
tab (described below). 

Note - The fields below only appear on the Edit Item screen. 

• The Total Available counter is the sum of Total Checked-Out and Total In-House. 
• The Total Checked-Out counter is the quantity of this item that is currently 

Checked-Out. 
• The Total In-House counter is the Total Available less the Total Checked-Out. 
• The Total On Order counter is the quantity of this item that is currently included 

on an active Pick Order. 
• The Total Buildable (applies to Assembly Items only) is the quantity that can be 

built of this Assembly Item based on the inventory levels of the component items. 
• The Committed counter (applies to Assembly, Inventory and Non-Inventory items 

only) is the number  that has been committed to a pick order. 
• The Total Shippable (applies to Kit Items only) is the total on hand amount minus 

committed quantities for all component items. (Committed is inventory that is 
contained on a pick order.) 

 

Location Settings Tab: 

When you have completed the General Information tab, click the Location Settings tab. This 
tab allows you to enter all locations where this item will be in inventory and to designate a primary 
location.  You can assign items to more than one location.  This tab uses the List functionality for 
grouping, ordering, filtering and deleting.   
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Complete the fields on this screen as described below: 

• Primary Location - Select this checkbox if this will be the primary location at 
this site for this item.  A primary location can be selected for each Site you 
have setup in the system.  When you select a primary location, when you 
Receive quantities of that item from a purchase order, they will automatically 
be assigned to that location.  Also, when you Pick quantities of that item for 
pick orders, they will automatically be removed from that location.  You can 
change these locations when picking and receiving if necessary.  In addition, 
the primary location will appear in any location fields (on the Add inventory 
screen, for example), however; you can change the location, if needed. 
 
Only one primary location can be selected per site. 

• Site and Location - Click in the box and select a Site and Location from the 
drop down list.  Only sites and locations you have previously selected will 
appear in this list.  Select More to view the Site or Location List.  You can 
also select New Location or New Site to access the Create New screen. 
 These represent the site and the location where the inventory will reside. 

• Quantity - This number is populated from the Inventory for this item.  This 
number displays how many of this item is currently in stock at the selected 
site and location. 

• Max Stock Level - Enter the maximum number of this item that you want to 
have in stock for the selected site and location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 

• Min Stock Level - Enter the minimum number of this item that you want to 
have in stock for the selected Site and Location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 
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• Reorder Qnty - Enter the number at which you want to reorder this item for 
the selected Site and Location.  You can set an option in the software so 
that the system warns you at login of any inventory items that have hit their 
reorder quantity.  For further information on setting this option, please refer to 
the Options Screen topic.   
  

After you have completed all fields, hit ENTER to begin a new line.  Your screen will 
look similar to the following after hitting ENTER: 
 

 
  

 

Additional Information Tab: 

When you have finished entering information on the Location Settings tab, click the Additional 
tab.  The Additional Information tab provides optional fields where other information about the 
Item can be recorded.  An example of this tab is shown below: 
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Complete the fields on this tab as described below: 

• Stocking Unit is the portion by which the quantity will be tracked.  At the item 
level, this should be "Eaches", meaning you should enter how you want each 
item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, 
box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, 
etc.)     
 
You will have the opportunity on the Managing Suppliers tab to enter the Order 
Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.).  The 
Order Unit will be used when creating Purchase Orders rather than the 
"Eaches" UOM that is entered on this tab.  Please see the Managing Suppliers 
Tab section, below. 

• Dimension Unit is the increment to be used for Length, Width and Height. 
 (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)  

• Length is the length of one Unit of Measure expressed in Dimension Units. 
• Width is the width of one Unit of Measure expressed in Dimension Units. 
• Height is the height of one Unit of Measure expressed in Dimension Units. 
• Weight Unit is the increment to be used for mass.  (Examples: ounce, pound, 

ton, milligram, gram, kilogram, metric ton, etc.) 
• Weight is the mass of one Unit of Measure expressed in Weight Units. 
• Manager is used to record the name of someone who manages this inventory 

item. 
• File Reference is used to record the path to a relevant file that might be an 

image file, documentation, specifications, etc.  This field does not function as a 
hyperlink.  It's just a static field where a filename or path and filename can be 
recorded. 
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• Add Notes allows you to record any additional information. 

 
   

Manage Suppliers Tab: 

This tab allows you to identify which suppliers you will use for this item and enter detailed supplier 
information, such as unit of measure.  Pro and Enterprise users can enter multiple suppliers for 
an item and mark one as the default, or preferred supplier.  Standard version users can enter only 
one supplier for each item.  
 

 
 
 
Adding Suppliers to an Item: 
 
To use this tab you must first select suppliers for this item in the Supplier window.  To do this: 

a. Click the New button at the bottom of the list.  The fields to the right of the 
Supplier window are enabled.  

b. Select a Supplier Code from the drop down list.  You can also select New 
Supplier from the list to create a new supplier. 

c. Enter the SKU number for this item in the Supplier Item SKU field. 
d. Enter the description of this item given by the supplier in the Supplier Item 

Description field. 
e. Enter the number of days lead time the supplier needs to process orders for this 

item in the Lead Time (in days) field.  The lead time is the time from the 
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requisition date to the delivery date.  For example, if you need the item by the 
15th of the month and the supplier requires 5 days to deliver the order, you would 
enter 5 here to ensure the order is sent to the supplier timely. 

f. The Status field displays the supplier's current status (Active or Inactive).  You 
can change the status by making a new selection from the drop down menu. 

g. You can make this the default supplier for this item by checking the Make this 
the default Supplier while ordering this item checkbox (Pro and Enterprise 
versions only).  When this is selected, this supplier will automatically populate 
purchase orders for this item.  You can change the supplier on the purchase 
order, if needed. 

h. Any notes entered for this supplier will appear in the Notes section. 
i. You can enter the supplier's unit of measure settings in the Order Unit Settings 

window (Pro and Enterprise versions only). This is the unit used by the 
supplier when shipping this item.  This may be box, pallet, etc.  This is different 
from the "Eaches" stocking unit you entered on the Additional tab.  For example, 
you may have entered "jar" for the stocking unit on the Additional tab, but the 
supplier may ship the item in boxes containing 10 jars.  When creating purchase 
orders, you would want to specify the Order Unit as box rather then jar (or you 
could end up with 100 boxes of jars rather than 100 jars).  

j. When you are done entering supplier information, click the Custom Texts or 
Custom Numbers and Dates tab (these tabs are optional). 

Deleting Suppliers from an Item: 

a. Highlight the supplier you want to delete from this item in the Supplier window.   
 

b. Click the Delete button. 

 

Custom Text and Custom Numbers and Dates Tab: 

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using 
Custom Fields. 

 

Saving the New Item: 

When you have finished adding information, click the OK/Save button.  The system behaves 
differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Automatic Serial Numbers 

You can choose to have the program automatically create and assign serial numbers each time 
you add inventory for this item (whether manually using the Add Inventory feature or by Receiving 
Inventory).  This option is available when creating a new item on the Create New Item screen. 
 For complete details on creating a new item, please refer to the Creating New Item topic. 

1. Click the checkbox to make the item you are adding or editing auto increment the serial 
number for each item added into inventory. 
 

2. If you are using alphabetic or alphanumeric values as Serial Numbers, the Automatic 
Serial Number option will still generate a numeric Serial Number, beginning with the 
value of entered in the Starting Number Field, if it does not exist already. 
 

3. Click OK to set the options. 
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Creating New Locations 

The Create New Location screen allows you to add a new Location to an existing Site or a new 
Location to a new Site.  Locations are places within a Site where inventory resides.  The site is 
usually a building, but it might also be a fleet vehicle, with one more bins that can be defined as 
inventory Locations within that vehicle.  For example, a site might be setup as Building 1 with a 
location of Supply Closet. 

A location is typically shorthand for a physical place such as a shelf in your warehouse. 
 Commonly used conventions include Location codes like this: 

    01 02 05   (for Row #, Shelf #, Bin #) 

When you are setting up your software for the first time, you may want to import your locations 
rather than adding them one at a time through this screen.  For information on importing 
information into your database, please refer to the Import Into Database topic. 

Adding Locations: 

1. From the Main Window, click New > Location. 
 
OR 
 
From the Main Window, click Lists > Location.  Then click the New icon on the 
Location List. 
 
The Create New Location screen will appear. 
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2. Select a site from the Site drop down menu, then enter the name of your new Location. 
 The Site and Location fields are both required.  
 
You can type in the name of a new site in the Site field.  A message will appear asking if 
you want to add it to your database.  Select Yes to add it.  The Create New Site screen 
will appear allowing you to setup the new site.  Complete this screen, the click OK to 
return to the Create New Location screen.  For detailed information on entering a new 
site, please refer to the Creating a New Site topic. 
 
Description allows you to enter a description of the Location.  This is useful when the 
Location value is vague (For example, Location "A7B2" could be described as "Aisle 7 
Bin 2"). 
 
Click the Add Notes button to add additional information to this record. 
 
For information about the Custom Texts and Custom Numbers and Dates tabs, see 
Using Custom Fields. 
 

2. When you have finished adding information, click the OK/Save button.  The system 
behaves differently at this point depending on your settings on the Options screen.  
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• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Creating New Manufacturers 

The Create New Manufacturer screen allows you to add a new Manufacturer to your database. 
 A Manufacturer is typically the company or organization that creates an item you will inventory.  If 
a Manufacturer is also your Supplier for an Item, it is best to setup the company in the software 
as both a Manufacturer and a Supplier. 

When you are setting up your software for the first time, you may want to import your 
manufacturers rather than adding them one at a time through this screen.  For information on 
importing information into your database, please refer to the Import Into Database topic. 

Adding a New Manufacturer: 

1. From the Main Window, click New > Manufacturer. 
 
OR 
 
From the Main Window, click Lists > Manufacturer.  Then click the New icon on the 
Manufacturer List. 
 
The Create New Manufacturer screen will appear. 
 

 
 
Note: This screen is opened automatically from the Create New Item screen when a 
new manufacturer name is entered. 
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2. Enter information on this screen as needed.  The Name and Address Type fields are 
required, all other fields are optional.   
 
The software provides you with the ability to enter a Billing Address, Receiving Address 
and/or Shipping Address for your manufacturers.  To enter multiple address, follow the 
steps below: 
 

a. On the Company Information screen, enter your company name.  Select what 
type of address you will be entering from the Address Type drop down menu. 

b. Enter the remainder of the address information, then click OK.  You will be 
returned to the Administration Menu. 

c. Click the Company Info icon again.  The Company Information screen will 
reappear populated with the information you just entered. 

d. Select a different address type of the Address Type drop down menu. The 
address lines (Address 1 and 2, City, State, Postal Code and Country) will clear 
while all other company information will remain on the screen.   

e. Enter the new address information, then click OK.  Repeat these steps for each 
address type.   
 

3. When you have finished entering data in the General Information tab, click the 
Additional tab (this tab is optional). 
 

 
 
The Additional tab provides optional fields where you can record the manufacturer's 
Phone, Extension, Fax, Cell No., Home No. and Email.  In addition, you can create 
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notes on this manufacturer on this tab by clicking the Add Notes button.   
 

4. For information about the Custom Texts and Custom Numbers and Dates tabs, see 
Using Custom Fields. 
 

5. When you have finished adding information, click the OK/Save button.  The system 
behaves differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Creating New Suppliers 

The Create New Supplier screen allows you to add a new supplier to your database.   A supplier 
is typically the company or organization from which you obtain an Item you will inventory.  If a 
manufacturer is also your supplier for an Item, it is best to add the company in the software as 
both a Manufacturer and a Supplier.  

When you are setting up your software for the first time, you may want to import your suppliers 
rather than adding them one at a time through this screen.  For information on importing 
information into your database, please refer to the Import Into Database topic. 

Adding New Suppliers: 

1. From the Main Window, click New > Suppliers. 
 
OR 
 
From the Main Window, click Lists > Suppliers.  Then click the New icon on the 
Supplier List. 
 
The Create New Supplier screen will appear. 
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2. Enter information on this screen as needed.  The Supplier Code and Address Type 
fields are required, all other fields are optional.  Supplier Codes cannot exceed 25 digits. 
 
The software provides you with the ability to enter a Billing Address, Receiving Address 
and/or Shipping Address for your suppliers.  To enter multiple address, follow the steps 
below: 
 

a. On the Company Information screen, enter your company name.  Select what 
type of address you will be entering from the Address Type drop down menu. 

b. Enter the remainder of the address information, then click OK.  You will be 
returned to the Administration Menu. 

c. Click the Company Info icon again.  The Company Information screen will 
reappear populated with the information you just entered. 

d. Select a different address type of the Address Type drop down menu. The 
address lines (Address 1 and 2, City, State, Postal Code and Country) will clear 
while all other company information will remain on the screen.   

e. Enter the new address information, then click OK.  Repeat these steps for each 
address type.   
 

3. When you have finished entering data in the General Information tab, click the 
Additional Information tab (this tab is optional). 
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The Additional Information tab provides optional fields where you can record the 
manufacturer's Phone, Extension, Fax, Cell No., Home No. and Email.  In addition, you 
can create notes on this manufacturer on this tab by clicking the Add Notes button.   

4. For information about the Custom Texts and Custom Numbers and Dates tabs, see 
Using Custom Fields. 
 

5. When you have finished adding information, click the OK/Save button.  The system 
behaves differently at this point depending on your settings on the Options screen.  
 

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 

If a supplier with the same Supplier Code is found, the message below will appear when 
you try to save. 

 
 
Enter a different Supplier Code to continue. 
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Creating a Pick Order 

Pick orders are created to designate certain inventory to be shipped to a customer.  On the 
Create New Pick Order screen, you are creating an order that tells your staff to get the order 
ready and what inventory to include.  These orders can be sent to the mobile devices (although 
pick orders cannot be created on mobile devices).  After the order has been picked, you need to 
mark it as ready to be shipped on the Pick Order screen accessed from the Receive/Pick menu. 
At this point, the inventory is removed from the system.  For more information on the Pick Order 
screen, please refer to the Shipping Pick Orders topic. 

We recommend you review the Pick/Ship Overview before creating pick orders for the first time. 

Creating New Pick Orders: 

1. From the Main Window, select New > Pick Order.   
 
 
OR 
 
From the Main Menu, click Lists > Pick Order.  On the Pick Order List, click the New 
icon. 
 
 
The Create New Pick Order screen appears.   
 

 
 
 
Notice that the screen prominently displays the status as New.  This status message 
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changes based on the state the order is in. 
 
Possible statuses are: 
 

• New - This always displays when creating a new order. 
• Issued - Once the pick order is printed or emailed, the status changes to Issued. 
• In Process - Once the order has started to be picked (via the Pick Order screen 

accessed from the Receive/Pick menu), the status becomes In Process and the 
Picked Quantity will display for each item on the order. 

• Overdue - This status can appear for New or In Process orders that have 
passed the designated due date.  These orders will appear with a symbol on the 
Pick Order List to alert you of their overdue status. 

• Closed - This status means the order has been completed and marked as 
closed. 
  

Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.   Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  
 

Clicking the   button will unlock the field. 

1. Enter a Pick Order Number.  This alpha-numeric value up to 36 characters can be 
manually entered at the time the pick order is created, scanned in, or you can click 
Generate to have the system assign an auto-generated number.  For more information 
on setting up automatically generated Pick Order Numbers, please refer to the 
Customize Numbers topic. 
 

2. Enter a Customer in the Customer field.  You can scan a value into this field, manually 
enter a value or click on the field to view a drop down list.  The list contains the last 10 
Customers selected on this screen.  Select <MORE> to view the entire Customer List or 
click <New> to go to the Create Customer Supplier screen to add a new customer to 
the database. 
 
When a customer is selected, the Customer Address information automatically 
populates.  If the selected customer has more than one address entered for it, you can 
select the Address Type from the drop down list. 
  

3. Enter an Order Date for this order.  This date defaults to today, but you can change this 
date by clicking the down arrow and selecting a new date. 
 

4. Enter a Due Date for this order.  You can type in a date in this field or click the down 
arrow to select a date. 
 

5. Enter a Reference Number for this Pick Order (optional).   
 

6. Select the preferred shipping method for this order in the Ship Via field from the drop 
down list.  This list contains several commonly used shipping methods, however; you can 
type in a new shipping method if desired.  The new entry will appear in the drop down list 
for future purchase orders. 
 

7. Enter any notes you want to associate with this order in the Notes field. 
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8. Now you are ready to enter your item information in the Line Item Details section.  
 
Complete this information as follows: 
 

• Type - Select the type of item that needs to be picked.  Options are: 
o Inventory - This item is in your inventory database.  Use this to pick 

existing items. 
o Non-Inventory - This item is not in your inventory database.  Use this to 

pick items that you do not want to appear in your inventory database, 
such as marketing fliers or business cards. 

o Assembly - Assembly Items are a collection of items that, once 
grouped, are considered to be a new, single item.  Assembly Items are 
pre-assembled and kept in stock. 

o Kit - Kit items are a collection of items that are grouped, or picked, at the 
time they are sold. 

o Manual - Use this option to add one-time items, such as shipping and 
handling, to an order.  Manual items cannot be picked on the mobile 
devices. 
 

• Item Number - Enter the Item Number of the item you want to add to the order. 
 To enter an Item Number, you can type or scan the value into the field, or you 
can use the drop down list to see the first 10 items in the database, select 
<more> on the drop down list to see all items in the Item List.   
 
You can create a new item by selecting <New> or by entering an unknown item 
number.  When either of these two situations occur, the Create New Item screen 
appears.  For more information on creating items, please refer to the Creating 
New Items topic. 
 
When you enter an Item Number the Description field populates. 

• Request Qty - Enter the requested number of this item.  This value can also be 
scanned.  You cannot enter negative numbers. 

• Stocking Unit - This field displays the stocking unit entered for this item on the 
New Item/Edit Item screen.  The stocking unit represents how you stock this 
item in your inventory.  For instance, if you stock the unit in boxes of 10. Box of 
10 would display in the Stocking Unit field on this screen.  For more information 
on creating items, please refer to the Creating New Items topic. 

• Description - This field populates after the item number is entered and cannot 
be changed on this screen.  If you need to change the description, you can do so 
on the Edit Item screen. 
 

9. After you have entered all items for this order, you can optionally select to: 
• Print on Save - If this box is checked, a copy of this order automatically prints 

when you click the Save button. 
• Email on Save - If this box is checked, a copy of this order is automatically sent 

to the email address listed in the Customer screen for this customer when you 
click the Save button.  If you have selected to view the Email Destination List 
(selected on the Options screen), the list will appear allowing you to select email 
addresses or change email addresses as needed.  If you have selected not to 
view the list, the order will automatically be sent to the email address listed in the 
Customer screen from the email address listed in the Company Information 
screen.  Please note that if the email addresses are not entered on the 
Customer or Company Information screens, you will receive an error message 
when you try to send emails. 
 



 

123 

An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to 
the CC Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, 
User Name and Password (if authentication is required for outgoing mail) and 
the SMTP Port on the Options screen.  If these are not set, an error message 
will appear. 
 
For more information on setting these email options on the Options screen, 
please refer to the Options Screen topic.  For more information on the Email 
Distribution List, please see the Email Distribution List topic. 
 

10. Click Save to save this order to the database. 
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Creating a New Purchase Order 

Purchase orders can be created in InventoryControl and emailed directly to your supplier, or 
printed for faxing or mailing.  We recommend you review the topic Purchase Orders/ Receiving 
Overview before using the purchase order feature for the first time. 

Creating New Purchase Orders: 

1. From the Main Window, select New > Purchase Order.   
 
OR 
 
From the Main Window, select Lists > Purchase Order.  On the Purchase Order List, 
click the New icon. 
 
 
The Create New Purchase Order screen appears.   
 

 
 
 
Notice that the screen prominently displays the status as New.  This status message 
changes based on the stage the purchase order is in. 
 
Possible statuses are: 
 

• New - This always displays when creating a new order. 
• Issued - Once the purchase order is printed or emailed, the status changes to 

Issued. 
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• In Process - Once the order has started to be received (via the Receive screen 
accessed from the Receive/Pick menu), the status becomes In Process and the 
Received Quantity will display for each item on the order. 

• Overdue - This status can appear for New or In Process orders that have 
passed the designated due date.  This orders will appear with a symbol on the 
Purchase Order List to alert you of their overdue status. 

• Closed - This status means the order has been completed and marked as 
closed. 

Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.   Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  
 

Clicking the   button will unlock the field. 

2. Enter a supplier in the Supplier field.  You can scan a value into this field, manually enter 
a value or click on the field to view a drop down list.  The list contains the last 10 
Suppliers selected on this screen.  Select <More> to view the entire Supplier List or 
click <New> to go to the Create New Supplier screen to add a new supplier to the 
database. 
 
When a supplier is selected, the Supplier Address information automatically populates. 
 If the selected supplier has more than one address, you can select the Address Type 
from the drop down list. 
 
After you enter the Supplier information, you can click the Items at Re-Order Quantity 
button at the bottom of the screen.  The system will then check for any items for this 
supplier that are at or below their reorder points and populate the purchase order with 
those items. 
 

3. Enter a Purchase Order Number.  This alpha-numeric value up to 36 characters can be 
manually entered at the time the purchase order is created, scanned in, or you can click 
Generate to have the system assign an auto-generated number.  For more information 
on setting up automatically generated Purchase Order Numbers, please refer to the 
Customize Numbers topic. 
 

4. Select a Ship To Address using the drop down menu.  All address types you entered on 
the Company Information screen will appear in the list, or you can select <New> to 
enter a new address.  Selecting <New> opens the Company Information screen 
allowing you to enter a new address.  For more information on the Company 
Information screen, please refer to the Entering Company Information topic. 
 

5. Enter a Reference Number for this Purchase Order (optional).   
 

6. The Order Date defaults to today's date.  You can change this date by clicking the button 
next to the field and selecting a new date. 
 

7. Select a Due Date for this Purchase Order.  You can type in a date or click the button 
next to the field and select a date. 
 

8. Select the preferred Ship Method for this order from the drop down list.  This list contains 
several commonly used shipping methods, however; you can type in a new shipping 
method if desired.  The new entry will appear in the drop down list for future purchase 
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orders. 
 

9. Select the Payment Method from the drop down list.  This list contains several 
commonly used shipping methods, however; you can type in a new shipping method if 
desired.  The new entry will appear in the drop down list for future purchase orders. 
 
Note:  If you need to delete a Ship or Payment Method you have entered, you can do 
so on the Manage Ship Methods or Manage Payment Methods screens.  These 
screens also allow you to Print, Export and Add New methods.  For more information on 
the Manage Ship Methods screen, please refer to the Managing Shipping Methods 
topic.  For more information on the Manage Payment Methods screen, please refer to 
the Managing Payment Methods topic. 
 

10. Now you are ready to enter your item information in the Line Item Details section. 
 Complete this information as follows: 

• Type - Select the type of item you are ordering.  Options are: 
o Inventory - This item is already in your inventory database.  Use this to 

re-order existing items. 
o Non-Inventory - This item is not listed as inventory in your database. 

 Use this to order items for which you do not want to track quantity, such 
as marketing fliers or business cards. 

o Manual - Use this option to add one-time items, such as shipping and 
handling, to an order.  Manual items cannot be received on the mobile 
devices. 

• Item Number - Enter the Item Number of the item you want to order.  To enter 
an Item Number, you can type or scan the value into the field, or you can use 
the drop down list to see the first 10 items in the database, select <more> on the 
drop down list to see all items in the Item List. 
 
When you enter an Item Number, the Description field populates. 

• Description - This field populates after the item number is entered.  This field 
can only be edited if Manual was selected in the Type field.  If you need to 
change the description, you can do so on the Edit Item screen. 

• Vendor SKU - This field populates after the item number is entered if a SKU was 
entered on the Add/Edit Item screen for this vendor.  This field can only be edited 
if Manual was selected in the Type field.  

• Ordered QTY - Enter the quantity you are ordering of this item.  This field 
defaults to 1.  You cannot enter negative values in this field. 

• Order Unit - Select the Order Unit from the drop down field or select <New> to 
enter a new Unit.  You may want to enter a new unit here that is not an "eaches" 
or Stocking Unit measurement.  For example, if you want to order 1 box of an 
item and this item ships in boxes containing 15 units, the "eaches", or Stocking 
Unit measurement is 15, but for ordering purposes, you could create a new unit 
that is BOX containing 15 units.  You would then order 1 box rather than 15 units 
to avoid confusion for the supplier. 
 
You can setup multiple Order Unit types for each supplier on the Create 
New/Edit Item screen - Manage Suppliers tab.  This allows you to enter units 
based on the suppliers method of shipping (whether the supplier ships in boxes 
of 15, pallets of 50, etc.) For instance, you could set up a Box and Pallet Order 
Unit on the Suppliers tab so that when you create a Purchase Order for that item 
to go to the supplier, you can quickly select whether you want a box or a pallet. 
 For more information on the Add Item screen - Manage Suppliers tab, please 
refer to the Creating New Items topic. 
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• Cost - The cost will populate based on the Order Unit selected.  You can also 
type in a new cost here.   

• Line Total - This field calculates based on the Quantity multiplied by the cost. 
 

11. After you have entered all items for this order, you can optionally select to: 
• Print on Save - If this box is checked, a copy of this order automatically prints 

when you click the Save button. 
• Email on Save - If this box is checked, a copy of this order is automatically sent 

to the email address listed in the Supplier screen for this supplier when you click 
the Save button.  If you have selected to view the Email Destination List 
(selected on the Options screen), the list will appear allowing you to select email 
addresses or change email addresses as needed.  If you have selected not to 
view the list, the order will automatically be sent to the email address listed in the 
Supplier screen from the email address listed in the Company Information 
screen.  Please note that if the email addresses are not entered on the Supplier 
or Company Information screens, you will receive an error message when you 
try to send emails. 
 
An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to 
the CC Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, 
User Name and Password (if authentication is required for outgoing mail) and 
the SMTP Port on the Options screen.  If these are not set, an error message 
will appear. 
 
For more information on setting these email options on the Options screen, 
please refer to the Options Screen topic. 
 

12. Click Save to save this purchase order to the database. 
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Creating a Kit Item 

This function applies to Pro and Enterprise Version users only. 

Kit Items are used when you want to combine two or more existing items in order for them to be 
sold together.  Kit items are not kept or tracked in inventory (you cannot add, move, check out, 
etc.).  We recommend you read the Kitting Overview topic before you begin creating Kit Items.   

Note:  You can import the general information for a Kit Item, but not the compositional information 
(i.e. which items make up the component items).  If you import Kit Items, you must then finish 
setting them up manually on the Edit Item screen. 

This topic discusses: 

Accessing the Create New Items Screen 

General Information Tab 

Kit Information Tab 

Additional Information Tab 

Custom Texts/Custom Numbers and Dates Tab 

Saving the New Item 

 

 

Accessing the Create New Items Screen: 

1. From the Main Window, select New > Item > Kit. 
 
The Create New Item screen appears: 
 



 

129 

 
 
Note that in addition to the usual tabs that appear on the Create New Item screen, there 
is also a tab labeled Kit Information. 

 

General Information Tab: 

The General Information tab is where you will enter the basic information about the item. 
 Please see the screen shot above for an example of this tab. 

Input the appropriate information in the fields provided: 
  

• Item Number is a required field.  The Item Number is often available on a 
barcode label already attached to the item.  This allows you to scan or manually 
enter the number from each item as it comes in.  Item numbers cannot exceed 
20 digits.  
 
Do not use a description as the item number.  You should enter a numeric value 
in the Item Number field.  A description of the item can be entered in the 
Description field. 
 
The Item Number is often the UPC code or SKU number of an inventory item. 
 Using an existing barcode for Item Number allows you to scan or manually enter 
the number from each Item as it comes in without having to print and affix your 
own barcode inventory item labels. 
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Automatic Item Numbers: If you have the Automatic Item Numbers option 
selected on the Options screen, the Item No. field will appear populated with the 
next number in the sequence.  For further information on this option, please refer 
to the Options Screen topic. 

• Category: When a new Category value is typed into the field, you will receive a 
message asking if you want to save it as a new Category.   

• Checkout Length is not available for Kit Items..   
• When a new Manufacturer is typed into the Manufacturer field, you will receive a 

message asking if you want to save the value as a new Manufacturer. 
• When you access the Create New Item screen by selecting New > Item > Kit, 

this field will automatically be set to Kit.  If you accessed it any other way, you 
can select Kit from the Type drop down.  

• The Item To Be Tracked By section is not available for Kit Items.  Tr0acking can 
take place for the component items, but not for the Kit Item. 
  

• Cost specifies the amount paid to get this item into inventory.   

• Average Cost is a calculated value that averages the costs paid for the current 
Quantity.  

If you have 20 quantity of this item at cost 10.00  

and add another 30 quantity at cost 8.00, 

Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 =  8.80 

Removes are calculated using the FIFO method, therefore, if you later remove 5, 5 
of the cost 10.00 items will be removed first, 

Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67 

When calculating Average Cost, the software does not include records that have an 
average cost of zero.  When you run an Inventory Cost Report, the software does 
include zero cost quantities when calculating Total Cost. 

• List Price specifies a manufacturer's list price for an item. 
• Sale Price specifies the price at which you sell an item. 
• Min Stock Level is not available for Kit Items. 
• Max Stock Level is not available for Kit Items. 
• Reorder Qty is not available for Kit Items. 
• Total Shippable is the total on hand amount minus committed quantities for all 

component items. (Committed is inventory that is contained on a pick order.) 
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Kit Information Tab: 

This tab is where you will indicate which items you want included in this Kit.   
 

 

To select items to include in your Kit Item: 

1. In the Type drop down, select Inventory, Non-Inventory or Assembly. 
 

 
2. In the Item Number field, select which item you want to add to this assembly.  If you 

select Full List, the Item List will be filtered by the Type you selected (i.e., if Non-
Inventory is selected, only non-inventory items will appear on the Item List.  If 
Assembly is selected, only Assembly items will appear in the List). 
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When you tab out of the Item Number field after selecting an item, the Description, 
Stocking Unit and Total In-House fields will populate with the information for that item. 
 

3. Enter the Quantity you want included in this Kit Item.   
  

4. Press Enter to access a new line and enter another Item, then repeat the steps above.   

Note:  The cost will be calculated and updated based on your selections on this tab unless you 
have checked the Do Not Override Cost on the General Tab checkbox located at the bottom of 
the Kit Information tab. 
  

 

Additional Information Tab: 

When you have finished entering information on the Kit Information tab, click the Additional tab. 
 The Additional Information tab provides optional fields where other information about the Item 
can be recorded.  An example of this tab is shown below: 
 

 
 
Complete the fields on this tab as described below: 

• Stocking Unit is the portion by which the quantity will be tracked.  At the item 
level, this should be "Eaches", meaning you should enter how you want each 
item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, 
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box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, 
etc.)     
 
You will have the opportunity on the Managing Suppliers tab to enter the Order 
Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.).  The 
Order Unit will be used when creating Purchase Orders rather than the 
"Eaches" UOM that is entered on this tab.  Please see the Managing Suppliers 
Tab section, below. 

• Dimension Unit is the increment to be used for Length, Width and Height. 
 (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)  

• Length is the length of one Unit of Measure expressed in Dimension Units. 
• Width is the width of one Unit of Measure expressed in Dimension Units. 
• Height is the height of one Unit of Measure expressed in Dimension Units. 
• Weight Unit is the increment to be used for mass.  (Examples: ounce, pound, 

ton, milligram, gram, kilogram, metric ton, etc.) 
• Weight is the mass of one Unit of Measure expressed in Weight Units. 
• Manager is used to record the name of someone who manages this inventory 

item. 
• File Reference is used to record the path to a relevant file that might be an 

image file, documentation, specifications, etc.  This field does not function as a 
hyperlink.  It's just a static field where a filename or path and filename can be 
recorded. 

• Add Notes allows you to record any additional information. 

 

Custom Text and Custom Numbers and Dates Tab: 

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using 
Custom Fields. 

 

Saving the New Item: 

When you have finished adding information, click the OK/Save button.  The system behaves 
differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Creating an Assembly Item 

This function applies to Pro and Enterprise Version users only. 

Assembly Items are used when you want to combine two or more existing items into one new 
item.  We recommend you read the Assembly Overview topic before you begin creating 
Assembly Items.   

This topic discusses: 

Accessing the New Assembly Items Screen 

General Information Tab 

Location Settings Tab 

Assembly Tab 

Additional Information Tab 

Manage Suppliers Tab  

Custom Texts/Custom Numbers and Dates Tab 

Saving the New Item 

 

 

Accessing the New Assembly Item Screen: 

1. From the Main Window, select New > Item > Assembly.   
 
 
The Create New Item screen appears: 
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Note that in addition to the usual tabs that appear on the Create New Item screen, there 
is also a tab labeled Assembly Information. 

 

 

General Information Tab: 

The General Information tab is where you will enter the basic information about the item. 
 Please see the screen shot above for an example of this tab. 

Input the appropriate information in the fields provided: 
  

• Item Number is a required field.  The Item Number is often available on a 
barcode label already attached to the item.  This allows you to scan or manually 
enter the number from each item as it comes in.  Item numbers cannot exceed 
20 digits.  
 
Do not use a description as the item number.  You should enter a numeric value 
in the Item Number field.  A description of the item can be entered in the 
Description field. 
 
The Item Number is often the UPC code or SKU number of an inventory item. 
 Using an existing barcode for Item Number allows you to scan or manually enter 
the number from each Item as it comes in without having to print and affix your 
own barcode inventory item labels. 
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Automatic Item Numbers: If you have the Automatic Item Numbers option 
selected on the Options screen, the Item No. field will appear populated with the 
next number in the sequence.  For further information on the this option, please 
refer to the Options Screen topic. 

• Category: When a new Category value is typed into the field, you will receive a 
message asking if you want to save it as a new Category.   

• Checkout Length specifies the default period, in days, that this Item can be 
checked out to a customer.   

• When a new Manufacturer is typed into the Manufacturer field, you will receive a 
message asking if you want to save the value as a new Manufacturer. 

• When you access the Create New Item screen by selecting New > Item > 
Assembly, this field will automatically be set to Assembly.  If you accessed it 
any other way, you can select Assembly from the Type drop down.  

• The Item To Be Tracked By section contains check boxes which determine 
whether the Serial Number, Lot, Date Code and Pallet fields must be completed 
throughout InventoryControl before you can create inventory from this item.   
 
Note: Keep in mind that marking the track by fields here mean that the entire 
Assembly Item, after build, will be tracked with a unique serial number, lot number, 
etc.  It may be the case that individual assets that make up the Assembly Item 
(selected on the Assembly tab) are also tracked by serial number, lot number, etc. 
 When you Build the Assembly Item on the Build Assembly screen, you will be 
required to enter the serial number or any other track by fields for each item 
included in the Assembly Item. 
  

Items To Be Tracked By: Field Will Be 
Available For Use 

Field Will Also 
Be Required 

  Disabled (not checked) No - 
 Enabled (checked) Yes Yes 

It is important at this time that you determine how you want to track each item. 
 Typically, small items that are all the same may not need to have any Tracked Bys 
selected.  Items such as printers may need to be tracked by Serial Number, so 
returns and maintenance can be properly tracked.  Medical supplies or food may 
need to be tracked by Date Code and/or Lot. 

Tracked By options cannot be changed after you add inventory to the item. 

• Automatic Serial Numbers: You can choose to have the program automatically 
create and assign serial numbers each time you add inventory for this item 
(whether manually using the Add Inventory feature or by Receiving Inventory).  To 
do this: 

a. Click the button to the right of the Serial Number check box.  The Auto 
Serial Number Options screen is displayed: 
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b. Check the Auto Increment Serial Numbers to have the software 
automatically assign incremented serial numbers. Enter a Starting 
Number.  This number determines the number at which the serial 
number sequence starts.  Since this option is applied at the Item level, 
each Item in the program may have its own unique series of serial 
numbers. 
 

c. Click OK to accept your entries. 

• The Require the user to fill out section contains check boxes which act much 
like the Tracked By boxes, but contains a different set of fields (Ref #, Supplier 
and Customer) which are always available for use, even if they are not required. 
 For example, if the option is not enabled for the Supplier Code field, a user adding 
inventory can enter a value for Supplier Code if he knows it or skip entering a 
value if he doesn't.  If however this option is enabled, a value for Supplier Code is 
required to complete the transaction. 

Require The User to Fill 
Out: 

Field Will Be 
Available For Use 

Field Will Also 
Be Required 

Disabled (not checked) Yes No 
Enabled (checked) Yes Yes 

   

• Cost specifies the amount paid to get this item into inventory.   
• Average Cost is a calculated value that averages the costs paid for the current 

Quantity.  

If you have 20 quantity of this item at cost 10.00  

and add another 30 quantity at cost 8.00, 

Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 =  8.80 

Removes are calculated using the FIFO method, therefore, if you later remove 5, 5 
of the cost 10.00 items will be removed first, 

Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67 

When calculating Average Cost, the software does not include records that have an 
average cost of zero.  When you run an Inventory Cost Report, the software does 
include zero cost quantities when calculating Total Cost. 
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• List Price specifies a manufacturer's list price for an item. 
• Sale Price specifies the price at which you sell an item. 
• Min Stock Level specifies the minimum stock level you wish to maintain.  
• Max Stock Level specifies the maximum stock level you wish to maintain. 
• Reorder Qty specifies the quantity at which you want to reorder inventory. 

 
Note:  The Minimum Stock Level, Maximum Stock Level and Reorder 
Quantity fields found on this tab represent these levels at the item level only, 
meaning these are the stock levels for this item throughout all locations.  If you 
want to maintain these levels by location, you can do so on the Location Settings 
tab (described below). 

• The Total Available counter is the sum of Total Checked-Out and Total In-House. 
• The Total Checked-Out counter is the quantity of this item that is currently 

Checked-Out. 
• The Total In-House counter is the Total Available less the Total Checked-Out. 
• The Total On Order counter is the quantity of this item that is currently included 

on an active Pick Order. 
• The Total Buildable is the quantity that can be built of this Assembly Item based 

on the inventory levels of the component items. 
• The Committed counter is the number of this Assembly Item that has been 

committed to a pick order. 

 

Location Settings Tab: 

When you have completed the General Information tab, click the Location Settings tab. This 
tab allows you to enter all locations where this item will be in inventory and to designate a primary 
location.  You can assign items to more than one location.  This tab uses the List functionality for 
grouping, ordering, filtering and deleting.   
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Complete the fields on this screen as described below: 

• Primary Location - Select this checkbox if this will be the primary location at 
this site for this item.  A primary location can be selected for each Site you 
have setup in the system.  When you select a primary location, when you 
Receive quantities of that item from a purchase order, they will automatically 
be assigned to that location.  Also, when you Pick quantities of that item for 
pick orders, they will automatically be removed from that location.  You can 
change these locations when picking and receiving if necessary.  In addition, 
the primary location will appear in any location fields (on the Add inventory 
screen, for example), however; you can change the location, if needed. 
 
Only one primary location can be selected per site. 

• Site and Location - Click in the box and select a Site and Location from the 
drop down list.  Only sites and locations you have previously selected will 
appear in this list.  Select More to view the Site or Location List.  You can 
also select New Location or New Site to access the Create New screen. 
 These represent the site and the location where the inventory will reside. 

• Quantity - This number is populated from the Inventory for this item.  This 
number displays how many of this item is currently in stock at the selected 
site and location.  When you first create your item, this number will be zero. 
 After you build your Assembly Item, this field will reflect the number you built 
(which is the quantity in stock). 

• Max Stock Level - Enter the maximum number of this item that you want to 
have in stock for the selected site and location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 
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• Min Stock Level - Enter the minimum number of this item that you want to 
have in stock for the selected Site and Location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 

• Reorder Qnty - Enter the number at which you want to reorder this item for 
the selected Site and Location.  You can set an option in the software so 
that the system warns you at login of any inventory items that have hit their 
reorder quantity.  For further information on setting this option, please refer to 
the Options Screen topic.   
  

After you have completed all fields, hit ENTER to begin a new line.  Your screen will 
look similar to the following after hitting ENTER: 
 

 
  

 

Assembly Tab: 

This is the tab where you will indicate which items you want included in this Assembly Item.  You 
can select any Inventoried, Non-inventoried and/or Assembly item.  
 

 

To select items to include in your Assembly Item: 
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1. In the Type drop down, select Inventory, Non-Inventory or Assembly. 
 

 
2. In the Item Number field, select which item you want to add to this assembly.  If you 

select Full List, the Item List will be filtered by the Type you selected (i.e., if Non-
Inventory is selected, only non-inventory items will appear on the Item List. 
 

 
 
When you tab out of the Item Number field after selecting an item, the Description, 
Stocking Unit and Total In-House fields will populate with the information for that item. 
 

3. Enter the Quantity you want included in this Assembly Item.  This number represents 
how many of this items is included with each build of this Assembly Item.   
 
Example: Assume this Assembly Item is a cabinet.  For each cabinet, you need 2 long 
panels, 2 short panels and one back piece and 6 screws.  When you enter the long panel 
item on this tab, you will enter 2 in the Quantity field.  When you enter the screws item 
on this tab, you will enter 6 in the Quantity field, etc. 
  

4. Select the Always Scrap checkbox if you want InventoryControl to always "scrap" or 
permanently remove the item from inventory during the Disassembly process.  You 
might use this option for a non-inventory item such as a box used for packaging the 
Assembly Item. 
 
If the Always Scrap checkbox is not selected, the on hand amount for the item will be 
increased during Disassembly (the item is assumed to be returned to inventory rather 
than removed after Disassembly.) 
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5. Press ENTER to access a new line and enter another Item, then repeat the steps above. 
 Your screen will appear similar to the following after pressing ENTER: 
 

 

Note:  The cost will be calculated and updated based on your selections on this tab unless you 
have checked the Do Not Override Cost on the General Tab checkbox located at the bottom of 
the Assembly Information tab. 
  

 

Additional Information Tab: 

When you have finished entering information on the Assembly tab, click the Additional tab.  The 
Additional Information tab provides optional fields where other information about the Item can 
be recorded.  An example of this tab is shown below: 
 

 
 
Complete the fields on this tab as described below: 
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• Stocking Unit is the portion by which the quantity will be tracked.  At the item 
level, this should be "Eaches", meaning you should enter how you want each 
item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, 
box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, 
etc.)     
 
You will have the opportunity on the Managing Suppliers tab to enter the Order 
Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.).  The 
Order Unit will be used when creating Purchase Orders rather than the 
"Eaches" UOM that is entered on this tab.  Please see the Managing Suppliers 
Tab section, below. 

• Dimension Unit is the increment to be used for Length, Width and Height. 
 (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)  

• Length is the length of one Unit of Measure expressed in Dimension Units. 
• Width is the width of one Unit of Measure expressed in Dimension Units. 
• Height is the height of one Unit of Measure expressed in Dimension Units. 
• Weight Unit is the increment to be used for mass.  (Examples: ounce, pound, 

ton, milligram, gram, kilogram, metric ton, etc.) 
• Weight is the mass of one Unit of Measure expressed in Weight Units. 
• Manager is used to record the name of someone who manages this inventory 

item. 
• File Reference is used to record the path to a relevant file that might be an 

image file, documentation, specifications, etc.  This field does not function as a 
hyperlink.  It's just a static field where a filename or path and filename can be 
recorded. 

• Add Notes allows you to record any additional information. 

 
   

Manage Suppliers Tab: 

This tab allows you to identify which suppliers you will use for this item and enter detailed supplier 
information, such as unit of measure.  Pro and Enterprise users can enter multiple suppliers for 
an item and mark one as the default, or preferred supplier.  Standard version users can enter only 
one supplier for each item.  
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Adding Suppliers to an Item: 
 
To use this tab you must first select suppliers for this item in the Supplier window.  To do this: 

a. Click the New button at the bottom of the list.  The fields to the right of the 
Supplier window are enabled.  

b. Select a Supplier Code from the drop down list.  You can also select New 
Supplier from the list to create a new supplier. 

c. Enter the SKU number for this item in the Supplier Item SKU field. 
d. Enter the description of this item given by the supplier in the Supplier Item 

Description field. 
e. Enter the number of days lead time the supplier needs to process orders for this 

item in the Lead Time (in days) field.  The lead time is the time from the 
requisition date to the delivery date.  For example, if you need the item by the 
15th of the month and the supplier requires 5 days to deliver the order, you would 
enter 5 here to ensure the order is sent to the supplier timely. 

f. The Status field displays the supplier's current status (Active or Inactive).  You 
can change the status by making a new selection from the drop down menu. 

g. You can make this the default supplier for this item by checking the Make this 
the default Supplier while ordering this item checkbox (Pro and Enterprise 
versions only).  When this is selected, this supplier will automatically populate 
purchase orders for this item.  You can change the supplier on the purchase 
order, if needed. 

h. Any notes entered for this supplier will appear in the Notes section. 
i. You can enter the supplier's unit of measure settings in the Order Unit Settings 

window (Pro and Enterprise versions only). This is the unit used by the 
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supplier when shipping this item.  This may be box, pallet, etc.  This is different 
from the "Eaches" stocking unit you entered on the Additional tab.  For example, 
you may have entered "jar" for the stocking unit on the Additional tab, but the 
supplier may ship the item in boxes containing 10 jars.  When creating purchase 
orders, you would want to specify the Order Unit as box rather then jar (or you 
could end up with 100 boxes of jars rather than 100 jars).  

j. When you are done entering supplier information, click the Custom Texts or 
Custom Numbers and Dates tab (these tabs are optional). 

Deleting Suppliers from an Item: 

a. Highlight the supplier you want to delete from this item in the Supplier window.   
 

b. Click the Delete button. 

 

Custom Text and Custom Numbers and Dates Tab: 

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using 
Custom Fields. 

 

Saving the New Item: 

When you have finished adding information, click the OK/Save button.  The system behaves 
differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Editing Data 

Editing Items 

The Edit Items screen allows you to modify an existing item.  This screen is accessed from the 
Item List by highlighting an item in the list, then clicking the Edit button on the toolbar.  For more 
information on using the List screens, see the Working with Lists topic. 

The Edit Items screen is identical to the New Item screen, except all the information previously 
entered for the item appears on the screen.  You can change any of this information.  For 
information on using each tab of the screen, please refer to the Create New Item topic. 
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Editing Assembly Items 

This function applies to Pro and Enterprise Version users only. 

The Edit Assembly Items screen allows you to modify an existing assembly item.  This screen is 
accessed from the Item List by highlighting an assembly item in the list, then clicking the Edit 
button on the toolbar.  For more information on using the List screens, see the Working with 
Lists topic. 

The Edit Assembly Items screen is identical to the New Assembly Item screen, except all the 
information previously entered for the item appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Create an 
Assembly Item topic. 

When editing assembly items, there are two points to keep in mind: 

1. You will need to sync the mobile device in order for the changes to be transferred. 
 

2. The change of configuration will not impact mobile transactions already done on the 
device. 
 
Example:  You create an assembly item with two component parts, Item 1 and Item 2. 
 Later, you edit the assembly item to have three component parts, Item 1, Item 2 and 
Item 3. 
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Editing Kit Items 

This function applies to Pro and Enterprise Version users only. 

The Edit Kit Items screen allows you to modify an existing kit item.  This screen is accessed 
from the Item List by highlighting a kititem in the list, then clicking the Edit button on the toolbar. 
 For more information on using the List screens, see the Working with Lists topic. 

The Edit Kit Items screen is identical to the New Kit Item screen, except all the information 
previously entered for the item appears on the screen.  You can change any of this information. 
 For information on using each tab of the screen, please refer to the Creating a Kit Item topic. 

When editing Kit items, there are two points to keep in mind: 

1. You will need to sync the mobile device in order for the changes to be transferred. 
 

2. The change of configuration will not impact mobile transactions already done on the 
device. 
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Editing Sites 

The Edit Site screen allows you to modify an existing site.  This screen is accessed from the Site 
List by highlighting a site in the list, then clicking the Edit button on the toolbar.  For more 
information on using the List screens, see the Working with Lists topic. 

The Edit Site screen is identical to the New Site screen, except all the information previously 
entered for the site appears on the screen.  You can change any of this information.  For 
information on using each tab of the screen, please refer to the Create New Site topic. 

 

 



 

150 

Editing Locations (or a Site and Location) 

The Edit Location screen allows you to modify an existing location.  This screen is accessed 
from the Location List by highlighting an location in the list, then clicking the Edit button on the 
toolbar.  For more information on using the List screens, see the Working with Lists topic. 

The Edit Location screen is identical to the New Location screen, except all the information 
previously entered for the location appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Create New 
Location topic. 
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Edit Customer 

The Edit Customer screen allows you to modify an existing customer.  This screen is accessed 
from the Customer List by highlighting a customer in the list, then clicking the Edit button on the 
toolbar.  For more information on using the List screens, see the Working with Lists topic. 

The Edit Customer screen is identical to the New Customer screen, except all the information 
previously entered for the customer appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Create New 
Customers topic. 
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Edit Supplier 

The Edit Supplier screen allows you to modify an existing supplier.  This screen is accessed 
from the Supplier List by highlighting a supplier in the list, then clicking the Edit button on the 
toolbar.  For more information on using the List screens, see the Working with Lists topic. 

The Edit Supplier screen is identical to the New Supplier screen, except all the information 
previously entered for the supplier appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Create New 
Supplier topic. 
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Editing Manufacturers 

The Edit Manufacturer screen allows you to modify an existing manufacturer.  This screen is 
accessed from the Manufacturer List by highlighting a manufacturer in the list, then clicking the 
Edit button on the toolbar.  For more information on using the List screens, see the Working with 
Lists topic. 

The Edit Manufacturer screen is identical to the New Manufacturer screen, except all the 
information previously entered for the manufacturer appears on the screen.  You can change any 
of this information.  For information on using each tab of the screen, please refer to the Create 
New Customers topic. 
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Adding Notes 

Several screens in the software provide the option to add notes to the record.  Clicking on the 
Add Note button allows you to associate any comments you may have with the record you are 
creating or editing.  This is useful to keep comments associated with the record.  

 

Enter your notes in the text box, then click OK to save and exit. 

Notes are displayed along with the date/time it was entered and the user name of the user who 
added it. 
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Editing Pick Orders 

This function applies to Pro and Enterprise Version users only. 

The Edit Pick Order screen allows you to modify an existing purchase order.  This screen is 
accessed from the Pick Order List by highlighting an item in the list, then clicking the Edit button 
on the toolbar.  For more information on using the List screens, see the Working with Lists 
topic. 

The Edit Purchase Order screen is identical to the New Purchase Order screen, except all the 
information previously entered for the order appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Creating a Pick 
Order topic. 
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Editing Purchase Orders 

This function applies to Pro and Enterprise Version users only. 

The Edit Purchase Order screen allows you to modify an existing purchase order.  This screen 
is accessed from the Purchase Order List by highlighting an item in the list, then clicking the 
Edit button on the toolbar.  For more information on using the List screens, see the Working with 
Lists topic. 

The Edit Purchase Order screen is identical to the New Purchase Order screen, except all the 
information previously entered for the order appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Creating a 
Purchase Order topic. 
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Assembly Items 

Assembly Overview 

This function applies to Pro and Enterprise Version users only. 

Assembly items are created when you combine two or more existing items or multiple quantity of 
one item to create a new item.  You will use the Assembly item type when you want to "build" 
several of the new items to have on hand in your inventory.  You can create Assembly Items 
using Inventoried, Non-Inventoried items and other Assembly items. 

Kit Items vs Assembly Items: 

While these two item types are used to accomplish similar goals - the grouping of items - they are 
used for different reasons. Assembly Items are a collection of items that, once grouped, are 
considered to be a new, single item.  The inventory quantities for the individual component items 
are reduced at the time the Assembly Items are built and the quantity for the Assembly Item is 
increased.  You can build several Assembly Items and keep them on hand in your inventory.  In 
addition, you can move and check in/out Assembly Items. 

Kit Items are a collection of items that are sold together, but are listed separately in the 
transaction (similar to a bill of goods) and continue to be tracked as separate items.  A Kit Item is 
created at the time of sale.  You cannot Add inventory in order to have multiple Kit Items on 
hand.  Inventory amounts for the component parts are reduced when the Kit Item is Removed 
from inventory. 

Assembly Item Example: 

Sebastian sells modular cabinets.  Each cabinet is made of several different sizes of wood panels 
and hardware.  Sebastian tracks each piece used to build these cabinets as a separate piece of 
inventory in his system, so he will know when he needs to reorder a particular size of panel or 
piece of hardware.  He builds several of each type of cabinet to have on hand to sell as well. 
 When he does this, he creates an Assembly Item in InventoryControl that is made up of each 
piece of inventory used to build the cabinet.  InventoryControl will then deduct the on hand 
amount for each piece of inventory used in the assembly, and increase the amount on hand of 
the assembled item. 

The flow of Assembly Items is provided below: 

1. Create Your Assembly Item: Use the Create New Item screen to create your Assembly 
Item.  When Assembly is selected as the Item Type, there is a tab labeled Assembly on 
the Create New Item screen.  Use this tab to indicate what items you want to include in 
the built Assembly Item.  Keep in mind that after you create your Assembly Item, the 
quantity for that item is zero and the on hand amounts for the included items have not 
changed.  As with other Items, creating the Assembly Item simply tells InventoryControl 
basic information about the Assembly Item and indicates what other items you want 
included with it.   

2. Build your Assembly Item: This is a similar process as Adding Inventory to other item 
types.  In this process you will tell InventoryControl how many of this Assembly Item you 
want to build.  InventoryControl will check the on hand amounts for each item included in 
the build to make sure you have enough to complete the desired amount.  After the build 
is complete, the on hand amounts for each item included in your Assembly Item will be 
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reduced by the number built, and the on hand amount for the Assembly Item will be 
increased. 

Detailed instructions on how to create Assembly Items and Build them are provided in the links 
below: 

Creating an Assembly Item 

Building Assembly Items 

Disassembling (Removing) Assembly Items 

 

 



 

159 

 

Creating an Assembly Item 

This function applies to Pro and Enterprise Version users only. 

Assembly Items are used when you want to combine two or more existing items into one new 
item.  We recommend you read the Assembly Overview topic before you begin creating 
Assembly Items.   

This topic discusses: 

Accessing the New Assembly Items Screen 

General Information Tab 

Location Settings Tab 

Assembly Tab 

Additional Information Tab 

Manage Suppliers Tab  

Custom Texts/Custom Numbers and Dates Tab 

Saving the New Item 

 

 

Accessing the New Assembly Item Screen: 

1. From the Main Window, select New > Item > Assembly.   
 
 
The Create New Item screen appears: 
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Note that in addition to the usual tabs that appear on the Create New Item screen, there 
is also a tab labeled Assembly Information. 

 

 

General Information Tab: 

The General Information tab is where you will enter the basic information about the item. 
 Please see the screen shot above for an example of this tab. 

Input the appropriate information in the fields provided: 
  

• Item Number is a required field.  The Item Number is often available on a 
barcode label already attached to the item.  This allows you to scan or manually 
enter the number from each item as it comes in.  Item numbers cannot exceed 
20 digits.  
 
Do not use a description as the item number.  You should enter a numeric value 
in the Item Number field.  A description of the item can be entered in the 
Description field. 
 
The Item Number is often the UPC code or SKU number of an inventory item. 
 Using an existing barcode for Item Number allows you to scan or manually enter 
the number from each Item as it comes in without having to print and affix your 
own barcode inventory item labels. 
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Automatic Item Numbers: If you have the Automatic Item Numbers option 
selected on the Options screen, the Item No. field will appear populated with the 
next number in the sequence.  For further information on the this option, please 
refer to the Options Screen topic. 

• Category: When a new Category value is typed into the field, you will receive a 
message asking if you want to save it as a new Category.   

• Checkout Length specifies the default period, in days, that this Item can be 
checked out to a customer.   

• When a new Manufacturer is typed into the Manufacturer field, you will receive a 
message asking if you want to save the value as a new Manufacturer. 

• When you access the Create New Item screen by selecting New > Item > 
Assembly, this field will automatically be set to Assembly.  If you accessed it 
any other way, you can select Assembly from the Type drop down.  

• The Item To Be Tracked By section contains check boxes which determine 
whether the Serial Number, Lot, Date Code and Pallet fields must be completed 
throughout InventoryControl before you can create inventory from this item.   
 
Note: Keep in mind that marking the track by fields here mean that the entire 
Assembly Item, after build, will be tracked with a unique serial number, lot number, 
etc.  It may be the case that individual assets that make up the Assembly Item 
(selected on the Assembly tab) are also tracked by serial number, lot number, etc. 
 When you Build the Assembly Item on the Build Assembly screen, you will be 
required to enter the serial number or any other track by fields for each item 
included in the Assembly Item. 
  

Items To Be Tracked By: Field Will Be 
Available For Use 

Field Will Also 
Be Required 

  Disabled (not checked) No - 
 Enabled (checked) Yes Yes 

It is important at this time that you determine how you want to track each item. 
 Typically, small items that are all the same may not need to have any Tracked Bys 
selected.  Items such as printers may need to be tracked by Serial Number, so 
returns and maintenance can be properly tracked.  Medical supplies or food may 
need to be tracked by Date Code and/or Lot. 

Tracked By options cannot be changed after you add inventory to the item. 

• Automatic Serial Numbers: You can choose to have the program automatically 
create and assign serial numbers each time you add inventory for this item 
(whether manually using the Add Inventory feature or by Receiving Inventory).  To 
do this: 

a. Click the button to the right of the Serial Number check box.  The Auto 
Serial Number Options screen is displayed: 
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b. Check the Auto Increment Serial Numbers to have the software 

automatically assign incremented serial numbers. Enter a Starting 
Number.  This number determines the number at which the serial 
number sequence starts.  Since this option is applied at the Item level, 
each Item in the program may have its own unique series of serial 
numbers. 

c. Click OK to accept your entries. 

• The Require the user to fill out section contains check boxes which act much 
like the Tracked By boxes, but contains a different set of fields (Ref #, Supplier 
and Customer) which are always available for use, even if they are not required. 
 For example, if the option is not enabled for the Supplier Code field, a user adding 
inventory can enter a value for Supplier Code if he knows it or skip entering a 
value if he doesn't.  If however this option is enabled, a value for Supplier Code is 
required to complete the transaction. 

Require The User to Fill 
Out: 

Field Will Be 
Available For Use 

Field Will Also 
Be Required 

Disabled (not checked) Yes No 
Enabled (checked) Yes Yes 

   

• Cost specifies the amount paid to get this item into inventory.   
• Average Cost is a calculated value that averages the costs paid for the current 

Quantity.  

If you have 20 quantity of this item at cost 10.00  

and add another 30 quantity at cost 8.00, 

Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 =  8.80 

Removes are calculated using the FIFO method, therefore, if you later remove 5, 5 
of the cost 10.00 items will be removed first, 

Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67 

When calculating Average Cost, the software does not include records that have an 
average cost of zero.  When you run an Inventory Cost Report, the software does 
include zero cost quantities when calculating Total Cost. 

• List Price specifies a manufacturer's list price for an item. 
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• Sale Price specifies the price at which you sell an item. 
• Min Stock Level specifies the minimum stock level you wish to maintain.  
• Max Stock Level specifies the maximum stock level you wish to maintain. 
• Reorder Qty specifies the quantity at which you want to reorder inventory. 

 
Note:  The Minimum Stock Level, Maximum Stock Level and Reorder 
Quantity fields found on this tab represent these levels at the item level only, 
meaning these are the stock levels for this item throughout all locations.  If you 
want to maintain these levels by location, you can do so on the Location Settings 
tab (described below). 

• The Total Available counter is the sum of Total Checked-Out and Total In-House. 
• The Total Checked-Out counter is the quantity of this item that is currently 

Checked-Out. 
• The Total In-House counter is the Total Available less the Total Checked-Out. 
• The Total On Order counter is the quantity of this item that is currently included 

on an active Pick Order. 
• The Total Buildable is the quantity that can be built of this Assembly Item based 

on the inventory levels of the component items. 
• The Committed counter is the number of this Assembly Item that has been 

committed to a pick order. 

 

Location Settings Tab: 

When you have completed the General Information tab, click the Location Settings tab. This 
tab allows you to enter all locations where this item will be in inventory and to designate a primary 
location.  You can assign items to more than one location.  This tab uses the List functionality for 
grouping, ordering, filtering and deleting.   
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Complete the fields on this screen as described below: 

• Primary Location - Select this checkbox if this will be the primary location at 
this site for this item.  A primary location can be selected for each Site you 
have setup in the system.  When you select a primary location, when you 
Receive quantities of that item from a purchase order, they will automatically 
be assigned to that location.  Also, when you Pick quantities of that item for 
pick orders, they will automatically be removed from that location.  You can 
change these locations when picking and receiving if necessary.  In addition, 
the primary location will appear in any location fields (on the Add inventory 
screen, for example), however; you can change the location, if needed. 
 
Only one primary location can be selected per site. 

• Site and Location - Click in the box and select a Site and Location from the 
drop down list.  Only sites and locations you have previously selected will 
appear in this list.  Select More to view the Site or Location List.  You can 
also select New Location or New Site to access the Create New screen. 
 These represent the site and the location where the inventory will reside. 

• Quantity - This number is populated from the Inventory for this item.  This 
number displays how many of this item is currently in stock at the selected 
site and location.  When you first create your item, this number will be zero. 
 After you build your Assembly Item, this field will reflect the number you built 
(which is the quantity in stock). 

• Max Stock Level - Enter the maximum number of this item that you want to 
have in stock for the selected site and location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 
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• Min Stock Level - Enter the minimum number of this item that you want to 
have in stock for the selected Site and Location.  This number can be 0 or a 
positive number, negative numbers are not allowed. 

• Reorder Qnty - Enter the number at which you want to reorder this item for 
the selected Site and Location.  You can set an option in the software so 
that the system warns you at login of any inventory items that have hit their 
reorder quantity.  For further information on setting this option, please refer to 
the Options Screen topic.   
  

After you have completed all fields, hit ENTER to begin a new line.  Your screen will 
look similar to the following after hitting ENTER: 
 

 
  

 

Assembly Tab: 

This is the tab where you will indicate which items you want included in this Assembly Item.  You 
can select any Inventoried, Non-inventoried and/or Assembly item.  
 

 

To select items to include in your Assembly Item: 



 

166 

1. In the Type drop down, select Inventory, Non-Inventory or Assembly. 
 

 
2. In the Item Number field, select which item you want to add to this assembly.  If you 

select Full List, the Item List will be filtered by the Type you selected (i.e., if Non-
Inventory is selected, only non-inventory items will appear on the Item List. 
 

 
 
When you tab out of the Item Number field after selecting an item, the Description, 
Stocking Unit and Total In-House fields will populate with the information for that item. 
 

3. Enter the Quantity you want included in this Assembly Item.  This number represents 
how many of this items is included with each build of this Assembly Item.   
 
Example: Assume this Assembly Item is a cabinet.  For each cabinet, you need 2 long 
panels, 2 short panels and one back piece and 6 screws.  When you enter the long panel 
item on this tab, you will enter 2 in the Quantity field.  When you enter the screws item 
on this tab, you will enter 6 in the Quantity field, etc. 
  

4. Select the Always Scrap checkbox if you want InventoryControl to always "scrap" or 
permanently remove the item from inventory during the Disassembly process.  You 
might use this option for a non-inventory item such as a box used for packaging the 
Assembly Item. 
 
If the Always Scrap checkbox is not selected, the on hand amount for the item will be 
increased during Disassembly (the item is assumed to be returned to inventory rather 
than removed after Disassembly.) 
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5. Press ENTER to access a new line and enter another Item, then repeat the steps above. 
 Your screen will appear similar to the following after pressing ENTER: 
 

 

Note:  The cost will be calculated and updated based on your selections on this tab unless you 
have checked the Do Not Override Cost on the General Tab checkbox located at the bottom of 
the Assembly Information tab. 
  

 

Additional Information Tab: 

When you have finished entering information on the Assembly tab, click the Additional tab.  The 
Additional Information tab provides optional fields where other information about the Item can 
be recorded.  An example of this tab is shown below: 
 

 
 
Complete the fields on this tab as described below: 
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• Stocking Unit is the portion by which the quantity will be tracked.  At the item 
level, this should be "Eaches", meaning you should enter how you want each 
item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, 
box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, 
etc.)     
 
You will have the opportunity on the Managing Suppliers tab to enter the Order 
Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.).  The 
Order Unit will be used when creating Purchase Orders rather than the 
"Eaches" UOM that is entered on this tab.  Please see the Managing Suppliers 
Tab section, below. 

• Dimension Unit is the increment to be used for Length, Width and Height. 
 (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)  

• Length is the length of one Unit of Measure expressed in Dimension Units. 
• Width is the width of one Unit of Measure expressed in Dimension Units. 
• Height is the height of one Unit of Measure expressed in Dimension Units. 
• Weight Unit is the increment to be used for mass.  (Examples: ounce, pound, 

ton, milligram, gram, kilogram, metric ton, etc.) 
• Weight is the mass of one Unit of Measure expressed in Weight Units. 
• Manager is used to record the name of someone who manages this inventory 

item. 
• File Reference is used to record the path to a relevant file that might be an 

image file, documentation, specifications, etc.  This field does not function as a 
hyperlink.  It's just a static field where a filename or path and filename can be 
recorded. 

• Add Notes allows you to record any additional information. 

 
   

Manage Suppliers Tab: 

This tab allows you to identify which suppliers you will use for this item and enter detailed supplier 
information, such as unit of measure.  Pro and Enterprise users can enter multiple suppliers for 
an item and mark one as the default, or preferred supplier.  Standard version users can enter only 
one supplier for each item.  
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Adding Suppliers to an Item: 
 
To use this tab you must first select suppliers for this item in the Supplier window.  To do this: 

a. Click the New button at the bottom of the list.  The fields to the right of the 
Supplier window are enabled.  

b. Select a Supplier Code from the drop down list.  You can also select New 
Supplier from the list to create a new supplier. 

c. Enter the SKU number for this item in the Supplier Item SKU field. 
d. Enter the description of this item given by the supplier in the Supplier Item 

Description field. 
e. Enter the number of days lead time the supplier needs to process orders for this 

item in the Lead Time (in days) field.  The lead time is the time from the 
requisition date to the delivery date.  For example, if you need the item by the 
15th of the month and the supplier requires 5 days to deliver the order, you would 
enter 5 here to ensure the order is sent to the supplier timely. 

f. The Status field displays the supplier's current status (Active or Inactive).  You 
can change the status by making a new selection from the drop down menu. 

g. You can make this the default supplier for this item by checking the Make this 
the default Supplier while ordering this item checkbox (Pro and Enterprise 
versions only).  When this is selected, this supplier will automatically populate 
purchase orders for this item.  You can change the supplier on the purchase 
order, if needed. 

h. Any notes entered for this supplier will appear in the Notes section. 
i. You can enter the supplier's unit of measure settings in the Order Unit Settings 

window (Pro and Enterprise versions only). This is the unit used by the 
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supplier when shipping this item.  This may be box, pallet, etc.  This is different 
from the "Eaches" stocking unit you entered on the Additional tab.  For example, 
you may have entered "jar" for the stocking unit on the Additional tab, but the 
supplier may ship the item in boxes containing 10 jars.  When creating purchase 
orders, you would want to specify the Order Unit as box rather then jar (or you 
could end up with 100 boxes of jars rather than 100 jars).  

j. When you are done entering supplier information, click the Custom Texts or 
Custom Numbers and Dates tab (these tabs are optional). 

Deleting Suppliers from an Item: 

a. Highlight the supplier you want to delete from this item in the Supplier window.   
 

b. Click the Delete button. 

 

Custom Text and Custom Numbers and Dates Tab: 

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using 
Custom Fields. 

 

Saving the New Item: 

When you have finished adding information, click the OK/Save button.  The system behaves 
differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Building Assembly Items 

This function applies to Pro and Enterprise Version users only. 

After you create your Assembly Items (see the Creating An Assembly Item topic), you can 
"build" your Assembly Items as needed using the Assembly feature.  Building Assembly Items 
can be thought of as the "manufacturing" portion of the Assembly Item feature.  When you Build 
an Assembly Item, the on hand amounts for the sub-items are reduced by the number needed to 
make the Assembly Item, and the on hand amount for the Assembly Item is increased. 
 Assembling/Building Assembly Items increases inventory for the Assembly Item in the same 
way that Adding increases inventory for other item types. 

Building an Assembly Item is a two part process.  First, you will select which Assembly Item you 
want to build (add inventory to), next you will remove the sub-items from inventory.  In other 
words, since your Assembly item is made up of other items, you have to remove the sub-items in 
order to add inventory to the Assembly Item. 

Adding vs. Assembling: Keep in mind that while you can use the Add feature to add inventory 
to an Assembly item, doing this will not affect the inventory amounts for the sub items. 
 You should only use Add if you want to add inventory to an Assembly Item due to a return (you 
can also use the Adjust feature for this).  To increase your inventory for an Assembly Item and 
decrease your inventory for the sub-items, use the Assembly feature. 

To Assemble Items: 

1. From the Main screen, click the Inventory icon. 
 

2. From the Inventory menu, click Assembly.  The Build Assembly screen appears: 
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Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Builds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  The Build Assembly button does not have to be clicked 
between each scan to post these transactions to the Pending Transaction List.  If any 
additional information, such as serial numbers is needed for one or more sub-items tied 
to this Assembly Item, you will be taken to the Remove screen so you can add this 
information.  See below for information on using the Remove screen. 
 

Clicking the   button will unlock the field. 
 

3. In the Item Number field, enter the Item Number of the Assembly Item you want to 
build.  The drop down list will display the last five items selected.  Click More to view the 
Item List.  The Item List will be filtered to only show Assembly Items.  Click New to 
create a new Assembly Item. 
 

4. If one of the sub-items has a default location, that location will appear in the Location 
field.  If more than one sub-item has a default location, the field will appear blank.  You 
can change the Location by clicking on the field and entering a new location. 
 

5. Now you can enter the quantity you want to build.  Note that the system tells you the 
maximum number you can build.  This number is based on how many of each sub-item 
you on hand.   
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6. You can optionally enter Cost.  This Cost reflects the cost of the entire Assembly Item 

(including sub-items). 
 

7. You can optionally enter Notes. 
 

8. If you setup any Track By fields when you created this Assembly Item, the Track By 
section will be enabled.  These Track By fields are tied to the entire Assembly Item 
(including sub-items). 
 

9. When you have entered all required information (Item Number, Location and any 
required Track Bys), the Build Assembly button will be enabled.   
 
The Build Assembly button will not be enabled until all required information is entered in 
the appropriate fields.  The Commit button will not be enabled until at least one Remove 
is posted to the Pending Transaction List. 
 
Click this button to continue building your item.   If no additional information (such as 
serial numbers) is needed for any of the associated sub-items, you can click Commit at 
this point to complete the build process.   
 
If additional information is needed for one or more items, the Remove screen appears. 
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This Remove screen displays all items tied to this Assembly Item.  Those items that 
appear checked as in the example above are ready to be built. 
 
Items that are not checked need additional information, usually a Track By.   
 

10. In the Item Number field, enter the Item Number, or highlight an unchecked item in the 
display window.  The selected item's information will populate the screen. 
 

11. Enter any missing information, usually a Track By such as Serial Number.  When you 
are tracking by serial number, click on the Serial Number drop down to see a list of all 
unique serial numbers associated with the selected item.  You can also scan this 
information. 
 
Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Builds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  This feature is especially useful when scanning serial numbers. 
 

Clicking the   button will unlock the field. 
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12. Click Next when you have completed entering the requested information. You will be 
returned to the Assembly screen.  You can choose another Assembly Item to build, or 
click Commit to commit your changes to the database. 
 
When you click Commit, the inventory quantities for the listed items will be reduced and 
the quantity for the Assembly Item will be increased by the number built. 
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Disassembling Assembly Items 

This function applies to Pro and Enterprise Version users only. 

The process of Disassembling Assembly Items will reduce your inventory for the Assembly 
Item and increase your inventory of the associated sub-items.  You will be Removing inventory 
for the Assembly Item and Adding inventory to the sub-items, unless the sub-item has been 
marked to be scrapped. 

To Disassemble Assembly Items: 

1. From the Main screen, click Inventory. 
 

2. On the Inventory menu, click Disassemble.  The Disassemble screen will appear. 
 

 
 
Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple 
Disassembles at one Location, for example.  Pushpins can be used to lock the values in 
all but one required field so that a scanner can be used to rapidly add inventory just by 
repeatedly scanning barcodes into that field.  The Disassemble button does not have to 
be clicked between each scan to post these transactions to the Pending Transaction 
List.  If any additional information, such as serial numbers is needed for one or more 
sub-items tied to this Assembly Item, you will be taken to the Add screen so you can add 
this information.  See below for information on using the Add screen. 
 

Clicking the   button will unlock the field. 
 

3. In the Item Number field, enter the Item Number of the Assembly Item you want to 
Disassemble.  The drop down list will display the last five items selected.  Click More to 
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view the Item List.  The Item List will be filtered to only show Assembly Items.  
 

4. If this Assembly Item is only in one location, that location will appear in the Location field. 
 If the item exists in more than one location, click the drop down menu and select More to 
view the Location List. 
 

5. Enter the quantity you want to disassemble.  The Maximum number that appears directly 
below this field indicates the amount of this item that you have in inventory.  You cannot 
disassemble more than you have in inventory. 
 

 
6. The current date will appear in the Disassemble Date field.  You can keep this date, or 

enter a different date on which the Disassembly will occur.  If you enter a future date, the 
inventory counts for the Assembly Item and component items will not be affected until 
that date. 
 

7. If this Assembly Item is tracked by Serial Number, enter it in the Serial Number field. 
 Remember that this is the serial number for the Assembly Item as a whole (entered on 
the General tab of the Create New/Edit Assembly Item screen).   
 

8. If this Assembly Item is tracked by Lot, Date Code or Pallet, enter those in the 
appropriate fields. 
 

9. You can optionally enter a Customer in the Customer field. 
 

10. When you have completed the information on this screen, click Disassemble.   
 
The Disassemble button will not be enabled until all required information is entered in 
the appropriate fields.  The Commit button will not be enabled until at least one Add is 
posted to the Pending Transaction List. 
 
If any of the component items are tracked (by serial number, for example), you will be 
taken to the Add screen after you click Disassemble. 
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The Add screen lists all component items for this Assembly Item.  Items that appear 
with a green checkmark are ready to be added.   
 
Items that are not checked need additional information, usually a Track By.   
 
Note:  If this Assembly Item has been modified, the View Config History button, shown 
below,  will appear at the top of the screen.   
 

 
 
Click this button to view a list of all previous configurations.  The View Config History 
screen appears. 
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To switch to a previous configuration, highlight a listing and click the Use This 
Configuration button. 
 

11. In the Item Number field, enter the Item Number, or highlight an item in the display 
window.  The selected item's information will populate the screen. 
 

12. Select a location for this item (if there is only one location or that item has a primary 
location, this will appear in the Location field). 
 

13. Select the Scrap checkbox if you want to scrap, or discard, this item.  This means the 
inventory for this item will not be increased.  You would use this if the item is damaged or 
you do not want to return it to your inventory for some reason.   
 
You can also optionally enter a reason if you choose to scrap this item. 
 

14. Enter any missing information, usually a Track By such as Serial Number.   You can 
also scan this information. 
 
Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Builds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  This feature is especially useful when scanning serial numbers. 
 

Clicking the   button will unlock the field. 
 

15. Click Add when you have entered the requested information.  The item will now be check 
marked in the list. 
 

16. Click Next to continue. You will be returned to the Disassemble screen.  You can 
choose another Assembly Item to build, or click Commit to commit your changes to the 
database. 
 
When you click Commit, the inventory quantities for the listed items will be increased and 
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the quantity for the Assembly Item will be decreased by the number disassembled. 
 Keep in mind that if an item is marked as "Always Scrap" on the Create New/Edit Item 
screen, or you have selected the Scrap option on this screen, the inventory for that item 
will not be increased. 
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Kit Items 

Kitting Overview 

This function applies to Pro and Enterprise Version users only. 

Kit items are a group of items that are sold together, but are still considered separate inventory 
items.  As opposed to Assembly Items, you cannot add inventory, move or check out/in Kit 
Items.  While Assembly Items can be created in advance (pre-assembled) and kept in inventory, 
Kit Items are created at pick or remove time. 

Kit Items vs Assembly Items 

While these two item types are used to accomplish similar goals - the grouping of items - they are 
used for different reasons. Assembly Items are a collection of items that, once grouped, are 
considered to be a new, single item.  The inventory quantities for the individual component items 
are reduced at the time the Assembly Items are built and the quantity for the Assembly Item is 
increased.  You can build several Assembly Items and keep them on hand in your inventory.  In 
addition, you can move and check in/out Assembly Items. 

Kit Items are a collection of items that are sold together, but are listed separately in the 
transaction (similar to a bill of goods) and continue to be tracked as separate items.  A Kit Item is 
created at the time of sale.  You cannot Add inventory in order to have multiple Kit Items on 
hand.  Inventory amounts for the component parts are reduced when the Kit Item is Removed 
from inventory. 

Kit Item Example: 

Here is an example of the workflow for creating a Kit Item: 

John's Computer Store sells custom configured computers.  While he keeps all components 
(monitors, keyboards, CPUs, Printers etc.) in stock, he tracks each of these as separate items. 
 When a customer buys a computer, he or she designates which monitor is needed, which printer, 
etc.  John then creates a Kit Item in InventoryControl made up of the selected components.  The 
Kit Item goes onto his Inventory List with zero quantity and stays that way until he Removes it, 
which would be the time of customer pick up or shipping.  At the time of Removal, the quantity for 
each component item is reduced and the Kit Item is completely removed from the ItemList. 

Kit Items should not be confused with Pick Orders.  Pick Orders can contain many unrelated 
items, Kit Items are a group of items that make up a new item (as in the Computer Store 
example).  Kit Items can be included on Pick Orders. 

Flow of Kit Items: 

1. Create the Kit Item: Use the Create New Item screen to create your kit item.  When you 
access the Create New Item screen for Kit items, there will be a tab labeled Kitting 
Information.  Use this tab to designate which items you want included in this Kit Item. 
 Keep in mind that inventory amounts for the component items are not changed when you 
create the Kit Item.  The Kit Item is added to your Item List. 
 

2. Remove the Kit Item: After the Kit Item has been picked and sold, use the Remove 
function to remove the designated quantity from inventory.  At this time, inventory 
amounts for the component parts will be reduced. 
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Creating a Kit Item 

This function applies to Pro and Enterprise Version users only. 

Kit Items are used when you want to combine two or more existing items in order for them to be 
sold together.  Kit items are not kept or tracked in inventory (you cannot add, move, check out, 
etc.).  We recommend you read the Kitting Overview topic before you begin creating Kit Items.   

Note:  You can import the general information for a Kit Item, but not the compositional information 
(i.e. which items make up the component items).  If you import Kit Items, you must then finish 
setting them up manually on the Edit Item screen. 

This topic discusses: 

Accessing the Create New Items Screen 

General Information Tab 

Kit Information Tab 

Additional Information Tab 

Custom Texts/Custom Numbers and Dates Tab 

Saving the New Item 

 

 

Accessing the Create New Items Screen: 

1. From the Main Window, select New > Item > Kit. 
 
The Create New Item screen appears: 
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Note that in addition to the usual tabs that appear on the Create New Item screen, there 
is also a tab labeled Kit Information. 

 

General Information Tab: 

The General Information tab is where you will enter the basic information about the item. 
 Please see the screen shot above for an example of this tab. 

Input the appropriate information in the fields provided: 
  

• Item Number is a required field.  The Item Number is often available on a 
barcode label already attached to the item.  This allows you to scan or manually 
enter the number from each item as it comes in.  Item numbers cannot exceed 
20 digits.  
 
Do not use a description as the item number.  You should enter a numeric value 
in the Item Number field.  A description of the item can be entered in the 
Description field. 
 
The Item Number is often the UPC code or SKU number of an inventory item. 
 Using an existing barcode for Item Number allows you to scan or manually enter 
the number from each Item as it comes in without having to print and affix your 
own barcode inventory item labels. 
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Automatic Item Numbers: If you have the Automatic Item Numbers option 
selected on the Options screen, the Item No. field will appear populated with the 
next number in the sequence.  For further information on this option, please refer 
to the Options Screen topic. 

• Category: When a new Category value is typed into the field, you will receive a 
message asking if you want to save it as a new Category.   

• Checkout Length is not available for Kit Items..   
• When a new Manufacturer is typed into the Manufacturer field, you will receive a 

message asking if you want to save the value as a new Manufacturer. 
• When you access the Create New Item screen by selecting New > Item > Kit, 

this field will automatically be set to Kit.  If you accessed it any other way, you 
can select Kit from the Type drop down.  

• The Item To Be Tracked By section is not available for Kit Items.  Tr0acking can 
take place for the component items, but not for the Kit Item. 
  

• Cost specifies the amount paid to get this item into inventory.   

• Average Cost is a calculated value that averages the costs paid for the current 
Quantity.  

If you have 20 quantity of this item at cost 10.00  

and add another 30 quantity at cost 8.00, 

Average Cost = ((20 x 10.00) + (30 x 8.00)) / 50 =  8.80 

Removes are calculated using the FIFO method, therefore, if you later remove 5, 5 
of the cost 10.00 items will be removed first, 

Average Cost = ((15 x 10.00) + (30 x 8.00)) / 45 = 8.67 

When calculating Average Cost, the software does not include records that have an 
average cost of zero.  When you run an Inventory Cost Report, the software does 
include zero cost quantities when calculating Total Cost. 

• List Price specifies a manufacturer's list price for an item. 
• Sale Price specifies the price at which you sell an item. 
• Min Stock Level is not available for Kit Items. 
• Max Stock Level is not available for Kit Items. 
• Reorder Qty is not available for Kit Items. 
• Total Shippable is the total on hand amount minus committed quantities for all 

component items. (Committed is inventory that is contained on a pick order.) 
 
  

 

Kit Information Tab: 
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This tab is where you will indicate which items you want included in this Kit.   
 

 

To select items to include in your Kit Item: 

1. In the Type drop down, select Inventory, Non-Inventory or Assembly. 
 

 
2. In the Item Number field, select which item you want to add to this assembly.  If you 

select Full List, the Item List will be filtered by the Type you selected (i.e., if Non-
Inventory is selected, only non-inventory items will appear on the Item List.  If 
Assembly is selected, only Assembly items will appear in the List). 
 

 
 
When you tab out of the Item Number field after selecting an item, the Description, 
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Stocking Unit and Total In-House fields will populate with the information for that item. 
 

3. Enter the Quantity you want included in this Kit Item.   
  

4. Press Enter to access a new line and enter another Item, then repeat the steps above.   

Note:  The cost will be calculated and updated based on your selections on this tab unless you 
have checked the Do Not Override Cost on the General Tab checkbox located at the bottom of 
the Kit Information tab. 
  

 

Additional Information Tab: 

When you have finished entering information on the Kit Information tab, click the Additional tab. 
 The Additional Information tab provides optional fields where other information about the Item 
can be recorded.  An example of this tab is shown below: 
 

 
 
Complete the fields on this tab as described below: 

• Stocking Unit is the portion by which the quantity will be tracked.  At the item 
level, this should be "Eaches", meaning you should enter how you want each 
item of this type to be measured. (Examples: bag, barrel, basket, block, bottle, 
box, carton, container, drum, gallon, jar, pack, package, pallet, section, tub, vial, 
etc.)     
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You will have the opportunity on the Managing Suppliers tab to enter the Order 
Unit used by the supplier for shipping purposes (Box, Pallet, Lot, etc.).  The 
Order Unit will be used when creating Purchase Orders rather than the 
"Eaches" UOM that is entered on this tab.  Please see the Managing Suppliers 
Tab section, below. 

• Dimension Unit is the increment to be used for Length, Width and Height. 
 (Examples: inch, foot, yard, millimeter, centimeter, meter, etc.)  

• Length is the length of one Unit of Measure expressed in Dimension Units. 
• Width is the width of one Unit of Measure expressed in Dimension Units. 
• Height is the height of one Unit of Measure expressed in Dimension Units. 
• Weight Unit is the increment to be used for mass.  (Examples: ounce, pound, 

ton, milligram, gram, kilogram, metric ton, etc.) 
• Weight is the mass of one Unit of Measure expressed in Weight Units. 
• Manager is used to record the name of someone who manages this inventory 

item. 
• File Reference is used to record the path to a relevant file that might be an 

image file, documentation, specifications, etc.  This field does not function as a 
hyperlink.  It's just a static field where a filename or path and filename can be 
recorded. 

• Add Notes allows you to record any additional information. 

 

Custom Text and Custom Numbers and Dates Tab: 

For information about the Custom Texts and Custom Numbers and Dates tabs, see Using 
Custom Fields. 

 

Saving the New Item: 

When you have finished adding information, click the OK/Save button.  The system behaves 
differently at this point depending on your settings on the Options screen.  

• When the Close New Form option is turned off: Click Save to commit your entry 
or click Close to exit the form. 

• When the Close New Form option is turned on: Click OK to commit your entry 
and exit the form or Cancel to exit the form without saving your entry. 
 
For more information about the Options screen, please refer to the Options 
Screen topic. 
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Removing Kit Items 

The Remove screen allows you to remove a kit item from the database.  This can be considered 
the same as shipping inventory.  You can designate which customer this inventory was shipped 
to on this screen.    

The Remove function uses FIFO (First in First Out) to determine what inventory is removed first. 
 If you Add 5 of Item 123 to Location Bin 1, for example, then another 5 come in on another day, 
you will have ten of that item.  When you later remove 3 of Item 123, the first set of 5 will be 
subtracted from inventory before the second set. 

Removing Inventory from an Item: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Remove icon.  The Remove screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. On the Item List, highlight an item in the grid, then click the Remove icon. 
 

 
 

To prevent fields from clearing, click the Pushpin  button located to the right of the 
field you want to lock for subsequent transactions.  This is helpful when you have to 
perform multiple removes at one Location, for example.   Pushpins can be used to lock 
the values in all but one required field so that a scanner can be used to rapidly remove 
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inventory just by repeatedly scanning barcodes into that field.  (The Remove button 
does not have to clicked between each scan to post these remove transactions to the 
Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item fields: Enter the Item Number of the item from which you want to 
remove inventory. To enter an Item Number, you can type or scan the value into the field, or 
you can use the drop down list to select an existing item from the first 10 Items shown there, 
or select <more> to select an Item from the Item List.  You can only Remove quantity from 
items with quantity greater than 0.  The Item Number list on this screen will not display or 
accept numbers that do not have quantity.  
 
Entering an Item Number populates the Item Number field as well as the Description field 
and enables the following fields: 

• Quantity (unless the item is Tracked By Serial Number - Set on the 
Add or Edit Item screens, which fixes the Quantity to a value of 1). 

• Location 
• Any of the associated Tracked By fields: Track by fields are not 

used for Kit items, though the individual component items may have 
track bys. 

• Customer 
• Notes 

  

You can use the drop down list of any enabled field to select an existing value for that field.   
 
Note: If the Automatic New option is enabled on the Options screen, the Create New 
Customer screen will be opened automatically if an unknown Customer is entered.   If the 
Automatic New option is turned off when an unknown Customer is entered, a prompt will 
ask if you want to use the Create New screen.  For more information on the enabling and 
disabling the Automatic New option, please refer to the Options screen topic. 

4. Enter the Customer: Select a Customer from the drop down list.  Select <New> from the 
Customer drop list to open the Create New Customer screen.   
 
The Notes field allows you to add and store additional information that describes the 
transaction.   
 

5. After you have completed entering the information, click the Remove button to add the 
transaction to the Pending Transaction List.  All fields on the Remove screen will be 
cleared and all but the Item Number field will be disabled.  You can either select another 
item to be removed or you can click Commit on the Pending Transaction List to submit the 
transaction(s). 
 
The Remove button will not be enabled until all required information is entered in the 
appropriate fields.  Click the Remove button to continue Removing the kit item.   If no 
additional information (such as serial numbers) is needed for any of the associated 
component items,  you can click Commit at this point to complete the remove process.   
 
If additional information is needed for one or more items, this Remove screen appears. 
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This Remove screen displays all items tied to this Kit Item.  Those items that appear 
checked as in the example above are ready to be removed. 
 
Items that are not checked need additional information, usually a Track By or Location, if 
inventory is kept at more than one location.   
 

6. In the Item Number field, enter the Item Number, or highlight an unchecked item in the 
display window.  The selected item's information will populate the screen. 
 

7. Enter any missing information, usually a Track By such as Serial Number.  When you are 
tracking by serial number, click on the Serial Number drop down to see a list of all unique 
serial numbers associated with the selected item.  You can also scan this information. 
 
Note: To prevent fields from clearing, click the pushpin  button located to the right of the 
field you want to lock.  This is helpful when you have to enter multiple serial numbers, for 
example.  Pushpins can be used to lock the values in all but one required field so that a 
scanner can be used to rapidly add inventory just by repeatedly scanning barcodes into that 
field.  This feature is especially useful when scanning serial numbers. 
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Clicking the   button will unlock the field. 
 

8. Click the Next button to continue.  You will be returned to the Remove screen where you 
can enter another item for removal, if needed. 
 

9. If you want to print a receipt of this transaction, enter the number of receipts in the Print 
receipt on Commit - Copies field. 
 

10. Click Commit to submit the transaction(s) to your database. 
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Using the List Screens 

Working with Lists 

This software contains easy to use List screens that allow you to view and access a variety of 
information quickly.  Screens that use the list view are Customer, Manufacturer, Item, Location, 
Site, Supplier, Inventory, Transaction, Purchase Order and Pick Order.  Each of these screens 
can be accessed by clicking the Lists Icon on the Main Window. 
 

 

Note: These screens all function the same; however, individual options may vary for each screen. 
 This topic covers how to use all possible functions available on the list screens.  Keep in mind 
that not all list screens contain all functions mentioned here.   

Below is an example of the basic list screen layout.  This is an example of the Inventory List. 
This screen can be divided into three sections (labeled A through C in the example below):  

A. Toolbar 

B. Contents List  

C. Buttons    
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In addition to these menus there are also "Context-Sensitive Menus" that appear when you right-
click on certain areas of the screen.  These provide another way to access many of the functions 
available in the toolbar.  These types of menus are also discussed later in this section.   

 

Quick Links: 

Click a link below to jump to that section of the topic: 

Section A: Toolbar  

Section B: Contents List  

Section C: Buttons  

"Context-Sensitive Menus"  
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Section A: Toolbar 

 

The toolbar at the top of the list screen provides quick access to a variety of functions and also 
allows you to customize how the information on the list is displayed.  Each of these functions is 
described below: 

Button Description 
Filter Filter access the Find screen allowing you to quickly lookup information.  For more information on 

the Find screen, please see Searching for Information. 
Toggle The Toggle button is enabled after you have used the Filter feature to limit the list to certain 

information.  Click the Toggle button to view all listings again.  For instance, if you have filtered 
your Item List to display only items with Monitor in the description field, you can click the Toggle 
button to display all items on the list again.  Click Toggle again and the list will again be filtered 
by your selection. 

Check-In 

 

(Applies to the Item and Inventory List screens only.) Highlight a listing that is Checked Out, 
then click the Check-In button.  The Check-In screen allows you to Check-In inventory that has 
previously been Checked Out to one or more customers.  While checking in inventory does not 
actually add inventory (quantity) to an item, it does free up that inventory to be checked-out to 
another customer, if needed, or to be included in a pick order.  For more information, please refer 
to the Checking In Inventory topic. 

Check-
Out 

(Applies to the Item, Inventory and Customer List screens only.) Highlight a listing, then 
click the Check-Out button.  The Check-Out screen allows you to check-out, or assign, 
inventory to customers.  For more information, please refer to the Checking Out Inventory 
topic. 

Move 
Inventory 

(Applies to the Location and Inventory List screens only.) Highlight a listing, then click the 
Move button.  The Move screen allows you to move inventory quantity for an item from one 
Location to another.  When you create an item, you can add which locations it may be.  When 
you then add inventory (quantity) to the item, you select in which location that quantity will reside. 
 The Move function allows you to move that inventory from the originally assigned location to 
another.  By moving inventory in the software, you can easily keep accurate records of where all 
of your inventory is currently located.  For more information, please refer to the Moving 
Inventory topic. 

Add 
Inventory 

 

(Applies to the Item and Inventory List screens only.)  Highlight a listing, then click the Add 
Inventory button, or just click the button to access the Add screen.  The Add screen allows you 
to manually add quantity to items already entered into your database.  Inventory is the amount or 
quantity of a particular item.  Items must first be imported or entered on the Create New Item 
screen (by selecting Lists > Item List > New) before you can add quantity to it.  For more 
information, please refer to the Adding Inventory topic. 

Remove 
Inventory 

(Applies to the Item and Inventory List screens only.)  Highlight a listing, then click the 
Remove button, or just click the button to access the Remove screen. The Remove Inventory 
screen allows you to remove quantity from any item in the database.  For more information, 
please refer to the Removing Inventory topic. 

Edit Highlight a listing on the screen, then click the Edit button.  The Edit screen appears allowing you 
to update and change information. 

New Accesses the New screen allowing you to enter a new Customer, Item, Manufacturer, Site, 
Supplier, Purchase Order or Pick Order.   

Duplicate Highlight a listing, then click the Duplicate button.  The New screen appears with all fields 
populated with the information from the listing you copied.   
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Export to 
File 

Export allows you to export the entire list to a comma-delimited text file.   

What is a comma-delimited file?  

This is a type of data format in which each piece of data is separated by a comma. This is a 
popular format for transferring data from one application to another, because most database 
systems are able to import and export comma-delimited data.  

For example, data pulled from a database and represented in comma-delimited format looks 
something like the following. Each column value is separated by a comma from the next column’s 
value and each row starts a new line: 

Adams, Jane, 46, female, New York 

Doe, John, 32, male, California 

Jones, Sam, 13, male, Texas 

Smith, Mary, 64, female, Louisiana  

When data is represented in comma-delimited format they also are referred to as comma-
separated values, abbreviated CSV. 

When the Export button is selected, a screen appears allowing you to specify where the exported 
data will be saved on your computer.  An example of the Export screen is shown below: 
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Make sure you save this to a location you can remember.  You must also choose a name for your 
file on this screen.  After you have made your selections, click Save to export your data. 

A confirmation message will appear when your data has been successfully exported by the 
system.   
  

Print Print allows you to print the list.  When this button is selected, a standard Page Setup screen 
appears allowing you to enter margins.  An example of this screen is shown below: 
 

 

Click the OK button on the Page Setup screen to print the list.  The list will print to your default 
printer.  

Group 
By 

The list screens provide you with the capability of "grouping" the displayed information so you can 
view data in a way that is most easy-to-read for you.  You can have one group, two groups, or 
many groups depending on how you want to view your information.  For instance, if you want all 
inventory on the Inventory List to be displayed grouped by location, you can quickly set this up.   

To see the grouping options, click the Group By button.  The top of the list screen expands to 
display the group selections as shown below: 
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Creating Groups 

To create a new group, click on a column header, then drag it to the space indicated on the 
screen.  For example, if you want to group information by Location, click on the Location column 
header and drag it to the indicated space. 
 
 

 
The screen now lists Site as one of your groups and the assets are grouped according to what 
Site they are assigned. 

You can create additional groups to further organize your information by continuing to drag and 
drop column headers.   

By default, the groups list information in ascending order (Location  001, Location 002, etc.).  You 
can change this to descending order by clicking on the group name.  Notice that after you click on 
the group name, the arrow next to the name is now pointing in the opposite direction and the 
information on the screen is reorganized. 

 

Deleting Groups 

If you no longer want to display information in a particular group you can easily ungroup the data. 
 For instance, if you have created a group for Location but now wish to remove it, you can do so 
by clicking on the group name and dragging it down into the column header section.  Let go of 
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your cursor anywhere in the column header section and the group disappears.  

 

The information contained in that group still appears on the display screen, but it is no longer 
grouped together. 

 
Hidden 
Columns 

Hidden Columns -  The list allows you to hide columns by right-clicking on a column label and 
selecting Hide Column.  This enables you to hide information you do not usually need.   

You can view the columns you have hidden by right clicking on any column and selecting Show 
Hidden Columns.  A pop-up screen similar to the one below appears listing all columns that are 
not currently visible. 

  

You can return these columns to the full List screen by double-clicking on a listing in the Hidden 
Columns screen and dragging it back to the column labels section on the List screen.   
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Section B: Contents List 

The contents list displays all data related to the selected list.  For example, if you selected 
Inventory, all Inventory entered in the system will display here, if you selected Manufactures, all 
manufacturers will display here, etc. 

 

Sorting Columns: Most of the columns that appear in the lists can be sorted ascending or 
descending.  The columns sort ascending by default.  To change the sort order, click on the 
column heading.  An arrow will appear next to the column name to let you know in which direction 
the information is sorted.  The example below shows the Last Name column sorted Ascending. 

 

Selecting a Listing: You can quickly scroll through the listings using the buttons directly below 
the contents list.  Keep in mind that you can also use the Filter button to limit the items that 
appear in the list (see Section A: Toolbars, above).  The list screens can display up to 1000 lines 
of information at a time.  If your list contains more than 1000 items, you must create a filter to 
show the items not on the list.   
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Click on a listing to highlight it, then click the button that accesses the desired function.  For 
example, if you want to edit Item 10002, use your mouse to click on that listing in your Item List, 
then click the Edit button. 

Arranging Columns: You can arrange the columns in the list into any order you wish.  To 
change the order, click on a column heading and drag it somewhere else on the list.  For 
example, if you want to make Location the first column in your Inventory List, click on the 
Location column heading and drag it to the first column in the list as shown below: 
 

 

After you drop the column into its new position, the list will reorganize with the Group information 
appearing first: 
 

 

  
 

 

Section C: Buttons 

 

This section contains the following buttons: 

Help (F1) - Click this button (or hit the F1 key on your keyboard) to access this help document. 

Close - Click this button to close the List.  Keep in mind when closing the list that your groups 
and column settings will be retained. 

 

Context-Sensitive Menus: 

The software provides you with a toolbar for quick access to various list features and, in addition, 
many of these features can also be accessed via "context-sensitive menus".  By right-clicking on 
a column heading, a list of available features appears, as shown below (Note that not all options 
shown below are available on all screens): 
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 Any changes you make to the list via this menu will be retained when the screen is closed and 
re-opened. 

This menu allows you to: 

Sort ASC - Select this option to sort the column in ascending order (A through Z or 1 through 10, 
etc.). 

Sort DESC - Select this option to sort the column in descending order (Z through A or 10 through 
1, etc.). 

Group By this Column - Select this option to group the screen by the selected column.  Please 
see Section A - Toolbar above for more information on grouping. 

Show Grouping - Select this option to show the groups selected for this list screen.  Please see 
Section A - Toolbar above for more information on grouping. 

Hide Columns - The list allows you to hide columns by right-clicking on a column label and 
selecting Hide Column.  This enables you to hide information you do not usually need.  When you 
hide a column, it will remain hidden until you manually return it to the List screen by following the 
instructions below. 

Show Hidden Columns -  You can quickly view the columns you have hidden by right clicking on 
any column and selecting Show Hidden Columns (or by clicking the Show Hidden button).  A pop-
up screen similar to the one below appears listing all columns that are not currently visible. 

  

You can return these columns to the full List screen by clicking on a listing in the Hidden 
Columns screen and dragging it back to the column labels section on the List screen.   
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Item List Example 

The Item List displays all items you have entered in the system.  Below is an example of this 
screen: 

 

The Item List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export or 
Print the list of Items.  For detailed information regarding each of these options, refer to the 
Working with Lists topic. 
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Inventory List Example 

The Inventory List displays all items that have inventory (quantity) in the software.  Inventory is 
the amount or quantity of a particular item.  Items must first be imported or entered on the Add 
Item screen before you can add quantity to it.   

 

The Inventory List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or Print 
a list of Inventory.  For detailed information regarding each of these options, refer to the Working 
with Lists topic. 
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Site List Example 

The Site List displays all sites you have setup in the system.   

 

The Site List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export or 
Print the list of Sites.  For detailed information regarding each of these options, refer to the 
Working with Lists topic. 
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Location List Example 

The Location List displays all locations you have setup in your system.  Below is an example of 
the Location List: 

 

The Location List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export 
or Print the list of Locations.  For detailed information regarding each of these options, refer to 
the Working with Lists topic. 
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Customer List Example 

The Customer List displays all customers you have setup in the software.  A customer is any 
person or entity to whom you check-out, receive or send (pick) inventory.   

 

The Customer List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export 
or Print the list of Customers.  For detailed information regarding each of these options, refer to 
the Working with Lists topic. 
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Manufacturer List 

The Manufacturer List displays all manufacturers you have setup in the system. 

 

The Manufacturer List window allows you to Edit, create New, Copy, Delete, Show, Filter, 
Export or Print the list of Manufacturers.  For detailed information regarding each of these 
options, refer to the Working with Lists topic. 
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Supplier List 

The Supplier List displays all suppliers you have setup in the system. 

 

The Supplier List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export 
or Print the list of Suppliers.  For detailed information regarding each of these options, refer to 
the Working with Lists topic. 
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Pick Order List Example 

This function applies to Pro and Enterprise Version users only. 

The Pick Order List displays all active pick orders entered in the system.  Active pick orders are 
those that have a status of New, New-Over Due, In Process or In Process-Over Due.  Below is 
an example of the Pick Order List. 
  

 
  

Notice the red flags next to some of the orders on the list.  These red flags indicate that the order 
is past due.  The status may be New-Past Due or In Process-Past Due.  Overdue orders will 
appear at the top of the list by default, but you can reorder the list as needed. 

The Pick Order List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export 
or Print the list of Pick Orders.  For detailed information regarding each of these options, refer to 
the Working with Lists topic. 
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Purchase Order List Example 

This function applies to Pro and Enterprise Version users only. 

The Purchase Order List displays all active purchase orders you have in your system.  Active 
purchase orders are those that have a status of New, New-Over Due, In Process or In Process-
Over Due.  Below is an example of the Purchase Order List.  

 

Notice the red flags next to some of the orders on the list.  These red flags indicate that the order 
is past due.  The status may be New-Past Due or In Process-Past Due.  Overdue orders will 
appear at the top of the list by default, but you can reorder the list as needed. 

The Purchase Order List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or 
Print the list of Purchase Orders.  For detailed information regarding each of these options, refer 
to the Working with Lists topic. 
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Transaction List Example 

The Transaction List displays all transactions (add, move, remove, etc.) that have occurred in 
the system along with the date of the transactions and the user who performed them.  Below is an 
example of the Transaction List: 

 

The Transaction List window allows you to Filter, Export or Print the list of Transactions.  For 
detailed information regarding each of these options, refer to the Working with Lists topic. 

Keep in mind that the list screens only display a maximum of 1000 rows.  If the dates for which 
you are looking are not shown in the list, use the Filter function to display the records you need. 
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Inventory 

Inventory Menu 

The Inventory Menu groups tasks such as Adding/Removing, Moving, Checking In/Out, 
Adjusting and Auditing inventory into one place.   

To Access the Inventory Menu: 

1. From the Main Window, click the Inventory icon. The Inventory Menu appears at the 
bottom of the screen. 
 
 

 
 
Click on any of the Inventory Menu icons to go to that function.  Detailed descriptions of 
the options found on the Inventory Menu are provided below: 
 

• Add - The Add screen allows you to add inventory (quantity) to an item at a 
specified location.  This allows you to "manually" add quantity to an item rather 
than receiving the inventory through a fulfilled Purchase Order.  For more 
information on adding inventory, please refer to the Adding Inventory topic.  For 
more information on receiving  inventory, please refer to the Receiving 
Inventory topic. 
 

• Remove - The Remove screen allows you to remove inventory (quantity) from 
an item at a specified location.  This allows you to "manually" remove quantity 
from an item rather than removing it through a pick order.  For more information 
on removing inventory, please refer to the Removing Inventory topic.  For more 
information on pick orders, please refer to the Creating Pick Orders topic. 
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• Move - The Move screen allows you to move inventory for an item from one  
Location to another.   When you add inventory (quantity) to an item, you select 
in which location that quantity will reside.  The Move function allows you to move 
that inventory from the originally assigned location to another.  By moving 
inventory in the software, you can easily keep accurate records of where all of 
your inventory is currently located.  For more information on the Move screen, 
please refer to the Moving Inventory topic. 
 

• Check-In - The Check-In screen allows you to check-in, or make available, 
inventory that has previously been Checked-Out to one or more customers. 
 While checking in does not actually add inventory to an item, it does free up that 
inventory to be checked-out to another customer, if needed, or to be included in a 
pick order.  For more information on the Check-In screen, please refer to the 
Checking In Inventory topic. 
 

• Check-Out - The Check-Out screen allows you to check-out, or assign, 
inventory to a customer for a specified length of time.  For more information on 
the Check-Out screen, please refer to the Checking Out Inventory topic. 
 

• Adjust - The Adjust screen allows you to modify the quantity of existing items. 
Adjust is like a "mini" Audit and will update the quantity using FIFO (First In First 
Out) to make the total equal to the quantity you enter here.  The Adjust function 
is useful if too much or too little quantity is accidentally entered for an item (on a 
mobile device, for example), inventory is lost, found, broken, etc. and you need to 
quickly correct the quantity for that item.  Adjusting is different from an Audit in 
that the Audit function makes other functions of the software, such as adding 
inventory, unavailable to ensure inventory is not added or removed while you are 
doing the counts.  All features are still available when adjusting inventory.  For 
more information on the Adjust screen, please refer to the Adjusting Inventory 
topic. 
 

• Assemble - Pro and Enterprise Versions Only - This icon opens the Build 
Assembly screen.  Build Assembly allows you to add inventory to your 
Assembly Items.  The Build process adds inventory to the Assembly Item 
while decreasing inventory for the component items.  For more information on the 
Assemble screen, please refer to the Building Assembly Items topic. 
 

• Disassemble - Pro and Enterprise Versions Only - This icon opens the 
Disassemble screen.  Disassemble allows you to decrease inventory for your 
Assembly Items.  The Disassemble process removes inventory for the 
Assembly Item while increasing inventory for the component items.  For more 
information on the Disassemble screen, please refer to the Disassembling 
Assembly Items topic. 
 

• Audit - This icon starts the Audit Mode of the software.  Audit Mode allows you 
to check the counts of all your inventory while disabling other features, such as 
add and remove, to make sure inventory counts in the system do not change 
while you are performing the audit.  If you are using mobile devices, you can use 
them simultaneously with the PC to perform an audit.  For more information on 
Auditing, please refer to the Auditing Your Inventory topic. 
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Manually Adding Inventory 

The Add Inventory screen allows you to manually add quantity to items already entered into your 
database.  Inventory is the amount or quantity of a particular item.  Items must first be imported or 
entered on the Add Item screen before you can add quantity to it.  

Inventory is also added when you add inventory on the mobile devices. For more information on 
adding inventory on the Wasp 3200 mobile device, please refer to the topic Windows Mobile 
Device - Adding Inventory.  For more information on adding inventory on the WDT2200 mobile 
device, please refer to the topic WDT2200 - Adding Inventory. 

Pro and Enterprise Version Users Only: Inventory is also added when you receive inventory 
from a purchase order.  For further information on receiving inventory on the PC, please refer to 
the topic Receiving Inventory.   
 
Pro and Enterprise Version Users Only:  Keep in mind that if you want to increase inventory 
amounts for Assembly Items, you should use the Build Assembly feature rather than the Add 
feature.  Build Assembly will adjust the inventory amounts for all component items.  You can use 
the Add feature if you want to add inventory to the Assembly Item only, without changing the 
inventory amounts for the component items, such as in the case of a returned item.  Use the Add 
feature for this carefully, so you do not cause the system to have incorrect inventory amounts for 
the component items. 
 
You cannot Add Non-inventory or Kit items. 

Manually Adding Inventory: 

1. From the Main Window, click on the Inventory icon.  The Inventory menu appears at 
the bottom of the screen. 
 

2. On the Inventory menu, click Add Inventory.  The Add Inventory screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. On the Item List, highlight an item in the grid, then click the Add icon. 
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Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Adds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  (The Add button does not have to be clicked between each 
scan to post these add transactions to the Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item fields: Enter the Item Number of the item to which you want to add 
inventory (if you accessed this screen from the Item List, this field will already be 
populated).  To enter an Item Number, you can type or scan the value into the field, or 
you can use the drop down list to see the first 10 items in the database, select <more> 
on the drop down list to see all items in the Item List or you can create a new item. 
 
Entering an Item Number populates the Item Number field as well as the Description 
field and enables the following fields: 

• Location 
• Quantity (unless the item is Tracked By Serial Number - Set on the Add or 

Edit Item screens, which fixes the Quantity to a value of 1) 
• Cost 
• Date Acquired 
• Any of the associated Track By fields: Serial Number, Date Code, Lot or 

Pallet (Set on the Add or Edit Item screens).  A Track By field is enabled or 
disabled at the time the item is created.  



 

216 

Below is an example of the screen with the fields enabled: 
 

 

You can use the drop down list of any enabled field to select an existing value for that 
field or select <New> from the Item Number, Location or Supplier drop down lists to 
open the Create New Item, Create New Location or Create New Supplier screens.  
 
Note: If the Automatic New option is enabled on the Options screen, the Create 
New Item, Create New Location or Create New Supplier screens will be opened 
automatically if an unknown Item Number, Location, or Supplier is entered.   If the 
Automatic New option is turned off when an unknown Item Number, Location or 
Supplier is entered, a prompt will ask if you want to use the Create New screen.  For 
more information on enabling and disabling the Automatic New option, please refer to 
the Options screen topic. 
 
The No. of Labels field determines the number of item labels that will be printed when 
the transaction is completed if the Print checkbox is selected.  The No. of Labels 
value defaults to the Quantity value but can be modified. The maximum number of 
labels for this field is 1000.  The item label used for this function is named 
AddTransactionItemLabel.lab and can be modified through the Labels interface. 

4. Complete the Track By fields.  As mentioned above, the Track By fields are enabled 
based on the Item Number you enter.  If there are no Track Bys set for the selected item, 
these fields will be disabled.  Track By fields are enabled or disabled at the time the 
item is entered on the Create New Item screen or when editing an item on the Edit Item 
screen. 
 

5. Complete the rest of the screen: If a Supplier and/or Ref # is required for this item, you 
can enter it now.  Similar to Tracked By fields, the requirement that one or more of these 
fields be filled out is established at the time the item was entered on the Create New 
Item screen and can be edited on the Edit Item screen. 
 
The Ref # drop down list displays the last ten Ref #s used. The <More> option of the 
Ref # drop down list displays all Ref #s with active quantity. 
 
The Supplier drop down list displays the last ten suppliers used. The <More> option of 
the Supplier drop down list displays all suppliers that can be chosen  (active suppliers). 
 
The No. of Labels field determines the number of item labels that will be printed if the 
Print checkbox is checked.  The value in this field defaults to the Quantity field value. 
 
The Notes field allows you to add and store additional information that describes the 
transaction.   
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6. You can optionally enter the Customer if you want to track return information. 
 

7. When you have finished entering information, click the Add button to post the transaction 
to the Pending Transaction List.  All fields on the Add Inventory screen will be cleared 
and all but the Item Number field will be disabled.  You can either select another item to 
be added to the Pending Transaction List or you can click Commit to submit the 
transaction(s). 
 
The Add button will not be enabled until all required information is entered in the 
appropriate fields.  The Commit button will not be enabled until at least one Add is 
posted to the Pending Transaction List. 
 

 
 
At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error. 
 

8. If you want to print a receipt of this transaction, enter the number of receipts in the Print 
receipt on Commit - Copies field. 
 

9. Select the Print Label checkbox to tell InventoryControl to print the number of labels in the 
No. of Labels field.  The file used to print this label is named AddTransactionItemLabel.lab 
and can be customized through the Labels feature. 
 
If the Print Labels box is not checked when you click Commit, but there is a quantity in the 
No. of Labels field,  you will see the following message: 
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Click Yes to continue without printing labels.  Click No to print the designated number of 
labels. 
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Removing Inventory 

The Remove Inventory screen allows you to remove quantity from any item in the database. 
 This can be considered the same as shipping inventory.  You can designate which customer this 
inventory was shipped to on this screen.   Inventory is the amount or quantity of a particular item. 
 Items must first be imported or entered on the Add Item screen before you can add quantity or 
remove quantity.  

Inventory is also removed when you pick items for a Pick Order (Applies to Pro and Enterprise 
Versions only).  For further information on Picking Orders, please refer to the topic Picking 
Orders. 

The Remove function uses FIFO (First in First Out) to determine what inventory is removed first. 
 If you Add 5 of Item 123 to Location Bin 1, for example, then another 5 come in on another day, 
you will have ten of that item.  When you later remove 3 of Item 123, the first set of 5 will be 
subtracted from inventory before the second set. 

Removing Inventory from an Item: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Remove icon.  The Remove screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. On the Item List, highlight an item in the grid, then click the Remove icon. 
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To prevent fields from clearing, click the Pushpin  button located to the right of the 
field you want to lock for subsequent transactions.  This is helpful when you have to 
perform multiple removes at one Location, for example.   Pushpins can be used to lock 
the values in all but one required field so that a scanner can be used to rapidly remove 
inventory just by repeatedly scanning barcodes into that field.  (The Remove button 
does not have to clicked between each scan to post these remove transactions to the 
Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item fields: Enter the Item Number of the item from which you want to 
remove inventory. To enter an Item Number, you can type or scan the value into the field, or 
you can use the drop down list to select an existing item from the first 10 Items shown there, 
or select <more> to select an Item from the Item List.  You can only Remove quantity from 
items with quantity greater than 0.  The Item Number list on this screen will not display or 
accept numbers that do not have quantity.  
 
Entering an Item Number populates the Item Number field as well as the Description field 
and enables the following fields: 

• Quantity (unless the item is Tracked By Serial Number - Set on the 
Add or Edit Item screens, which fixes the Quantity to a value of 1). 

• Location 
• Any of the associated Tracked By fields: Serial Number, Date 

Code, Lot or Pallet (Set on the Add or Edit Item screens).  A Tracked 
By field is enabled or disabled at the time the item is created.  

• Customer 
• Notes 
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Below is an example of the Remove screen with the fields enabled: 
 

 

You can use the drop down list of any enabled field to select an existing value for that field.   
 
Note: If the Automatic New option is enabled on the Options screen, the Create New 
Customer screen will be opened automatically if an unknown Customer is entered.   If the 
Automatic New option is turned off when an unknown Customer is entered, a prompt will 
ask if you want to use the Create New screen.  For more information on the enabling and 
disabling the Automatic New option, please refer to the Options screen topic. 

4. Complete the Track By fields: As mentioned above, the Track By fields are enabled based 
on the Item Number you enter.  If there are no Track Bys set for the selected item, these 
fields will be disabled.  Track By fields are enabled or disabled at the time the item is 
entered on the Create New Item screen or when editing an item on the Edit Item screen. 
 
Since you can only remove existing quantity, if the Tracked By item you are removing is not 
in the list, make sure you have the right Item Number and Location.  The Tracked By fields 
will only show values that are possible for the selected Item Number and Location.  (If an 
item with a given Serial Number is not in the list, it may be Checked-Out, and thus, not 
removable.)  If you still do not see the Tracked By information you expect, you should make 
sure the selected Item Number at the selected Location exists and has quantity.  Also 
check that you are using the right Site. 
  

5. Enter the Customer: Select a Customer from the drop down list.  Select <New> from the 
Customer drop list to open the Create New Customer screen.   
 
The Notes field allows you to add and store additional information that describes the 
transaction.   
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6. After you have completed entering the information, click the Remove button to add the 
transaction to the Pending Transaction List.  All fields on the Remove screen will be 
cleared and all but the Item Number field will be disabled.  You can either select another 
item to be removed or you can click Commit on the Pending Transaction List to submit the 
transaction(s). 
 
The Remove button will not be enabled until all required information is entered in the 
appropriate fields.  The Commit button will not be enabled until at least one Remove is 
posted to the Pending Transaction List. 
 

 
 
At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error. 
 

7. If you want to print a receipt of this transaction, enter the number of receipts in the Print 
receipt on Commit - Copies field. 
 

8. Click Commit to submit the transaction(s) to your database. 
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Moving Inventory 

The Move Inventory screen allows you to move inventory quantity for an item from one Location 
to another.  When you create an item, you can add which locations it may be.  When you then 
add inventory (quantity) to the item, you select in which location that quantity will reside.  The 
Move function allows you to move that inventory from the originally assigned location to another. 
 By moving inventory in the software, you can easily keep accurate records of where all of your 
inventory is currently located. 

You can only move inventory that is listed in the system as having a quantity greater than 0 
(quantity is added on the Add Inventory screen or when Receiving inventory.) 

Moving Inventory to a Different Location: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click Move.  The Move screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. Highlight the item for which you want to move inventory, then click the Move icon.  The 
Move screen appears. 
 

 
 

To prevent fields from clearing, click the Pushpin  button located to the right of the 
field you want to lock for subsequent transactions.  This is helpful when you have to 
perform multiple removes at one Location, for example.   Pushpins can be used to lock 
the values in all but one required field so that a scanner can be used to rapidly remove 
inventory just by repeatedly scanning barcodes into that field.  (The Move button does 
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not have to clicked between each scan to post these remove transactions to the Pending 
Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item Fields: To Move inventory, first enter the Item Number of the item 
you want to move.  To enter an Item Number, you can type or scan the value into the 
field, or you can use the drop down list to select an existing item from the 10 items shown 
or use <more> to select an item from the Item List.   
 
When you enter an item number, the Item Number field is populated as well as the 
Description and the following fields are enabled: 

• From Location (filtered by Site) 
• Quantity (unless the item is Tracked By serial number, then the quantity defaults 

to 1 and cannot be changed),  
• To Location 
• Any of the associated Track By fields: Serial Number, Date Code, Lot or Pallet. 

  A Tracked By field is enabled or disabled at the time the Item is created.  
• Notes 

Below is an example of the Move screen with the fields enabled: 
 

 

You can use the drop down list of any enabled field to select an existing value for that field. 
 The To Location field is not enabled until the From Location information is entered.  
 
Note: If the Automatic New option is enabled on the Options screen, the Create New 
Location screen will be opened automatically if an unknown Location is entered.   If the 
Automatic New option is turned off when an unknown Location is entered, a prompt will 
ask if you want to use the Create New screen.  For more information on the enabling and 
disabling the Automatic New option, please refer to the Options screen topic. 
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4. Complete the Track By fields: As mentioned above, the Track By fields are enabled 
based on the Item Number you enter.  If there are no Track Bys set for the selected item, 
these fields will be disabled.  Track By fields are enabled or disabled at the time the item 
is entered on the Create New Item screen or when editing an item on the Edit Item 
screen. 
 
Since you can only move existing quantity, if the Tracked By item you are removing is 
not in the list, make sure you have the right Item Number and Location.  The Tracked 
By fields will only show values that are possible for the selected Item Number and 
Location.  (If an item with a given Serial Number is not in the list, it may be Checked-
Out, and thus, not removable.)  If you still do not see the Tracked By information you 
expect, you should make sure the selected Item Number at the selected Location exists 
and has quantity.  Also check that you are using the right Site. 
 

5. Enter where you want the inventory moved: After Tracked By information is entered, 
choose the To Location (where the Inventory is being moved). 
 
The Notes fields allows you to add and store additional information that describes the 
transaction.   
 

6. After you have entered the information on the screen, click the Move button to add the 
transaction to the Pending Transaction List.  All fields on the screen will be cleared and 
all but the Item Number field will be disabled.  You can either select another item to be 
added to Pending Transaction List or you can click Commit on the Pending 
Transaction List to submit the transaction(s). 
 
The Move button will not be enabled until all required information is entered in the 
appropriate fields.  The Commit button will not be enabled until at least one move is 
posted to the Pending Transaction List. 
 

 
 
At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error. 
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7. Check the Print Receipt option to print a receipt when the transactions are Committed. 
 

8. Click Commit to submit the transaction(s) to your database.   
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Checking In Inventory 

The Check-In screen allows you to Check-In inventory that has previously been Checked-Out to 
one or more customers.  While checking in inventory does not actually add inventory (quantity) to 
an item, it does free up that inventory to be checked-out to another customer or to be included in 
a pick order. 
  

Checking In Inventory: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Check-In icon.  The Check-In screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. Highlight the item for which you want to check-in inventory, then click the Check-In icon. 
 The Check-In screen appears. 
 

 
 
Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Adds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
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barcodes into that field.  (The Add button does not have to clicked between each scan to 
post these add transactions to the Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item fields: To Check-In Inventory, first enter the Item Number of the 
inventory item you want to Check-In.  To input an Item Number, you can type or scan the 
value into the field, or you can use the drop down list to select an existing item from the Item 
List.   
 
Entering an item number populates the Item Number field as well as the Description and 
Check-In Location and will enable the following fields: 

•  Quantity (unless the item is Tracked By Serial Number - Set on the Add or 
Edit Item screens, which fixes the Quantity to a value of 1) 

• Any of the associated Tracked By fields: Serial Number, Date Code, Lot or 
Pallet (Set on the Add or Edit Item screens).  A Tracked By field is enabled or 
disabled at the time the item is created.  
  

Below is an example of the Check-In screen with the fields enabled: 
 

 

The Maximum field displays the quantity of this item currently Checked-Out. 
 
To enter a customer, you can type or scan the value into the field, or you can use the drop 
down list.  You can only check-In inventory from a customer that was previously entered on 
the Create New Customer screen and only customers who have items checked-out will 
appear in the Customer List.  After a customer is selected, the customer information is 
displayed. 
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4. Complete the Track By fields:  As mentioned above, the Track By fields are enabled 
based on the Item Number you enter.  If there are no Track Bys set for the selected item, 
these fields will be disabled.  Track By fields are enabled or disabled at the time the item is 
entered on the Create New Item screen or when editing an item on the Edit Item screen. 
 
If the item being checked-in is tracked by Serial Number, after the Serial Number is entered, 
the default location in the Location drop down list will be the location from which the Item 
was checked-out. 
 
For items not tracked by Serial Number, the default check-in location is the first location of 
all the locations from which this customer has this item checked-out.  For example, if a 
customer has an item checked out from three locations - A, B, and C - Location A will 
become the default location when the Item Number is entered. 
  

5. Enter the Check-In Location: The locations included in the Locations drop down list are 
also limited by any other tracked by options that may have been enabled for this item.  Thus, 
the listed locations will: 

1.  Have an item Checked-Out by the selected customer 

and 

2.  Match all other Track By options enabled for this item 

Using the previous example, if the Track By Lot option is enabled, and the Lot for the item at 
Locations A and B is 123, but the Lot for this item at Location C is 199, once you input 123 
in the Lot field of the Check-In screen, only Locations A and B will be displayed in the 
Location drop list. 
 
The default check-in location can be replaced by selecting the location of choice from the 
drop down list.  
 
<More> can be selected from the drop down list to select any location entering into the 
system.  This will cause the item to be Moved automatically to the selected location 
immediately after the check-in.  Continuing with the example above, if the item came from 
Location A but you want to check it into Location F, click <More> and select Location F. 
When the transaction is processed, the item will be checked-in to Location A and then 
moved to Location F automatically.   
 
The Notes field allows you to add and store additional information that describes the 
transaction.   

6. Once you have entered the required information on the Check-In screen, click the Check-In 
button to add the transaction to the Pending Transaction List.  All fields on the screen will 
be cleared and all but the Item Number field will be disabled.  You can either select another 
item for Check-In or you can click Commit on the Pending Transaction List to submit the 
transaction(s). 
 
The Check-In button will not be enabled until all required information is entered in the 
appropriate fields. The Commit button will not be enabled until at least one Check-In is 
posted to the Pending Transaction List. 
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At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error using the Remove and Remove All buttons. 
 

7. Check the Print Receipt option to print a receipt when the transactions are Committed. 
 

8. Click Commit to submit the transaction(s) to your database.   
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Checking Out Inventory 

The Check-Out screen allows you to check-out, or assign, inventory to customers for a specified 
length of time.  Checking out inventory decreases the quantity of that item that you have on-hand, 
but does not remove the inventory from your database (since it is assumed the inventory will be 
checked back in).  The check-out function is useful if you lease equipment to customers or have a 
need to temporarily loan-out inventory. 

You can only check-out inventory that has been added.  This means that when you create an 
item, you must add inventory (quantity) to it before you can check out that item to a customer. 
 Remember that inventory is the amount or quantity of an item.  You can add inventory to an item 
either on the Add Inventory screen or by Receiving inventory. 

Checking Out Inventory: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Check-Out icon.  The Check-Out screen appears. 

OR 

1. From the Main Window, select Lists > Item.  The Item List appears. 
 

2. Highlight the item for which you want to check-in inventory, then click the Check-Out 
icon.  The Check-Out screen appears. 
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Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Adds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  (The Add button does not have to clicked between each scan to 
post these add transactions to the Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Customer field: To Check-Out Inventory, first enter a customer in the 
Customer field.  To input a Customer, you can type or scan the value into the field, you 
can use the drop down list to select an existing customer from the Customer List or 
select <New> from the drop down list to access the Create New Customer screen. This 
will populate the Customer field as well as the Name, Address and Phone fields. 
 
Note: If the Automatic New option is enabled on the Options screen, the Create 
Customer screen will be opened automatically if an unknown Customer is entered.   If 
the Automatic New option is turned off when an unknown Customer is entered, a 
prompt will ask if you want to use the Create New screen.  For more information on the 
enabling and disabling the Automatic New option, please refer to the Options screen 
topic. 
 

4. Complete the Item fields: Next, select the Item Number for the inventory the customer 
wants to check-out.  To input an Item Number, you can type or scan the value into the 
field, or you can use the drop list to select an existing Item from the Item List.   
 
Entering an Item Number populates the Item Number field as well as the Description 
field and enables the following fields: 

• Location - filtered by Site. 
• Quantity - unless the item is Tracked By Serial Number - Set on 

the Add or Edit Item screens, which fixes the Quantity to a value of . 
• Any of the associated Tracked By fields: Serial Number, Date 

Code, Lot or Pallet (Set on the Add or Edit Item screens).  A 
Tracked By field is enabled or disabled at the time the item is 
created. 
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Below is an example of this screen with the fields enabled: 
 

 

The Maximum value shows the greatest quantity of this Item that can be Checked-Out. 

5. Complete the Track By fields: As mentioned above, the Track By fields are enabled 
based on the Item Number you enter.  If there are no Track Bys set for the selected item, 
these fields will be disabled.  Track By fields are enabled or disabled at the time the item 
is entered on the Create New Item screen or when editing an item on the Edit Item 
screen. 
 
Since you can only check-out existing quantity, if the Tracked By item you are checking 
out is not in the list, make sure you have the right Item Number and Location.  The 
Tracked By fields will only show values that are possible for the selected Item Number 
and Location.  (If an item with a given Serial Number is not in the list, it may be 
Checked-Out, and thus, not removable.)  If you still do not see the Tracked By 
information you expect, you should make sure the selected Item Number at the selected 
Location exists and has quantity.  Also check that you are using the right Site. 
 

6. Complete the Due Date fields: If you choose the default Return Date, it is calculated by 
adding the number of days specified in the item's Checkout Length field to today's date. 
 The Checkout Length is set on the Create New Item screen and edited on the Edit Item 
screen.  You can override the default return date by selecting the Custom or None 
button.  Custom allows you to specify a return date by entering it in the Custom Date 
field. None allows a customer to check-out inventory for an indefinite period of time. 
 
The Notes screen allows you to add and store additional information that describes the 
transaction.   
 



 

234 

7. After you have entered the inventory information on the Check-Out screen, click the 
Check-Out button to add the transaction to the Pending Transaction List.  All fields on 
the screen will be cleared and all but the Customer and Item Number fields will be 
disabled.  You can either select another item to be added to the Pending Transaction 
List or you can click Commit to submit the transaction(s). 
 
The Check-Out button will not be enabled until all required information is entered in the 
appropriate fields.  The Commit button will not be enabled until at least one transaction is 
posted to the Pending Transaction List. 
 

 
 
At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error. 
 

8. Check the Print Receipt option to print a receipt when the transactions are Committed. 
 

9. Click Commit to submit the transaction(s) to your database or Discard to close without 
submitting the transactions. 
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Adjusting Inventory Amounts 

The Adjust Inventory screen allows you to modify the quantity (inventory amount) of existing 
items.  Adjust is like a "mini" Audit and will update the quantity using FIFO (First In First Out) to 
make the total equal to the quantity you enter here.  The Adjust function is useful if too much or 
too little quantity is accidentally entered for an item (on a mobile device, for example), inventory is 
lost, found, broken, etc. and you need to quickly correct the quantity for that item.  Adjusting is 
different from an Audit in that the Audit function makes other functions of the software, such as 
adding inventory, unavailable to ensure inventory is not added or removed while you are doing 
the counts.  All features are still available when adjusting inventory. 

Note:  An item tracked by Serial Number which has been Checked-Out cannot be Adjusted. 

This topic covers: 

Adjusting Inventory 

Duplicate Serial Numbers Warning 

 

Adjusting Inventory: 

1. From the Main Window, click the Inventory icon.  The Inventory menu appears at the 
bottom of the screen. 
 

2. On the Inventory menu, click the Adjust icon.  The Adjust screen appears. 
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Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.  This is helpful when you have to perform multiple Adds at one 
Location, for example.  Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  (The Add, Adjust, etc. button does not have to clicked between 
each scan to post these transactions to the Pending Transaction List.) 
 

Clicking the   button will unlock the field. 
 

3. Complete the Item fields:  To input an Item Number, you can type or scan the value 
into the field, or you can use the drop down list to select an existing item from the Item 
List.   
 
You can use the drop down list of any enabled field to select an existing value for that 
field.   
 
Entering an item number populates the Item Number field as well as the Description 
and enables the following fields: 
  

• Location - filtered by Site. 
• Quantity  
• Any of the associated Track By fields: Any of the associated Track By fields: 

Serial Number, Date Code, Lot or Pallet.   A Tracked By field is enabled or disabled 
at the time the Item is created.  

Below is an example of the screen with the fields enabled: 
 

 
 
  

Selecting a Reason from the drop down list allows you to track why this adjustment is 
being made.  The Reason also determines if the quantity is positive or negative for By 
Difference adjusts.  
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When to select the By Counts or By Difference check boxes: 

By Count indicates that the Quantity you are entering is the total count of that item at the 
specified Location.  For instance, if the software shows that you have 3 of Item A at 
Location 1, but you have counted 5, you should enter 5. 

By Difference indicates that the Quantity you are entering is the change you want to see 
in the Quantity for that Item at that Location.  For instance, if you just damaged 2 of Item A 
at Location 1, you can enter 2, set the Reason to Breakage (-), and the total will be 
adjusted downward by 2. 

4. Complete the Track By fields: The Track By fields are enabled based on the Item 
Number you enter.  If there are no Track Bys set for the selected item, these fields will be 
disabled.  Track By fields are enabled or disabled at the time the item is entered on the 
Create New Item screen or when editing an item on the Edit Item screen. 
 
When an item is tracked by Serial Number, 0 and 1 are the only valid values for 
Quantity.  
 

5. Enter the Quantity: After you have specified the Item, Location and Track Bys, you 
should input the total Quantity you are adding to the item.  
 

6. Enter the Transaction Code: This field allows you to type a new or select a previously 
committed code that describes the transaction.  Transaction Codes can be any code your 
business assigns to certain types of adjustment transactions.  Assigning these codes can 
help you with reporting as each type of adjustment can (breakage, return, etc.) can be 
given it's own code.  This software does not contain any preset codes.  This gives you 
the opportunity to assign a code that best suits your needs, and allows for the entry of 
codes you already use in your business for these types of transactions. 
 

7. Enter Notes (Optional): The Notes field allows you to add and store additional 
information that describes the transaction.   
 

8. Click the Adjust button to add the transaction to the Pending Transaction List. All fields 
on the screen will be cleared and all but the Item Number field will be disabled.  You can 
either select another item to Adjust or you can click Commit on the Pending 
Transaction List to submit the transaction(s). 
 
The Adjust button will not be enabled until all required information is entered in the 
appropriate fields. The Commit button will not be enabled until at least one transaction is 
posted to the Pending Transaction List. 
 
 



 

238 

 
 
At any time, you can review the Pending Transaction List and remove any transactions 
that were entered in error using the Remove or Remove All buttons. 
 

9. If you want to print a receipt of this transaction, enter the number of receipts in the Print 
receipt on Commit - Copies field. 
 

10. Click Commit to submit the transaction(s) to your database. 

 

Duplicate Serial Numbers Warning: 

If you are tracking the item by Serial Number and the system detects an item with the same 
serial number in a location other than the one you selected on the Adjust screen, when you click 
the Adjust button you will receive a warning message that states: 

"You are trying to adjust an item that is tracked by serial number.  We have found that serial 
number at a different location.  Do you want to adjust the item at that location to 0 so you can 
movie it to this location?" 

Select Yes on this message to adjust the quantity of the item to 0 at the location detected by the 
software.  The quantity adjustment will be made in the location detected by the software and the 
item will automatically be moved to the location you selected on the Adjust screen.  The 
transaction will appear on the Pending Transaction List. 

Select No if you think you have selected the incorrect location.  The Adjust transaction will not 
appear on the Pending Transaction List and you will be able to correct the location on the 
Adjust screen. 
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Purchase Orders/Pick Orders 

Pick Order Overview 

This function applies to Pro and Enterprise Version users only. 

Pick Orders are orders that you create when inventory is requested by a customer and needs to 
be taken (picked) from your warehouse, store, storage facility, etc. and shipped to the customer. 
 InventoryControl allows you to create a pick order that can then be automatically emailed to the 
warehouse and/or printed for reference. 

The basic flow of pick orders is as follows: 

1. Your business receives a request for inventory (through an invoice, a sales slip, etc.).  A 
pick order for the requested merchandise is entered on the Create New Pick Order 
screen.  You can enter any item in any quantity on this screen.  Actual on-hand amounts 
are not checked at this point.  You can choose to email the order and/or print the order. 
 These two actions occur when you click the Save button.   
 
A newly created Pick Order has a status of New.  The status remains New until pick 
quantities are entered on the Picking Order screen.  If the order becomes overdue 
before it begins to be picked, the status changes to New - Overdue. 
 
For detailed information creating pick orders, please see the Creating a Pick Order 
topic. 
 
The Pick Order now appears on your Pick Order List (Lists > Pick Orders).  From the 
Pick Order List you can Edit or Delete (as long as the order is not in process) the order 
as needed. 
 
For an example of the Pick Order List, please refer to the Pick Order List Example 
topic.  For detailed information on using the list screen, please refer to the Working with 
Lists topic. 
 

2. When the order is actually being picked, that is, the inventory is being readied for 
shipping to the customer, the picked quantities for each item on the order are entered in 
the Picking Order screen (Receive/Pick menu > Pick).  This can be done on the PC or 
on the mobile devices.  At this time, the quantities are checked and you cannot pick more 
than you actually have in inventory.   
 
For detailed information on picking orders on the PC, please refer to Picking Orders. 
 For detailed information on picking orders on a Windows Mobile Device, please refer to 
Windows Mobile Device - Picking Items for Orders.  For detailed information on picking 
orders on the WDT2200, please refer to WDT2200 - Picking Inventory for Orders. 
 
Pick orders that have some items picked have a status of In Process.  If the order 
becomes overdue, it will have a status of In Process - Overdue. 
 
For detailed information on the Picking Order screen, please refer to the Picking 
Orders topic. 
 

3. After the order is fully picked it has a status of Completed.   
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Creating a Pick Order 

Pick orders are created to designate certain inventory to be shipped to a customer.  On the 
Create New Pick Order screen, you are creating an order that tells your staff to get the order 
ready and what inventory to include.  These orders can be sent to the mobile devices (although 
pick orders cannot be created on mobile devices).  After the order has been picked, you need to 
mark it as ready to be shipped on the Pick Order screen accessed from the Receive/Pick menu. 
At this point, the inventory is removed from the system.  For more information on the Pick Order 
screen, please refer to the Shipping Pick Orders topic. 

We recommend you review the Pick/Ship Overview before creating pick orders for the first time. 

Creating New Pick Orders: 

1. From the Main Window, select New > Pick Order.   
 
 
OR 
 
From the Main Menu, click Lists > Pick Order.  On the Pick Order List, click the New 
icon. 
 
 
The Create New Pick Order screen appears.   
 

 
 
 
Notice that the screen prominently displays the status as New.  This status message 
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changes based on the state the order is in. 
 
Possible statuses are: 
 

• New - This always displays when creating a new order. 
• Issued - Once the pick order is printed or emailed, the status changes to Issued. 
• In Process - Once the order has started to be picked (via the Pick Order screen 

accessed from the Receive/Pick menu), the status becomes In Process and the 
Picked Quantity will display for each item on the order. 

• Overdue - This status can appear for New or In Process orders that have 
passed the designated due date.  These orders will appear with a symbol on the 
Pick Order List to alert you of their overdue status. 

• Closed - This status means the order has been completed and marked as 
closed. 
  

Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.   Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  
 

Clicking the   button will unlock the field. 

1. Enter a Pick Order Number.  This alpha-numeric value up to 36 characters can be 
manually entered at the time the pick order is created, scanned in, or you can click 
Generate to have the system assign an auto-generated number.  For more information 
on setting up automatically generated Pick Order Numbers, please refer to the 
Customize Numbers topic. 
 

2. Enter a Customer in the Customer field.  You can scan a value into this field, manually 
enter a value or click on the field to view a drop down list.  The list contains the last 10 
Customers selected on this screen.  Select <MORE> to view the entire Customer List or 
click <New> to go to the Create Customer Supplier screen to add a new customer to 
the database. 
 
When a customer is selected, the Customer Address information automatically 
populates.  If the selected customer has more than one address entered for it, you can 
select the Address Type from the drop down list. 
  

3. Enter an Order Date for this order.  This date defaults to today, but you can change this 
date by clicking the down arrow and selecting a new date. 
 

4. Enter a Due Date for this order.  You can type in a date in this field or click the down 
arrow to select a date. 
 

5. Enter a Reference Number for this Pick Order (optional).   
 

6. Select the preferred shipping method for this order in the Ship Via field from the drop 
down list.  This list contains several commonly used shipping methods, however; you can 
type in a new shipping method if desired.  The new entry will appear in the drop down list 
for future purchase orders. 
 

7. Enter any notes you want to associate with this order in the Notes field. 
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8. Now you are ready to enter your item information in the Line Item Details section.  
 
 Complete this information as follows: 

• Type - Select the type of item that needs to be picked.  Options are: 
o Inventory - This item is in your inventory database.  Use this to pick 

existing items. 
o Non-Inventory - This item is not in your inventory database.  Use this to 

pick items that you do not want to appear in your inventory database, 
such as marketing fliers or business cards. 

o Assembly - Assembly Items are a collection of items that, once 
grouped, are considered to be a new, single item.  Assembly Items are 
pre-assembled and kept in stock. 

o Kit - Kit items are a collection of items that are grouped, or picked, at the 
time they are sold. 

o Manual - Use this option to add one-time items, such as shipping and 
handling, to an order.  Manual items cannot be picked on the mobile 
devices. 

• Item Number - Enter the Item Number of the item you want to add to the order. 
 To enter an Item Number, you can type or scan the value into the field, or you 
can use the drop down list to see the first 10 items in the database, select 
<more> on the drop down list to see all items in the Item List.   
 
You can create a new item by selecting <New> or by entering an unknown item 
number.  When either of these two situations occur, the Create New Item screen 
appears.  For more information on creating items, please refer to the Creating 
New Items topic. 
 
When you enter an Item Number the Description field populates. 

• Request Qty - Enter the requested number of this item.  This value can also be 
scanned.  You cannot enter negative numbers. 

• Stocking Unit - This field displays the stocking unit entered for this item on the 
New Item/Edit Item screen.  The stocking unit represents how you stock this 
item in your inventory.  For instance, if you stock the unit in boxes of 10. Box of 
10 would display in the Stocking Unit field on this screen.  For more information 
on creating items, please refer to the Creating New Items topic. 

• Description - This field populates after the item number is entered and cannot 
be changed on this screen.  If you need to change the description, you can do so 
on the Edit Item screen. 
 

9. After you have entered all items for this order, you can optionally select to: 
• Print on Save - If this box is checked, a copy of this order automatically prints 

when you click the Save button. 
• Email on Save - If this box is checked, a copy of this order is automatically sent 

to the email address listed in the Customer screen for this customer when you 
click the Save button.  If you have selected to view the Email Destination List 
(selected on the Options screen), the list will appear allowing you to select email 
addresses or change email addresses as needed.  If you have selected not to 
view the list, the order will automatically be sent to the email address listed in the 
Customer screen from the email address listed in the Company Information 
screen.  Please note that if the email addresses are not entered on the 
Customer or Company Information screens, you will receive an error message 
when you try to send emails. 
 
An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to 
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the CC Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, 
User Name and Password (if authentication is required for outgoing mail) and 
the SMTP Port on the Options screen.  If these are not set, an error message 
will appear. 
 
For more information on setting these email options on the Options screen, 
please refer to the Options Screen topic.  For more information on the Email 
Distribution List, please see the Email Distribution List topic. 
 

10. Click Save to save this order to the database. 
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Editing Pick Orders 

This function applies to Pro and Enterprise Version users only. 

The Edit Pick Order screen allows you to modify an existing purchase order.  This screen is 
accessed from the Pick Order List by highlighting an item in the list, then clicking the Edit button 
on the toolbar.  For more information on using the List screens, see the Working with Lists 
topic. 

The Edit Purchase Order screen is identical to the New Purchase Order screen, except all the 
information previously entered for the order appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Creating a Pick 
Order topic. 
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Pick Order List Example 

This function applies to Pro and Enterprise Version users only. 

The Pick Order List displays all active pick orders entered in the system.  Active pick orders are 
those that have a status of New, New-Over Due, In Process or In Process-Over Due.  Below is 
an example of the Pick Order List. 
  

 
  

Notice the red flags next to some of the orders on the list.  These red flags indicate that the order 
is past due.  The status may be New-Past Due or In Process-Past Due.  Overdue orders will 
appear at the top of the list by default, but you can reorder the list as needed. 

The Pick Order List window allows you to Edit, create New, Copy, Delete, Show, Filter, Export 
or Print the list of Pick Orders.  For detailed information regarding each of these options, refer to 
the Working with Lists topic. 
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Picking Orders 

This function applies to Pro and Enterprise Version users only. 

When a pick order is actually being picked, that is, the inventory is being readied for shipping to 
the customer, the quantities that are removed from inventory for each item on the order are 
entered in the Pick screen.  At this time, the quantities are checked and you cannot pick more 
than you actually have in inventory.   

Picking Orders: 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click the Pick button.  The Pick screen appears: 
 

 
  

3. Select which pick order you will be working on from the Order Number drop down list. 
 The most recently selected orders will appear in the list or select <More> to view the 
Pick Order List.  When you select an Order Number, the information for the selected 
picking order populates the screen: 
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4. Enter the date these items are to be shipped in the Ship Date field.   
 

5. You can optionally type in notes for this order in the Notes screen.   
 

6. Now you can mark the items as picked.  Select the checkbox next to the item you are 
picking: 
 

 
 
The Quantity field becomes enabled allowing you to enter the quantity you picked.   
 
You must mark these items as picked from one or more locations by clicking the plus sign 
in front of the listing: 
 

 
 
A box appears allowing you to select a Location and a Quantity for that location.  The 
Available Qty is also shown so you can easily see how many of this item are available at 
this location. 
 

7. You can select options to be performed upon clicking Save from the On Save section. 
 Options are: 

• Print Packing Slip. Copies - Prints the packing slip containing all items picked 
for this order.  Enter the number of copies of this packing slip you want to print in 
the field provided. 
 
You can open a pick order and print one or more copies of the packing slip 
regardless of what state the pick order is in (new, issued).  To do this, enter the 
number of copies you want to print, then click OK.  All items picked for this order 
will be included on the packing slip, regardless of the setting of the Packing Slip 
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for Session option (see Note, below, for more information on the Packing Slip 
for Session option). 

• Email Packing Slip - Sends an email containing this packing slip to the selected 
addresses.  If you have selected to view the Email Destination List (selected on 
the Options screen), the list will appear allowing you to select email address or 
change email addresses as needed.  If you have selected not to view the list, the 
packing slip will automatically be sent to the email address listed in the 
Customer screen from the email address listed in the Company Information 
screen.  Please note that if the email addresses are not entered on the 
Customer or Company Information screens, you will receive an error message 
when you try to send emails. 
 
An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to 
the CC Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, 
User Name and Password (if authentication is required for outgoing mail) and 
the SMTP Port on the Options screen.  If these are not set, an error message 
will appear. 
 
For more information on the Options screen, please refer to the Options Screen 
topic. 

• Close this Pick Order - Marks this order as closed.  Select this option after all 
items for the order have been picked. 

Note on the Packing Slip for Session Option:   

By default, the packing slip that can be printed and/or emailed upon saving displays 
only items picked in the current pick session. If you want to pick multiple times and 
print a packing slip that displays all the picks for this pick order, including items 
picked previously, you can select to do so on the Options screen. 

For example: 

Assume Pick Order 001 a quantity of 5 for item ABC and a quantity of 4 for item 
XYZ.  Today I pick 2 of item ABC and 2 of item XYZ and ship them. The packing 
slip will display 2 ABC and 2 XYZ.  Tomorrow I pick the other 3 of item ABC and 2 
of item XYZ and ship them. The packing slip has 3 ABC and 2 XYZ. 

This would also be exactly the same if both picks and ships were done on the same 
day. 

If, however, I pick what I have in the morning and don’t ship it and a shipment 
comes in that day or the next and I complete the order before shipping anything, I 
will want all of the items picked throughout the day to display on one packing slip. 
To do this the option must be set on the Options screen to accumulate all of the 
picks on the pick slip.   For more information on this option, please refer to the 
Options Screen topic. 

After entering the pick quantities, click Save to update the amounts on the screen.  Inventory is 
removed for those items you marked as picked.  Click Close to close the screen. 
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Quick/Scan Entry: 

This feature opens a window that allows you to quickly type in or scan in information.  When you 
click the Quick/Scan Entry button, a window similar to the one shown below appears: 

 

You can scan the barcode label on the item and the fields on the Quick/Scan Entry screen will 
populate with the scanned information.  Click the Pick button, then scan the next item and the 
screen clears and repopulates with the new information.  This is an easy method for quickly 
marking items as picked. 
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Purchase Orders/Receiving Overview 

This function applies to Pro and Enterprise Version users only. 

Purchase orders can be created in InventoryControl when you need to order additional inventory 
from suppliers.  These orders can be emailed to the supplier and/or printed upon creation and 
can be easily referenced and searched in the system.  When you receive shipment of the items 
on the purchase order, the items can be marked as received either on the PC's Receive screen 
or on the mobile devices. 

InventoryControl allows you to create purchase orders for: 

• Inventory Items - This item is already in your inventory database.  Use this to re-order 
existing items. 

• Assembly Items - Assembly items are created when you combine two or more existing 
items or multiple quantity of one item to create a new item.   

• Non-Inventory Items - This item is not listed as inventory in your database.  Use this to 
order items for which you do not want to track inventory, such as marketing fliers or 
business cards. 

• Manually Entered Items - Use this option to add one-time items, such as shipping and 
handling, to an order.  Be aware that manual items cannot be received on the mobile 
devices. 

The basic flow from purchase order creation to receiving the items is as follows: 

1. When you need to replenish inventory for an item or items, create a purchase order on 
the Create New Purchase Order screen (accessed from New > Purchase Order).  After 
you select a Supplier for this purchase order, you can click the Items at Re-Order Point 
button at the bottom of the screen.  The system will then check for any items for this 
supplier that are at or below their reorder points and populate the purchase order with 
those items. 
 
A newly created Purchase Order has a status of New.  The status remains New until 
item quantities are entered on the Receive screen.  If the order becomes overdue before 
you receive it, the status changes to New - Overdue. 
 
For detailed information creating purchase orders, please see the Creating a Purchase 
Order topic. 
 
The Purchase Order now appears on your Purchase Order List (Lists > Purchase 
Orders).  From the Purchase Order List you can Edit or Delete (as long as the order 
has not been partially received) the order as needed. 
 
For an example of the Purchase Order List, please refer to the Purchase Order List 
Example topic.  For detailed information on using the list screen, please refer to the 
Working with Lists topic. 
 

2. When you begin to receive inventory the purchase order, you will enter the quantity 
received for each item on the Receive screen (Receive/Pick menu > Receive). 
 Inventory for an item can be marked as received on the PC's Receive screen or on the 
mobile devices.  This screen allows you to enter quantities received by location, and can 
optionally show you costing information as well.   Receiving inventory on the Receive 
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screen adds inventory to that item. 
 
Purchase orders that have some items received have a status of In Process.  If the order 
becomes overdue, it will have a status of In Process - Overdue. 
 
For detailed information on the Receive screen, please refer to the Receiving Inventory 
topic.  For detailed information on receiving inventory on the WDT2200, please refer to 
WDT2200 - Receiving Inventory.  For detailed information on receiving inventory on a 
Windows Mobile Device, please refer to Windows Mobile Device - Receiving Inventory. 
 

3. After the order is fully picked it has a status of Completed.   
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Creating a New Purchase Order 

Purchase orders can be created in InventoryControl and emailed directly to your supplier, or 
printed for faxing or mailing.  We recommend you review the topic Purchase Orders/ Receiving 
Overview before using the purchase order feature for the first time. 

Creating New Purchase Orders: 

1. From the Main Window, select New > Purchase Order.   
 
OR 
 
From the Main Window, select Lists > Purchase Order.  On the Purchase Order List, 
click the New icon. 
 
 
The Create New Purchase Order screen appears.   
 

 
 
 
Notice that the screen prominently displays the status as New.  This status message 
changes based on the stage the purchase order is in. 
 
Possible statuses are: 

• New - This always displays when creating a new order. 
• Issued - Once the purchase order is printed or emailed, the status changes to 

Issued. 
• In Process - Once the order has started to be received (via the Receive screen 

accessed from the Receive/Pick menu), the status becomes In Process and the 
Received Quantity will display for each item on the order. 
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• Overdue - This status can appear for New or In Process orders that have 
passed the designated due date.  This orders will appear with a symbol on the 
Purchase Order List to alert you of their overdue status. 

• Closed - This status means the order has been completed and marked as 
closed. 

Note: To prevent fields from clearing, click the pushpin  button located to the right of 
the field you want to lock.   Pushpins can be used to lock the values in all but one required 
field so that a scanner can be used to rapidly add inventory just by repeatedly scanning 
barcodes into that field.  
 

Clicking the   button will unlock the field. 

2. Enter a supplier in the Supplier field.  You can scan a value into this field, manually enter 
a value or click on the field to view a drop down list.  The list contains the last 10 
Suppliers selected on this screen.  Select <More> to view the entire Supplier List or 
click <New> to go to the Create New Supplier screen to add a new supplier to the 
database. 
 
When a supplier is selected, the Supplier Address information automatically populates. 
 If the selected supplier has more than one address, you can select the Address Type 
from the drop down list. 
 
After you enter the Supplier information, you can click the Items at Re-Order Quantity 
button at the bottom of the screen.  The system will then check for any items for this 
supplier that are at or below their reorder points and populate the purchase order with 
those items. 
 

3. Enter a Purchase Order Number.  This alpha-numeric value up to 36 characters can be 
manually entered at the time the purchase order is created, scanned in, or you can click 
Generate to have the system assign an auto-generated number.  For more information 
on setting up automatically generated Purchase Order Numbers, please refer to the 
Customize Numbers topic. 
 

4. Select a Ship To Address using the drop down menu.  All address types you entered on 
the Company Information screen will appear in the list, or you can select <New> to 
enter a new address.  Selecting <New> opens the Company Information screen 
allowing you to enter a new address.  For more information on the Company 
Information screen, please refer to the Entering Company Information topic. 
 

5. Enter a Reference Number for this Purchase Order (optional).   
 

6. The Order Date defaults to today's date.  You can change this date by clicking the button 
next to the field and selecting a new date. 
 

7. Select a Due Date for this Purchase Order.  You can type in a date or click the button 
next to the field and select a date. 
 

8. Select the preferred Ship Method for this order from the drop down list.  This list contains 
several commonly used shipping methods, however; you can type in a new shipping 
method if desired.  The new entry will appear in the drop down list for future purchase 
orders. 
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9. Select the Payment Method from the drop down list.  This list contains several 
commonly used shipping methods, however; you can type in a new shipping method if 
desired.  The new entry will appear in the drop down list for future purchase orders. 
 
Note:  If you need to delete a Ship or Payment Method you have entered, you can do 
so on the Manage Ship Methods or Manage Payment Methods screens.  These 
screens also allow you to Print, Export and Add New methods.  For more information on 
the Manage Ship Methods screen, please refer to the Managing Shipping Methods 
topic.  For more information on the Manage Payment Methods screen, please refer to 
the Managing Payment Methods topic. 
 

10. Now you are ready to enter your item information in the Line Item Details section. 
 Complete this information as follows: 

• Type - Select the type of item you are ordering.  Options are: 
o Inventory - This item is already in your inventory database.  Use this to 

re-order existing items. 
o Non-Inventory - This item is not listed as inventory in your database. 

 Use this to order items for which you do not want to track quantity, such 
as marketing fliers or business cards. 

o Manual - Use this option to add one-time items, such as shipping and 
handling, to an order.  Manual items cannot be received on the mobile 
devices. 

• Item Number - Enter the Item Number of the item you want to order.  To enter 
an Item Number, you can type or scan the value into the field, or you can use 
the drop down list to see the first 10 items in the database, select <more> on the 
drop down list to see all items in the Item List. 
 
When you enter an Item Number, the Description field populates. 

• Description - This field populates after the item number is entered.  This field 
can only be edited if Manual was selected in the Type field.  If you need to 
change the description, you can do so on the Edit Item screen. 

• Vendor SKU - This field populates after the item number is entered if a SKU was 
entered on the Add/Edit Item screen for this vendor.  This field can only be edited 
if Manual was selected in the Type field.  

• Ordered QTY - Enter the quantity you are ordering of this item.  This field 
defaults to 1.  You cannot enter negative values in this field. 

• Order Unit - Select the Order Unit from the drop down field or select <New> to 
enter a new Unit.  You may want to enter a new unit here that is not an "eaches" 
or Stocking Unit measurement.  For example, if you want to order 1 box of an 
item and this item ships in boxes containing 15 units, the "eaches", or Stocking 
Unit measurement is 15, but for ordering purposes, you could create a new unit 
that is BOX containing 15 units.  You would then order 1 box rather than 15 units 
to avoid confusion for the supplier. 
 
You can setup multiple Order Unit types for each supplier on the Create 
New/Edit Item screen - Manage Suppliers tab.  This allows you to enter units 
based on the suppliers method of shipping (whether the supplier ships in boxes 
of 15, pallets of 50, etc.) For instance, you could set up a Box and Pallet Order 
Unit on the Suppliers tab so that when you create a Purchase Order for that item 
to go to the supplier, you can quickly select whether you want a box or a pallet. 
 For more information on the Add Item screen - Manage Suppliers tab, please 
refer to the Creating New Items topic. 

• Cost - The cost will populate based on the Order Unit selected.  You can also 
type in a new cost here.   

• Line Total - This field calculates based on the Quantity multiplied by the cost. 
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11. After you have entered all items for this order, you can optionally select to: 
 

• Print on Save - If this box is checked, a copy of this order automatically prints 
when you click the Save button. 

• Email on Save - If this box is checked, a copy of this order is automatically sent 
to the email address listed in the Supplier screen for this supplier when you click 
the Save button.  If you have selected to view the Email Destination List 
(selected on the Options screen), the list will appear allowing you to select email 
addresses or change email addresses as needed.  If you have selected not to 
view the list, the order will automatically be sent to the email address listed in the 
Supplier screen from the email address listed in the Company Information 
screen.  Please note that if the email addresses are not entered on the Supplier 
or Company Information screens, you will receive an error message when you 
try to send emails. 
 
An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to 
the CC Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, 
User Name and Password (if authentication is required for outgoing mail) and 
the SMTP Port on the Options screen.  If these are not set, an error message 
will appear. 
 
For more information on setting these email options on the Options screen, 
please refer to the Options Screen topic. 
 

12. Click Save to save this purchase order to the database. 
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Editing Purchase Orders 

This function applies to Pro and Enterprise Version users only. 

The Edit Purchase Order screen allows you to modify an existing purchase order.  This screen 
is accessed from the Purchase Order List by highlighting an item in the list, then clicking the 
Edit button on the toolbar.  For more information on using the List screens, see the Working with 
Lists topic. 

The Edit Purchase Order screen is identical to the New Purchase Order screen, except all the 
information previously entered for the order appears on the screen.  You can change any of this 
information.  For information on using each tab of the screen, please refer to the Creating a 
Purchase Order topic. 
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Purchase Order List Example 

This function applies to Pro and Enterprise Version users only. 

The Purchase Order List displays all active purchase orders you have in your system.  Active 
purchase orders are those that have a status of New, New-Over Due, In Process or In Process-
Over Due.  Below is an example of the Purchase Order List.  

 

Notice the red flags next to some of the orders on the list.  These red flags indicate that the order 
is past due.  The status may be New-Past Due or In Process-Past Due.  Overdue orders will 
appear at the top of the list by default, but you can reorder the list as needed. 

The Purchase Order List allows you to Edit, create New, Copy, Delete, Show, Filter, Export or 
Print the list of Purchase Orders.  For detailed information regarding each of these options, refer 
to the Working with Lists topic. 
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Receiving Inventory from Purchase Orders 

This function applies to Pro and Enterprise Version users only. 

When you begin receiving inventory on a purchase order you created in the system, you will mark 
that inventory as received on the Receive screen.  This screen allows you to select which 
purchase order you are receiving on and to mark individual items on that purchase order as 
received into a specific location. 

Receiving Inventory: 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click Receive.  The Receive screen appears: 
 

 
  

3. On the Receive screen, select which Purchase Order you are receiving on from the 
drop down list.  When you select a Purchase Order, the screen populates with the 
information from that order as shown below: 
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Note:  In the example above, the Show Costing Information option is enabled on the 
Options screen show costing information is displaying on the Receive screen.  If this 
option was not enabled, the costing information would not appear on this screen.  For 
more information on enabling the Show Costing Information option, please refer to the 
Options Screen topic. 
  

4. Enter the date these items were received in the Date field.  You can enter previous dates, 
but not future dates. 
 

5. You can optionally type in a receipt number in the Receipt Number field.  If you receive 
this order in more than one shipment, you can partially receive it and enter in each 
receipt number as you access the screen.  Previously entered receipt numbers, if any, 
will appear in the Receipt Number drop down list. 
 

6. Now you can mark the items as received.  Select the checkbox next to the item you are 
receiving: 
 

 
 
The Quantity field becomes enabled allowing you to enter the quantity you received.  In 
the example above, you would enter however many cartons of this item you received. 
 
You must mark these items as received into one or more locations by clicking the plus 
sign in front of the listing: 
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A box appears allowing you to select a Location and a Quantity for that location. 
 Please be aware that quantities entered here are broken into Eaches.  For instance, in 
the example above, 18 cartons of Item 400003 were ordered.  Assume there are 200 
items per carton.  When you enter 5 in the Location/Quantity field, you are telling the 
system that 5 items from a carton were received into this specific location, rather than 5 
cartons being received.  If you wanted to receive 5 cartons into this location, you would 
need to enter 1000 (5 x 200). 
 
  

7. After you have entered quantity amounts for all items you are receiving, you can 
(optionally) select tasks from the On Save section.  You can select to: 

• Print Receipts: When this is selected, when you click Save all receipts entered 
for this Receive screen will print.  This means that if you received this order in 
two separate shipments, and entered two separate receipts in the Receipt 
Number field, both receipts will print. 

• Print Labels: When this is selected, when you click Save, labels will print for the 
received items. 

• Close This PO: When this is selected, when you click Save, the selected 
Purchase Order will be marked as closed.  You would want to use this when you 
have received all items from the purchase order. 

• Create Backorder, if necessary: When this is selected, after you click Save, a 
backorder will be created for any items that have not been received on this 
Purchase Order. 
 

8. Click Save to save your changes.  The Received Quantity field for each item will go up 
by the amount you entered as received.  When you click Save, the on hand quantities for 
the items you just received will increase by the amounts you entered. 
 
If you partially received the order, the order's status will change to In Process. 

Quick/Scan Entry: 

This feature opens a window that allows you to quickly type in or scan in information.  When you 
click the Quick/Scan Entry button, a window similar to the one shown below appears: 
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You can scan the barcode label on the item and the fields on the Quick/Scan Entry screen will 
populate with the scanned information.  Click the Receive button, then scan the next item and the 
screen clears and repopulates with the new information.  This is an easy method for quickly 
marking items as picked. 
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Deleting Purchase Orders/Pick Orders 

You can quickly delete a Purchase Order or Pick Order from the Purchase Order or Pick Order 
List.  Only orders with a status of New can be deleted.  Once the status changes to In Process, 
meaning the order is partially received or partially picked, the order can no longer be deleted 
(however, these can still be edited or closed). 

Deleting Purchase Orders/Pick Orders: 

1. From the Main Window, select Lists > Purchase Orders or Lists > Pick Orders, 
depending on which type of order you want to delete.  The List screen appears. 
 

2. On the List screen, highlight the order you want to delete, then click the Delete button.  If 
this order cannot be deleted (has a status of In Process), a warning message will appear 
notifying you.  If the order can be deleted, a confirmation message will appear. 
 

3. Click Yes on the confirmation message to delete the order. 
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Receive/Pick Menu 

This function applies to Pro and Enterprise Version users only. 

The Receive/Pick Menu groups functions for receiving inventory from purchase orders and 
shipping pick orders into one location.  You can also manage your shipping methods and 
payment methods from this screen as well as customize automatically generated purchase order 
and pick order numbers. 

Receiving can be done either through the PC or on the mobile devices and adds inventory to your 
database.  Pick orders are orders to pick and ship inventory to a customer, thus removing the 
inventory from your database. 

To Access the Receive/Pick Menu: 

1. On the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears at 
the bottom of the screen. 
 

 
 

2. Click on any of the Receive/Pick Menu icons to go to that function.  Detailed descriptions 
of the options found on the Receive/Pick Menu are provided below: 
 

• Receive - The Receive function allows you to receive inventory from a purchase 
order.  This adds inventory to an item in the same way you manually add 
inventory via the Add Inventory screen (accessed from the Inventory menu or 
from the Item and Inventory lists).  For detailed information on this screen, 
please refer to the Receiving Inventory topic. 
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• Pick - The Pick function allows you to designate pick orders for shipping or to 
close a pick order.  Pick Orders list inventory that needs to be sent to a 
customer.  Pick orders remove inventory from an item in the same way you 
manually remove inventory via the Remove Inventory screen (accessed from 
the Inventory menu or from the Item and Inventory lists.)  For information 
creating a new pick order, please refer to the Creating a Pick Order topic.  For 
information on shipping Pick Orders, please refer to the Picking Orders topic. 
 For an overview of Pick Orders, please refer to the Pick Orders Overview topic. 

• Manage Ship Methods - This function access a screen that allows you to add, 
delete, export or print shipping methods you have entered into the system (via 
the Shipping Method field on the Create New Purchase Order or Create New 
Pick Order screens).  For detailed information on this function, please refer to 
the Managing Shipping Methods topic. 

• Manage Payment Methods -  This function access a screen that allows you to 
add, delete, export or print shipping methods you have entered into the system 
(via the Shipping Method field on the Create New Purchase Order screen). 
 For detailed information on this function, please refer to the Managing Payment 
Methods topic. 

• Customize Numbers - This feature allows you to customize the format of 
Purchase Order Numbers and Pick Order Numbers that the software 
automatically generates when creating a new Purchase Order or Pick Order. 
 For detailed information on this feature, please refer to the Customizing 
Numbers topic. 
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Managing Payment Methods 

This function accesses a screen that allows you to delete, export or print shipping methods you 
have entered into the system via the Payment Method field on the Create New Purchase Order 
screen. 

This topic discusses: 

Adding Payment Methods 

Deleting/Printing/Exporting Payment Methods 

 

Adding Payment Methods: 

Note:  Payment Methods can also be added on the Create New Purchase Order screen by 
typing in a new method in the Payment Method field. 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click the Manage Payment Methods icon.  The Payment 
Method List appears displaying all payment methods entered into the system. 
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3. The last row on the grid is blank.  Click in the row and type in the new payment method.   
 

4. Press ENTER or the down arrow key on your keybord to go to the next new row and 
enter another payment method. 
 

5. Click Save to save your additions or Cancel to close the screen without saving. 

 

Deleting/Printing/Exporting Payment Methods: 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click the Manage Payment Methods icon.  The Payment 
Method List appears displaying all shipping methods entered into the system. 
 

3. Highlight the desired listing, then select the function you want to perform.  Options are: 
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• Delete - This deletes the highlighted shipping method from the database.  When 
you select this option, a confirmation message will appear.  Select Yes on the 
confirmation message to delete the method.  It will no longer appear in the 
Payment Methods drop down list. 

• Print - Allows you to print the Payment Method List.  When this option is 
selected, a standard Page Setup screen appears allowing you to enter margins. 
 An example of this screen is shown below: 
 

 
 
Click the OK button on the Page Setup screen to print the list.  The list will print to 
your default printer.   
 

• Export - Allows you to export the Payment Method List to an external text file. 
 When the Export option is selected, a screen appears allowing you to specify 
where the exported data will be saved on your computer.  An example of the 
Export screen is shown below: 
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Make sure you save this to a location you can remember.  You must also choose a 
name for your file on this screen.  After you have made your selections, click Save 
to export your data. 

A confirmation message will appear when your data has been successfully exported by the 
system.   
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Managing Shipping Methods 

This function accesses a screen that allows you to delete, export or print shipping methods you 
have entered into the system via the Shipping Method field on the Create New Purchase Order 
or Create New Pick Order screens. 

This topic discusses: 

Adding Shipping Methods 

Deleting/Printing/Exporting Shipping Methods 

 

Adding Shipping Methods: 

Note:  Shipping Methods can also be added on the Create New Purchase Order and Create 
New Pick Order screens by typing in a new method in the Shipping Method field. 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click the Manage Shipping Methods icon.  The Ship 
Method List appears displaying all shipping methods entered into the system. 
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3. The last row on the grid is blank.  Click in the row and type in the new shipping method.   
 

4. Click enter to go to the next new row and enter another shipping method. 
 

5. Click Save to save your additions or Cancel to close the screen without saving. 

 

Deleting/Printing/Exporting Ship Methods: 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click the Manage Ship Methods icon.  The Ship Method 
List appears displaying all shipping methods entered into the system. 
 

3. Highlight the desired listing, then select the function you want to perform.  Options are: 

• Delete - This deletes the highlighted shipping method from the database.  When 
you select this option, a confirmation message will appear.  Select Yes on the 
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confirmation message to delete the method.  It will no longer appear in the 
Shipping Methods drop down list. 

• Print - Allows you to print the Ship Method List.  When this option is selected, a 
standard Page Setup screen appears allowing you to enter margins.  An example 
of this screen is shown below: 
 
 

 
 
Click the OK button on the Page Setup screen to print the list.  The list will print to 
your default printer.   

• Export - Allows you to export the Ship Method List to an external text file.  When 
the Export option is selected, a screen appears allowing you to specify where the 
exported data will be saved on your computer.  An example of the Export screen 
is shown below: 
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Make sure you save this to a location you can remember.  You must also choose a 
name for your file on this screen.  After you have made your selections, click Save 
to export your data. 
 
A confirmation message will appear when your data has been successfully 
exported by the system.   
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Customizing Numbers 

To make creating Purchase Orders and Pick Orders easier, InventoryControl allows you to set up 
auto-generated numbers.  This allows you to quickly create sequential numbers at the click of a 
button on the Create New Purchase Order and Create New Pick Order screens. 

Customizing Purchase Order and Pick Order Numbers: 

1. From the Main Window, click the Receive/Pick icon.  The Receive/Pick menu appears 
at the bottom of the screen. 
 

2. On the Receive/Pick menu, click Customize Numbers.  A menu appears allowing you 
to select to customize Purchase Order Numbers or Pick Order Numbers. 
 

 
 

3. Click on Purchase Order Numbers or Pick Order Numbers, depending on what you 
want to customize.  The screen for these two are identical so for this example, we are 
going to select Purchase Order Numbers.  The Define PO Number Format screen 
appears. 
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4. Select the type of value you are entering from the Type drop down list.  Your options are: 
 

• Text - This option enters text or numeric data into the number.  If you select 
Text, a text field appears allowing you to enter the text you want to appear in the 
number. 
 

 
 

• Date - This option inserts the date into the number.  If you select Date, a format 
field appears allowing you to select how you want the date to appear (mm/dd/yy. 
etc.) 
 

 
 

• Counter - This option inserts a sequential counter into the number.  If you select 
Counter, fields appear allowing you to select how many digits you want to 
appear in the counter and at what number the counter should start.  In the 
example below, we entered 5 in the Digits field and 2 in the counter field.  This 
means the counter will display up to 5 digits and begin counting at 2. 
 
 

 

5. When you have chosen your Type and entered the required values, select Add.  Your 
entries will appear in the grid at the top of the screen and an example of how your 
number will look appears in the window at the bottom of the screen. 
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6. Repeat steps 4 and 5 until you have entered all types of data you want to appear in your 
number.  Your selections will appear in the number in the order they are displayed in the 
grid.   
 
You can change the order by highlighting a listing in the grid and clicking the Up or Down 
buttons.   
 
You can delete an item in the grid by highlighting it and clicking the Delete button. 

7. Click the OK button when you are finished formatting the number. 
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Email Distribution List 

If the Email on Save box is checked on the Create New Pick Order or Create New Purchase 
Order screen, a copy of this order is automatically sent to the email address listed in the 
Customer screen for this customer (for Pick Orders) or to the email address listed in the 
Supplier screen for this supplier (for Purchase Orders)  when you click the Save button.  If you 
have selected to view the Email Destination List (selected on the Options screen), the list will 
appear allowing you to select email addresses or change email addresses as needed.  If you 
have selected not to view the list, the order will automatically be sent.  An example of this screen 
is shown below: 

 

To Addresses:  The order is sent to the email address listed in the Customer or Supplier 
screen.  If there is no email address listed on the Customer or Supplier screen, you will receive 
an error message when you try to send emails.  You can add an address to the Customer or 
Supplier screen, and/or edit the address listing on these screens at any time.  See Creating 
New Suppliers or Creating New Customers for information on the Suppliers or Customers 
screen. 

From Addresses: The order is sent from the email address listed in the Company Information 
screen. If there is no email address listed on the Company Information screen (this should be 
your company email address), you will receive an error message when you try to send emails. 
 You can add/edit your company email address at any time on the Company Information 
screen.  See Entering Company Information for more details on the Company Information 
screen. 
 
CC Addresses: An email is also sent to any CC addresses designated on the Options screen. 
 You can choose to ignore the CC address by deselecting the checkbox next to the CC 
Addresses field on the Email Destination List.  
 
In order for the email feature to work correctly, you must set your SMTP Server, User Name and 
Password (if authentication is required for outgoing mail) and the SMTP Port on the Options 
screen.  If these are not set, an error message will appear. 
 
For more information on setting these email options on the Options screen, please refer to the 
Options Screen topic.  For more information on creating pick orders, please refer to the 
Creating a Pick Order topic.  For more information on creating purchase orders, please refer to 
the Creating a Purchase Order topic. 
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Labels 

Labels Menu 

The Labels menu provides access to pre-built labels contained in the software or allows you to 
create new labels. 

Printing, Editing, Creating, Browsing Labels: 

1. On the Main Window, click Labels.  The Labels screen appears: 
 

 
 

2. Printing Labels: To print labels: 
  

a. You must first select a Label printer.  To do this, click Options> Select Label 
Printer.  The Select Label Printer screen appears. 
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Highlight the printer you want to use, then click OK.  This label printer will remain 
the default label printer for this user until you change it on this screen. 

b. Select the label you want to print from the Label screen. 

Editing Labels: To edit a label that appears in the Label list, highlight the item then click 
the Edit button or double-click the label name.  This will start the Wasp Labeler 
application with the selected label loaded. 
 
Creating Labels: Selecting <Create New Label> will open Wasp Labeler with a blank 
label template. 
 
Browsing Labels: Selecting <Browse To Other Labels> lets you select the .LAB file you 
want to open by browsing your drives. 
 
  

For more information or help on the Wasp Labeler software click on Help within Wasp 
Labeler. 
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Reports 

Report Selection 

This software comes with many built-in reports to help you maintain your inventory.   

Selecting a Report: 

1. From the Main Window, click the Reports icon.  The Reports screen appears: 
 

 
 

2. Highlight the desired report, then click the OK button, or double-click on the report name. 
 The report opens in the Report Viewer.  For more information on viewing reports, please 
refer to the Report Viewer topic. 
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Selecting <Browse To Other Reports> lets you select the .RPT file you want to open by 
browsing your drives. 

Note:  If you use Crystal Reports™ (not included with Inventory Control) to create custom 
reports, they will be listed with the default reports shown above if you save your new .RPT files in 
the folder called Reports under the folder where you installed Inventory Control.  If you are unsure 
where this is, just use the Windows Find (or Search) command to locate the folder containing the 
file Inventory Control.exe, then save your .RPT files in the Reports folder beneath it.   
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Report Viewer 

The Report Viewer presents reports in an interactive environment that permits keyword 
searches, printing and export to Adobe Acrobat® Reader™ (.pdf), Microsoft® Excel (.xls), 
Microsoft® Word (.doc) or Rich Text Format (.rtf) files. 

The Report Viewer is accessed by selecting a report name from the Report Selection screen. 

 

The Status Bar in this example reports the current page being viewed, the total number of pages 
and the current zoom factor. 

The left panel shows the report tree that shows how the report is organized and allows you to 
chose specific nodes. 

The ReportViewer Tool Bar provides the following functions: 

 Go to First Page takes you to the beginning of the report. 

 Go to Previous Page 

 Go to Next Page 

 Go to Last Page takes you to the end of the report. 

 Print Report launches the Print dialog. 
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 Refresh updates the report with current data. 

 Export Report allows you to save the report as your choice of any of the following formats: 

Adobe Acrobat® Reader™ (.pdf file) 

Microsoft® Excel (.xls file) 

Microsoft® Word (.doc file) 

or Rich Text Format (.rtf file) 

 Toggle Group Tree OFF/ON - When this is turned off, it will increase the width of the Report 
display by turning off the Group Tree area at the left of the ReportViewer screen.  When it is on, it 
will restore the Group Tree display at the left of the ReportViewer screen - the default display. 

 Zoom allows you to scale the Report display via a drop list of percentages: 

 

 Search allows you to find all occurrences of a specified keyword within the displayed Report: 

 



 

283 

Specify a keyword and click Find Next to find the next occurrence. 

Filter allows you to create filters for the selected report using the Report Filter Setup dialog. 

 

Once a filter has been applied, the filter criteria will be displayed to the right of the Filter 
tool in the toolbar. 

 

Depending on the number of transactions in your database, the Report you have selected, and 
the performance of your PC, ReportViewer can remain blank for quite some time while it access 
the database and dynamically builds the Report for display.  
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Alerts 

InventoryControl contains built alerts that you can display to tell you when action needs to be 
taken on certain items or orders in the system.  To access the Alerts feature, select Check for 
Alerts from the Main screen. 

The following is a list of Alerts that might appear on your system: 

Kit Item(s) with incomplete info This function applies to Pro and Enterprise Version users 
only. 

Assembly items with incomplete info This function applies to Pro and Enterprise Version 
users only. 

Checked Out Item(s) Past Due 

Purchase Orders Past Due This function applies to Pro and Enterprise Version users only. 

Pick Orders Past Due This function applies to Pro and Enterprise Version users only. 

Expired Items 

Items Understocked by Location 

Items Understocked by Item Totals 

Items with Negative Quantity 

Below is an example of the Alerts menu: 
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Working with Mobile Devices 

Pending Uploads Screen 

The Pending Uploads screen allows you to select and validate data for upload into the 
InventoryControl database (on the PC). This data has previously been collected from one or more 
mobile devices. 

Using the Pending Uploads Screen: 

1. This screen will automatically appear after transferring data from the mobile device to the 
PC.   
 
OR 
 
From the Mobility Menu, click Process Mobile. 
 

 
 
Step 1: Upload Selection is the first screen presented: 
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2. Use the Upload Selection screen to select one of the sets of data that has been 
downloaded from a mobile device.  There may be several files in the list, depending on 
how many mobile devices you use and how often you do this step to process 
accumulated files.   
 
We recommend that you always select the oldest file and process those transactions first. 
 
The example above shows transactions uploaded from WindowsCE232 on May 31, 2007 
at 19:31:30.   
 
The device WindowsCE232 has been selected from the drop down list that displays all 
the mobile devices that have transferred mobile data to the PC, but have not yet been 
uploaded into the InventoryControl database.   
 

3. Click Next.   
 
If you had a new addition (customer, location, etc.) the New Records screen appears 
listing these.  You can accept or reject each of them.  If the new data was created in 
error, you can also assign an existing value to take its place.  
 
If no new Customers, Suppliers or Locations were created by the mobile device User, 
InventoryControl will skip this step. 
 
On occasion, you might notice that the number of new Customer, Supplier or Location 
records displayed here in Step 2 are less than the quantity shown in Step 1.  This can 
happen when an existing Customer, Supplier or Location was not downloaded to the 
mobile device due to filtering done creating a mobile database.  When the mobile device 
user subsequently specifies a "new" Customer, Supplier or Location while performing an 
inventory transaction, the "new" mobile device record gets automatically mapped to the 
existing PC record between Steps 1 and 2. 
 
The New Records toolbar has the following functions: 

•  Select all transactions in the list for Acceptance. 

•  De-Select transactions in the list. 

•  Assign an Existing Value instead of creating a new record 
 
When this button is clicked, a screen appears with a drop down list of existing 
locations from which a value can be selected.  Click OK after selecting the Existing 
Location you want to Assign from the drop down list. 

4. Click Next to continue.  The Transactions screen appears: 
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This screen displays any pending transactions. 
 

5. Mark the transactions you wish to Accept by clicking the checkbox.  Here, we have a 
Receive transaction that has been Accepted.  Each transaction completed on the mobile 
device is listed.  Any  errors or  warnings are marked and you are allowed to accept 
or reject transactions or make changes to fix errors. 
 
The Transactions toolbar has the following functions: 

•  Select all transactions in the list for Acceptance. 

•  De-Select transactions in the list. 

•  Display Error (or Warning) associated with the highlighted record. 

This example shows an Add transaction that has been de-selected because there is 
an Error associated with it:   

 Click on the Display Error  toolbar button to see details 
about this record's error.   

This example shows an Add transaction that has been de-selected because there is 
a Warning associated with it:   



 

288 

 Click on the Display Error  toolbar button to see details 
about this record's warning. 

The  Error  or Warning  message associated with the selected transaction will 
be displayed in the XML Process Errors screen.   

Click Close to return to the Pending Transaction screen. 

The Display Error toolbar button will be  grayed-out when no record with an 
Error  or Warning  symbol is highlighted. 

 Edit Transactions allows you to make changes to the values specified at the mobile 
device. 

6. Click Finish when you've decided which transactions to Accept and marked them 
appropriately. 

Pending Uploads will post the Accepted transactions to the InventoryControl database and then 
return to the Main Window. 
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Mobile Devices Pending Uploads - Edit Transactions 

The Edit Transactions screen allows you to make changes to the values specified for a 
transaction (add, remove, etc.) before they are added to the database. 

Editing Transactions: 

1. From the Pending Transactions screen, click the Edit Transactions  button.  The 
Edit Transactions screen appears: 
 

 
 

2. Make changes to the enabled fields as necessary. 
 

3. Click OK to save the changes or Cancel to return to the Pending Transactions screen 
without making changes. 
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Edit Transactions - Kit Items 

 
The steps for editing Pick or Remove Transactions containing Kit Items is slightlydifferent.   
 

1. The process is the same for uploading these transactions.  If you want to edit it, on the 
Step 3 - Transactions screen, click on the component item of the Kit item you want to 
edit and select Edit Transaction. 
 

 
 

2. The Edit Transactions screen shown below appears: 
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Change the Quantity or Location, then click the Replace button (or Remove, in the 
case of a Remove transaction). 
 
 

3. The screen now shows your changes. 
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4. Click Save on the Edit Transactions screen to save your changes and return to the 
Step 3 - Transactions screen. 
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WDT2200 

WDT2200  - Setup the Device 

The Wasp WDT2200 Communication Wizard allows you to setup your Wasp WDT2200 PDT for 
use with InventoryControl, filter the database to be used on the PDT, and transfer data to and 
from the PDT.  

Note: The WDT2200 must be powered on and connected to the PC's serial port before 
proceeding. 

Setting Up the Device: 

1. On the InventoryControl Main Window, click the Mobility icon.  If you have more than 
one type of mobile device installed, a menu will appear allowing you to select which 
device you will be working with.  If you have only one type, the Mobility Menu for that 
device will appear at the bottom of the screen. 
 

2. On the Mobility Menu, select Setup Mobile. 
 

 
 
The Wasp WDT2200 Communication Wizard screen appear with the Setup WDT2200 
tab displayed. 
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3. Click Auto Detect COM Port Settings.  A status screen appears as the system is 
detecting the default settings: 
 

 
 
 
The default settings are: 
 
Parity: None 
Baud Rate: 19200 
Stop Bits: 1 
 
When the system is finished looking for the settings, they will appear in the fields: 
 

 
 

4. Normally, you should not have to make changes to the values set by the Auto Detect 
function, but changes can be made to the COM Port Settings, if necessary: 

Specify the Serial Port to which your PDT is connected.  The Serial Port drop list will 
display COM1 through COMn where 'n' is the highest address found on your system. 
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Specify the Baud Rate at which your PC is to communicate with the PDT.  It is 
recommended that you use the default value of 19200, reducing the Baud Rate to lesser 
values only if you encounter difficulty transferring files. 

Specify the Parity and Stop Bits for the serial port if it is not defined with the defaults 
shown above (None and 1, respectively.) 
 
If InventoryControl is not already installed, you will receive the following message: 
 

 

5. Click Yes to install the program. 
 
While it is loading you will see a status bar and the device will beep occasionally. 
 

 
 
When the install has completed, the following confirmation message will appear: 
 

 
 

6. Click OK on the confirmation message. 
 
After the first install of InventoryControl, you can resend the program at any time by 
connecting the device and clicking the Transfer Program to Mobile Device button. 
 

7. Next you need to create the mobile database.  For more information, please refer to the 
WDT 2200 - Creating the PDT Database topic. 
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WDT2200 - Creating the PDT Database 

After you send the InventoryControl program to your mobile device, you will need to create a 
mobile version of the database so you can transfer the data from the pc to the mobile device. 
 You will also need to create a new database each time you want to send changes from the PC to 
the mobile device.  Create PDT Database builds the database that will be transferred to the PDT. 
  

Note:  If there are inventory transactions on the PDT which have not yet been transferred to the 
PC, you should Receive the Data from PDT first.  For more information on receiving data from the 
PDT, please refer to the WDT2200 - Receiving Data from the PDT topic.  Sending a new 
database first will result in losing the data on the PDT. 

Creating the Database: 

1. If you are continuing the setup process, click the Next button at the bottom of the Setup 
WDT 2200 tab, or click the Create PDT Database tab.  (You must send the 
InventoryControl program to the device before you can send the database.)  Please refer 
to the WDT 2200 - Setting Up the Device topic for more information. 
 
OR 
 
If you are creating a database for a device that already has the program, from the 
InventoryControl Main Window, click the Mobility icon.  If you have more than one 
type of mobile device installed, a menu will appear allowing you to select which device 
you will be working with.  If you have only one type, the Mobility Menu for that device will 
appear at the bottom of the screen. 
 
On the Mobility Menu, select Create Mobile. 
 

 
 
The Create PDT Database tab displays: 
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Filter Records allows you to specify which data will be used to create the PDT database. 
 By filtering the records to include only those that are needed at the PDT, memory is 
conserved as is the time necessary to do transfers between the PC and the PDT. 
 
The default values, shown above, apply no filtering to your data.  All Items will be 
selected, including those which are not yet in a Location. 
 

  If the specified filters produce no eligible Items or Sites, no data will be transmitted to 
the PDT when a Send Data to PDT is attempted. An error will display on the PDT to 
verify/send Data to PDT. 
 
  

2. Select the Site, Location, Item Numbers, Customers, Suppliers, Purchase Orders 
(Pro and Enterprise Versions Only) and Pick Orders (Pro and Enterprise Versions Only) 
to be downloaded to the device, then click OK. 
 
Select the Specify Filter button if you will be limiting the data.  Click the Hand icon to 
access the Find screen to search for data.  The data you select on the Find screen will 
be entered in the text box for that section and only that data will be sent to the mobile 
device.  Please refer to the Searching for Information topic for more information on the 
Find screen. 
 
Select the Minimally Required checkbox to only send data that is required for normal 
operation.  For example, if you select to send all Items, but don't want to send all 
locations, only those locations designated as Primary Locations for individual items will 
be sent.  Or, if you don't want to send all Suppliers, but some Suppliers are entered on 
the Item screen/Managing Suppliers tab for items, only those suppliers entered on the 
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Item screen will be sent. 
 
Tips for Filtering Information 

The default values apply no filtering to your data. All Items will be selected, including 
those which are not yet in a Location. 

Site: 

Source: Specify <all> or one of the Sites listed in the drop down list. This 
determines which Sites will be shown in the Source Site list on the WDT2200. 

This is the Site for all inventory transactions to be performed by the device. 
If you want the device's database to include Items at more than one Site, 
 select <all>. You can only select ALL or 1 specific site.  For example, if you 
have 5 sites, you cannot select 2 to be a Source.  You can either select 1 or 
all. 

Destination: If more than one Site is defined on the system and you have 
selected a specific Site in the Source Site field, you can select one of the Sites 
listed in the Destination drop down list. This determines which Sites will be shown 
in the Destination Site list of the WDT2200 Site Configuration function and 
which locations will be listed in the Move To list. 

This field will be grayed-out with a value of <all>, as shown above, if only 
one Site is defined in InventoryControl or if a value of <all> has been 
specified for the Source Site. If a specific Site has been selected for the 
Source Site, that same site will be the default value for Destination Site, but 
you can change the Destination Site to a different value using the drop 
down list. 

Source Site: Destination 
Site: 

The Source 
Sites  Listed in 
the WDT2200 

Site 
Configuration 
 will Include: 

The 
Destination 
Sites  Listed 

in the 
WDT2200 

Site 
Configuration 
 will Include: 

<all> 

This value is 
forced to <all> 
when there is 
only one Site 
setup in the 

system. 

<all> 

This value is 
forced to <all> 
when <all> is 
specified as 
the Source 

Site. 

All Sites All Sites 

A Specific 
Site 

Destination 
Site is the 

Same as the 
Source Site 

The Specified 
Source Site 

The Same 
Site 

A Specific 
Site 

A Different 
Site 

The Specified 
Source Site 

The Specified 
Destination 
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Site 

As an example, if you have more than two Sites and want to be able to 
move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the 
mobile device, you will have to create a mobile database for Source Site 1 
and Destination Site 2, transfer the database to the mobile device, use the 
device for those Moves, send the information back to the PC, then repeat 
the entire process beginning with by creating a second database to do 
Moves from Source Site 1 to Destination Site 3. Alternately, if your device 
has enough memory to hold a database containing records for all of your 
Items, at all Sites, you can specify a Source value of <all> and then control 
Source Site and Destination Site on the mobile device (see WDT2200 - Site 
Configuration for more information. 

Location: 

From: Specify <all> or use <More> from the drop list to find a specific Location at 
the Source Site that denotes the first in a range of Locations that will be included 
in the mobile database. The last 10 Locations used will be also be listed in the 
From drop list. 

Specifying <all> will include all Locations for the specified Source Site in 
the mobile Database.  

To: Specify <all> or click the Hand icon to find a specific Location at the Source 
Site that denotes the last in a range of Locations that will be included in the mobile 
database. The last 10 Locations used will also be listed in the To drop list. 

Specifying <all> will include all Locations for the specified Destination Site 
in the mobile Database.  

A specific value can be used for From even though <all> is used for To: (For 
example, From: Bin 50 used with To:<all>, would select Bin 50 through whatever 
the largest Bin number is.)   

Similarly, a specific value can be used for To in combination with From:<all>. 
 (For example, From:<all> used with To: Bin 100, would select every bin up 
through Bin 100.) 

Item Number: 

From: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the first valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the From drop list. 

To: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the last valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the To drop list. 

Include Items not in a Location: This is an option that is turned on and grayed-out 
when no filtering is applied. When filtering is applied in one or more of the above fields, 
this option becomes user-controllable. It allows you to include in the mobile database 
Items which are not yet in a Location, in addition to those selected via the filters specified. 
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 (This can be employed when you expect to use the mobile device to Add quantity for 
Items that have never been inventoried before. The mobile device user can specify 
previously defined Locations or create new Locations while adding the previously 
"Location-less" Items.) 

 

3. Click OK when you have finished specifying filter criteria.  You will see this message: 
 

 
 

4. Click No if you want to return to the Filter Records dialog.  Click Yes if you want to 
proceed with creating the PDT database.   
 
Several status bars will be displayed as the PDT database is created.  Depending on the 
filter criteria, the database may take several minutes to create. 
 

 If you have not yet created any Location, Supplier or Item data in InventoryControl, 
or your Filter Records criteria exclude all the data, you will receive the following message: 
 
"Create PDT database completed.  The criteria entered has resulted in no items 
being selected for the mobile databse.  Please click Back button to modify the 
criteria and try again." 
 
 
If the above message is displayed, click OK and then the Back button to restart the Filter 
Records dialog.  Finish creating your PC database before attempting another transfer to 
the PDT. 
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5. Click Next if you want to proceed to the PC to Mobile Device tab where you can send the 
database you just created to the device. 
 
Click Back to restart the Filter Records dialog. 
 
Click Cancel if you want to avoid transferring the newly created PDT database to the 
PDT at this time.  The Create PDT Database screen will close.  The database you just 
created for the PDT can still be transferred later. 
 

6. You are now ready to send the database to the PDT.  For more information, please refer 
to the WDT2200 - Sending Data to the PDT topic. 
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WDT2200 - Sending Data to PDT 

The Send Data to PDT function is used to transfer data from the PC to the PDT.  You will need to 
create the mobile database first on the Create PDT Database tab before using this function.  For 
more information on creating the database, please refer to the WDT2200 - Creating the PDT 
Database topic. 

Sending Data to the PDT: 

1. If you are continuing the setup process, click the Next button at the bottom of the Create 
PDT Database tab, or click the PC to Mobile Device tab.  (You must create the mobile 
database before you can send it to the device.)  Please refer to the WDT 2200 - Creating 
the PDT Database topic for more information. 
 
OR 
 
If you are creating a database for a device that already has the program, from the 
InventoryControl Main Window, click the Mobility icon.  If you have more than one 
type of mobile device installed, a menu will appear allowing you to select which device 
you will be working with.  If you have only one type, the Mobility Menu for that device will 
appear at the bottom of the screen. 
 
On the Mobility Menu, select Send Data To. 
 

 
 
The PC to Mobile Device tab displays: 
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2. If the specified filters produce no eligible Items or Sites, no data will be transmitted to the 
PDT when a Send Data to PDT is attempted. 
 

3. Make sure the WDT2200 is connected to the PC and powered on, then click the Next 
button on the PC screen to proceed.  
 
Note:  If you click the Next button while still logged in on the PDT, the PC screen will 
prompt you to log out of InventoryControl on the PDT before proceeding. 
 
After clicking Next, the PC will transfer the database to the PDT: 
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When finished transferring the data, the following message will be displayed on the PC: 
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Having received both the InventoryControl program and a database, the PDT will now 
display the logon screen: 

InventoryControl 
V4 
User: 
 
Password 
 
F1-About 

Once you've entered values for User and Password, you'll be able to perform against the 
downloaded database.  

4.  After performing inventory transactions on the PDT, you can retrieve them on the Mobile 
Device to PC tab. 

or 

Click Finish now to close this dialog and return to the InventoryControl Main Menu.   

or  

Click the Back button to restart the Send Data to PDT dialog.    
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WDT2200 - Receiving Data from PDT 

The Receive Data from PDT function is used to transfer data from the PDT to the PC. 

Receiving Data from the PDT: 

1. If you are continuing the setup process, click the Next button at the bottom of the Create 
PDT Database tab, or click the PC to Mobile Device tab.  (You must create the mobile 
database before you can send it to the device.)  Please refer to the WDT 2200 - Creating 
the PDT Database topic for more information. 
 
OR 
 
If you are creating a database for a device that already has the program, from the 
InventoryControl Main Window, click the Mobility icon.  If you have more than one 
type of mobile device installed, a menu will appear allowing you to select which device 
you will be working with.  If you have only one type, the Mobility Menu for that device will 
appear at the bottom of the screen. 
 
On the Mobility Menu, select Retreive Data From. 
  

The Receive Data from PDT function can be accessed via the Mobile Devices > PDT > 
WDT2200 > Receive Data from PDT menu item:  
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 The following conditions must be true before proceeding: 

• The WDT2200 must be powered on and connected to the PC's serial port. 
• The InventoryControl Log On screen must be displayed on the PDT.  Logout if the 

PDT is still running the InventoryControl program. 

If you attempt to Receive Data From PDT while InventoryControl is running on the PDT, 
you will receive a message that you need to logout of the program on the PDT, then try 
again. 
 
After logging out of inventoryControl on the PDT, click the Back button to restart the 
dialog. 

Click the Next button to start the transfer.  

 If no inventory transactions were performed on the PDT since the last time data was 
transferred to or from the PDT, the following message will be displayed: 
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If transactions were received from the PDT successfully, you will receive a confirmation message. 

Click Finish to close this dialog and return to InventoryControl 

or  

Click the Mobile Device to PC tab or the Back button to restart the dialog if you want to 
receive data from another PDT. 

When finished transferring data from one or more PDT's, proceed to Upload From Mobile 
Devices. 
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WDT2200 - Data Cycle 

      A Summary of the PDT Data Cycle: 

1. The WDT2200's Date and Time should be set first, then Setup Device is used to define 
COM Port settings prior to transferring the InventoryControl program. 
 

2. Send Program to PDT transfers the InventoryControl program to the PDT. 
 

3. Create PDT Database builds a database for the PDT that can contain all the data in the 
PC database or a subset of the PC's records (via the Filter Records dialog.)   
   

4. Send Data to PDT sends the InventoryControl database to the PDT. 
 

5. Use the PDT.  With both the InventoryControl program and the PDT database 
transferred to the PDT, the PDT User can now use the PDT for Add, Remove, Move, 
Adjust, Details, Receive (Pro and Enterprise Version only), Pick (Pro and Enterprise 
Version onlyl) or Audit transactions (when Audit Mode is active). 
 

6. Receive Data from PDT transfers all the PDT transactions to the PC along with any new 
Customers, Suppliers or Locations the PDT User has created. 
 

7. Upload From Mobile Devices allows you to select and validate data for upload into the 
InventoryControl database.  If you make mistakes on the PDT the data can be modified 
before being accepted into the PC database. 

Steps 1 and 2 are typically done only once per PDT.  From then on, steps 3 through 7 
might be repeated multiple times. 
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WDT2200 - Logging On 

When you turn on the device loaded with InventoryControl, the screen will appear as follows: 

InventoryControl 
 
Users: 
 
Password: 

Key in a valid User and Password for this PDT, pressing the Enter  key after each. 

InventoryControl PC Users who have the appropriate security settings can log on to any 
InventoryControl PDT. 

Successful log on will take you to the PDT Main Menu. 
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WDT2200 - Resetting the Device 

The following steps can be performed to clear all data from the WDT2200.   

 Any inventory transactions not yet uploaded to the PC will be lost if the PDT is reset per the 
following instructions: 

1)  Power off the WDT2200 by pressing and holding the power  key until no text is 
displayed on the screen. 

2)  With the WDT2200 powered off...  

 

...hold down the CMD and left-arrow keys, then press the power key.   

The Start Menu will be displayed: 

 

 If you do not see the Start Menu shown above, power off the PDT and repeat the key 
sequence described above. 

3)  From the Start Menu, select 3. COLD START by pressing the 3 key on the PDT.   

 

4)  Respond with 1=YES to delete all data by pressing the 1 key on the PDT.   The 
WDT2200 will be Cold Started and all data will be lost. 

At the PC, with the WDT2200 connected to your PC and powered on, you must now perform a 
Setup Device on the PC, to set your COM Port Settings and then Send Program to PDT before 
you can proceed to Create PDT Database. 
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WDT2200 - Setting the Date and Time 

If the InventoryControl program and a database have already been transferred to the WDT2200, 
the InventoryControl Log On screen will be displayed when you first power on the PDT: 

InventoryControl 
 
User: 
 
Password: 

 

If the WDT2200 displays the screen above when powered on, jump to Instructions for Setting 
Date and Time on a WDT2200 That Already Has InventoryControl Installed. 

-OR- 

If InventoryControl has not yet been loaded to the WDT2200, the default power-on prompt will be 
displayed, showing the ROM version and memory capacity: 

 

Instructions for Setting Date and Time on a Cold Started WDT2200: 

1)  Press and hold the Command key until the following system menu is displayed: 

 

2)  Press the 8 key to select 8.SET  

3)  Press the 1 key to select 1.DATE & TIME 

4)  Overwrite the Date shown with today's date in the format mm-dd-yyyyy.  You can use 

the right-arrow key  to correct any entry errors or press the Enter key to accept the 
current date and advance to setting the Time of Day. 

5)  Overwrite the Time shown with the current time of day in the format hh-mm-ss using 
values of 0 through 12 for Midnight through Noon and 13 through 23 for the hours of 1:00 
PM through 11:00 PM. 
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6)  Press the 5 key to select 5.EXIT  

7)  Press the Escape key to exit the system menu and return to the default power-on 
prompt. 

You should now perform the Setup Device function to load the InventoryControl program to your 
WDT2200. 

 

Instructions for Setting Date and Time on a WDT2200 That Already Has 
InventoryControl Installed: 

1)  If the InventoryControl Main Menu is currently displayed: 

 

select 8-LOGOUT to exit to the InventoryControl Log On screen: 

InventoryControl 
 
User: 
 
Password: 

2)  From the Log On screen, power off the WDT2200 by pressing and holding the power 

 key until no text is displayed on the screen. 

3)  With the WDT2200 powered off...  

 



 

314 

...hold down the CMD and left-arrow keys, then press the power key.   

A START MENU will be displayed: 

 

 If you do not see the Start Menu shown above, power off the PDT and repeat the key 
sequence described above. 

4)  From the Start Menu, select 2. WARM START by pressing the 2 key on the PDT.   

5)  The default power-on prompt will be displayed, showing the ROM version and memory 
capacity: 

 

Press and hold the Command key until the following system menu is displayed: 

 

6)  Press the 8 key to select 8.SET  

7)  Press the 1 key to select 1.DATE & TIME 

8)  Overwrite the Date shown with today's date in the format mm-dd-yyyyy.   

You can use the right-arrow key to correct any entry errors or press the Enter key to 
accept the current date and advance to setting the Time of Day. 

9)  Overwrite the Time shown with the current time of day in the format hh-mm-ss using 
values of 0 through 12 for Midnight through Noon and 13 through 23 for the hours of 1:00 
PM through 11:00 PM. 

10)  Press the 5 key to select 5.EXIT  

11)  Press the 1 key to select 1.RUN from the system menu. 

12)  Use the left- and right-arrow keys, if necessary to select MI3WDT.EXE from the list of 
programs installed on the WDT2200.   
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Press the Enter key when the screen above is displayed: 

The InventoryControl Log On screen will then be displayed, allowing you to continue 
operations with the new date and time settings. 
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WDT2200 - Main Menu 

 

The InventoryControl WDT2200 PDT Main Menu (not in Audit Mode): 
 
1-Add 
2-Remove 
3-Move 
4-Adjust 
5-Details 
6-Site Config 
7-Logout 
8-Receive 
9-Pick 
0-About 

Press the appropriate number key on the PDT to perform that function. 

 To Logout, press the 8 key.  You will be returned to the Log On screen. 

The Audit function is disabled when InventoryControl is not in Audit Mode. 

The WDT2200 PDT Main Menu in Audit Mode: 
 
Audit Mode 
 
1-Audit 
2-Details 
3-Site Config 
4-About 
 
8-LOGOUT 

 Press the appropriate number key on the PDT to perform that function. 

To Logout, press the 8 key.  You will be returned to the Log On screen. 

The Add, Remove, Move and Adjust functions are disabled when in Audit Mode.  
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WDT2200 - Interface 

 

The Wasp WDT2200 Keypad 

 

• Press and hold the power  key to turn the unit On or Off. 

• Press and release the Alpha  key to toggle between Alphabetic and Numeric input.   

Cursor style in Alphabetic mode:     _ 

Cursor style in Numeric mode:       � 

• Double- or triple-tap an alphabetic key to obtain the second or third character.   

• Use the Space  key to input a blank space. 

• Use the Clear  key to backspace over a character entered in error. 

• Press and release the CMD  key just prior to accessing any of the secondary 
functions or characters shown in yellow. 

• Press the large yellow Scan  key to activate the bar code scanner when input is 
needed for an inventory transaction. 
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WDT2200 - About Screen 

The About screen can be accessed by selecting the 7 key on the PDT Main Menu or the 4 key 
when the PDT is in Audit Mode. 

About displays the current User, the device's Serial Number, and the current state of the Allow 
Negative Quantities on Mobile Devices option. 

InventoryControl 
(C) 2008 
Wasp Barcode 
Technologies 
Build #: 
User:  
Allow Negative: 
ESC=Exit 

Allow Negative:  T (True) indicates that the User is allowed to Remove or Move more quantity 
than is shown in Details for that Item.  This option is set on the Options screen on the PC.  For 
more information on this option, please refer to the Options Screen topic. 

Allow Negative:  F (False) indicates that Remove and Move transactions are limited to the 
quantity shown in Details for that Item. 

Press the Escape  key to return to the Main menu. 
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WDT2200 - Site Configuration 

When data for multiple Sites has been included in the mobile database, the WDT 2200's Site 
Config screen allows the PDT User to specify which of those Sites is to be used for inventory 
transactions he or she is about to perform.   
 
The Source Site will determine the locations available in the Location field of the Add, Remove, 
Adjust and Audit functions.  It will also determine the locations available in the From: location 
field of the Move function. 

The Destination Site will determine the locations available in the Move function's To: location 
field. 

 No inventory transactions can be performed on the PDT until Source and Destination Sites 
have been selected in Site Config.  This must be done at least once following after sending a new 
mobile database to the device. 
 
Configuring Sites: 
  

1. The Site Config function can be accessed by selecting the 6 key on the PDT Main 
Menu, or the 3 key if the PDT is in Audit Mode. 
 
Site Config 
Source/Dest Site 
*(Select) 
 
*(Select) 
 
F1=Src  F2=Dest 
ESC=Menu 
 

2. Select a Source Site by pressing the F1 key. 
 
Source Site: 
Warehouse 1 
 
Press Ent to accept. 
ESC to cancel 
 
F1=Prev  F4=Next 
 
Above, the site WAREHOUSE 1 can be accepted as the Source Site by pressing the 

 key to accept the value. 
 
or 
 
Press the F4 key to scroll to the next Site in the PDT database. 
 
or 
 
Press the F1 key to scroll to the next Site in the PDT database. 
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or 
 

Press the Escape  key to cancel. 
 
When a Source Site is selected, a screen similar to the one below will appear: 
 
Site Config 
Source/Dest Site 
*Warehouse 2 
 
*(Select) 
 
F1=Src  F2=Dest 
ESC=Menu 
 

3. Select a Destination Site by pressing the F2 key. 
 
Dest Site: 
Warehouse 3 
 
Press Ent to accept, 
ESC to cancel 
 
F1=Prev  F4=Next 
 
Above, the site WAREHOUSE 3 can be accepted as the Destination Site by pressing 
the ENT key to accept the value. 
 
or 
 
Press the F4 key to scroll to the next Site in the PDT database. 
 
or 
 
Press the F1 key to scroll to the next Site in the PDT database. 
 
or 
 
Press the ESC key to cancel. 
 

4. Use F1 or F2 again to change your Site selections or press ESC to return to the Main Menu 
if you are done making your Site selections. 

Note: In this example, the Source and Destination Sites are different.  Every inventory transaction 
will be for Items at the Source Site's Locations except for Moves, where the To Locations will be 
limited to those at the Destination Site:  All Moves will be from Warehouse 2 locations to 
Warehouse 3 locations.    

Had Warehouse 2 been selected as both the Source Site and the Destination Site, all Moves 
would be from locations within Warehouse 2 to other locations within Warehouse 2. 
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WDT2200 - Adding Inventory 

The Add function is used to add quantity to any item defined in the PDT database. 

Notes: 

• Adds can also be done at the PC. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• If Source and/or Destination sites are not specified during on the database you sent to 

the PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 

Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to the 
topic, WDT2200 - Configuring Sites. 

The following topics discussed in this section are: 

Adding Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on a Track By 

Tips for Speeding Up Data Entry 

 

Adding Inventory: 

1. From the Main Menu, press the 1 key.  The Add screen appears. 

Add 
Item #: 
123 
 
Scan or key in value  
and press Ent. 
Press ESC for Menu 
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2. Press the Ent key after supplying an Item # or press the ESC key to return to the Main 
Menu. 

Add 
Item #: 
9999999 
 
Entry not found. 
Scan or key in value 
and press Ent. 
ESC=Menu 

 

If the Item # entered is not found in the PDT's database, you will be prompted to try again, 
as shown above. 

If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #. 

3. Scan or key in a Location value.  The Location field is required for all Add transactions.  
 
Enter a Location and press F4 to advance to the next data entry field. 
Press F1 to go back to the previous data entry field. 
Press ESC to cancel transaction and return to the previous screen. 
 
Add 
123 
Monitor 
Location: 
Warehouse1 
 
ESC=Cancel 
F1=Prev F4=Next 

4. If you press F4 to advance to the Supplier field, without first providing a Location value, 
the following message will be displayed: 
 
Please scan or key  
in location 

ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Location value. 
 
If you are prompted to confirm a new Location that you believe should already exist in the 
database, press the ESC key to cancel, then return to the Main Menu to check Site 
Config.   If the Location you entered exists only at a Site other than the currently selected 
Source Site, InventoryControl must treat that value as a new Location for the Source 
Site.  Select a different Source Site in Site Config if that's where you intended to perform 
this transaction. 
 
When a Location value has been entered, press F4 to advance to the next required field. 
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Add 
123 
Monitor 
Supplier: 
 
ESC=Cancel 
F1=Prev F4=Next 
 
  

6. PO and Supplier values might be required for this Item # if track bys were set when the 
item was created.   If not, the fields can be left empty or values may be entered 
optionally.  For more information on Track by fields, please refer to the topic Creating 
New Items.   

Press F4 to advance to the next data entry field. 

Supplier: 
ACME 
 
New entry. Press ENT 
to accept or ESC to  
cancel. 
Ent=OK 
ESC=Cancel 
      

As shown above, if you enter a Location or Supplier that's not currently in the PDT 
database, you will be prompted to accept or reject the entry as a new value to be added to 
the database.  The currently selected Source Site will be displayed when you are about to 
create a new Location.   

7. Press the ENT key to accept the new value or the ESC key to Cancel the creation of a 
new Location or Supplier. 

Add 
123 
Monitor 
Qty: 
 
ESC=Cancel 
F1=Prev F4=Next 
 
Key in the inventory quantity being added and press Enter to complete the Add 
transaction. The Qty value entered must be numeric and it must be greater than zero. 

NO TRACK BY FIELDS: If this Item does not have enabled for the Date Code, Pallet or 
Lot fields, a screen like the one above will be shown, prompting the entry of Qty. 

TRACK BY FIELDS: If this Item does have enabled for Date Code, Pallet or Lot fields, a 
screen like the one below will be shown, expecting input for each Tracked By field that's 
enabled.  In this example, Date Code is required for this item: 
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Add 
123 
Monitor 
Date Code: 
 
ESC=Cancel 
F1=Prev F4=Next 
  

Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next 
data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed:  

Please scan or key 
in Date Code 
 
ESC=Exit 

Press ESC to exit the error message and then provide the required Tracked By value (a 
Date Code, in this example). 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Add 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Add screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
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• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 
will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing an Add 
for this Item:   

Add 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Add for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Add.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Add.  PO, Supplier and Tracked By values, if any, for this second Add will be 
the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Add are values for Qty and Location.  The 
Total Qty field is incremented each time an Add is submitted while looping.    

Press the ENT key to submit the Add transaction and continue looping or press the F4 key to exit 
the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   
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Add 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Add: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Add.  The Location, PO, Supplier, and 
any Tracked By values just specified will be used with every Add transaction entered until F4 is 
used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time an Add is done while looping. 

 Press the ENT key to submit the Add transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing an Add for this Item:   

Add 
123 
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Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Add for this Item #, for more than one 
Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will 
remain locked while looping on Pallet, after entering them for the first Add: 

123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Add,  this screen is ready to receive inputs for another Add.  Item #, Location, PO and 
Supplier values for this second Add will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each Add are values for Qty and 
Pallet.  The Total Qty is incremented each time an Add is submitted while looping.    

 Press the ENT key to submit the Add transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 

 

Tips for Speeding Up Data Entry: 

• When you create a new item, if the Category, Manufacturer, UOM or any combination of 
pinnable fields will be used on a large number of items, create one item with those fields, 
then pin the fields.  Now, the information will be retained in those fields so you don't have 
to keep re-entering it for each new item.    
 

• Make sure you have the Close New Forms option turned off (on the InventoryControl 
Options screen) so the New Item screen, or any other screen where new information is 
added, stays open after each new item is saved.   
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WDT2200 - Details Screen 

The Details function is used to display Location and Quantity information for any Item in the 
PDT's database for the Sites selected in Site Configuration. 

Details is an abbreviated version of the functionality available in the PC's Inventory List. 

Note:  Source and/or Destination sites are not specified during on the database you sent to the 
PDT, the following message will be displayed the first time you attempt to perform an inventory 
transaction on the PDT: 
 
Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 
 
Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site Config 
function.  For more information on configuring sites on the PDT, please refer to the topic, 
WDT2200 - Configuring Sites. 

 

Viewing Details for Items with Tracked By options disabled: 

1. The Details function can be accessed by pressing the 5 key on the PDT Main Menu or 
the 2 key if  the PDT is in Audit Mode.  The screen shown below appears: 
 
Details 
Item #: 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 

2. Press the PDT's ENT key after supplying an Item # or press the PDT's ESC key to return 
to the Main Menu. 
 
If the Item # you enter is not found in the PDT's database, you will be prompted to try 
again, as shown below: 
 
Details 
Item #: 
9999999 
 
Entry not found. 
Scan or key in 
value and perss 
Ent.  ESC=Menu 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #.   
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Details 
100007 
Monitor 
Location: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 

3. The Location field is required for all Details transactions.   Enter a Location and press 
F4 to advance to the next data entry field. 

or 

Press F1 to go back to the previous data entry field. 

or 

Press ESC to cancel the transaction and return to the previous screen. 
 
If you press F4 to advance without first providing a Location value, the following message 
will be displayed: 

Please scan or key 
in Location 
 
ESC=Exit 
 
Press Esc to return and enter Location. 
 
When a Location value has been entered, the screen will appear as shown below: 

1000007 
 
Monitor 
 
Total Qty 
626.00000 
 
ENT=OK  F4=Next 
 
Details first reports the Item's Total Qty across all Locations at every Site. 

4. Press F4 to display the next Details screen for this item: 
 
1000007 
Loc: 1 
 
Qty at Loc: 
500.0000 
TrackBy Qty: 
0.0000 
F1=Prev  ENT=OK 
 
In the example shown above, Qty at Loc has a value of 500.00000, showing that 500 of 
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the 626 Total Qty are at Location 1.   The TrackBy Qty is 0.00000 because no Tracked 
By options are enabled,entered or valid for this Item #. 

 

Viewing Details for Items with One or More Tracked By Options Enabled: 

When a Location value has been entered for an Item # that has one or more Tracked By options 
enabled, you will be given the opportunity to narrow the Details display by entering values for any 
of the Tracked By fields displayed on the consecutive screens. Press F4  to advance to each 
field. 

If an item has all four Tracked By options enabled,  all are available for inputting values which you 
can use to limit the TrackBy Qty that will shown in the Details display.   
 
Input fields will only be displayed for those Tracked By options that are enabled for the Item 
specified. 

1. The Details function can be accessed by pressing the 5 key on the PDT Main Menu or 
the 2 key if  the PDT is in Audit Mode.  The screen shown below appears: 
 
Details 
Item #: 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 

2. Press the PDT's ENT key after supplying an Item # or press the PDT's ESC key to return 
to the Main Menu. 
 
If the Item # you enter is not found in the PDT's database, you will be prompted to try 
again, as shown below: 
 
Details 
Item #: 
9999999 
 
Entry not found. 
Scan or key in 
value and perss 
Ent.  ESC=Menu 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #.   
 
Details 
10067 
Mouse 
Pallet: 
33 
 
ESC=Cancel 
F1=Prev  F4=Next 
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In the example above, the Item # specified has the Tracked By Pallet option enabled. 
 Having previously supplied the Item # and a Location, the can supply a Pallet number, 
but doing so is optional. 
 
Values you specify here will limit the TrackBy Qty shown on the Details display to some 
number less than or equal to the Qty value shown for the specified Location. Use of 
these fields is optional.  If they are left blank, TrackBy Qty will equal Qty at Loc in the 
Details display. 
 
In the example below, having specified a value for the Tracked By field Pallet, in addition 
to Location, Details is reporting a Qty at Loc of 17.00000 and a TrackBy Qty for the 
specified Pallet of 4.00000. 
 
10067 
LOC: AISLE 1 
 
Qty at Loc: 
17.00000 
TrackBy Qty: 
4.00000 
F1=Prev  ENT=OK 
 
If the TrackBy Qty is zero for an Item that has one or more Tracked By options enabled, 
no quantity matching the TrackBy values you just specified exists for the Item at the 
specified Location. 
 

3. Press F4 to advance to the next field. 

or  

Press F1 to return to the previous field. 

or 

Press the Enter key to return to the Details function for another query.   
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WDT2200 - Adjusting Inventory 

The Adjust function allows you to modify the quantity of existing items.  Adjust is like a "mini" 
Audit and will update the quantity using FIFO (First In First Out) to make the total equal to the 
quantity you enter here.  The Adjust function is useful if too much or too little quantity is 
accidentally entered for an item (on a mobile device, for example), inventory is lost, found, 
broken, etc. and you need to quickly correct the quantity for that item.  Adjusting is different from 
an Audit in that the Audit function makes other functions of the software, such as adding 
inventory, unavailable to ensure inventory is not added or removed while you are doing the 
counts.  All features are still available when adjusting inventory. 

Notes: 

• An item tracked by Serial Number which has been Checked-Out can not be Adjusted. 
• Inventory adjustments can also be made at the PC using the Adjust screen. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• Source and/or Destination sites are not specified during on the database you sent to the 

PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 
 
Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 
 
Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to 
the topic, WDT2200 - Configuring Sites. 

The following topics are covered in this section: 

Adjusting Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on a Track By (other than Serial Number) 

 

Adjusting Inventory: 

1. From the Main Menu, press the 4 key. 
 
Adjust 
Item #: 
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123 
 
Scan or key in  
value and press  
Ent.  Press ESC 
for Menu. 
 

2. Press the Enter key after supplying an Item # or press the ESC key to return to the Main 
Menu. 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try 
again, as shown below. 
 
Adjust 
Item #: 
99999999 
 
Entry not found. 
Scan or key in value 
and press Ent.   
ESC=Menu. 
 
If the Item # entered is found in the PDT's database, the Item's Description will be 
displayed beneath the Item #. 
 

3. Scan or key in a Location value.  If the Item # entered is found in the database, the 
Item's Description will be displayed beneath the Item #.   

Adjust 
100007 
Monitor 
Location: 
AREA 2 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
The Location field is required for all Adjust transactions.   

4. After entering a Location and press F4 to advance to the next data entry field. 

or  

Press F1 to go back to the previous data entry field. 

or 

Press ESC to cancel transaction and return to the previous screen. 
 
If you press F4 to advance to the next data entry field, without first providing a Location 
value, the following message will be displayed: 

Please scan or key 
in Location 
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ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Location value. 

As shown below, if you enter a Location that's not currently in the PDT database, you will 
be prompted to accept or reject the entry as a new value to be added to the database. 
 The currently selected Source Site will be displayed when you are about to create a new 
Location.  

Site: 
Warehouse2 
 
New Location: 
Area 7 
 
Ent=OK 
ESC=Cancel 

If you are prompted to confirm a new Location that you believe should already exist in the 
database, press the ESC key to cancel, then return to the Main Menu to check Site 
Config.  If the Location you entered exists only at a Site other than the currently selected 
Source Site, InventoryControl must treat that value as a new Location for the Source 
Site.  Select a different Source Site in Site Config if that's where you intended to perform 
this transaction. 
 
Press the ENT key to accept the new location or the ESC key to cancel the creation of a 
new Location. 
  

5. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a 
screen like the one below will be shown, prompting the entry of Qty. 

Adjust 
100007 
Monitor 
Qty: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in the inventory quantity at this Location and press F4 to complete the Adjust 
transaction. The Qty value entered must be numeric and it must be greater than or equal 
to zero. 
 
If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, screens 
like the one below will be shown, expecting input for each Tracked By field that's enabled. 
 A Date Code is required for this Item:  

Adjust 
100007 
Monitor 
Date Code: 
 
ESC=Cancel 



 

335 

F1=Prev  F4=Next 
 
Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the next 
data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed: 

Please scan or key 
in Date Code 
 
ESC=Exit 
 
Press ESC to exit the error message and then provide the required Tracked By value (a 
Date Code, in this example). 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Adjust 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Adjust screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 



 

336 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing an Adjust 
for this Item:   

Add 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Adjust for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Adjust.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Adjust.  PO, Supplier and Tracked By values, if any, for this second Adjust will 
be the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Adjust are values for Qty and Location. 
 The Total Qty field is incremented each time an Adjust is submitted while looping.    

Press the ENT key to submit the Adjust transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Adjust 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
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Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Adjust: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Add.  The Location, PO, Supplier, and 
any Tracked By values just specified will be used with every Adjust transaction entered until F4 is 
used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time an Adjust is done while looping. 

 Press the ENT key to submit the Adjust transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing an adjust for this Item:   

Adjust 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 
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An asterisk (*) indicates the intention to do more than one adjust for this Item #, for more than 
one Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields 
will remain locked while looping on Pallet, after entering them for the first adjust: 

123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first adjust,  this screen is ready to receive inputs for another adjust.  Item #, Location, PO and 
Supplier values for this second adjust will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each adjust are values for Qty and 
Pallet.  The Total Qty is incremented each time an adjust is submitted while looping.    

 Press the ENT key to submit the adjust transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Auditing Inventory 

Audit allows you to count the Quantity of one or more Items in your inventory when in Audit 
Mode.  Before you can conduct an audit using the mobile device, you must download a new 
database created while InventoryControl is in audit mode.  For more information on turning on the 
audit mode on the PC, please refer to the topic Auditing Your Inventory.  For more information 
on creating the database, please refer to the topic WDT2200 - Creating the PDT Database. 

Notes: 

• Audits can also be done at the PC. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• If Source and/or Destination sites are not specified during on the database you sent to 

the PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 

Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to the 
topic, WDT2200 - Configuring Sites. 

Topics discussed in this section: 

Auditing Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Auditing Inventory: 

1. The Audit function can be accessed by selecting the 1 key on the PDT Main Menu. 

2. Press the Enter  key after supplying an Item # or press the ESC key to return to the 
Main Menu 
 
Audit 
Item #: 
123 
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Scan or key in value 
and press Ent. 
Press ESC for Menu 
 
If the Item # you entered is not found in the PDT's database, you will be prompted to try 
again. 
 
Audit 
Item #: 
9999999 
 
Entry not found.  
Scan or key in value 
and press Ent. 
ESC=Menu 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #:   
 

3. Scan or key in a Location value.  The Location field is required for all Audit transactions.  
 
Audit 
10007 
Monitor 
Location: 
AREA 2 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Enter a Location and press F4 to advance to the next data entry field. 
 
or  
 
Press F1 to go back to the previous data entry field. 
 
or 
 
Press ESC to cancel transaction and return to the previous screen. 
 
If you press F4 to advance to the next data entry field, without first providing a Location 
value, the following message will be displayed: 
 
Please scan or key  
in Location 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Location value. 
 
As shown below, if you enter a Location that's not currently in the PDT database, you 
will be prompted to accept or reject the entry as a new value to be added to the 
database.  The currently selected Source Site will be displayed when you are about to 
create a new Location.   
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Site: 
Warehouse 2 
 
New Location: 
Area 7 
 
ENT=OK 
ESC=Cancel 
 
If you are prompted to confirm a new Location that you believe should already exist in 
the database, press the ESC key to cancel, then return to the Main Menu to check Site 
Config.  If the Location you entered exists only at a Site other than the currently 
selected Source Site, InventoryControl must treat that value as a new Location for the 
Source Site.  Select a different Source Site in Site Config if that's where you intended to 
perform this transaction. 
 
Press the ENT key to accept the new value or the ESC key to Cancel the creation of a 
new Location. 
 

4. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a 
screen like the one above will be shown, prompting the entry of Qty. 
 
Audit 
100007 
Monitor 
Qty: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in the inventory quantity at this Location and press ENT or F4 to complete the Audit 
transaction.  The Qty value entered must be numeric and it must be greater than or equal 
to zero. 
 
If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, screens 
like the one below will be shown, expecting input for each Tracked By field that's 
enabled. 
 
Audit 
100007 
Monitor 
Date Code: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the 
next data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed: 
 
Please scan or key 
in Date Code 
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ESC=Exit 
 
Press Esc to Exit the error message and then provide the required Tracked By value (a 
Date Code, in this example). 
 

5. When the you are finished doing Audits, even just for an afternoon of counting during a 
week-long Audit, the Counts can be uploaded to the PC (please refer to the topic 
WDT2200 - Receiving Data from the PDT for more information).  Multiple PDTs can 
upload their counts multiple times throughout the Audit Mode period. 
  

6. When the PC is no longer in Audit Mode, you can create another mobile database to 
send to the PDT.  This will return the PDT to its normal mode. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Audit 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Audit screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 
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In the example below the F3 key was pressed when prompted for Location while doing an Audit 
for this Item:   

Audit 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Audit for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Audit.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Audit.  PO, Supplier and Tracked By values, if any, for this second Audit will 
be the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Audit are values for Qty and Location.  The 
Total Qty field is incremented each time an Audit is submitted while looping.    

Press the ENT key to submit the Audit transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Audit 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 



 

344 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Audit: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Audit.  The Location, PO, Supplier, and 
any Tracked By values just specified will be used with every Audit transaction entered until F4 is 
used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time an Audit is done while looping. 

 Press the ENT key to submit the Audit transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing an Audit for this Item:   

Audit 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Audit for this Item #, for more than one 
Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will 
remain locked while looping on Pallet, after entering them for the first Audit: 
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123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Audit,  this screen is ready to receive inputs for another Audit.  Item #, Location, PO and 
Supplier values for this second Audit will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each Audit are values for Qty and 
Pallet.  The Total Qty is incremented each time an Audit is submitted while looping.    

 Press the ENT key to submit the Audit transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Moving Inventory 

The Move function allows you to move inventory quantity for an item from one Location to 
another.  When you create an item, you can add which locations it may be.  When you then add 
inventory (quantity) to the item, you select in which location that quantity will reside.  The Move 
function allows you to move that inventory from the originally assigned location to another.  By 
moving inventory in the software, you can easily keep accurate records of where all of your 
inventory is currently located. 

Note:  

• Make sure the PDT's date and time are set correctly before performing inventory 
transactions. 

• Move transactions can also be performed on the PC's Move screen. 
• Source and/or Destination sites are not specified during on the database you sent to the 

PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 
 
Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 
 
Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to 
the topic, WDT2200 - Configuring Sites. 

The following topics are discussed in this section: 

Moving Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Moving Inventory: 

1. The Move function can be accessed by pressing the 3 key on the PDT Main Menu. 
 

2. Press the PDT's Enter  key after supplying an Item # or press the PDT's ESC key to 
return to the Main Menu. 
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Move 
Item #: 
123 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try 
again, as shown below. 
 
Move 
Item #: 
99999999 
 
Entry not found. 
Scan or key in value 
and press Ent. 
ESC=Menu 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #. 
 

3. Scan or key in a From location value.   
 
Move 
1000052 
Fence-Rail 
From: 
A1 
 
ESC=Cancel 
F1=Prev  F4=Next   
 
The From and To fields are required for all Move transactions. 
 
Enter a From Location and press F4 to advance to the next data entry field. 

or  

Press F1 to go back to the previous data entry field. 

or 

Press ESC to cancel transaction and return to the previous screen. 
 
 

 If you press F4 to advance to the To location field without first providing a From 
location value, the following message will be displayed: 
 
Please scan or key  
in From 
 
ESC=Exit 
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Press ESC to Exit the error message and then provide the required From location value. 
  

Note: If the Allow Negative Quantities on Mobile Devices Option is disabled on the 
Options screen, you will receive a warning message if you attempt to Move quantity from 
a location that does not exist in the PDT database.  The Allow Negative option must be 
set on the PC prior to creating the mobile database.  You can check the state of this option 
on the PDT by viewing the PDT About screen. 
 
New Source Site From locations can only be created during Move when the Allow 
Negative Quantities on Mobile Devices option is enabled.  Please see the Options 
Screen topic for more information on this option. 
 
When a From location value has been entered, press F4 or ENT to advance to the To 
location field. 

4. Provide the required To location value. 
 
Move 
1000052 
Fence-Rail 
To: 
A2 
 
ESC=Cancel 
F1=Prev  F4=Next   
 
As shown below, if a From or To Location value is entered that's not currently in the 
database, you will be prompted to accept or reject the entry as a new value to be added 
to the database for the Source or Destination Site shown. 
 
Site: 
Warehouse 2 
 
New Location: 
Area 2 
 
ENT=OK 
ESC=Cancel 
 
If you are prompted to confirm a new Location that you believe should already exist in 
the database at that Site, press ESC to cancel, then return to the Main Menu to check 
Site Config.   If the From location you entered exists only at a Site other than the 
currently selected Source Site, InventoryControl must treat that value as a new Location 
for the Source Site. Select a different Source Site in Site Config if that's where you 
intended to perform this transaction. 
 
Press the ENT key to accept the new value or the ESC key to Cancel the creation of a 
new Location. 
 

5. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a 
screen like the one below will be shown, prompting the entry of Qty.  
 
Move 
1000052 



 

349 

Fence-Rail 
Qty: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in the inventory Qty being Moved and press F4 or ENT to complete the Move 
transaction.  The Qty value entered must be numeric and it must be greater than zero. 
 
If the Allow Negative Quantities on Mobile Devices option is disabled, you will see the 
following message if you attempt to Move more quantity than that which is available for 
this Item at the specified From location.  
 
Available: 
15.0000 
 
Not enough qty avail 
able to complete the  
transaction. 
ESC=Exit 
 
 
Press ESC and enter a value that does not exceed the Available amount. 

6. If the Item does have Tracked By enabled for Date Code, Pallet or Lot fields, a screen 
like the one below will be shown, expecting input for each Tracked By field that's enabled 
before entering a value for Qty. 
 
Move 
100068 
Paint Can 
Pallet: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
 
Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the 
next data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed: 
 
Please scan or key 
in Pallet 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Tracked By value (a 
Pallet, in this example). 
 
Note: If  the Allow Negative Quantities on Mobile Devices option is disabled, any 
entered Tracked By value that does not match a value associated with inventory 
available at the previously specified From location, the following screen display will be 
displayed: 
 
No item with this tr 
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ackby specific in st 
ock 
 
ESC=Exit 
 
If Allow Negative Quantities on Mobile Devices is enabled, any Tracked By value is 
allowed. 
 
Press ESC to exit the error message and then provide a Tracked By value that matches 
inventory in stock at the From location. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Add 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Move screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing an Move 
for this Item:   
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Move 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Move for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Add.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Add.  PO, Supplier and Tracked By values, if any, for this second Add will be 
the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Move are values for Qty and Location. 
 The Total Qty field is incremented each time a Move is submitted while looping.    

Press the ENT key to submit the Move transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Move 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Move: 
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Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Move.  The Location, PO, Supplier, 
and any Tracked By values just specified will be used with every Move transaction entered until 
F4 is used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time an Move is done while looping. 

 Press the ENT key to submit the Move transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing an Move for this Item:   

Move 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Move for this Item #, for more than one 
Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will 
remain locked while looping on Pallet, after entering them for the first Move: 
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123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Move,  this screen is ready to receive inputs for another Move.  Item #, Location, PO and 
Supplier values for this second Move will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each Move are values for Qty and 
Pallet.  The Total Qty is incremented each time an Move is submitted while looping.    

 Press the ENT key to submit the Move transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Removing Inventory 

The Remove function allows you to remove quantity from any item in the database.   Inventory is 
the amount or quantity of a particular item.  Items must first be imported or entered on the Add 
Item screen before you can add quantity or remove quantity.  

Inventory is also removed when you pick items for a Pick Order (Applies to Pro and Enterprise 
Versions only).  For further information on Picking Orders, please refer to the topic WDT2200 - 
Picking Orders.  

Notes: 

• Removes can also be done at the PC using the Remove screen. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• Source and/or Destination sites are not specified during on the database you sent to the 

PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 
 
Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 
 
Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to 
the topic, WDT2200 - Configuring Sites. 

Topics discussed in this section are: 

Removing Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Removing Inventory: 

1. The Remove function can be accessed by pressing the  2 key on the Main Menu. 
 
Remove 
Item #: 
123 
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Scan or key in value 
and press Ent. 
Press ESC for Menu 
  

2. Press the PDT's Enter  key after supplying an Item # or press the PDT's ESC key 
to return to the Main Menu. 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try 
again, as shown below: 
 
Remove 
Item #: 
9999999 
 
Entry not found. 
Scan or key in value 
and press Ent. 
ESC=Menu 
 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #. 
 

3. Scan or key in a Location value:   
 
Remove 
123 
Monitor 
Location: 
AREA 2 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
The Location field is required for all Remove transactions.  
 
Enter a Location and press F4 to advance to the next data entry field. 
 
or  
 
Press F1 to go back to the previous data entry field. 
 
or 
 
Press ESC to cancel transaction and return to the previous screen. 
 
If you press F4 to advance to the Customer field, without first providing a Location 
value, the following message will be displayed: 
 
Please scan or key 
in Location 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Location value. 
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Note:  If the Allow Negative Quantities on Mobile Devices option is disabled, you will 
see a warning message if you attempt to Remove quantity from a Location that does not 
exist in the PDT database.  The Allow Negative option must be set on the PC prior to 
creating the database.  You can check the state of this option on the PDT by using the 7 
key on the Main Menu to go to the PDT About screen.  
 
New Locations can only be created during Remove when the Allow Negative 
Quantities on Mobile Devices option is enabled.  If you are prompted to confirm a new 
Location that you believe should already exist in the database, press ESC to cancel, 
then return to the Main Menu to check Site Config.  If the Location you entered exists 
only at a Site other than the currently selected Source Site, InventoryControl must treat 
that value as a new Location for the Source Site.  Select a different Source Site in Site 
Config if that's where you intended to perform this transaction. 
 

4. Enter a Customer Number, then press F4. 
 
Remove 
123 
Monitor 
Customer: 
00001 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
A Customer value might be required for this Item #.   If not, the Customer field can be left 
empty or a value may be entered optionally.   
 
As shown below, if a Customer value is entered that's not currently in the PDT database, 
you will be prompted to accept or reject the entry as a new value to be added to the 
database.  The currently selected Source Site will be displayed when you are about to 
create a new Location. 
 
Customer: 
ACME 
 
New entry. Press Ent 
To accept or ESC to  
Cancel. 
ENT=OK 
ESC=Cancel 
 

5. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a 
screen like the one below will be shown, prompting the entry of Qty. 
 
Remove 
100007 
Paint Can 
Qty: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in the inventory quantity being Removed and press ENT to complete the Remove 
transaction.  The Qty value entered must be numeric and it must be greater than zero. 
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If the Allow Negative Quantities on Mobile Devices option is disabled, you will see the 
following message if you attempt to Remove more quantity than that which is available 
for this Item at the specified Location.  
 
Available: 
83.0000 
 
Not enough qty avail 
able to complete the  
transaction 
ESC=Exit 
 
Press ESC and enter a value that does not exceed the Available amount. 
 
If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, a screen 
like the one below will be shown, expecting input for each Tracked By field that's 
enabled. 
 
Remove 
100006 
Paint Can 
Pallet: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the 
next data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed: 
 
Please scan or key 
in Pallet 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Tracked By value (a 
Pallet, in this example). 
 
If the Allow Negative Quantities on Mobile Devices options is disabled, and a Tracked 
By value that does not match a value associated with inventory available at the 
previously specified Location is entered, the following screen will be displayed:  
 
No item with this tr 
ackby specific in st 
ock 
 
ESC=Exit 
 
If Allow Negative Quantities on Mobile Devices is enabled, any Tracked By value is 
allowed. 
 
Press Esc to Exit the error message and then provide a Tracked By value that matches 
inventory in stock at the specified Location. 
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Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Add 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Remove screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing a 
Remove for this Item:   

Add 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Remove for this Item #, to more than 
one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while 
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looping on Location after entering them for the first Add.  Tracking fields are needed only for any 
Tracked By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Add.  PO, Supplier and Tracked By values, if any, for this second Remove will 
be the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Remove are values for Qty and Location. 
 The Total Qty field is incremented each time a Remove is submitted while looping.    

Press the ENT key to submit the Remove transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Remove 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Remove: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 
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Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Remove.  The Location, PO, Supplier, 
and any Tracked By values just specified will be used with every Remove transaction entered 
until F4 is used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time a Remove is done while looping. 

 Press the ENT key to submit the Remove transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing a Remove for this Item: 
  

Remove 
123 
Monitor 
Pallet:        * 
 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Remove for this Item #, for more than 
one Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields 
will remain locked while looping on Pallet, after entering them for the first Remove: 

123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 
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Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Remove,  this screen is ready to receive inputs for another Remove.  Item #, Location, PO 
and Supplier values for this second Remove will be the same as those supplied at the beginning 
of the loop.   

While looping on this Tracked By field, all that is required for each Remove are values for Qty 
and Pallet.  The Total Qty is incremented each time a Remove is submitted while looping.    

 Press the ENT key to submit the Remove transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Removing Kit Items 

This function applies to Pro and Enterprise Version users only. 

The Remove Kit function allows you to remove a kit item from the database.  This can be 
considered the same as shipping inventory.  You can designate which customer this inventory 
was shipped to on this screen.      

Notes: 

• Make sure the PDT's date and time are set correctly before performing inventory 
transactions. 

• Source and/or Destination sites are not specified during on the database you sent to the 
PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 
 
Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 
 
Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to 
the topic, WDT2200 - Configuring Sites. 

Topics discussed in this section are: 

Removing Kit Items 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Removing Kit Items: 

1. The Remove Kit function can be accessed by pressing the  2 key on the Main Menu. 
 The Remove screen appears 
 
Remove 
Item #: 
123 
 
Scan or key in value 
and press Ent. 
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Press ESC for Menu 
  

2. Press the PDT's Enter  key after supplying an Item # or press the PDT's ESC key 
to return to the Main Menu. 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try 
again, as shown below: 
 
Remove 
Item #: 
9999999 
 
Entry not found. 
Scan or key in value 
and press Ent. 
ESC=Menu 
 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item #. 
 

3. Enter the Quantity you want to remove. This is the how many Kits you want to remove. 
 
Remove Kit 
123 
123 Description 
QTY: 
12 
 
ESC=Cancel 
F1=Prev  F4=Next 
 

4. Next a screen will appear allowing you to scan or enter the component items for this kit 
item.  Scan the Item Number, or use the F1/F4 keys or the arrow keys to browse through 
a list of the component items.  Press F2 to clear your selection. 
 
Scan/Select Item #: 
1001 
 
Rem Qty: 12 
Total Qty: 30 
 
ESC=Cancel Ent= OK 
F1/F4 Browse F2=CLR 
 
Rem Qty represents how many Kits you have removed so far and the Total Qty is how 
many of that component item you have removed.  For example, if you have 5 of item 
1001 contained in Kit 123, then the Total Qty would be 12 x 5 = 60. 
 

5. Scan or key in a Location value (Note: If this is a non-inventory item, you will be taken 
directly to the Quantity screen - See Step 6):   
 
Remove 
123 
Item Description 
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Location: 
AREA 2 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
The Location field is required for all Remove transactions.  
 
Enter a Location and press F4 to advance to the next data entry field. 
 
or  
 
Press F1 to go back to the previous data entry field. 
 
or 
 
Press ESC to cancel transaction and return to the previous screen. 
 
If you press F4 to advance to the next field, without first providing a Location value, the 
following message will be displayed: 
 
Please scan or key 
in Location 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Location value. 
 
Note:  If the Allow Negative Quantities on Mobile Devices option is disabled, you will 
see a warning message if you attempt to Remove quantity from a Location that does not 
exist in the PDT database.  The Allow Negative option must be set on the PC prior to 
creating the database.  You can check the state of this option on the PDT by using the 7 
key on the Main Menu to go to the PDT About screen.  
 
New Locations can only be created during Remove when the Allow Negative 
Quantities on Mobile Devices option is enabled.  If you are prompted to confirm a new 
Location that you believe should already exist in the database, press ESC to cancel, 
then return to the Main Menu to check Site Config.  If the Location you entered exists 
only at a Site other than the currently selected Source Site, InventoryControl must treat 
that value as a new Location for the Source Site.  Select a different Source Site in Site 
Config if that's where you intended to perform this transaction. 
 

6. If this Item does not have Tracked By enabled for the Date Code, Pallet or Lot fields, a 
screen like the one below will be shown, prompting the entry of Qty. 
 
Remove 
100007 
Paint Can 
Qty: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in the inventory quantity being Removed and press ENT to complete the Remove 
transaction.  The Qty value entered must be numeric and it must be greater than zero. 
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If the Allow Negative Quantities on Mobile Devices option is disabled, you will see the 
following message if you attempt to Remove more quantity than that which is available 
for this Item at the specified Location.  
 
Available: 
83.0000 
 
Not enough qty avail 
able to complete the  
transaction 
ESC=Exit 
 
Press ESC and enter a value that does not exceed the Available amount. 
 
If this Item does have Tracked By enabled for Date Code, Pallet or Lot fields, a screen 
like the one below will be shown, expecting input for each Tracked By field that's 
enabled. 
 
Remove 
100006 
Paint Can 
Pallet: 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Key in or scan values for each of the Tracked By fields, pressing F4 to advance to the 
next data entry field. 
 
If you press F4 to advance to the next data entry field, without first inputting a required 
Tracked By value, a screen similar to the following will be displayed: 
 
Please scan or key 
in Pallet 
 
ESC=Exit 
 
Press ESC to Exit the error message and then provide the required Tracked By value (a 
Pallet, in this example).  
 
Note:  You can press the F2 key to view the last Serial Number entered. 
 
If the Allow Negative Quantities on Mobile Devices options is disabled, and a Tracked 
By value that does not match a value associated with inventory available at the 
previously specified Location is entered, the following screen will be displayed:  
 
No item with this tr 
ackby specific in st 
ock 
 
ESC=Exit 
 
If Allow Negative Quantities on Mobile Devices is enabled, any Tracked By value is 
allowed. 
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Press Esc to Exit the error message and then provide a Tracked By value that matches 
inventory in stock at the specified Location. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Add 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Remove screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing a 
Remove for this Item:   

Add 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 



 

367 

An asterisk (*) indicates the intention to do more than one Remove for this Item #, to more than 
one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while 
looping on Location after entering them for the first Add.  Tracking fields are needed only for any 
Tracked By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Add.  PO, Supplier and Tracked By values, if any, for this second Remove will 
be the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Remove are values for Qty and Location. 
 The Total Qty field is incremented each time a Remove is submitted while looping.    

Press the ENT key to submit the Remove transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Remove 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Remove: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 
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Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Remove.  The Location, PO, Supplier, 
and any Tracked By values just specified will be used with every Remove transaction entered 
until F4 is used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time a Remove is done while looping. 

 Press the ENT key to submit the Remove transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing a Remove for this Item: 
  

Remove 
123 
Monitor 
Pallet:        * 
 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Remove for this Item #, for more than 
one Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields 
will remain locked while looping on Pallet, after entering them for the first Remove: 

123 
Qty: 
Pallet:        * 
 
Total Qty: 
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30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Remove,  this screen is ready to receive inputs for another Remove.  Item #, Location, PO 
and Supplier values for this second Remove will be the same as those supplied at the beginning 
of the loop.   

While looping on this Tracked By field, all that is required for each Remove are values for Qty 
and Pallet.  The Total Qty is incremented each time a Remove is submitted while looping.    

 Press the ENT key to submit the Remove transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Picking Inventory for Orders 

This function applies to Pro and Enterprise Version users only. 

When a pick order is actually being picked, that is, the inventory is being readied for shipping to 
the customer, the quantities that are removed from inventory for each item on the order are 
entered in the Pick screen.  

Notes: 

• Picks can also be done at the PC. 
• Manual items cannot be picked on the mobile devices.  Please refer to Creating a Pick 

Order for more information on Manual items. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• If Source and/or Destination sites are not specified during on the database you sent to 

the PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 

Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to the 
topic, WDT2200 - Configuring Sites. 

The topics discussed in this section are: 

Picking Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Picking Inventory: 

1. From the Main Menu, press 9.  The Pick screen appears: 
 
Pick 
Order #: 
 
Scan or key in value 
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and press Ent. 
Press ESC for Menu 
 

2. Enter the Pick Order number, then press the Ent key.  Press ESC to return to the Main 
Menu. 
 
Pick  
Order #: 
00001 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 

3. Enter the Item Number you are picking, then press Ent.  Press ESC to return to the Main 
Menu. 
 
Pick 
Item #: 
1002 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try again 
after you press Ent. 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item # after you press Ent. 
  

4. Enter the Location of this item, then press F4.  Press F1 to return to the previous screen 
and select a different item. 
 
Pick  
1002 
Monitor 
 
Location: 
001 
 
ESC=Cancel 
F1=Prev  F4=Next 
 

5. Picks are always calculated in Eaches, meaning the quantity in which you stock them (as 
opposed to the quantity in which they are shipped to you, which may differ).  Enter how 
many of this item you will be picking.   
 
Pick 
1002 
Monitor 
 
EA.Qty 
1 
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ESC=Cancel 
F1=Prev  F4=Next 
 
 
Note: If this item has any track bys set (serial number, date code, pallet, etc.), you will 
required to enter those prior to entering a quantity.  If this item is tracked by Serial 
Number, the quantity is limited to 1. 
 

6. Press F4 to complete the transaction. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Pick 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Pick screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing an Pick 
for this Item:   
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Pick 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Pick for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Add.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Pick.  PO, Supplier and Tracked By values, if any, for this second Pick will be 
the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Pick are values for Qty and Location.  The 
Total Qty field is incremented each time a Pick is submitted while looping.    

Press the ENT key to submit the Pick transaction and continue looping or press the F4 key to exit 
the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Pick 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Pick: 
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Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Pick.  The Location, PO, Supplier, and 
any Tracked By values just specified will be used with every Pick transaction entered until F4 is 
used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time a Pick is done while looping. 

 Press the ENT key to submit the Pick transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing a Pick for this Item:   

Pick 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Pick for this Item #, for more than one 
Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will 
remain locked while looping on Pallet, after entering them for the first Pick: 
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123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Pick,  this screen is ready to receive inputs for another Pick.  Item #, Location, PO and 
Supplier values for this second Pick will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each Pick are values for Qty and 
Pallet.  The Total Qty is incremented each time an Pick is submitted while looping.    

 Press the ENT key to submit the Pick transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Picking Kit Items 

This function applies to Pro and Enterprise Version users only. 

When a pick order is actually being picked, that is, the inventory is being readied for shipping to 
the customer, the quantities that are removed from inventory for each item on the order are 
entered in the Pick screen.  

Notes: 

• Make sure the PDT's date and time are set correctly before performing inventory 
transactions. 

• If Source and/or Destination sites are not specified during on the database you sent to 
the PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 

Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to the 
topic, WDT2200 - Configuring Sites. 

The topics discussed in this section are: 

Picking Inventory 

Looping on Serial Number 

Looping on Location 

Looping on Item Number 

Looping on Track Bys (Other than Serial Number) 

 

Picking Inventory: 

1. From the Main Menu, press 9.  The Pick screen appears: 
 
Pick 
Order #: 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
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2. Enter the Pick Order number, then press the Ent key.  Press ESC to return to the Main 
Menu. 
 
Pick  
Order #: 
00001 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 

3. Enter the Item Number you are picking, then press Ent.  Press ESC to return to the Main 
Menu. 
 
Pick 
Item #: 
123 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try again 
after you press Ent. 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item # after you press Ent. 
  

4. Enter the Quantity:  This is how many Kits you want to pick. 
 
Pick Kit 
123 
123 Description 
Qty: 
12 
 
ESC=Cancel 
F1=Prev F4=Next 
 

5. Next a screen will appear allowing you to scan or enter the component items for this kit 
item.  Scan the Item Number, or use the F1/F4 keys to browse through a list of the 
component items.  Press F2 to clear your selection. 
 
Scan/Select Item #: 
1001 
 
Rem Qty: 12 
Total Qty: 30 
 
ESC=Cancel Ent= OK 
F1/F4 Browse F2=CLR 
 
Rem Qty represents how many Kits you have picked so far and the Total Qty is how 
many of that component item you have picked.  For example, if you have 5 of item 1001 
contained in Kit 123, then the Total Qty would be 12 x 5 = 60.  Continuing this example, if 
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you pick more than 60, a warning will appear that you are picking more than indicated on 
the Pick Order.  You can continue, but the discrepancy will be caught when you sync that 
data back to the PC and you will have to correct the quantity on the Edit Transaction 
screen. 
 

6. Enter the Location of this item, then press F4.  Press F1 to return to the previous screen 
and select a different item. 
 
Pick  
1001 
Monitor 
 
Location: 
001 
 
ESC=Cancel 
F1=Prev  F4=Next 
 

7. If a track by other than Serial Number is required, you will enter it now. 
 
Pick  
1001 
Monitor 
Date Code: 
DC-1234 
 
ESC=Cancel 
F1=Prev F4=Next 
 

8. Picks are always calculated in Eaches, meaning the quantity in which you stock them (as 
opposed to the quantity in which they are shipped to you, which may differ).  Enter how 
many of this item you will be picking.   
 
Pick 
1001 
Monitor 
 
EA.Qty 
1 
 
ESC=Cancel 
F1=Prev  F4=Next 
 

9. If this item is tracked by Serial Number or Lot, you will be required to enter the 
numbers/codes now. 
 
1001 
EA. QTY:1 
 
SN: 
100023021 
 
Qty:4/100 
F4=Done F2=Last SN 
 
When looping on serial number, note that the Qty field displays how many serial numbers 



 

379 

exist for this item and how many you have entered so far.  In the example above, 4 serial 
numbers have been entered out of a possible 100 (4/100).  You can press F2 to display 
the last serial number entered. 
 

10. Press F4 to complete the transaction. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Pick 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done F2=Last SN 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number. When looping on serial number, note that the Qty field displays how many serial 
numbers exist for this item and how many you have entered so far.  In the example above, 4 
serial numbers have been entered out of a possible 100 (4/100).  You can press F2 to display the 
last serial number entered. 

Press F4 after entering the last Serial Number to the Pick screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the example below the F3 key was pressed when prompted for Location while doing an Pick 
for this Item:   

Pick 
123 
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Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Pick for this Item #, to more than one 
Location. Values entered for Item #, PO and Supplier, if any, will remain locked while looping on 
Location after entering them for the first Add.  Tracking fields are needed only for any Tracked 
By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Pick.  PO, Supplier and Tracked By values, if any, for this second Pick will be 
the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Pick are values for Qty and Location.  The 
Total Qty field is incremented each time a Pick is submitted while looping.    

Press the ENT key to submit the Pick transaction and continue looping or press the F4 key to exit 
the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Pick 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 

 

Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Pick: 
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Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Pick.  The Location, PO, Supplier, and 
any Tracked By values just specified will be used with every Pick transaction entered until F4 is 
used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time a Pick is done while looping. 

 Press the ENT key to submit the Pick transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing a Pick for this Item:   

Pick 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 

 

An asterisk (*) indicates the intention to do more than one Pick for this Item #, for more than one 
Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields will 
remain locked while looping on Pallet, after entering them for the first Pick: 
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123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Pick,  this screen is ready to receive inputs for another Pick.  Item #, Location, PO and 
Supplier values for this second Pick will be the same as those supplied at the beginning of the 
loop.   

While looping on this Tracked By field, all that is required for each Pick are values for Qty and 
Pallet.  The Total Qty is incremented each time an Pick is submitted while looping.    

 Press the ENT key to submit the Pick transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 
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WDT2200 - Receiving Inventory 

This function applies to Pro and Enterprise Versions only. 

This screen allows you to select which purchase order you are receiving on and to mark 
individual items on that purchase order as received into a specific location. 

Notes: 

• Picks can also be done at the PC. 
• Manual items cannot be received on the mobile devices.  Please refer to Creating a 

Purchase Order for more information on Manual items. 
• Make sure the PDT's date and time are set correctly before performing inventory 

transactions. 
• If Source and/or Destination sites are not specified during on the database you sent to 

the PDT, the following message will be displayed the first time you attempt to perform an 
inventory transaction on the PDT: 

Please use the Site 
Config function to 
Select Source and  
Destination Sites. 
 
ESC=Exit 

Press the Escape key to return to the Main Menu, then select the 6 key to go to the Site 
Config function.  For more information on configuring sites on the PDT, please refer to the 
topic, WDT2200 - Configuring Sites. 

The topics discussed in this section are: 

Receiving Inventory 

Looping on Serial Number 

Looping on Item Number 

Looping on Location 

Looping on Track Bys (Other than Serial Number) 

Tips for Speeding Up Data Entry 

 

Receiving Inventory: 

1. From the Main Menu, press the 9 key.  The Receive screen appears: 
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Receive 
PO: 
 
 
Scan or key in value  
and press Ent. 
Pres ESC for Menu 

2. Enter the PO number that contains the items you are receiving: 
 
Receive 
PO: 
10007 
 
Scan or key in value  
and press Ent. 
Pres ESC for Menu 
 

3. Enter the Item Number you are receiving: 
 
Receive 
Item: 
1001 
 
Scan or key in value  
and press Ent. 
Pres ESC for Menu 
 
If the Item # entered is not found in the PDT's database, you will be prompted to try again 
after you press Ent. 
 
If the Item # entered is found in the database, the Item's Description will be displayed 
beneath the Item # after you press Ent. 
 

4. Enter the Location into which you will be receiving the item.  Note:  If this item has a 
designated primary location (setup on the Create New Item or Edit Item screen on the 
PC), then that location will appear by default.  You can change this location, if needed. 
 
A location must be entered. 
 
Receive 
1001 
Monitor 
Location: 
Location 1  
 
ESC=Cancel 
F1=Prev  F4=Next 
 

5. The quantity ordered for this item on the PO will appear followed by the order unit 
quantity.  The order unit quantity is the unit of measure used by this supplier for shipping 
purposes.  In the example below, 100 boxes were ordered, each box contains 10 items 
and 1 is being received. 
 
Receive 
1001 
Monitor 



 

385 

PO Qty:  100.0000 
box/10.0000: 
1 
 
ESC=Cancel 
F1=Prev  F4=Next 
 
Note: If this item has any track bys set (serial number, date code, pallet, etc.), you will 
required to enter those prior to entering a quantity.  If this item is tracked by Serial 
Number, the quantity is limited to 1. 
 

6. Press F4 to complete the transaction. 

 

Looping on Serial Number: 

Fields can be looped, or pinned, by pressing the F3 key.  An asterisk displays next to the looped 
field. 

If track by Serial Number is enabled for this Item, the Qty field will be set to 1.  A quantity of one 
is assumed for each Serial Number.  Looping will determine the final count for this Receive 
transaction, as you scan (or key in) one or more Serial Numbers for this Item: 

1000066 
Qty:1 
 
SN:      * 
 
Count:0 
F4=Done 
  

As each SN is keyed in or scanned, the Count will be increased. Press ENT after inputting each 
serial number.  

Press F4 after entering the last Serial Number to the Receive screen. 

Notes: 

•  When an Item is tracked by Serial Number, you can only loop on Serial Number.   
• When an Item is not Tracked By Serial Number, you can use F3 to designate a field that 

will be used for looping.  The values in every field except Qty will remain locked while 
looping. 

 

Looping on Location: 

Fields can be looped, or pinned, by pressing the F3 key. 
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In the example below the F3 key was pressed when prompted for Location while doing a 
Receive for this Item:   

Receive 
123 
Monitor 
Location:      * 
 
ESC=Cancel 
F1=Prev F4=Next 

An asterisk (*) indicates the intention to do more than one Receive for this Item #, to more than 
one Location. Values entered for Item #, PO and Supplier, if any, will remain locked while 
looping on Location after entering them for the first Add.  Tracking fields are needed only for any 
Tracked By options enabled for the Item entered. 

In the example below F3 was pressed when prompted for Location and then values for Location, 
PO, Supplier, any Tracked By's, and a Qty of 10 were entered, this screen is ready to receive 
inputs for another Pick.  PO, Supplier and Tracked By values, if any, for this second Pick will be 
the same as those supplied at the beginning of the loop, if any.   

123 
Qty: 
Location: 
 
Total Qty: 
10.00000 
F4=Done 

While looping on Location, all that is required for each Receive are values for Qty and Location. 
 The Total Qty field is incremented each time a Receive is submitted while looping.    

Press the ENT key to submit the Receive transaction and continue looping or press the F4 key to 
exit the loop. 

 

Looping on Item Number: 

Fields can be looped, or pinned, by pressing the F3 key. 

In the following example, F3 was pressed when prompted for Item #:   

Receive 
Item #:        * 
 
Scan or key in value 
and press Ent. 
Press ESC for Menu 
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Above, the asterisk (*) indicates the intention to loop on Item #.  Values entered for Location, 
PO, Supplier and any Tracked By fields (other than Serial Number) will remain locked after 
entering them for the first Receive: 

Qty: 
 
Item #: 
 
Count:25 
F4=Done 

 

Above, having pressed F3 when prompted for Item # and then having entered the item number 
and values for Location, PO, Supplier, any Tracked By's, and a value of 25 for Qty, this screen 
is ready to receive Qty and Item # inputs for the second Receive.  The Location, PO, Supplier, 
and any Tracked By values just specified will be used with every Receive transaction entered 
until F4 is used to exit the loop.   

While looping on Item #, all that is required for each transaction here are values for Qty and Item 
#.  The Count is incremented each time a Receive is done while looping. 

 Press the ENT key to submit the Receive transaction and continue looping  

or  

Press the F4 key to exit the loop. 

 

 When looping on Item #, all items entered should have the same Tracked By requirements. If 
a different Tracked By field is required, you will be prompted to enter the information before 
continuing.  Looping will need to be reset. 

 

Looping on a Tracked By  (other than Serial Number) 

Here, for example, F3 was pressed when prompted for Pallet while doing a Receive for this Item: 
  

Receive 
123 
Monitor 
Pallet:        * 
 
ESC=Cancel 
F1=Prev  F4=Next 
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An asterisk (*) indicates the intention to do more than one Receive for this Item #, for more than 
one Pallet.  Values entered for Item #, Location, PO, Supplier, and any other Tracked By fields 
will remain locked while looping on Pallet, after entering them for the first Receive: 

123 
Qty: 
Pallet:        * 
 
Total Qty: 
30.00000 
F4=Done 

 

Above, having entered a value for Pallet and a value of 30 for Qty on the previous screen for the 
first Receive,  this screen is ready to receive inputs for another Receive.  Item #, Location, PO 
and Supplier values for this second Receive will be the same as those supplied at the beginning 
of the loop.   

While looping on this Tracked By field, all that is required for each Receive are values for Qty and 
Pallet.  The Total Qty is incremented each time an Receive is submitted while looping.    

 Press the ENT key to submit the Receive transaction and continue looping  

or  

Press the F4 key to exit the loop. 

  When looping on a Tracked By field, all items entered should have the same Tracked By 
requirements. If a different Tracked By field is required, you will be prompted to enter the 
information before continuing. Looping will need to be restarted. 

 

Tips for Speeding Up Data Entry: 

• When you create a new item, if the Category, Manufacturer, UOM or any combination of 
pinnable fields will be used on a large number of items, create one item with those fields, 
then pin the fields.  Now, the information will be retained in those fields so you don't have 
to keep re-entering it for each new item.    

• Make sure you have the Close New Forms option turned off (on the InventoryControl 
Options screen) so the New Item screen, or any other screen where new information is 
added, stays open after each new item is saved.   
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Windows Mobile Device 

Windows Mobile Device Synchronization 

The synchronization process involves actions on both the PC and the mobile device side. 
Whenever data is added or edited on the PC, it is necessary to synchronize the PC database with 
the mobile database before the updated data will be reflected on the mobile device. The same is 
true for additions and changes made on the mobile device. The databases on the mobile device 
and the PC must be synchronized before the changes made on the mobile device database will 
be reflected in the PC database. 

The following topics will guide you through the different required synchronization procedures. 

• Setup Mobile Device 
• Create Database 
• Send Data to PC 
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 Windows Mobile Device 

Windows Mobile Device - Data Cycle 

PC: 

1. Windows Mobile Device Setup: Setup Device 

3. Create Mobile Database: Created on PC 

4. Synchronize Pocket PC: Download PC to Pocket PC 

Pocket PC: 

5. Get Data from PC on Pocket PC 

6. Use Pocket PCs 

7. Send Data to PC from Pocket PC 

PC: 

8. Synchronize Pocket PC: Upload Pocket PC to PC 

9. Process Mobile Device Data 
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Windows Mobile Device - Rebooting 

If your device locks up, you can perform a warm reboot. This will reset the device and should 
return it to normal functioning.  A warm reboot will not affect your data. 

To perform a warm reboot, gently insert a pin into the Reset hole on the back of the device, then 
remove the pin.   

The device will reset. 
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Windows Mobile Device - Setup the Mobile Device 

This is the first step in sending the InventoryControl database to your mobile device. 

Note: Before setting up the device, be sure that it is connected to the PC. 

Setting Up the Mobile Device: 

1. On the InventoryControl Main Window, click the Mobility icon.  A menu will appear 
allowing you to select which device you will be working with.  If you have only one type, 
the Mobility Menu for that device will appear at the bottom of the screen. 

2. On the Mobility Menu, select Setup Mobile. 
 

 
 
 
The Wasp Mobile Device Communication Wizard opens with the Mobile Device 
Setup tab selected. 
 
If this is the first install of the program on the mobile device, the software will 
automatically send the Platform, Program and a Clean Database to the mobile device. 
 
Once the mobile device has been found, the Setup Mobile Device tab displays the 
following information: 
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• If this is the first time you are setting up the device, you can skip this screen by 
clicking the Next button.  The platform, program and a clean database are 
automatically sent to the device. 

• If there was a problem with the initial setup, you can select Platform, Program 
and Clean Database. 

• If you already have a platform set up, select either Program or Program and 
Clean Database. 

• If you click the Install Programs button, the Add/Remove Programs screen will 
display. 

2. Click the Install button.  A message displays: 
 
"You have chosen to send an empty database to the mobile device.  This will wipe out 
any data that currently resides on the mobile device. Lost data cannot be recovered!" 

3. Click Yes to send the database.  A message displays regarding additional steps on the 
Pocket PC. 
 

 
4. If you are using Windows CE 5, you can click OK on this message and disregard it.  If 

you are using any other version, you will need to click OK on this screen and follow the 
steps on the mobile device to continue.  You may receive this message again during the 
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install.  Each time you receive it, you will need to check the mobile device for additional 
instructions. 

5. After the install is complete, click the Next button at the bottom of the screen.  The 
Create Mobile Database tab displays. 
 

 
 
This tab allows you to filter the information that will be sent to the mobile device, if 
desired.  Filtering helps save memory space on the mobile device by allowing you to 
select only the data you need to load onto the device as opposed to loading all available 
data.  You can load all data, if desired. 

6. Select the Site, Location, Item Numbers, Customers, Suppliers, Purchase Orders 
(Pro and Enterprise Versions Only) and Pick Orders (Pro and Enterprise Versions Only) 
to be downloaded to the device, then click Next. 
 
Select the Specify Filter button if you will be limiting the data.  Click the Hand icon to 
access the Find screen to search for data.  The data you select on the Find screen will 
be entered in the text box for that section and only that data will be sent to the mobile 
device.  Please refer to the Searching for Information topic for more information on the 
Find screen. 
 
Select the Minimally Required checkbox to only send data that is required for normal 
operation.  For example, if you select to send all Items, but don't want to send all 
locations, only those locations designated as Primary Locations for individual items will 
be sent.  Or, if you don't want to send all Suppliers, but some Suppliers are entered on 
the Item screen/Managing Suppliers tab for items, only those suppliers entered on the 
Item screen will be sent. 
 
Tips for Filtering Information 
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The default values apply no filtering to your data. All Items will be selected, including 
those which are not yet in a Location. 

Site: 

Source: Specify <all> or one of the Sites listed in the drop down list. This 
determines which Sites will be shown in the Source Site list on the mobile device. 

This is the Site for all inventory transactions to be performed by the device. 
If you want the device's database to include Items at more than one Site, 
 select <all>. You can only select ALL or 1 specific site.  For example, if you 
have 5 sites, you cannot select 2 to be a Source.  You can either select 1 or 
all. 

Destination: If more than one Site is defined on the system and you have 
selected a specific Site in the Source Site field, you can select one of the Sites 
listed in the Destination drop down list. This determines which Sites will be shown 
in the Destination Site list of the mobile device's Site Configuration function and 
which locations will be listed in the Move To list. 

This field will be grayed-out with a value of <all>, as shown above, if only 
one Site is defined in InventoryControl or if a value of <all> has been 
specified for the Source Site. If a specific Site has been selected for the 
Source Site, that same site will be the default value for Destination Site, but 
you can change the Destination Site to a different value using the drop 
down list. 

Source Site: Destination 
Site: 

The Source 
Sites  Listed in 

the Mobile 
Device Site 

Configuration 
 will Include: 

The 
Destination 
Sites  Listed 
in the Mobile 
Device Site 

Configuration 
 will Include: 

<all> 

This value is 
forced to <all> 
when there is 
only one Site 
setup in the 

system. 

<all> 

This value is 
forced to <all> 
when <all> is 
specified as 
the Source 

Site. 

All Sites All Sites 

A Specific 
Site 

Destination 
Site is the 

Same as the 
Source Site 

The Specified 
Source Site 

The Same 
Site 

A Specific 
Site 

A Different 
Site 

The Specified 
Source Site 

The Specified 
Destination 

Site 

As an example, if you have more than two Sites and want to be able to 
move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the 
mobile device, you will have to create a mobile database for Source Site 1 
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and Destination Site 2, transfer the database to the mobile device, use the 
device for those Moves, send the information back to the PC, then repeat 
the entire process beginning with by creating a second database to do 
Moves from Source Site 1 to Destination Site 3. Alternately, if your device 
has enough memory to hold a database containing records for all of your 
Items, at all Sites, you can specify a Source value of <all> and then control 
Source Site and Destination Site on the mobile device (see Windows 
Mobile Device - Configuring Sites for more information. 

Location: 

From: Specify <all> or use <More> from the drop list to find a specific Location at 
the Source Site that denotes the first in a range of Locations that will be included 
in the mobile database. The last 10 Locations used will be also be listed in the 
From drop list. 

Specifying <all> will include all Locations for the specified Source Site in 
the mobile Database.  

To: Specify <all> or click the Hand icon to find a specific Location at the Source 
Site that denotes the last in a range of Locations that will be included in the mobile 
database. The last 10 Locations used will also be listed in the To drop list. 

Specifying <all> will include all Locations for the specified Destination Site 
in the mobile device Database.  

A specific value can be used for From even though <all> is used for To: (For 
example, From: Bin 50 used with To:<all>, would select Bin 50 through whatever 
the largest Bin number is.)   

Similarly, a specific value can be used for To in combination with From:<all>. 
 (For example, From:<all> used with To: Bin 100, would select every bin up 
through Bin 100.) 

Item Number: 

From: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the first valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the From drop list. 

To: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the last valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the To drop list. 

Include Items not in a Location: This is an option that is turned on and grayed-out 
when no filtering is applied. When filtering is applied in one or more of the above fields, 
this option becomes user-controllable. It allows you to include in the mobile database 
Items which are not yet in a Location, in addition to those selected via the filters specified. 
 (This can be employed when you expect to use the mobile device to Add quantity for 
Items that have never been inventoried before. The mobile device user can specify 
previously defined Locations or create new Locations while adding the previously 
"Location-less" Items.) 
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7. After you have made your filter selections, click the Next button.  The following message 
appears: 
 

 
8. Click Yes to create the database.  The wizard displays a confirmation message that the 

database has been successfully created. 
 

 
9. Click the Next button.  The PC to Mobile Device tab displays.   Note at the bottom of the 

screen the wizard indicates there are two steps on this tab. 
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10. After checking to make sure the device is connected to your PC, click Next.  A status bar 
will appear as the data is transferred.  A confirmation message appears after the transfer 
is complete: 
 

 
11. Click Finish to close the Wizard screen.   
12. On the mobile device, you will see a message similar to the following: 

 

 
 
Click OK to insert the records into the mobile database.  InventoryControl will start 
automatically on the device after the transfer. 
 
You can now perform transactions on the mobile device. 

After you have performed transactions on the mobile device, you need to send the data back to 
the PC.  
  

 

 

The next step is to perform the Get Data from PC function on the Pocket PC. 
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Windows Mobile Device Synchronization 

The synchronization process involves actions on both the PC and the mobile device side. 
Whenever data is added or edited on the PC, it is necessary to synchronize the PC database with 
the mobile database before the updated data will be reflected on the mobile device. The same is 
true for additions and changes made on the mobile device. The databases on the mobile device 
and the PC must be synchronized before the changes made on the mobile device database will 
be reflected in the PC database. 

The following topics will guide you through the different required synchronization procedures. 

• Setup Mobile Device 
• Create Database 
• Send Data to PC 
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Windows Mobile Device - Sending the Database from the PC 

As you add, change or remove data from the InventoryControl database, you will need to create 
and send a new database to your mobile devices.  Follow the instructions below to do this. 

There are two separate procedures you must complete to successfully send data from the PC to 
the mobile device. You must first complete the procedure on the PC side before you can finish 
the procedure on the mobile device side. 

• PC Procedure 
• Mobile Device Procedure 

 

PC Procedure 

1. On the InventoryControl Main Window, click the Mobility icon.  A menu will appear 
allowing you to select which device you will be working with.  If you have only one type, 
the Mobility Menu for that device will appear at the bottom of the screen. 

2. On the Mobility Menu, select Create Mobile. 
 

 
 
 
The Wasp Mobile Device Communication Wizard opens with the Create Mobile 
Database tab selected. 
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This tab allows you to filter the information that will be sent to the mobile device, if 
desired.  Filtering helps save memory space on the mobile device by allowing you to 
select only the data you need to load onto the device as opposed to loading all available 
data.  You can load all data, if desired. 

3. Select the Site, Location, Item Numbers, Customers, Suppliers, Purchase Orders 
(Pro and Enterprise Versions Only) and Pick Orders (Pro and Enterprise Versions Only) 
to be downloaded to the device, then click OK. 
 
Select the Specify Filter button if you will be limiting the data.  Click the Hand icon to 
access the Find screen to search for data.  The data you select on the Find screen will 
be entered in the text box for that section and only that data will be sent to the mobile 
device.  Please refer to the Searching for Information topic for more information on the 
Find screen. 
 
Select the Minimally Required checkbox to only send data that is required for normal 
operation.  For example, if you select to send all Items, but don't want to send all 
locations, only those locations designated as Primary Locations for individual items will 
be sent.  Or, if you don't want to send all Suppliers, but some Suppliers are entered on 
the Item screen/Managing Suppliers tab for items, only those suppliers entered on the 
Item screen will be sent. 
 
Tips for Filtering Information 

The default values apply no filtering to your data. All Items will be selected, including 
those which are not yet in a Location. 

Site: 
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Source: Specify <all> or one of the Sites listed in the drop down list. This 
determines which Sites will be shown in the Source Site list on the mobile device. 

This is the Site for all inventory transactions to be performed by the device. 
If you want the device's database to include Items at more than one Site, 
 select <all>. You can only select ALL or 1 specific site.  For example, if you 
have 5 sites, you cannot select 2 to be a Source.  You can either select 1 or 
all. 

Destination: If more than one Site is defined on the system and you have 
selected a specific Site in the Source Site field, you can select one of the Sites 
listed in the Destination drop down list. This determines which Sites will be shown 
in the Destination Site list of the mobile device Site Configuration function and 
which locations will be listed in the Move To list. 

This field will be grayed-out with a value of <all>, as shown above, if only 
one Site is defined in InventoryControl or if a value of <all> has been 
specified for the Source Site. If a specific Site has been selected for the 
Source Site, that same site will be the default value for Destination Site, but 
you can change the Destination Site to a different value using the drop 
down list. 

Source Site: Destination 
Site: 

The Source 
Sites  Listed in 

the Mobile 
Device Site 

Configuration 
 will Include: 

The 
Destination 
Sites  Listed 
in the Mobile 
Device Site 

Configuration 
 will Include: 

<all> 

This value is 
forced to <all> 
when there is 
only one Site 
setup in the 

system. 

<all> 

This value is 
forced to <all> 
when <all> is 
specified as 
the Source 

Site. 

All Sites All Sites 

A Specific 
Site 

Destination 
Site is the 

Same as the 
Source Site 

The Specified 
Source Site 

The Same 
Site 

A Specific 
Site 

A Different 
Site 

The Specified 
Source Site 

The Specified 
Destination 

Site 

As an example, if you have more than two Sites and want to be able to 
move inventory from Site 1 to Site 2 -and- from Site 1 to Site 3 on the 
mobile device, you will have to create a mobile database for Source Site 1 
and Destination Site 2, transfer the database to the mobile device, use the 
device for those Moves, send the information back to the PC, then repeat 
the entire process beginning with by creating a second database to do 
Moves from Source Site 1 to Destination Site 3. Alternately, if your device 
has enough memory to hold a database containing records for all of your 
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Items, at all Sites, you can specify a Source value of <all> and then control 
Source Site and Destination Site on the mobile device (see Windows 
Mobile Device - Configuring Sites for more information. 

Location: 

From: Specify <all> or use <More> from the drop list to find a specific Location at 
the Source Site that denotes the first in a range of Locations that will be included 
in the mobile database. The last 10 Locations used will be also be listed in the 
From drop list. 

Specifying <all> will include all Locations for the specified Source Site in 
the mobile Database.  

To: Specify <all> or click the Hand icon to find a specific Location at the Source 
Site that denotes the last in a range of Locations that will be included in the mobile 
database. The last 10 Locations used will also be listed in the To drop list. 

Specifying <all> will include all Locations for the specified Destination Site 
in the mobile device Database.  

A specific value can be used for From even though <all> is used for To: (For 
example, From: Bin 50 used with To:<all>, would select Bin 50 through whatever 
the largest Bin number is.)   

Similarly, a specific value can be used for To in combination with From:<all>. 
 (For example, From:<all> used with To: Bin 100, would select every bin up 
through Bin 100.) 

Item Number: 

From: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the first valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the From drop list. 

To: Specify <all> or click the Hand icon to find a specific Item Number that will 
establish the last valid value in a range of Item Numbers. The last 10 Item 
Numbers used will be also be listed in the To drop list. 

Include Items not in a Location: This is an option that is turned on and grayed-out 
when no filtering is applied. When filtering is applied in one or more of the above fields, 
this option becomes user-controllable. It allows you to include in the mobile database 
Items which are not yet in a Location, in addition to those selected via the filters specified. 
 (This can be employed when you expect to use the mobile device to Add quantity for 
Items that have never been inventoried before. The mobile device user can specify 
previously defined Locations or create new Locations while adding the previously 
"Location-less" Items.) 

 

4. After you have made your filter selections, click the Next button.  The following message 
appears: 
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5. Click Yes to create the database.  The wizard displays a confirmation message that the 

database has been successfully created. 
 

 
6. Click the Next button.  The PC to Mobile Device tab displays.   Note at the bottom of the 

screen the wizard indicates there are two steps on this tab. 
 

 
 
Note:  Make sure you have the InventoryControl application closed on the mobile device 
before clicking Next on this tab.  Otherwise you will receive a warning message that you 
need to exit the InventoryControl application on the mobile device before proceeding. 
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7. After checking to make sure the device is connected to your PC, click Next.  A status bar 
will appear as the data is transferred.  A confirmation message appears after the transfer 
is complete: 
 

 
8. Click Finish to close the Wizard screen.   

 

 

Mobile Device Procedure 

On the mobile device, you will see a message similar to the following: 
 

 
 
Click OK to insert the records into the mobile database.  InventoryControl automatically starts on 
the device after the transfer. 

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Retrieving Data from the Device 

The Send Data to PC function enables you to send data from the mobile device to your PC.  You 
will use this function after you have performed transactions (add, move, etc.) and need to send 
the data back to the PC. 

Sending Data to the PC: 

1. On the InventoryControl Main Window, click the Mobility icon.  If you have more than 
one type of mobile device installed, a menu will appear allowing you to select which 
device you will be working with.  If you have only one type, the Mobility Menu for that 
device will appear at the bottom of the screen. 

2. On the Mobility Menu, select Get Data From. 
 

 
 
The Wasp Mobile Device Communication Wizard screen displays with the Mobile 
Device to PC tab displayed: 
 

 
 
 
Make sure the device is attached to the PC, then click Next. 

3. The data uploaded from the Pocket PC is sent to an XML file.  
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The Pending Uploads screen will display to allow you to process the uploaded data in 
the XML file.  

See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this 
function. 
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Windows Mobile Device - Default Settings 

The Windows Mobile version of InventoryControl offers several time-saving features: 

Site Configuration: If your company uses the same two Sites for all inventory purpose, in the 
Site Configuration screen, you can set up your device to automatically include these Sites in the 
appropriate fields in InventoryControl. 

Pinning: Pinning can be used to lock the values in any field. This enables you to enter repeated 
information rapidly without having to manually re-enter repetitive data. 
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Windows Mobile Device - Interface 

 
 
Once the database has been sent to the mobile device, it will be ready for conducting inventory 
operations.  For more information on setting up your device, please refer to the Windows Mobile 
Device - Setup Mobile Device topic. 
 
Tap the device's InventoryControl icon with the stylus to start the application. 
 

An hour glass icon displays while the application opens.  
 
The Logon screen displays. 
 

 
 
Enter your user name and password, then tap OK. 
 

The first time you log on to InventoryControl on your mobile device, enter Admin in the User 
Name field and leave the Password field blank. After you have sent the database from the PC to 
the mobile device, user names and passwords that are stored on the PC will be downloaded to 
the mobile device. Once this has occurred, you must use your normal user name and password 
to log on to the mobile  version of InventoryControl.  For more information on sending the 
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database to the mobile device, please refer to the Windows Mobile Device - Sending New Data 
from the PC topic. 
 
Below is an example of the InventoryControl Main Menu. 
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Windows Mobile Device - Entering Alphanumeric Data 

You can enter letters and numbers in fields on the mobile device by using the device's key pad, 
using the keyboard or by scanning barcodes. 

Regardless of the method you use to enter data, note that once you enter data in the first 
field and move to the next field, only the fields that are relevant to the data you entered will 
display. For example, if you enter an Item that is tracked by serial number, the Serial # field 
would remain on the screen, but other fields such as Date Code and Pallet would no longer 
display. If you enter an Item that is not tracked, all tracking fields - PO, Supplier, Lot, Date Code, 
Serial # and Pallet - will no longer display. 

Using the Device's Key Pad 

The method for using your device's numeric or alphanumeric keypad is documented in the user 
manual for that device.  Please refer to that documentation for full details. 

Using the Software Keyboard 

Tap the keyboard icon  at the bottom of the screen.  

The keyboard options menu displays. 

 

To open the keyboard, select Keyboard. 

The keyboard (Input Panel) displays. 

 

Tap in the field in which you want to enter data, then use your stylus to select the characters on 
the keyboard. 

To close the keyboard, tap the keyboard icon  at the bottom of the screen. 
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Select Hide Input Panel. 

Scanning 

If you have information -- such as an Item Number, Site or Location -- in barcode format, and your 
mobile device has a barcode scanner, you can scan the barcode to enter the data in a chosen 
field. 

Tap in the field in which you want to enter data, then scan the barcode by aiming the scanner at 
the barcode and pressing the scan button. 

If you find that the scanner is not responding, you may need to enable the scanner. 
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Windows Mobile Device - Enabling the Scanner 

Before you use InventoryControl on your Windows Mobile Device for the first time, you may need 
to enable the scanner. 

If at any time the scanner on your mobile device stops functioning, this procedure should also 
restore its functionality.  

Enabling the Scanner: 

1. Tap the Start icon at the bottom left corner of the device screen. 
2. Select Settings > Control Panel. 

 

 
 
The Control Panel screen displays. 
 

 
3. Scroll down to locate the Scanner Settings icon. Double-tap the Scanner Settings icon. 
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The Scanner Control Panel displays. 

4. Tap the To Kpd tab. 
 

 
 
The To Kpd tab displays. 
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5. Select the Start Scan2Key When Exit check box. Make sure the check box has a check 

in it. 
6. Tap the OK button in the upper right corner of the screen to apply the setting and close 

the Scanner Control Panel screen. 
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Windows Mobile Device - Site Configuration 

InventoryControl provides a time-saving feature for companies who use the same two Sites for 
all inventory transactions on the mobile device. On the Site Configuration screen, you can set 
up your device to automatically include these Sites in the appropriate fields in InventoryControl 

Configuring Site: 

1. To access the Site Configuration screen, select Tools > Site Configuration. 
 

 
 
The Site Configuration screen displays. 
 

 
 
You can enter the data by scanning, using the device's key pad, or using the device's 
keyboard. Click here for more information about entering data. 

2. Enter the Source Site.  The Source Site field is used as the default for Add, Remove, 
Move (from), Adjust and Details fields. 

3. Enter the Destination Site. The Dest Site field is used as the default for Move (to). 
4. Tap OK. 

 
After you have configured the Sites, you will see that the appropriate fields are pre-
populated with the selected sites in all the device's InventoryControl screens. 
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Windows Mobile Device - About Screen 

The About screen displays basic information about the version of InventoryControl installed on 
your device. 

Viewing the About Screen: 

To open the About screen, select Help > About. 
 

 
 
The About screen displays: 
 

 
 
Information on this screen includes: 

• Application title (InventoryControl) 
• Version number and build number 
• Setting for the Allow Negative Numbers on the Mobile Device option.  This option is set 

on the Options screen in the PC version of InventoryControl.  For more information on this 
option, please refer to the Options Screen topic. 

• Source Site and Destination Site.  These are the sites and locations to which the mobile 
device will default when moving, adding, etc. inventory.  These are set on the PC.  For more 
information on setting the Source and Destination Sites, please refer to the Selecting Sites 
topic. 

• Copyright information 
• The Wasp Barcode website address. 
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Windows Mobile Device - Adding Inventory 

The Add inventory function is used to add quantity to any item setup in the database. 

Inventory can also be added at the PC. See the Adding Inventory and Importing into the 
Database topics for more information. 

Adding Inventory: 

1. From the Main Menu, click the Add icon.  The Add screen displays. 
 

 
 
Note:  On the Add screen, you can enter characters manually, scan in data (see 
Entering Alphanumeric Data on the Windows Mobile Device for details) or use the 
Search function. 

2. Enter the number of the item to which you want to add inventory in the Item #  field.   
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In the example above, one Item (1001) is being added to Site 2, Location 1. 
 
After the Item Number is entered, the Add screen displays only the fields that are 
necessary for adding this particular Item. For example, if you enter an Item that is tracked 
by serial number, the Serial No field will remain on the screen, but other fields such as 
Date Code and Pallet will no longer display. Exception: The PO and Supplier fields will 
always display in the Add screen, even if the Item you entered is not tracked by these 
fields. 

3. Enter the Site and Location to which the Item is to be added. 
 

 
4. Enter the Quantity of the Item to be added. 
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Note: If the Item Number you are adding is tracked by serial number, the quantity (Qty 
field) must be 1. 

5. When all required information is entered, tap OK.  The Item is added and the Add screen 
resets, ready for the next Item to be added. 
 
Tapping the Reset button clears all fields and restores all available fields to the Add 
screen display. 

6. When you are finished with the Add screen, tap Close to return to InventoryControl 
main menu. 

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 

Tips for Speeding Up Data Entry: 

• When you create a new item, if the Category, Manufacturer, UOM or any combination of 
pinnable fields will be used on a large number of items, create one item with those fields, 
then pin the fields.  Now, the information will be retained in those fields so you don't have 
to keep re-entering it for each new item.    

• Make sure you have the Close New Forms option turned off (on the InventoryControl 
Options screen) so the New Item screen, or any other screen where new information is 
added, stays open after each new item is saved.   
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Windows Mobile Device - Pinning Fields 

"Pinning" can be used to lock values you have entered in any field. Pinning enables you to enter 
repeated information rapidly without having to re-enter repetitive data. After a field is pinned, you 
can manually enter data, or you can use a scanner to rapidly Add, Remove, Move, Adjust, etc. by 
repeatedly scanning barcodes. 

For example, if you need to add the same inventory Item Number multiple times, you can pin the 
Item # field and perform continuous Adds without having to re-enter the Item Number for each 
Add. 

Note: Before pinning a field, make sure the data you want pinned in the field is entered. Once 
you pin the field, you cannot change the data entered in the field until the field is unpinned.   

Remember that once you close a screen, the field will no longer be pinned when you re-open that 
screen. 

Pinning Fields: 

To pin a field, tap the field name. 

 

The entire field turns grey. This indicates the field is now pinned. Whatever information that has 
been entered in this field will remain until the screen is closed.  

 

Unpinning Fields: 

To unpin the field, click the field name again. The field will no longer be grey, and you may now 
change the information in the field. 
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Windows Mobile Device - Adding New Customers 

You can add new Customers in InventoryControl on the Windows Mobile Device only in the 
Remove screen. 

The new Customer will not be added unless the data for all other fields is completed correctly 
and the inventory is successfully removed. 

Adding a Customer on the Remove Screen: 

In this example, a new Customer will be added and an Item will be removed. 

1. On the Remove screen, enter the data for the Item you want to remove.  
2. In the Customer field, enter the new Customer you want to add. 

 

 
3. Click OK.  The message below appears: 

 

 
4. Click Yes. 

 
The fields are now reset in the Remove screen. 

5. If no errors display, this indicates that both the removal of the Item and the addition of the 
Customer were successful. To check, tap the Search icon  next to the Customer field. 

6. The Search Customers screen displays, and the Customer you added displays in the 
Customer list. 
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See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Adding a New Location 

You can add new Locations in InventoryControl on the mobile device. However, you cannot 
add new Sites. New Locations can be added in the Add, Remove, Move, Adjust, Pick (Pro 
and Enterprise Versions Only) and Receive (Pro and Enterprise Versions Only) screens on 
the mobile device. 

Notes:  

• You can only add a new Location if the Allow Negative Quantities on the Mobile 
Device option is enabled on the Options screen (on the PC).  For more information on 
this option, please refer to the Options Screen topic. 

• The new Location will not be added unless the data for all other fields is completed 
correctly and the function (Add, Remove, Move, etc.) is successfully completed. 

Adding a New Location: 

In this example, a new Location - Location 4 -  will be added in the Add screen.  The steps are 
the same for the Remove, Move, Adjust and Receive (Pro and Enterprise Versions Only) 
screens. 

1. On the Add screen, enter the data for the Item you want to add.  
2. In the Location field, enter the new Location you want to add. 
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3. Click OK.  The following message displays. 
 

 
4. Click Yes.  The fields are now reset in the Add screen. 

 
If no errors display, this indicates that both the addition of the Location and the Item were 
successful.  

5. To verify that the addition was successful, enter the Site with which the Location you 
added is associated, then tap the Search icon  next to the Location field. 

6. The Search Locations screen displays, and the Location you added displays in the 
Location list. 
 

 

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Adding New Suppliers 

You can add new Suppliers in InventoryControl on the Windows Mobile Device. New Suppliers 
can only be added in the Add screen. 

Notes:  

• You will only be able to add a Supplier for an Item that is tracked by supplier. 
• The new Supplier will not be added unless the data for all other fields is completed 

correctly and the Add is successfully completed.  

Adding New Suppliers: 

In this example, a new Supplier will be added to the database while an Item is added. 

1. On the Add screen, enter the data for the Item you want to add.  
2. In the Supplier field, enter the new Supplier you want to add. 

 

 
3. Click OK.  The following message displays. 

 

 
4. Click Yes.  The Item and the new Supplier are added, and the fields are now reset in the 

Add screen. 
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If no errors display, this indicates that both the addition of the Supplier and the Item 
were successful.  

5. To verify the supplier was added, tap the Search icon  next to the Supplier field. 
 
The Search Suppliers screen displays, and the Supplier you added displays in the 
Supplier # list. 
 
  

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Details Screen 

The Details screen is used to display Location and Quantity information for any Item in the 
mobile database for the Site selected.  You can also view transactions on this screen. 

Details is an abbreviated version of the functionality available in the PC's Inventory  and 
Transactions Lists. 

To View Details: 

1. From the Main Menu, tap Details.  The Details screen appears. 
 

 
 
Note: You can enter characters manually, scan in data (see Entering Alphanumeric 
Data on the Windows Mobile Device for details) or use the Search function. 

2. This screen consists of two sections: Filter and Search Results.  The Filter section is 
expanded by default.  To open or close a section, click on the blue arrow that precedes 
the section name. 
 
 

If the arrow is pointing down,  that section is expanded, as the Filter section 
is in the Details screen example, above. 
 
If the arrow is pointing right, , that section is collapsed, as the Search 
Results section is in the Details screen example, above. 
 
Select the data you want to view by entering Filter information, then tapping the 
Inventory or Transactions buttons.  Keep in mind that after you enter an item number, 
the fields on the screen may change.  For instance, if you enter an item number that is 
tracked only by Serial Number, Lot, Date Code and Pallet fields will disappear because 
you do not need to information in those fields for this particular item. 
 
If you want to view all Inventory or all Transaction in the database, click the Inventory 
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or Transactions button without entering any filter information.  Transactions displays all 
events that have been performed on this device since the last sync.  Transactions can be 
used to verify if certain actions have been completed or to check that counts are correct. 
 
Inventory can be used to locate items, check quantity or determine where to move an 
item.  
 
The Search Results section automatically expands displaying the requested data: 
 

 
 
You can view details for only one field, or for a combination of fields. For example, if you 
select only an Item Number and leave all other fields blank, the Details screen will 
display the total quantity of the Item Number in all Sites and Locations. If you select an 
Item Number and a specific Site, the Details screen will display the quantity of that Item 
at the specified Site only. 
 
You can scroll right to left through the data using the bar at the bottom of the results grid. 

3. You can expand the Filter section again by tapping the blue arrow or by clicking the 
Show Filter button.  Enter new Filter information, then click Inventory or Transactions 
to view the search results. 
 
To clear the fields and find details for another Item, select the Reset button.  

4. To close the Details screen and return to the InventoryControl main menu, click the 
Close button.  

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Adjusting Inventory Quantities 

The Adjust function is used to modify the inventory quantity for existing Items. 

Inventory amounts can also be adjusted at the PC. See the Adjusting Inventory topic for more 
information. 

Adjusting Inventory: 

1. From the Main Menu, tab the Adjust icon.   
 
The Adjust screen displays. 
 

 
 
Note: You can enter characters manually, scan in data (see Entering Alphanumeric 
Data on the Windows Mobile Device for details) or use the Search function. 

2. Enter the Item Number in the Item # field.  In the example below, quantity for item 1001 
at Site 1, Location 3, is being adjusted because one of these items is broken. 
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Note that once the Item Number is selected, the Adjust screen displays only the fields 
that are necessary for adding this particular Item. For example, if you enter an Item that is 
tracked by serial number, the Serial # field will remain on the screen, but other fields 
such as Date Code and Pallet will no longer display. If you enter an Item that is not 
tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no 
longer display. 

3. Enter the Site and Location for the Item you want to adjust. 
 

 
4. Enter the Transaction Code in the Trans Code field. You can type any code directly into 

this field. Enter the code your company has defined for this transaction. 
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5. Select either By Count or By Diff and enter an amount. Click the down arrow in the By 

Count/By Difference field to select one of these options. By Count is used when a 
literal count has been made of inventory. By Difference is used when you want to 
indicate the amount by which the inventory has increased or decreased.  For example, if 
you have counted 15 of an item, but the software indicates you have 16, select By Count 
and enter 15.  If, however, the software indicates you have 16 items and you break one, 
you can indicate this by entering By Diff and selecting a reason code that indicates 
breakage.  Keep in mind that you cannot enter negative numbers.  You must indicate 
whether the system should add or subtract quantity by selecting the appropriate Reason 
code.  Reason codes are defined for you later in this topic. 
 

 
6. The Reason field is only used when the adjustment is By Difference. You do not need to 

use this field if you choose By Count.  If you do select By Difference in the Reason 
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field, you must enter a Reason Code.   
 

 
 
To search for a Reason Code, select the Search icon  by the Reason field.  The 
Adjust Code screen displays. 
 

 
 
The first three codes in the screen are used when quantities are being added. The 
second three codes are used when quantities are subtracted. 

• Positive: Indicates inventory was added. 
• Found: Indicates inventory previously missing has been found. 
• Return: Indicates the inventory is a returned item. 
• Negative: Indicates inventory was removed. 
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• Breakage: Indicates inventory is broken. 
• Lost: Indicates inventory is missing. 

Select a code and tab OK. 

1. When all required information is entered, tap OK.  The item's quantity is adjusted and the 
Adjust screen resets, ready for the next Item to be adjusted. 
 
Tapping the Reset button clears all fields and restores all available fields to the Adjust 
screen display. 

2. When you are finished with the Adjust screen, tap Close to return to InventoryControl 
main menu. 

See the Mobile Device Troubleshooting topic if you encounter errors while using this function. 
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Windows Mobile Device - Auditing Inventory 

Audit allows you to count the quantity of one or more items in your inventory when in Audit 
Mode.  Before you can conduct an audit using the mobile device, you must download a new 
database created while InventoryControl is in audit mode.  For more information on turning on the 
audit mode on the PC, please refer to the topic Auditing Your Inventory.  For more information on 
creating the database, please refer to the topic Windows Mobile Device - Setup Mobile Device. 

Inventory can also be audited at the PC. 

 

• Switching to Audit Mode on the Pocket PC 
• Returning to Normal Mode on the Pocket PC 

 

Switching to Audit Mode on the Windows Mobile Device 

1. To switch the device to Audit mode, you must first start an Audit on the PC side and send 
the new database to the mobile device.  For information on this, please refer to the topic 
Auditing Your Inventory. 

2. Next, create a new Pocket PC database, then synchronize the database with the Pocket 
PC. 

The Pocket PC version of InventoryControl opens in Audit mode. 

 

To perform an Audit, select Audit. 

The Audit screen displays. 
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Enter an Item Number, Site and Location. 

 

Note that once the Item Number is selected, the Audit screen displays only the fields that are 
necessary for Auditing this particular Item. For example, if you enter an Item that is tracked by 
serial number, the Serial # field will remain on the screen, but other fields such as Date Code 
and Pallet will no longer display. If you enter an Item that is not tracked by anything, all tracking 
fields - Lot, Date Code, Serial # and Pallet - will no longer display. 

• Enter the Transaction Code in the Trans Code field. This is a free form text field. Enter the 
code your company has defined for this transaction. 
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• Enter the Quantity. 

 

Tap OK.  

The Audit Item is entered and the screen resets, ready for the next Item. 

Note that when the screen resets, only the fields used for the Item you just entered display. To 
reset the screen so that all available fields display, tap Reset. 

When you have finished entering Items for the Audit, close the Audit screen by tapping the Close 
button. 

To send the Audit information to the PC, use the Send PC Data option. See Pocket PC Send PC 
Data for full details on this process. 

 

Returning to normal mode on the Pocket PC 

1. After sending the Audit data to the PC and processing the data on the PC side, on the 
PC, select Tools > Audit > End Audit. 
 
A confirmation message displays. 

2. Select Yes on the confirmation screen. 
 
InventoryControl returns to normal mode on the PC. 

3. Next, create a new mobile database, then synchronize the database with the Pocket PC. 
4. Close the mobile version of InventoryControl, then restart the application. 

 
The mobile version of MobileInventory opens in normal mode. 
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See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this 
function. 
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Windows Mobile Device -  Moving Inventory 

The Move function is used to move inventory quantity from one Location to another.  This allows 
you to move inventory quantity for an item from one Location to another.  When you create an 
item, you can add which locations it may be.  When you then add inventory (quantity) to the item, 
you select in which location that quantity will reside.  The Move function allows you to move that 
inventory from the originally assigned location to another.  By moving inventory in the software, 
you can easily keep accurate records of where all of your inventory is currently located. 

If the Allow Negative Quantities on Mobile Devices option is enabled on the Options screen, 
you can also move more quantity than is available at the source Location.  For more information 
on this option, please refer to the Options Screen topic. 

When moving an Item, the From Site and the To Site must be different. For example, you 
cannot move an Item from Site 100, Location 13 to Site 100, Location 13.  

Inventory can also be moved at the PC. See the Moving Inventory topic for more information. 

Moving Inventory: 

1. From the Main Menu, tap the Move icon.  The Move screen displays. 
 

 
 
Note: You can enter characters manually, scan in data (see Entering Alphanumeric 
Data on the Pocket PC for details) or use the Search function. 

2. In this example, a quantity of Item (1001) is being moved from Site 1, Location 2 to Site 
2, Location 3. 
 
 
Enter the Item Number in the Item field. 
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Note that once the Item Number is selected, the Move screen displays only the fields that 
are necessary for adding this particular Item. For example, if you enter an Item that is 
tracked by serial number, the Serial # field will remain on the screen, but other fields 
such as Date Code and Pallet will no longer display. If you enter an Item that is not 
tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no 
longer display. 

3. Enter the Site and Location from which the Item will be moved. 
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4. Enter the Site and Location to which the Item will be moved. 
 

 
5. Indicate the Quantity of the Item that will be moved. 

 

 
6. When all required information is entered, tap OK. 

 
The Item is moved and the Move screen resets, ready for the next Item to be moved. 
 
Tapping the Reset button clears all fields and restores all available fields to the Move 
screen display. 

7. When you are finished with the Move screen, tap Close to return to the 
InventoryControl main menu. 
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See the Windows Mobile Device Troubleshooting topic if you encounter errors while using 
this function. 
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Windows Mobile Device - Removing Inventory 

The Remove function is used to remove quantity from any Item that has quantity recorded in the 
database.   Inventory is the amount or quantity of a particular item.  

Notes regarding the Allow Negative Quantities option: 

• If this option is enabled (on the PC's Options Screen), you can enter a Quantity larger than 
the actual amount currently shown in the mobile database for that inventory Item. If the 
option is not enabled, you will not be allowed to enter a Quantity larger than the amount 
shown in the database.   

• The Allow Negative Quantities option also must be enabled before you can add a new 
Location in this screen. 

• For more information on this option, please refer to the Options Screen topic. 

Inventory can also be removed at the PC. See the Removing Inventory topic for more information. 

Removing Inventory: 

1. From the Main Menu, tap the Remove icon.  The Remove screen appears. 
 

 
 
You can enter characters manually, scan in data (see Entering Alphanumeric Data on 
the Pocket PC for details) or use the Search function. 
 
In this example, Mouse 1001 is being removed from Site 1, Location 2. 

2. Enter the Item Number to be removed in the Item field. 
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Note that once the Item Number is selected, the Remove screen displays only the fields 
that are necessary for adding this particular Item. For example, if you enter an Item that is 
tracked by serial number, the Serial # field will remain on the screen, but other fields 
such as Date Code and Pallet will no longer display. If you enter an Item that is not 
tracked, all tracking fields - PO, Supplier, Lot, Date Code, Serial # and Pallet - will no 
longer display. 

3. Enter the Site and Location from which this Item should be removed. 
 

 
4. Optionally enter a Customer. 
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5. Enter the Quantity of the Item to be removed. 
 

 
6. When all required information is entered, tap OK.  The Item is removed and the Remove 

screen resets, ready for the next Item to be removed. 
 
Tapping the Reset button clears all fields and restores all available fields to the Remove 
screen display. 

7. When you are finished with the Remove screen, tap Close to return to the 
InventoryControl main menu. 

See the Windows Mobile Device Troubleshooting topic if you encounter errors while using 
this function. 
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Windows Mobile Device - Removing a Kit Item 

This function applies to Pro and Enterprise Version users only. 

The Remove Kit function allows you to remove a kit item, which means removing quantity from 
the component items from your database..  This can be considered the same as shipping 
inventory.  You can designate which customer this inventory was shipped to on this screen.      

Kit Items can also be removed at the PC. See the Removing Kit Items topic for more information. 

Removing Kit Items: 

1. From the Main Menu, tap the Remove icon.  The Remove screen appears. 
 

 
 
You can enter characters manually, scan in data (see Entering Alphanumeric Data for 
details) or use the Search function. 
 
  

2. Enter the Item number you want to remove in the Item # field, or tap the i icon to access 
the Find screen.  Please refer to the Search Function topic for information on using the 
Find screen. 

The Remove screen changes when a Kit item is selected: 
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3. You can optionally enter a customer number or search for a customer. 
4. Enter the quantity you want to remove and click OK.  The quantity is the number of 

Kits you want to remove.  The Remove Kit screen appears.   
 

 
 
This is where you will select the Kit's component items to remove. 

5. Enter the Item # of the component item, or tap the i icon to view the Kit Info screen. 
Only items contained in this Kit will appear. 
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The Kit Info screen displays all component items for this Kit item.   
 
The Item # is the item number of the component item.   
 
The Total Qty is the total quantity of this item in this kit multiplied by the quantity you 
want to remove.  If there are 5 items in the kit and you have indicated you want to 
remove 12, 60 will display here (5 x 12 = 60).  If there are 10 items in the kit and you 
want to remove 12, 120 will display here (10 x 12 = 120). 
 
Undo will "undo" all of the transactions for that component item and reset the quantity 
processed back to zero. 
 
Doubleclick on the desired item.  The Remove Kit screen will reappear with the 
selected item populated in the Item # field. 

6. Enter the Site, Location and any Track Bys for this item. 
7. Enter the Quantity you want to remove. 
8. Click OK to remove the item.  Now you can select another component item to remove. 
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Windows Mobile Device - Receiving Inventory 

The Receive inventory function is used to add quantity to an item from a purchase order. 
 Purchase Orders are created on the PC.  For more information on creating Purchase Orders, 
please refer to the Creating a Purchase Order topic. 

Inventory can also be received at the PC. Manual items cannot be received on the mobile 
devices.  Please refer to Creating a Purchase Order for more information on Manual items. 

Receiving Inventory on the Windows Mobile Device: 

1. From the Main Menu, tap the Receive icon.  The Receive screen displays. 
 

 
 
Note:  On the Receive screen, you can enter characters manually, scan in data (see 
Entering Alphanumeric Data on the Windows Mobile Device for details) or use the 
Search function. 

2. Enter or search for the PO number that contains the item you are receiving. 
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3. Enter the number of the item you are receiving in the Item #  field.   
 

 
 
In the example above, Item 1002 is being received.   
 
The Details section displays the shipping unit of measure, how many of the item is 
contained in the shipping unit of measure (eaches) and the cost information.  Cost only 
displays if the Show Costing Information During Receive option is enabled on the PC 
Options screen.  For more information on this option, please refer to the Options Screen 
topic. 
 
You can expand the Details section by tapping the blue arrow next to word Details.  If 
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there is more than one possible order unit, the Details section will open automatically and 
you must pick one of the UOM entries to receive.  An example of the expanded section is 
shown below: 
 

 
 
In this example, each box contains 10 items and costs 10 per item ($100.00 per box). 
  

4. Enter the Site and Location into which the Item is to be received. 
 

 
5. Enter the Quantity of the Item to be received.  Keep in mind that you should enter the 

Order Unit of measure here.  For instance, if you are receive 1 box of 10, enter 1 rather 
than 10.  InventoryControl will do the math behind the scenes and break the shipment 
down to 10 for you. 
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Note: If this item were tracked by serial number, the quantity would be entered in eaches 
since you can only have 1 item per serial number. 
 
If you enter a quantity that is higher than the quantity entered on the Purchase Order, a 
warning will appear.  You can continue with the higher quantity if you so choose. 

6. When all required information is entered, tap OK.  The Item(s) is marked as Received 
and the Receive screen resets, ready for the next Item to be received. 
 
Tapping the Reset button clears all fields and restores all available fields to the Receive 
screen display. 

7. When you are finished with the Add screen, tap Close to return to InventoryControl 
main menu. 

See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this 
function. 

Tips for Speeding Up Data Entry: 

• When you create a new item, if the Category, Manufacturer, UOM or any combination of 
pinnable fields will be used on a large number of items, create one item with those fields, 
then pin the fields.  Now, the information will be retained in those fields so you don't have 
to keep re-entering it for each new item.    

• Make sure you have the Close New Forms option turned off (on the InventoryControl 
Options screen) so the New Item screen, or any other screen where new information is 
added, stays open after each new item is saved.   
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Windows Mobile Device - Picking Items for Orders 

The Pick inventory function is used to remove quantity from an item as it is added to a pick order. 
 Pick Orders are created on the PC when an order comes in from a customer requesting 
inventory.  For more information on creating Pick Orders, please refer to the Creating a Pick 
Order topic. 

Inventory can also be picked at the PC. Manual items cannot be picked on the mobile devices. 
 Please refer to Creating a Pick Order for more information on Manual items. 

Picking Inventory on the Windows Mobile Device: 

1. From the Main Menu, tap the Pick icon.  The Pick screen displays. 
 

 
 
Note:  On the Pick screen, you can enter characters manually, scan in data (see 
Entering Alphanumeric Data on the Windows Mobile Device for details) or use the 
Search function. 

2. Enter or search for the Order # that contains the item you are picking. 
 



 

458 

 
 
  

3. Enter the number of the item you are picking in the Item #  field.   
 

 
 
In the example above, one Item 1001 is being picked.   
 
  

4. Enter the Site and Location from which the item is being picked.  If you have selected a 
Primary Location for this item (on the Add/Edit Item screen) the Site and Location 
fields will automatically populate.  You can change these fields if needed. 



 

459 

 

 
5. Enter the Quantity of the Item to be picked.  If you enter a higher quantity than is 

indicated on the Pick Order, a warning will appear, but you will be allowed to enter the 
higher quantity if you so choose. 
 

 
 
Note: Notice that this is in eaches.   

6. When all required information is entered, tap OK.  The Item(s) is marked as Received 
and the Receive screen resets, ready for the next Item to be received. 
 
Tapping the Reset button clears all fields and restores all available fields to the Receive 
screen display. 

7. When you are finished with the Add screen, tap Close to return to InventoryControl 
main menu. 
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See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this 
function. 
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Windows Mobile Device - Picking Kit Items 

The Pick inventory function is used to remove quantity from an item as it is added to a pick order. 
 Pick Orders are created on the PC when an order comes in from a customer requesting 
inventory.  For more information on creating Pick Orders, please refer to the Creating a Pick 
Order topic. 

Picking Inventory on the Windows Mobile Device: 

1. From the Main Menu, tap the Pick icon.  The Pick screen displays. 
 

 
 
Note:  On the Pick screen, you can enter characters manually, scan in data (see 
Entering Alphanumeric Data on the Windows Mobile Device for details) or use the 
Search function. 

2. Enter or search for the Order # that contains the item you are picking. 
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3. Enter the number of the item you are picking in the Item #  field or click the i icon to 
search..   
 

 
4. Enter the Quantity you want to pick.  This is the number of kits you want to pick. 
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5. On the Pick Kit screen, enter the Item number of the component item you want to pick 
or click the i icon to search. 
 

 
 
If you click the search icon, the following Kit Info screen will appear allowing you to select 
a component item.  Only items contained in the selected Kit will appear on this screen. 
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The Kit Info screen displays all component items for this Kit item.   
 
The Item # is the item number of the component item.   
 
The Total Qty is the total quantity of this item in this kit multiplied by the quantity you 
want to pick.  If there are 5 items in the kit and you have indicated you want to pick 12, 60 
will display here (5 x 12 = 60).  If there are 10 items in the kit and you want to pick 12, 
120 will display here (10 x 12 = 120). 
 
Undo will "undo" all of the transactions for that component item and reset the quantity 
processed back to zero. 
 
Doubleclick on the desired item.  The Remove Kit screen will reappear with the selected 
item populated in the Item # field. 

6. Enter the Site and/or Location from which the item is being picked.  If you have selected 
a Primary Location for this item (on the Add/Edit Item screen) the Site and Location 
fields will automatically populate.  You can change these fields if needed. 
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7. Enter the Quantity of the Item to be picked.  If you enter a higher quantity than is 

indicated on the Pick Order, a warning will appear, but you will be allowed to enter the 
higher quantity if you so choose. 
 

 
 
Note: Notice that this is in eaches.   

8. When all required information is entered, tap OK.  The Item(s) is marked as Received 
and the Receive screen resets, ready for the next Item to be received. 
 
Tapping the Reset button clears all fields and restores all available fields to the Receive 
screen display. 

9. When you are finished with the Add screen, tap Close to return to InventoryControl 
main menu. 
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See the Windows Mobile Device Troubleshooting topic if you encounter errors while using this 
function. 
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Windows Mobile Device Troubleshooting 

This topic covers error messages and issues that may arise while using the Windows Mobile 
Device.  

The subjects currently covered in this Troubleshooting topic are listed below. Click the subject 
that most closely matches what you are searching for. 

Click the subject you want to troubleshoot: 

Error/Alert Messages (listed in alphabetical order): 

� Customer does not exist. Do you want to add this new customer? 
� Customer is not valid 
� Item doesn't exist 
� Location doesn't exist. Do you want to add this new location? 
� Location is not valid 
� Pallet is not valid 
� Please select one record from the list and click OK button to return to previous form 
� Quantity is not valid 
� Serial is not valid 
� Site does not exist 
� Source and destination sites are set to be the same... 
� Supplier does not exist. Do you want to add this new supplier? 
� The Adjust reason you entered is not valid 
� The mobile device has unprocessed transactions... 
� There is not enough quantity in stock to complete the transaction... 

Issues 

� Search screen is empty (no choices) 

 
"The Adjust Reason You Entered is not Valid" 

This message displays when you have selected By Difference and you have not entered a 
Reason code. You must either choose a Reason code or change your selection to By Count.  

 

"Quantity is not valid." 

This message displays when you have either not entered a number in the Quantity field, or 
you have enter alpha characters in the Quantity field. 
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Customer 

"Customer is Not Valid" 

This message displays if you leave the Customer field empty when it is a required field. You 
must enter a Customer in the Customer field. 

 

"Customer does not exist.  Do you want to add this new customer: <CUSTOMER 
NAME>?" 

This message displays if you enter a Customer in the Customer field that does not currently 
exist in the mobile  database. For more information on adding customers, please refer to the 
Windows Mobile Device - Adding Customers topic.  

 

 

Get Data from PC 

"The mobile device has unprocessed transactions.  Please process them on the PC 
database first, then you can get new database records from the PC side." 

This message indicates there are database records that have been sent from the device to the 
PC, but the data has not been processed on the PC side. Be sure you have completed the 
entire Send PC Data process, including processing the mobile device data in the Pending 
Uploads wizard. 

 

 

Items 

Messages 

"Item doesn't exist.  Hard Drive 500." 

This message displays under the following circumstances.: 

• Entering an Item Number that does not exist. 
You cannot add Item Numbers on the mobile device. You can only add Item Numbers on 
the PC side. You must either select another item, or add the Item Number on the PC 
side, download this new data to the device, and then select it on in the appropriate 
screen on your mobile device. 

• Leaving the Item Number screen blank. 
In screens where an Item Number is required, you will receive this message if you leave 
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the Item Number field blank and tap OK. 

  

Locations 

Messages 

"Location is not valid." 

This message displays if you do not enter a Location in the Location field or too many 
characters have been entered in the Location field. You must enter a Location in the Add, 
Remove, Move, Adjust and Stage screens. You can add a new Location on the mobile 
device if the one you need is not currently in the mobile device database. 

 

"Location does not exist.  Do you want to add this new location: <LOCATION NAME>?" 

This message displays if you enter a Location that does not exist in the mobile device 
database. Click here if you want to add this Location to the database. 

  

Move 

Messages 

"Source and Destination sites are set to be the same.  Destination site and location 
needs to be different than the Source Site and Location." 

This message indicates you selected the same Site and Location for both the Source from 
which you were moving the Item and the Destination to which you were moving the Item. You 
cannot have the same Site and Location for both the Source and the Destination. 

You must either change the Site and Location in the From Site and From Loc fields, or 
change the Site and Location in the To Site and To Loc fields. 

For example, if you entered Site 201 and Location A20 in both the Source and Destination 
Site/Location fields, you are trying to move an Item from its current Location to its current 
Location. 

If the Item is currently located at Site 201, Location A20, to move it to another site you must 
enter a different Destination, such as Site 100, Location B13. 
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Pallet 

Messages 

"Pallet is not valid." 

This message displays if: 

• The Item Number you entered is tracked by Pallet and you have not entered a Pallet in 
the Pallet field.  

• The Pallet you entered is not the correct Pallet by which the Item you entered is tracked. 
• A Pallet that does not exist has been entered in the Pallet field. 

If a Pallet is required, you must enter the Pallet by which the entered Item Number is tracked. 

  

  

Search 

Messages 

"Please select one record from the list and click OK button to return to previous form." 

This message displays if you do not select any record in the Search screen and then tap OK. 

You must either select a record in the Search screen, then tap OK, or tap Cancel to exit the 
Search screen without selecting a record. 

 

List area in Search screen is empty (no choices presented). 
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If you click the Search icon  next to a field in any screen in the mobile version of 
InventoryControl and the Search screen offers no list of choices, then no data for this field 
has been downloaded from the PC. You can add three types of records on the mobile device: 
Locations, Suppliers and Customers. 

For other records, you must add data from the PC side, then send the new data to the mobile 
device. 

Topics Related to Adding Data from the PC Side: 

• Create New Purchase Order 
• Create New Pick Order 
• Create New Item 
• Create New Manufacturer 
• Create New Site 

  

Serial Number 

Messages 

"Serial # is not valid." 

This message displays if: 

• The Item Number you entered is tracked by Serial Number and you have not entered a 
Serial Number in the Serial # field. 

• The Serial Number you entered is not the correct Serial Number by which the Item you 
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entered is tracked. 
• A Serial Number that does not exist has been entered in the Serial # field. 
• If a Serial Number is required, you must enter the Serial Number by which the entered 

Item Number is tracked. 

  

Sites 

"Site does not exist." 

This message displays if you enter a Site that is not in the database. 

You cannot create Sites on the mobile device. You can only create Sites on the PC side. You 
must either select another Site, or create the new Site on the PC side, download this new data 
to the device, and then select it on in the appropriate screen on your mobile device. 

 

 

Stock 

Messages 

"There is not enough quantity in stock to complete the transaction.  Quantity 
remaining: 0." 

This message will display if you attempt to Remove, Move or Adjust a greater quantity of an 
Item than is currently in stock. 

If there is an adequate quantity of the Item at a different Site and Location, you can select the 
Item from that Site and Location. If the quantity in all Sites and Locations is less than the 
amount you are trying to Remove, Move or Adjust, you will not be able to process this Item 
until enough a large enough quantity of the Item has been stocked. 

 

 

Supplier 

"Supplier does not exist.  Do you want to add this new supplier: <SUPPLIER NAME>? 

This message displays when you enter a Supplier that is not currently in the mobile device 
database in the Supplier field. For more information on adding suppliers on the mobile 
device, please refer to Windows Mobile Device - Adding Suppliers. 

 



 

473 
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Windows Mobile Device - Searching for Information 

You can use the Search function to enter data in many of the Inventory Control fields. 

Whenever the Search function is available, the Search icon  displays next to a field. 

To Search: 

1. Tap the Search icon to open the Search screen. 
 

 
 
The Search screen opens. 
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The title of the screen is specific to the field you select. For example, if you select the 
Search icon next to the Item field, the Search Items screen opens. If you select the 
Search icon next to the Site field, the Search Sites screen opens. 
 
When searching for a Location, note that you must first select a Site, then the Location. If 
you do not select a Site first, the Search Location screen will be empty. 

2. You can either select an Item from the list that displays in this screen, or enter search 
criteria in the top field, then tap Find. 
 

 
 
If you use the Find button, the Items that match the criteria you specified display. 
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Please note that InventoryControl contains partial search capability.  For example, if you 
are searching for item 1234, and enter 123, the application will return all items that 
contain the numbers 123 in the Item Number field.   
 
If your entry returns no results, you can clear the search field, then tap Find to display all 
records. 

Select the Item you want, then tap OK. 
 
The Search screen closes and the Item you selected displays in the field you selected. 
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Technical Support 

 Wasp Technical Support, Knowledge Base and Downloads  

 Wasp BarCode Online Store 
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